o

e



SEVENTH EDITION

Elementary
Statistics

A Step by Step Approach

Allan G. Bluman

Professor Emeritus
Community College of Allegheny County

% Higher Education

Boston Burr Ridge, IL  Dubuque, IA New York San Francisco St. Louis
Bangkok Bogota Caracas Kuala Lumpur Lisbon London Madrid Mexico City
Milan Montreal New Delhi Santiago Seoul Singapore Sydney Taipei Toronto



The McGraw-Hill Companies

2 Higher Education

ELEMENTARY STATISTICS: A STEP BY STEP APPROACH, SEVENTH EDITION

Published by McGraw-Hill, a business unit of The McGraw-Hill Companies, Inc., 1221 Avenue of the Americas,
New York, NY 10020. Copyright © 2009 by The McGraw-Hill Companies, Inc. All rights reserved. Previous
editions © 2007, 2004, 2001, 1998, and 1995. No part of this publication may be reproduced or distributed in any
form or by any means, or stored in a database or retrieval system, without the prior written consent of The
McGraw-Hill Companies, Inc., including, but not limited to, in any network or other electronic storage or
transmission, or broadcast for distance learning.

Some ancillaries, including electronic and print components, may not be available to customers outside the
United States.

This book is printed on acid-free paper.
1234567890VNH/VNHO0938

ISBN 978-0-07-353497-8
MHID 0-07-353497-8

ISBN 978-0-07-333121-8 (Annotated Instructor’s Edition)
MHID 0-07-333121-X

Editorial Director: Stewart K. Mattson

Sponsoring Editor: Dawn R. Bercier

Director of Development: Kristine Tibbetts
Developmental Editor: Michelle Driscoll
Marketing Manager: John Osgood

Project Manager: April R. Southwood

Lead Production Supervisor: Sandy Ludovissy
Senior Media Project Manager: Sandra M. Schnee
Designer: Tara McDermott

Cover Designer: Rick D. Noel

(USE) Cover Image: © Atlantide Phototravel/Corbis
Senior Photo Research Coordinator: Lori Hancock
Supplement Producer: Mary Jane Lampe
Compositor: /CC Macmillan Inc.

Typetace: 10.5/12 Times Roman

Printer: Von Hoffimann Press

The credits section for this book begins on page 815 and is considered an extension of the copyright page.
Library of Congress Cataloging-in-Publication Data

Bluman, Allan G.
Elementary statistics : a step by step approach / Allan G. Bluman. — 7th ed.
p. cm.

Includes bibliographical references and index.

ISBN 978-0-07-353497-8 — ISBN 0-07-353497-8 (hard copy : acid-free paper)
1. Statistics—Textbooks. 1. Title.

QA276.12.B59 2009

519.5—dc22

2008030803

www.mhhe.com


www.mhhe.com

3

The Nature
of Probability
and Statistics 1

Frequency
Distributions
and Graphs 35

Data Description 103

Probability and
Counting Rules 181

Discrete Probability
Distributions 251

The Normal
Distribution 299

Confidence Intervals
and Sample
Size 355

10

11

12

13

14

Hypothesis
Testing 399

Testing the Difference
Between Two Means,
Two Proportions, and
Two Variances 471

Correlation and
Regression 533

Other Chi-Square
Tests 589

Analysis of
Variance 627

Nonparametric
Statistics 669

Sampling and
Simulation 717

All examples and exercises in this textbook (unless cited) are hypothetical and are presented to enable students to achieve a basic understanding of the statisti-
cal concepts explained. These examples and exercises should not be used in lieu of medical, psychological, or other professional advice. Neither the author nor
the publisher shall be held responsible for any misuse of the information presented in this textbook.



iv Brief Contents

APPENDI

A Algebra Review 751

B- 1 Writing the Research

Report 757

B-2 Bayes’ Theorem 759

B-3 Alternate Approach to

APPENDI

the Standard Normal
Distribution 763

C Tables 767

APPENDI

APPENDI

APPENDI

APPENDI

APPENDI

£ OO m m ©O

Index 1-1

Data Bank 797

Glossary 805

Bibliography 813

Photo Credits 815

Selected
Answers SA-1



Preface ix

The Nature of Probability
and Statistics 1
Introduction 2

1-1 Descriptive and Inferential
Statistics 3

1-2 Variables and Types of Data 6
1=3 Data Collection and Sampling Techniques 9
Random Sampling 10
Systematic Sampling 11
Stratified Sampling 12
Cluster Sampling 12
Other Sampling Methods 13
1=4 Observational and Experimental Studies 13
1-5 Uses and Misuses of Statistics 16
Suspect Samples 17
Ambiguous Averages 17
Changing the Subject 17
Detached Statistics 18
Implied Connections 18
Misleading Graphs 18
Faulty Survey Questions 18
1-6 Computers and Calculators 19
Summary 25

Frequency Distributions

and Graphs 35
Introduction 36

2-1 Organizing Data 37
Categorical Frequency Distributions 38
Grouped Frequency Distributions 39

2-2

2-3

Data Description 103

3-1

Histograms, Frequency Polygons,
and Ogives 51

The Histogram 51

The Frequency Polygon 53
The Ogive 54

Relative Frequency Graphs 56
Distribution Shapes 59
Other Types of Graphs 68
Bar Graphs 69

Pareto Charts 70

The Time Series Graph 71
The Pie Graph 73
Misleading Graphs 76

Stem and Leaf Plots 80
Summary 94

Introduction 104

Measures of Central
Tendency 105

The Mean 106

The Median 109

The Mode 111

The Midrange 114

The Weighted Mean 115

Distribution Shapes 117

Measures of Variation 123

Range 124

Population Variance and Standard Deviation 125

Sample Variance and Standard Deviation 128

Variance and Standard Deviation
for Grouped Data 129

Coefficient of Variation 132
Range Rule of Thumb 133
Chebyshev’s Theorem 134
The Empirical (Normal) Rule 136



vi Contents

3=-3 Measures of Position 142
Standard Scores 142
Percentiles 143
Quartiles and Deciles 149
Outliers 151

3-4 Exploratory Data Analysis 162

The Five-Number Summary and Boxplots 162

Summary 171

cuaPTER

Probability and Counting
Rules 181

Introduction 182

4-1 Sample Spaces and
Probability 183
Basic Concepts 183
Classical Probability 186
Complementary Events 189
Empirical Probability 191
Law of Large Numbers 193
Subjective Probability 194
Probability and Risk Taking 194

4-2 The Addition Rules for Probability 199

4-3 The Multiplication Rules and Conditional
Probability 211
The Multiplication Rules 211
Conditional Probability 216
Probabilities for “At Least” 218

4-4 Counting Rules 224
The Fundamental Counting Rule 224
Factorial Notation 227
Permutations 227
Combinations 229

4-5 Probability and Counting Rules 237
Summary 242

cuaPTER

Discrete Probability
Distributions 251

Introduction 252
5-1 Probability

Distributions 253
5-2 Mean, Variance, Standard Deviation,

and Expectation 259

Mean 259

Variance and Standard Deviation 262

Expectation 264

6-1

6-4

cHAPTER 7/

Confidence Intervals
and Sample Size 355

7-1

INOT 6

The Normal Distribution 299

The Binomial Distribution 270

Other Types of Distributions (Optional) 283
The Multinomial Distribution 283

The Poisson Distribution 284

The Hypergeometric Distribution 286

Summary 292

Introduction 300
Normal Distributions 302

The Standard Normal
Distribution 304

Finding Areas Under the Standard Normal
Distribution Curve 305

A Normal Distribution Curve as a Probability
Distribution Curve 307

Applications of the Normal
Distribution 316

Finding Data Values Given Specific
Probabilities 319

Determining Normality 322
The Central Limit Theorem 331
Distribution of Sample Means 331

Finite Population Correction
Factor (Optional) 337

The Normal Approximation to the Binomial
Distribution 340

Summary 347

Introduction 356

Confidence Intervals for the
Mean When o Is Known
and Sample Size 357

Confidence Intervals 358
Sample Size 363

Confidence Intervals for the Mean
When o Is Unknown 370

Confidence Intervals and Sample Size
for Proportions 377

Confidence Intervals 378
Sample Size for Proportions 379

Confidence Intervals for Variances
and Standard Deviations 385

Summary 392



Hypothesis Testing 399

Introduction 400

8=1 Steps in Hypothesis
Testing—Traditional
Method 401

8-2 zTestforaMean 413

P-Value Method for Hypothesis Testing 418
8-3 tTest fora Mean 427
8-4 z Test for a Proportion 437

8-5 x? Test for a Variance or Standard
Deviation 445

8-6 Additional Topics Regarding Hypothesis
Testing 457

Confidence Intervals and Hypothesis Testing 457
Type Il Error and the Power of a Test 459
Summary 462

cHAPTER o

Testing the Difference

Between Two Means, Two

Proportions, and

Two Variances 471
Introduction 472

9-1 Testing the Difference Between
Two Means: Using the z Test 473

9-2 Testing the Difference Between Two
Means of Independent Samples:
Using the t Test 484

9-3 Testing the Difference Between Two Means:
Dependent Samples 491

9-4 Testing the Difference Between
Proportions 503

9-5 Testing the Difference Between
Two Variances 512

Summary 523
Hypothesis-Testing Summary 1 531

| cuapter L)

Correlation and
Regression 533
Introduction 534

10-1 Scatter Plots and
Correlation 535

Correlation 539
10-2 Regression 551
Line of Best Fit 551

Contents vii

Determination of the Regression
Line Equation 552

10-3 Coefficient of Determination and Standard
Error of the Estimate 565

Types of Variation for the Regression Model 565
Coefficient of Determination 568
Standard Error of the Estimate 568
Prediction Interval 570
10-4 Multiple Regression (Optional) 573
The Multiple Regression Equation 575
Testing the Significance of R 577
Adjusted R? 578
Summary 582

cuaptER B

Other Chi-Square Tests 589

Introduction 590

11-=1 Test for Goodness
of Fit 591

Test of Normality
(Optional) 596

11-2 Tests Using Contingency Tables 604
Test for Independence 604

Test for Homogeneity of Proportions 609
Summary 619

| cuapTER | b/

Analysis of Variance 627

Introduction 628

12-1 One-Way Analysis of
Variance 629

12-2 The Scheffé Test
and the Tukey Test 640

Scheffé Test 640
Tukey Test 642

12-3 Two-Way Analysis of Variance 645
Summary 659

Hypothesis-Testing Summary 2 667

EIoE13

Nonparametric
Statistics 669

Introduction 670

13-1 Advantages and
Disadvantages of
Nonparametric Methods 671




viii Contents

Advantages 671 APPEND

Disadvantages 671
Ranking 671
13-2 The Sign Test 673
Single-Sample Sign Test 673
Paired-Sample Sign Test 675
13=3 The Wilcoxon Rank Sum Test 681
13-4 The Wilcoxon Signed-Rank Test 686
13-5 The Kruskal-Wallis Test 691

13-6 The Spearman Rank Correlation Coefficient
and the Runs Test 697

Rank Correlation Coefficient 697
The Runs Test 700
Summary 708

APPEND

APPEND

APPEND

APPEND
Hypothesis-Testing Summary 3 714

cuarren 1

Sampling and
Simulation 717

APPEND

APPEND

Introduction 718

14-1 Common Sampling
Techniques 719

APPEND

Random Sampling 719

Systematic Sampling 723

Stratified Sampling 724

Cluster Sampling 726

Other Types of Sampling Techniques 727

APPEND

APPEND

14-2 Surveys and Questionnaire Design 734

14-3 Simulation Techniques and the Monte Carlo
Method 737

The Monte Carlo Method 737
Summary 743

>

Xz 6O T m © 0O

Index 1-1

Algebra Review 751

Writing the Research
Report 757

Bayes’ Theorem 759

Alternate Approach to
the Standard Normal
Distribution 763

Tables 767

Data Bank 797

Glossary 805

Bibliography 813

Photo Credits 815

Selected Answers SA-1



Approach

About This
Book

Elementary Statistics: A Step by Step Approach was written as an aid in the beginning
statistics course to students whose mathematical background is limited to basic algebra.
The book follows a nontheoretical approach without formal proofs, explaining concepts
intuitively and supporting them with abundant examples. The applications span a broad
range of topics certain to appeal to the interests of students of diverse backgrounds
and include problems in business, sports, health, architecture, education, entertainment,
political science, psychology, history, criminal justice, the environment, transportation,
physical sciences, demographics, eating habits, and travel and leisure.

While a number of important changes have been made in the seventh edition, the learn-
ing system remains untouched and provides students with a useful framework in which
to learn and apply concepts. Some of the retained features include the following:

* Over 1800 exercises are located at the end of major sections within each chapter.

+ Hypothesis-Testing Summaries are found at the end of Chapter 9 (z, ¢, x?, and
F tests for testing means, proportions, and variances), Chapter 12 (correlation,
chi-square, and ANOVA), and Chapter 13 (nonparametric tests) to show students
the different types of hypotheses and the types of tests to use.

» A Data Bank listing various attributes (educational level, cholesterol level, gender,
etc.) for 100 people and several additional data sets using real data are included
and referenced in various exercises and projects throughout the book.

+ An updated reference card containing the formulas and the z, ¢, ¥, and PPMC
tables is included with this textbook.

* End-of-chapter Summaries, Important Terms, and Important Formulas give
students a concise summary of the chapter topics and provide a good source for
quiz or test preparation.

* Review Exercises are found at the end of each chapter.

 Special sections called Data Analysis require students to work with a data set to
perform various statistical tests or procedures and then summarize the results. The
data are included in the Data Bank in Appendix D and can be downloaded from
the book’s website at www.mhhe.com/bluman.

* Chapter Quizzes, found at the end of each chapter, include multiple-choice,
true/false, and completion questions along with exercises to test students’
knowledge and comprehension of chapter content.

» The Appendixes provide students with an essential algebra review, an outline for
report writing, Bayes’ theorem, extensive reference tables, a glossary, and answers
to all quiz questions, all odd-numbered exercises, selected even-numbered
exercises, and an alternate method for using the standard normal distribution.


www.mhhe.com/bluman

X Preface

Changes in
the Seventh

Edition

The Applying the Concepts feature is included in all sections and gives students
an opportunity to think about the new concepts and apply them to hypothetical
examples and scenarios similar to those found in newspapers, magazines, and radio
and television news programs.

This edition of Elementary Statistics is updated and improved for students and instruc-
tors in the following ways:

Over 300 new exercises have been added, most using real data, and many
exercises incorporate thought-provoking questions requiring students to interpret
their results.

Titles have been given to each application example and each exercise problem to
emphasize their real-world relevance.

Six new Speaking of Statistics topics have been included.

An explanation of bar graphs has been added to Chapter 2 since bar graphs are one
of the most commonly used graphs in statistics, and they are slightly different from
Pareto charts.

Over 40 examples have been replaced with new ones, the majority using real data.

Two graphs have been added to the explanation of the chi-square distribution in
Chapter 7 to help clarify the nature of the distribution and how the distribution is
related to the chi-square table.

The Excel Technology Step by Step boxes have been updated to reflect Microsoft
Excel 2007.

The shortcut formula for the standard deviation has been changed. The formula used

_ 2
now is s = ’1(2’)1((2—_(12)}(), which is the one used in most other statistics books.

X2 — [(2X)?
It also avoids the complex fraction used in the other formula s = \/%
Many reviewers have stated that they like the first formula better than the second one.
The cumulative standard normal distribution is used throughout the book.
The null hypothesis is stated using the equals sign in all cases where appropriate.

When o or o, and o, are known, the z tests are used in hypothesis testing. When o
or o, and o, are unknown, the ¢ tests are used in hypothesis testing.

The F test for two variances is no longer used before the ¢ test for the difference
between two means when o, and o, are unknown.

The Data Projects at the end of each chapter are all new and are specific to the
areas of Business and Finance, Sports and Leisure, Technology, Health and
Wellness, Politics and Economics, and Your Class.
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Over 300 examples with detailed solutions
serve as models to help students solve
problems on their own. Examples are solved
by using a step by step explanation, and
illustrations provide a clear display of results

for students.

422 Chapter 8 Hypothesis Testing

nh W=

o N

What is your decision?
What is your conclusion?

hd

‘What hypotheses would you use?

Is the sample considered small or large?

‘What assumption must be met before the hypothesis test can be conducted?
Which probability distribution would you use?

Would you select a one- or two-tailed test? Why?

‘What critical value(s) would you use?

Conduct a hypothesis test. Use o = 30.3.

Using this information, answer these questions.

10. Write a brief statement summarizing your conclusion.
11. If you lived in a city whose population was about 50,000, how many automobile thefts
per year would you expect to occur?

See page 468 and page 469 for the answers.

For Exerciscs 1 through 13, perform cach of the
following steps.

State the hypotheses and identify the claim.
Find the critical value(s).

Compute the test value.

Make the decision.

Summarize the results.

[

Use diagrams to show the critical region (or regions),
and use the traditional method of hypothesis testing
unless otherwise specified.

1. Walking with a Pedometer An increase in walking
has been shown to contribute to a healthier life-style. A
sedentary American takes an average of 5000 steps per
day (and 65% of Americans are overweight). A group of
health-conscious employees of a large health care system
volunteered to wear pedometers for a month to record
their steps. It was found that a random sample of 40
walkers took an average of 5430 steps per day, and the
population standard deviation is 600 steps. At a = 0.05
can it be concluded that they walked more than the
mean number of 5000 steps per day?

Source: www.msn.com/health

Credit Card Debt It has been reported that the average
credit card debi for college seniors is $3262. The student
senate at a large university feels that their seniors have a
debt much less than this, so it conducts a study of 50
randomly selected seniors and finds that the average debt
s $2995, and the population standard deviation is $1100.
With & = 0.05, is the student senate correct?

Source: USA TODAY.

N

3. Revenue of Large Businesses A researcher
estimates that the average revenue of the largest

8-24

businesses in the United States is greater than $24 billion.
Asample of 50 companies is selected, and the revenues (in
billions of dollars) are shown. At & = 0.05, s there cnough
evidence to support the researcher’s claim? o = 28.7.

178 122 91 44 35
61 56 46 20 32
30 28 28 20 27
29 16 16 19 15
41 38 36 15 25
31 30 19 19 19
24 16 15 15 19
25 25 18 14 15
24 23 17 17 22
22 21 20 17 20

Source: New York Times Almanac.

4. Salaries of Ph.D. Students Full-time Ph.D. students
receive an average salary of $12,837 according to the
U.S. Department of Education. The dean of graduate
studies at a large state university feels that Ph.D.
students in his state earn more than this. He surveys
44 randomly selected students and finds their average
salary is $14,443, and the population standard deviation
is $1500. With & = 0.05, is the dean correct?

Source: U.S. Department of Education/Chronicle of Higher Education.

5. Health Care Expenses The mean annual expenditure
per 25- to 34-year-old consumer for health care is $1468.
“This includes health insurance, medical services, and
drugs and medical supplies. Students at a large university
took a survey, and it was found that for a sample of
60 students, the mean health care expense was $1520,
and the population standard deviation is $198. Is there
sufficient evidence at a = 0.01 to conclude that their
health care expenditure differs from the national average
of $1468? Is the conclusion different at & = 0.05?

Source: Time Almanac
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Numerous examples and exercises
use real data. The icon shown here
indicates that the data set for the
exercise is available in a variety of file
formats on the text's website and

Data CD.
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Numerous Procedure Tables summarize
processes for students’ quick reference.
All use the step by step method.
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Section 14-1 Common Sampling Techniques 723

Should We Be Afraid of Lightning?
The National Weather Service collects
various types of data about the weather.
For example, cach year in the United
States about 400 million lightning strikes
occur. On average, 400 people are struck
by lightning, and 85% of those struck

are men. About 100 of these people die.
The cause of most of these deaths is not
burns, even though temperatures as

high as 54,000°F are reached, but heart
attacks. The lightning strike short-circuits
the body’s autonomic nervous system,
causing the heart to stop beating. In

some instances, the heart will restart on
its own. In other cases, the heart victim will need emergency resuscitation.

‘The most dangerous places to be during a thunderstorm are open fields, golf courses, under trees, and near water,
such as a lake or swimming pool. Its best to be inside a building during a thunderstorm although there’s no guarantee
that the building won’t be struck by lightning. Are these statistics descriptive or inferential? Why do you think more men
are struck by lightning than women? Should you be affaid of lightning?

2
Method for Selecting 18 13 41 30 56 20 37 74 49 56 45 46 83
Three-Digit Numbers 19 &2 02 6 34 27 77 34 24 9 16 77 00

Use one column and part of the next column for three digits, that is, 404.

Systematic Sampling

A systematic sample is a sample obtained by numbering each element in the population
and then selecting every third or fifth or tenth, etc., number from the population to be
included in the sample. This is done after the first number is selected at random.

table,

N

The Speaking of Statistics sections
invite students to think about poll
results and other statistics-related
news stories in another connection
between statistics and the real world.




Historical Notes, Unusual Stats, and
Interesting Facts, located in the margins,
make statistics come alive for the reader.

418 Chapter 8 Hypothesis Testing

Again, remember that nothing is being proved true or false. The statistician is only
stating that there is or is not enough evidence to say that a claim is probably true or false.
As noted previously, the only way to prove something would be to use the entire
population under study, and usually this cannot be done, especially when the population

is large.

P-Value Method for Hypothesis Testing

Statisticians usually test hypotheses at the common « levels of 0.05 or 0.01 and some-
times at 0.10. Recall that the choice of the level depends on the seriousness of the
type 1 error. Besides listing an « value, many computer statistical packages give a

P-value for hypothesis tests.

The P-value (or probability value) is the probability of getting a sample statistic (such as
the mean) or a more extreme sample statistic in the direction of the alternative hypothesis

when the null hypothesis is true.

In other words, the P-value is the actual area under the standard normal distribution curve
(or other curve, depending on what statistical test is being used) representing the proba-
bility of a particular sample statistic or a more extreme sample statistic occurring if the

null hypothesis is true.
For example, suppose that an alternative hypothesis is /: 1 > 50 and the mean of
a sample is X = 52. If the computer printed a P-value of 0.0356 for a statistical test,
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Rules and definitions are set off for
easy referencing by the student.

then the probability of getting a sample mean of 52 or greater is 0.0356 if the true
population mean is 50 (for the given sample size and standard deviation). The rela-
tionship between the P-value and the « value can be explained in this manner. For
P = 0.0356, the null hypothesis would be rejected at & = 0.05 but not at & = 0.01. See

Figure §-18.
When the hypothesis test is two-tailed, the area in one tail must be doubled. For
a two-tailed test, if a is 0.05 and the area in one tail is 0.0356, the P-value will be
2(0.0356) = 0.0712. That is, the null hypothesis should not be rejected at e = 0.03, since
0.0712 is greater than 0.05. In summary, then, if the P-value is less than a, reject the null
hypothesis. If the P-value is greater than e, do not reject the null hypothesis.
The P-values for the z test can be found by using Table E in Appendix C. First find
the area under the standard normal distribution curve corresponding to the z test value;
then subtract this area from 0.5000 to get the P-value for a right-tailed or a left-tailed test.
To get the P-value for a two-tailed test, double this area after subtracting. This procedure
is shown in step 3 of Examples 86 and 8-7.
The P-value method for testing hypotheses differs from the traditional method some-

what. The steps for the P-value method are summarized next.

Critical Thinking sections at the end
of each chapter challenge students to
apply what they have learned to new
situations. The problems presented
are designed to deepen conceptual
understanding and/or to extend

topical coverage.
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Equation of regression line
Level of significance = 0.1
Test statistic = 0.794556

Critical value = 0378419

' =0.725983X + 16.5523

Are both variables moving in the same direction?
‘Which number measures the distances from the prediction line to the actual values?

N

Which number is the slope of the regression line?
Which number is the y intercept of the regression line?
Which number can be found in a table?

Which number is the allowable risk of making a type I error?

Which number measures the variation explained by the regression?

Applying the Concepts are exercises found at the
end of each section to reinforce the concepts
explained in the section. They give the student an
opportunity to think about the concepts and apply
them to hypothetical examples similar to real-life
ones found in newspapers, magazines, and
professional journals. Most contain open-ended
questions—questions that require interpretation

and may have more than one correct answer. These
exercises can also be used as classroom discussion

Which number measures the scatter of points about the regression line?
What is the null hypothesis?

Which number is compared to the critical value to see if the null hypothesis should be
rejected?

. Should the null hypothesis be rejected?

SR v ke~

See page 588 for the answers.

@ Data Projects

1. Business and Finance Use 30 stocks classified as the
Dow Jones industrials as the sample. Note the amount
each stock has gained or lost in the last quarter.
Compute the mean and standard deviation for the data
set. Compute the 95% confidence interval for the mean
and the 95% confidence interval for the standard
deviation. Compute the percentage of stocks that had a
gain in the last quarter. Find a 95% confidence interval
for the percentage of stocks with a gain.

2. Sports and Leisure Use the top home run hitter from
cach major league bascball team as the data set. Find
the mean and the standard deviation for the number of
home runs hit by the top hitter on cach team. Find a
95% confidenc interval for the mean number of home
runs hit,

bd

Technology Use the data collected in data project 3 of
Chapter 2 regarding song lengths. Select a specific
genre and compute the percentage of songs in the
sample that are of that genre. Create a 95% confidence
interval for the true percentage. Use the entire music
library and find the population percentage of the library
with that genre. Does the population percentage fall
within the confidence interval

e

4. Health and Wellness Use your class as the sample.
Have each student take her or his temperature on a
healthy day. Compute the mean and standard deviation
for the sample. Create a 95% confidence interval for
the mean temperature. Does the confidence interval
obtained support the long-held belief that the average
body temperature is 98.6°F?

E

Politics and Economics Sclect five political polls and
note the margin of error, sample size, and percent
favoring the candidate for each. For cach poll,
determine the level of confidence that must have been
used to obtain the margin of error given, knowing the
percent favoring the candidate and number of
participants. Is there a pattern that emerges?

ES

and standard deviation for the data set. Compute a 95%
confidence interval for the mean BMI of a student. A
BMI score over 30 is considered obese. Does the
confidence interval indicate that the mean for BMI
could be in the obese range?

. Your Class Have each student compute his or her body
mass index (BMI) (703 times weight in pounds, divided
by the quantity height in inches squared). Find the mean

topics for instructors who like to use this type of
teaching technique.

Data Projects, which appear at the end of each chapter, further challenge students’ understanding and application of
the material presented in the chapter. Many of these require the student to gather, analyze, and report on real data.

Xix



XX Guided Tour: Features and Supplements

Multimedia MathZone—www.mhhe.com/bluman

Supplements McGraw-Hill’s MathZone is a complete online homework system for mathematics and
statistics. Instructors can assign textbook-specific content from over 40 McGraw-Hill

Ve o titles as well as customize the level of feedback students receive, including the ability to

MathZone * > ; ) . . :

& have students show their work for any given exercise. Assignable content includes an
array of videos and other multimedia along with algorithmic exercises, providing study
tools for students with many different learning styles.

Within MathZone, a diagnostic assessment tool powered by ALEKS™s available to
measure student preparedness and provide detailed reporting and personalized remediation.
MathZone also helps ensure consistent assignment delivery across several sections through
a course administration function and makes sharing courses with other instructors easy.

For additional study help students have access to NetTutor™a robust online live
tutoring service that incorporates whiteboard technology to communicate mathematics.
The tutoring schedules are built around peak homework times to best accommodate stu-
dent schedules. Instructors can also take advantage of this whiteboard by setting up a
Live Classroom for online office hours or a review session with students.

For more information, visit the book’s website (www.mhhe.com/bluman) or contact
your local McGraw-Hill sales representative (www.mhhe.com/rep).

ALEKS—www.aleks.com

ALEKS (Assessment and LEarning in Knowledge Spaces) is a dynamic online learning
system for mathematics education, available over the Web 24/7. ALEKS assesses stu-
dents, accurately determines their knowledge, and then guides them to the material that
they are most ready to learn. With a variety of reports, Textbook Integration Plus, quizzes,
and homework assignment capabilities, ALEKS offers flexibility and ease of use for
instructors.

* ALEKS uses artificial intelligence to determine exactly what each student knows
and is ready to learn. ALEKS remediates student gaps and provides highly efficient
learning and improved learning outcomes.

e ALEKS is a comprehensive curriculum that aligns with syllabi or specified
textbooks. Used in conjunction with McGraw-Hill texts, students also receive links
to text-specific videos, multimedia tutorials, and textbook pages.

* Textbook Integration Plus allows ALEKS to be automatically aligned with syllabi
or specified McGraw-Hill textbooks with instructor chosen dates, chapter goals,
homework, and quizzes.

* ALEKS with AI-2 gives instructors increased control over the scope and sequence
of student learning. Students using ALEKS demonstrate a steadily increasing
mastery of the content of the course.

e ALEKS offers a dynamic classroom management system that enables instructors to
monitor and direct student progress towards mastery of course objectives.

ALEKS Prep for Statistics

ALEKS prep for Statistics can be used during the beginning of the course to prepare stu-
dents for future success and to increase retention and pass rates. Backed by two decades
of National Science Foundation funded research, ALEKS interacts with students much
like a human tutor, with the ability to precisely assess a student’s preparedness and pro-
vide instruction on the topics the student is ready to learn.

ALEKS Prep for Statistics:

* Assists students in mastering core concepts that should have been learned prior to
entering the present course.


www.mhhe.com/bluman
www.mhhe.com/bluman
www.mhhe.com/rep
www.aleks.com

Guided Tour: Features and Supplements xXXxi

* Frees up lecture time for instructors, allowing more time to focus on current course
material and not review material.

* Provides up to six weeks of remediation and intelligent tutorial help to fill in
students’ individual knowledge gaps.

Electronic Textbook

CourseSmart is a new way for faculty to find and review eTextbooks. It’s also a great
option for students who are interested in accessing their course materials digitally and
saving money. CourseSmart offers thousands of the most commonly adopted textbooks
across hundreds of courses from a wide variety of higher education publishers. It is the
only place for faculty to review and compare the full text of a textbook online, providing
immediate access without the environmental impact of requesting a print exam copy.
At CourseSmart, students can save up to 50% off the cost of a print book, reduce the
impact on the environment, and gain access to powerful Web tools for learning including
full text search, notes and highlighting, and e-mail tools for sharing notes between
classmates. www.CourseSmart.com

Computerized Test Bank (CTB) Online (instructors only)

The computerized test bank contains a variety of questions, including true/false, multiple-
choice, short answer, and short problems requiring analysis and written answers. The test-
ing material is coded by type of question and level of difficulty. The Brownstone Diploma®
system enables you to efficiently select, add, and organize questions, such as by type of
question or level of difficulty. It also allows for printing tests along with answer keys as well
as editing the original questions, and it is available for Windows and Macintosh systems.
Printable tests and a print version of the test bank can also be found on the website.

Lecture Videos

New lecture videos introduce concepts, definitions, theorems, formulas, and problem-
solving procedures to help students better comprehend the topic at hand. These videos
are closed-captioned for the hearing-impaired, are subtitled in Spanish, and meet the
Americans with Disabilities Act Standards for Accessible Design. They can be found
online at www.mhhe.com/bluman and are also available on DVD.

Exercise Videos

In these videos the instructor works through selected exercises, following the solution
methodology employed in the text. Also included are tutorials for using the TI-83 Plus
and TI-84 Plus calculators, Excel, and MINITAB, presented in an engaging format for
students. These videos are closed-captioned for the hearing-impaired, are subtitled in
Spanish, and meet the Americans with Disabilities Act Standards for Accessible Design.
They can be found online at www.mhhe.com/bluman and are also available on DVD.

NetTutor

NetTutor is a revolutionary system that enables students to interact with a live tutor over
the Web by using NetTutor’s Web-based, graphical chat capabilities. Students can also
submit questions and receive answers, browse previously answered questions, and view
previous live chat sessions. NetTutor can be accessed through MathZone.

MINITAB Student Release 14

The student version of MINITAB statistical software is available with copies of the text.
Ask your McGraw-Hill representative for details.


www.CourseSmart.com
www.mhhe.com/bluman
www.mhhe.com/bluman
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Print
Supplements

SPSS Student Version for Windows

A student version of SPSS statistical software is available with copies of this text. Consult
your McGraw-Hill representative for details.

Annotated Instructors Edition (instructors only)

The Annotated Instructor’s Edition contains answers to all exercises and tests. The
answers to most questions are printed in red next to each problem. Answers not appear-
ing on the page can be found in the Answer Appendix at the end of the book.

Instructor’s Solutions Manual (instructors only)

By Sally Robinson of South Plains College, this manual includes worked-out solutions
to all the exercises in the text and answers to all quiz questions. This manual can be found
online at www.mhhe.com/bluman.

Student’s Solutions Manual

By Sally Robinson of South Plains College, this manual contains detailed solutions to all
odd-numbered text problems and answers to all quiz questions.

MINITAB 14 Manual

This manual provides the student with how-to information on data and file management,
conducting various statistical analyses, and creating presentation-style graphics while
following each text chapter.

TI-83 Plus and TI-84 Plus Graphing Calculator Manual

This friendly, practical manual teaches students to learn about statistics and solve problems
by using these calculators while following each text chapter.

Excel Manual

This workbook, specially designed to accompany the text, provides additional practice in
applying the chapter concepts while using Excel.


www.mhhe.com/bluman
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Today

Of people in the
United States, 14%
said that they feel
happiest in June, and
149% said that they
feel happiest in
December.

Chapter 1 The Nature of Probability and Statistics

Are We Improving Our Diet?

It has been determined that diets rich in fruits and vegetables are associated with a lower
risk of chronic diseases such as cancer. Nutritionists recommend that Americans consume
five or more servings of fruits and vegetables each day. Several researchers from the
Division of Nutrition, the National Center for Chronic Disease Control and Prevention,
the National Cancer Institute, and the National Institutes of Health decided to use statis-
tical procedures to see how much progress is being made toward this goal.

The procedures they used and the results of the study will be explained in this
chapter. See Statistics Today—Revisited at the end of this chapter.

Introduction

You may be familiar with probability and statistics through radio, television, newspapers,
and magazines. For example, you may have read statements like the following found in
newspapers.

* In Massachusetts, 36% of adults aged 25 and older have at least a bachelor’s degree.
(Source: U.S. Census Bureau.)

e In 1995 there were 926,621 bankruptcy filings, while in 2005 there were
2,078,415 bankruptcy filings. (Source: Administrative Office of the U.S. Courts,
Washington, D.C.)

 Toddlers need an average of 13 hours of sleep per day.

» The average in-state college tuition and fees for 4-year public college is $5836.
(Source: The College Board.)

* There is a 3.8% probability of selecting a briefcase containing $1 million on the
television show “Deal or No Deal.”

* The back-to-school student plans to spend, on average, $114.38 on electronics and
computer-related items. (Source: National Retail Federation.)

Statistics is used in almost all fields of human endeavor. In sports, for example, a sta-
tistician may keep records of the number of yards a running back gains during a football
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game, or the number of hits a baseball player gets in a season. In other areas, such as pub-
lic health, an administrator might be concerned with the number of residents who con-
tract a new strain of flu virus during a certain year. In education, a researcher might want
to know if new methods of teaching are better than old ones. These are only a few exam-
ples of how statistics can be used in various occupations.

Furthermore, statistics is used to analyze the results of surveys and as a tool in sci-
entific research to make decisions based on controlled experiments. Other uses of statis-
tics include operations research, quality control, estimation, and prediction.

Statistics is the science of conducting studies to collect, organize, summarize, analyze,
and draw conclusions from data.

Students study statistics for several reasons:

1. Like professional people, you must be able to read and understand the various
statistical studies performed in your fields. To have this understanding, you must be
knowledgeable about the vocabulary, symbols, concepts, and statistical procedures
used in these studies.

2. You may be called on to conduct research in your field, since statistical procedures
are basic to research. To accomplish this, you must be able to design experiments;
collect, organize, analyze, and summarize data; and possibly make reliable
predictions or forecasts for future use. You must also be able to communicate the
results of the study in your own words.

3. You can also use the knowledge gained from studying statistics to become better
consumers and citizens. For example, you can make intelligent decisions about
what products to purchase based on consumer studies, about government spending
based on utilization studies, and so on.

These reasons can be considered the goals for studying statistics.
It is the purpose of this chapter to introduce the goals for studying statistics by
answering questions such as the following:

What are the branches of statistics?
What are data?
How are samples selected?

Descriptive and Inferential Statistics

To gain knowledge about seemingly haphazard situations, statisticians collect informa-
tion for variables, which describe the situation.

A variable is a characteristic or attribute that can assume different values.

Data are the values (measurements or observations) that the variables can assume.
Variables whose values are determined by chance are called random variables.

Suppose that an insurance company studies its records over the past several years
and determines that, on average, 3 out of every 100 automobiles the company insured
were involved in accidents during a 1-year period. Although there is no way to predict
the specific automobiles that will be involved in an accident (random occurrence), the
company can adjust its rates accordingly, since the company knows the general pattern
over the long run. (That is, on average, 3% of the insured automobiles will be involved
in an accident each year.)

A collection of data values forms a data set. Each value in the data set is called a
data value or a datum.

1-3
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The origin of
descriptive statistics
can be traced to data
collection methods
used in censuses taken
by the Babylonians and
Egyptians between
4500 and 3000 B.C.

In addition, the Roman
Emperor Augustus

(27 B.C.—AD. 17)
conducted surveys

on births and deaths

of the citizens of the
empire, as well as the
number of livestock
each owned and the
crops each citizen
harvested yearly.

Twenty-nine percent of
Americans want their
boss's job.

Inferential statistics
originated in the
1600s, when John
Graunt published his
book on population
growth, Natural and
Political Observations
Made upon the Bills
of Mortality. About the
same time, another
mathematician/
astronomer, Edmund
Halley, published the
first complete mortality
tables. (Insurance
companies use
mortality tables to
determine life
insurance rates.)

Data can be used in different ways. The body of knowledge called statistics is some-
times divided into two main areas, depending on how data are used. The two areas are

1. Descriptive statistics
2. Inferential statistics

Descriptive statistics consists of the collection, organization, summarization, and
presentation of data.

In descriptive statistics the statistician tries to describe a situation. Consider the national

census conducted by the U.S. government every 10 years. Results of this census give you

the average age, income, and other characteristics of the U.S. population. To obtain this

information, the Census Bureau must have some means to collect relevant data. Once data

are collected, the bureau must organize and summarize them. Finally, the bureau needs a

means of presenting the data in some meaningful form, such as charts, graphs, or tables.
The second area of statistics is called inferential statistics.

Inferential statistics consists of generalizing from samples to populations, performing
estimations and hypothesis tests, determining relationships among variables, and making
predictions.

Here, the statistician tries to make inferences from samples to populations. Inferential
statistics uses probability, i.e., the chance of an event occurring. You may be familiar
with the concepts of probability through various forms of gambling. If you play cards,
dice, bingo, and lotteries, you win or lose according to the laws of probability. Probability
theory is also used in the insurance industry and other areas.

It is important to distinguish between a sample and a population.

A population consists of all subjects (human or otherwise) that are being studied.

Most of the time, due to the expense, time, size of population, medical concerns, etc.,
it is not possible to use the entire population for a statistical study; therefore, researchers
use samples.

A sample is a group of subjects selected from a population.

If the subjects of a sample are properly selected, most of the time they should pos-
sess the same or similar characteristics as the subjects in the population. The techniques
used to properly select a sample will be explained in Section 1-3.

An area of inferential statistics called hypothesis testing is a decision-making
process for evaluating claims about a population, based on information obtained from
samples. For example, a researcher may wish to know if a new drug will reduce the num-
ber of heart attacks in men over 70 years of age. For this study, two groups of men over
70 would be selected. One group would be given the drug, and the other would be given
a placebo (a substance with no medical benefits or harm). Later, the number of heart
attacks occurring in each group of men would be counted, a statistical test would be run,
and a decision would be made about the effectiveness of the drug.

Statisticians also use statistics to determine relationships among variables. For
example, relationships were the focus of the most noted study in the 20th century,
“Smoking and Health,” published by the Surgeon General of the United States in 1964.
He stated that after reviewing and evaluating the data, his group found a definite rela-
tionship between smoking and lung cancer. He did not say that cigarette smoking
actually causes lung cancer, but that there is a relationship between smoking and lung
cancer. This conclusion was based on a study done in 1958 by Hammond and Horn. In
this study, 187,783 men were observed over a period of 45 months. The death rate from
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Speaking of

Statistics

Statistics and the New Planet

In the summer of 2005, astronomers
announced the discovery of a new planet
in our solar system. This planet, as of this
writing, has not yet been named; however,
astronomers have dubbed it Xena. They
also discovered that it has a moon that is
larger than Pluto.! Xena is about 9 billion
miles from the Sun. (Some sources
say 10 billion.) Its diameter is about
4200 miles. Its surface temperature has
been estimated at —400°F, and it takes
560 years to circle the Sun.

How does Xena compare to the other
planets? Let’s look at the statistics.

Distance from Mean
Diameter the Sun Orbital period temperature Number of
Planet (miles) (millions of miles) (days) (°F) moons
Mercury 3,032 36 88 333 0
Venus 7,521 67.2 224.7 867 0
Earth 7,926 93 365.2 59 1
Mars 4,222 141.6 687 —85 2
Jupiter 88,846 483.8 4,331 —166 63
Saturn 74,897 890.8 10,747 —220 47
Uranus 31,763 1,784.8 30,589 —320 27
Neptune 30,775 2,793.1 59,800 —330 13
Pluto' 1,485 3,647.2 90,588 =375 1

Source: NASA.
!Some astronomers no longer consider Pluto a planet.

With these statistics, we can make some comparisons. For example, Xena is about the size of the planet Mars, but it
is over 21 times the size of Pluto. (Compare the volumes.) It takes about twice as long to circle the Sun as Pluto. What
other comparisons can you make?

lung cancer in this group of volunteers was 10 times as great for smokers as for
nonsmokers.

Finally, by studying past and present data and conditions, statisticians try to make
predictions based on this information. For example, a car dealer may look at past sales
records for a specific month to decide what types of automobiles and how many of each
type to order for that month next year.

Applying the Concepts 1=1

Attendance and Grades

Read the following on attendance and grades, and answer the questions.
A study conducted at Manatee Community College revealed that students who attended
class 95 to 100% of the time usually received an A in the class. Students who attended class
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A dL Old

Only one-third of
crimes committed are
reported to the police.

Objective [E]]
Identify types of data.

80 to 90% of the time usually received a B or C in the class. Students who attended class less
than 80% of the time usually received a D or an F or eventually withdrew from the class.

Based on this information, attendance and grades are related. The more you attend class,
the more likely you will receive a higher grade. If you improve your attendance, your grades
will probably improve. Many factors affect your grade in a course. One factor that you have
considerable control over is attendance. You can increase your opportunities for learning by
attending class more often.

1. What are the variables under study?

. What are the data in the study?

. Are descriptive, inferential, or both types of statistics used?

. What is the population under study?

. Was a sample collected? If so, from where?

6. From the information given, comment on the relationship between the variables.

wm AW N

See page 33 for the answers.

Variables and Types of Data

As stated in Section 1-1, statisticians gain information about a particular situation by col-
lecting data for random variables. This section will explore in greater detail the nature of
variables and types of data.

Variables can be classified as qualitative or quantitative. Qualitative variables are
variables that can be placed into distinct categories, according to some characteristic or
attribute. For example, if subjects are classified according to gender (male or female),
then the variable gender is qualitative. Other examples of qualitative variables are reli-
gious preference and geographic locations.

Quantitative variables are numerical and can be ordered or ranked. For example, the
variable age is numerical, and people can be ranked in order according to the value of their
ages. Other examples of quantitative variables are heights, weights, and body temperatures.

Quantitative variables can be further classified into two groups: discrete and contin-
uous. Discrete variables can be assigned values such as 0, 1, 2, 3 and are said to be count-
able. Examples of discrete variables are the number of children in a family, the number
of students in a classroom, and the number of calls received by a switchboard operator
each day for a month.

Discrete variables assume values that can be counted.

Continuous variables, by comparison, can assume an infinite number of values in an
interval between any two specific values. Temperature, for example, is a continuous vari-
able, since the variable can assume an infinite number of values between any two given
temperatures.

Continuous variables can assume an infinite number of values between any two specific
values. They are obtained by measuring. They often include fractions and decimals.

The classification of variables can be summarized as follows:

Data

/\

Qualitative Quantitative

Discrete Continuous
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Since continuous data must be measured, answers must be rounded because of the
limits of the measuring device. Usually, answers are rounded to the nearest given unit.
For example, heights might be rounded to the nearest inch, weights to the nearest ounce,
etc. Hence, a recorded height of 73 inches could mean any measure from 72.5 inches up
to but not including 73.5 inches. Thus, the boundary of this measure is given as 72.5-73.5
inches. Boundaries are written for convenience as 72.5—73.5 but are understood to mean
all values up to but not including 73.5. Actual data values of 73.5 would be rounded to
74 and would be included in a class with boundaries of 73.5 up to but not including 74.5,
written as 73.5-74.5. As another example, if a recorded weight is 86 pounds, the exact
boundaries are 85.5 up to but not including 86.5, written as 85.5-86.5 pounds. Table 1-1
helps to clarify this concept. The boundaries of a continuous variable are given in one
additional decimal place and always end with the digit 5.

Table 1=1  Recorded Values and Boundaries

Variable Recorded value Boundaries
Length 15 centimeters (cm) 14.5-15.5 cm
Temperature 86 degrees Fahrenheit (°F) 85.5-86.5°F
Time 0.43 second (sec) 0.425-0.435 sec
Mass 1.6 grams (g) 1.55-1.65¢g

In addition to being classified as qualitative or quantitative, variables can be classified
by how they are categorized, counted, or measured. For example, can the data be orga-
nized into specific categories, such as area of residence (rural, suburban, or urban)? Can
the data values be ranked, such as first place, second place, etc.? Or are the values obtained
from measurement, such as heights, 1Qs, or temperature? This type of classification—i.e.,
how variables are categorized, counted, or measured—uses measurement scales, and
four common types of scales are used: nominal, ordinal, interval, and ratio.

The first level of measurement is called the nominal level of measurement. A sample
of college instructors classified according to subject taught (e.g., English, history, psy-
chology, or mathematics) is an example of nominal-level measurement. Classifying
survey subjects as male or female is another example of nominal-level measurement.
No ranking or order can be placed on the data. Classifying residents according to zip
codes is also an example of the nominal level of measurement. Even though numbers
are assigned as zip codes, there is no meaningful order or ranking. Other examples of
nominal-level data are political party (Democratic, Republican, Independent, etc.), reli-
gion (Christianity, Judaism, Islam, etc.), and marital status (single, married, divorced,
widowed, separated).

The nominal level of measurement classifies data into mutually exclusive (nonover-
lapping), exhausting categories in which no order or ranking can be imposed on the data.

The next level of measurement is called the ordinal level. Data measured at this level
can be placed into categories, and these categories can be ordered, or ranked. For exam-
ple, from student evaluations, guest speakers might be ranked as superior, average, or
poor. Floats in a homecoming parade might be ranked as first place, second place, etc.
Note that precise measurement of differences in the ordinal level of measurement does not
exist. For instance, when people are classified according to their build (small, medium, or
large), a large variation exists among the individuals in each class.



A dL Old

Sixty-three percent
of us say we would
rather hear the bad
news first.

Chapter 1 The Nature of Probability and Statistics

Other examples of ordinal data are letter grades (A, B, C, D, F).

The ordinal level of measurement classifies data into categories that can be ranked;
however, precise differences between the ranks do not exist.

The third level of measurement is called the interval level. This level differs from
the ordinal level in that precise differences do exist between units. For example, many
standardized psychological tests yield values measured on an interval scale. IQ is an
example of such a variable. There is a meaningful difference of 1 point between an 1Q
of 109 and an IQ of 110. Temperature is another example of interval measurement, since
there is a meaningful difference of 1°F between each unit, such as 72 and 73°F. One
property is lacking in the interval scale: There is no true zero. For example, IQ tests do
not measure people who have no intelligence. For temperature, 0°F does not mean no
heat at all.

The interval level of measurement ranks data, and precise differences between units
of measure do exist; however, there is no meaningful zero.

The final level of measurement is called the ratio level. Examples of ratio scales are
those used to measure height, weight, area, and number of phone calls received. Ratio
scales have differences between units (1 inch, 1 pound, etc.) and a true zero. In addition,
the ratio scale contains a true ratio between values. For example, if one person can lift
200 pounds and another can lift 100 pounds, then the ratio between them is 2 to 1. Put
another way, the first person can lift twice as much as the second person.

The ratio level of measurement possesses all the characteristics of interval
measurement, and there exists a true zero. In addition, true ratios exist when the same
variable is measured on two different members of the population.

There is not complete agreement among statisticians about the classification of data
into one of the four categories. For example, some researchers classify 1Q data as ratio
data rather than interval. Also, data can be altered so that they fit into a different category.
For instance, if the incomes of all professors of a college are classified into the three
categories of low, average, and high, then a ratio variable becomes an ordinal variable.
Table 1-2 gives some examples of each type of data.

Table 1-2  Examples of Measurement Scales

Nominal-level Ordinal-level Interval-level Ratio-level
data data data data
Zip code Grade (A, B, C, SAT score Height
Gender (male, female) D, F) 1Q Weight
Eye color (blue, brown, Judging (first place, Temperature Time
green, hazel) second place, etc.) Salary
Political affiliation Rating scale (poor, Age
Religious affiliation good, excellent)
Major field (mathematics, Ranking of tennis
computers, etc.) players
Nationality
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Applying the Concepts 1=2

Safe Travel
Read the following information about the transportation industry and answer the questions.

Transportation Safety

The chart shows the number of job-related injuries for each of the transportation industries
for 1998.

Industry Number of injuries
Railroad 4520
Intercity bus 5100
Subway 6850
Trucking 7144
Airline 9950

. What are the variables under study?

. Categorize each variable as quantitative or qualitative.

. Categorize each quantitative variable as discrete or continuous.
. Identify the level of measurement for each variable.

wm A W N =

. The railroad is shown as the safest transportation industry. Does that mean railroads have
fewer accidents than the other industries? Explain.

6. What factors other than safety influence a person’s choice of transportation?
7. From the information given, comment on the relationship between the variables.

See page 33 for the answers.

Data Collection and Sampling Techniques

In research, statisticians use data in many different ways. As stated previously, data can
be used to describe situations or events. For example, a manufacturer might want to know
something about the consumers who will be purchasing his product so he can plan an
effective marketing strategy. In another situation, the management of a company might
survey its employees to assess their needs in order to negotiate a new contract with the
employees’ union. Data can be used to determine whether the educational goals of a
school district are being met. Finally, trends in various areas, such as the stock market,
can be analyzed, enabling prospective buyers to make more intelligent decisions con-
cerning what stocks to purchase. These examples illustrate a few situations where col-
lecting data will help people make better decisions on courses of action.

Data can be collected in a variety of ways. One of the most common methods is
through the use of surveys. Surveys can be done by using a variety of methods. Three of
the most common methods are the telephone survey, the mailed questionnaire, and the
personal interview.

Telephone surveys have an advantage over personal interview surveys in that they
are less costly. Also, people may be more candid in their opinions since there is no face-
to-face contact. A major drawback to the telephone survey is that some people in the pop-
ulation will not have phones or will not answer when the calls are made; hence, not all
people have a chance of being surveyed. Also, many people now have unlisted numbers
and cell phones, so they cannot be surveyed. Finally, even the tone of the voice of the
interviewer might influence the response of the person who is being interviewed.

Mailed questionnaire surveys can be used to cover a wider geographic area than tele-
phone surveys or personal interviews since mailed questionnaire surveys are less expen-
sive to conduct. Also, respondents can remain anonymous if they desire. Disadvantages

1-9
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[ orical Note

A pioneer in census
taking was Pierre-
Simon de Laplace. In
1780, he developed
the Laplace method
of estimating the
population of a
country. The principle
behind his method
was to take a census
of a few selected
communities and to
determine the ratio of
the population to the
number of births in
these communities.
(Good birth records
were kept.) This ratio
would be used to
multiply the number
of births in the entire
country to estimate the
number of citizens in
the country.

of mailed questionnaire surveys include a low number of responses and inappropriate
answers to questions. Another drawback is that some people may have difficulty reading
or understanding the questions.

Personal interview surveys have the advantage of obtaining in-depth responses to
questions from the person being interviewed. One disadvantage is that interviewers must
be trained in asking questions and recording responses, which makes the personal inter-
view survey more costly than the other two survey methods. Another disadvantage is that
the interviewer may be biased in his or her selection of respondents.

Data can also be collected in other ways, such as surveying records or direct obser-
vation of situations.

As stated in Section 1-1, researchers use samples to collect data and information
about a particular variable from a large population. Using samples saves time and money
and in some cases enables the researcher to get more detailed information about a par-
ticular subject. Samples cannot be selected in haphazard ways because the information
obtained might be biased. For example, interviewing people on a street corner during the
day would not include responses from people working in offices at that time or from
people attending school; hence, not all subjects in a particular population would have
a chance of being selected.

To obtain samples that are unbiased—i.e., that give each subject in the population
an equally likely chance of being selected—statisticians use four basic methods of
sampling: random, systematic, stratified, and cluster sampling.

Random Sampling
Random samples are selected by using chance methods or random numbers. One such
method is to number each subject in the population. Then place numbered cards in a bowl,
mix them thoroughly, and select as many cards as needed. The subjects whose numbers
are selected constitute the sample. Since it is difficult to mix the cards thoroughly, there
is a chance of obtaining a biased sample. For this reason, statisticians use another method
of obtaining numbers. They generate random numbers with a computer or calculator.
Before the invention of computers, random numbers were obtained from tables.

Some two-digit random numbers are shown in Table 1-3. To select a random sample
of, say, 15 subjects out of 85 subjects, it is necessary to number each subject from 01 to 85.
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Then select a starting number by closing your eyes and placing your finger on a number
in the table. (Although this may sound somewhat unusual, it enables us to find a starting
number at random.) In this case suppose your finger landed on the number 12 in the sec-
ond column. (It is the sixth number down from the top.) Then proceed downward until
you have selected 15 different numbers between 01 and 85. When you reach the bottom
of the column, go to the top of the next column. If you select a number greater than 85
or the number 00 or a duplicate number, just omit it. In our example, we will use the
subjects numbered 12, 27, 75, 62, 57, 13, 31, 06, 16, 49, 46, 71, 53, 41, and 02. A more
detailed procedure for selecting a random sample using a table of random numbers is
given in Chapter 14, using Table D in Appendix C.

Systematic Sampling

Researchers obtain systematic samples by numbering each subject of the population and
then selecting every kth subject. For example, suppose there were 2000 subjects in the
population and a sample of 50 subjects were needed. Since 2000 + 50 = 40, then k = 40,

1-11
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In 1936, the Literary
Digest, on the basis of
a biased sample of its
subscribers, predicted
that Alf Landon would
defeat Franklin D.
Roosevelt in the
upcoming presidential
election. Roosevelt
won by a landslide.
The magazine ceased
publication the
following year.
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Table 1=3  Random Numbers

79 41 71 93 60 35 04 67 96 04 79 10 86
26 52 53 13 43 50 92 09 87 21 83 75 17
18 13 41 30 56 20 37 74 49 56 45 46 83
19 82 02 69 34 27 77 34 24 93 16 77 00
14 57 44 30 93 76 32 13 55 29 49 30 77
29 12 18 50 06 33 15 79 50 28 50 45 45
01 27 92 67 93 31 97 55 29 21 64 27 29
55 75 65 68 65 73 07 95 66 43 43 92 16
84 95 95 96 62 30 91 64 74 83 47 89 71
62 62 21 37 82 62 19 44 08 64 34 50 11
66 57 28 69 13 99 74 31 58 19 47 66 89
48 13 69 97 29 01 75 58 05 40 40 18 29
94 31 73 19 75 76 33 18 05 53 04 51 41
00 06 53 98 01 55 08 38 49 42 10 44 38
46 16 44 27 80 15 28 01 64 27 89 03 27
77 49 85 95 62 93 25 39 63 74 54 82 85
81 96 43 27 39 53 85 61 12 90 67 96 02
40 46 15 73 23 75 96 68 13 99 49 64 11

and every 40th subject would be selected; however, the first subject (numbered between
1 and 40) would be selected at random. Suppose subject 12 were the first subject selected;
then the sample would consist of the subjects whose numbers were 12, 52, 92, etc., until
50 subjects were obtained. When using systematic sampling, you must be careful about
how the subjects in the population are numbered. If subjects were arranged in a manner
such as wife, husband, wife, husband, and every 40th subject were selected, the sample
would consist of all husbands. Numbering is not always necessary. For example, a
researcher may select every tenth item from an assembly line to test for defects.

Stratified Sampling

Researchers obtain stratified samples by dividing the population into groups (called
strata) according to some characteristic that is important to the study, then sampling from
each group. Samples within the strata should be randomly selected. For example, sup-
pose the president of a two-year college wants to learn how students feel about a certain
issue. Furthermore, the president wishes to see if the opinions of the first-year students
differ from those of the second-year students. The president will select students from
each group to use in the sample.

Cluster Sampling

Researchers also use cluster samples. Here the population is divided into groups called
clusters by some means such as geographic area or schools in a large school district, etc.
Then the researcher randomly selects some of these clusters and uses all members of the
selected clusters as the subjects of the samples. Suppose a researcher wishes to survey
apartment dwellers in a large city. If there are 10 apartment buildings in the city, the
researcher can select at random 2 buildings from the 10 and interview all the residents of
these buildings. Cluster sampling is used when the population is large or when it involves
subjects residing in a large geographic area. For example, if one wanted to do a study
involving the patients in the hospitals in New York City, it would be very costly and
time-consuming to try to obtain a random sample of patients since they would be spread
over a large area. Instead, a few hospitals could be selected at random, and the patients
in these hospitals would be interviewed in a cluster.

The four basic sampling methods are summarized in Table 1-4.
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1-4  Summary of Sampling Methods

Random Subjects are selected by random numbers.

Systematic Subjects are selected by using every kth number after the first subject is
randomly selected from 1 through £.

Stratified Subjects are selected by dividing up the population into groups (strata), and
subjects are randomly selected within groups.

Cluster Subjects are selected by using an intact group that is representative of the
population.

m Other Sampling Methods

Older Americans are
less likely to sacrifice
happiness for a higher-
paying job. According
to one survey, 38% of
those aged 18-29
said they would
choose more money
over happiness, while
only 3% of those over
65 would.

1-4

Objective [
Explain the difference
between an
observational and an
experimental study.

In addition to the four basic sampling methods, researchers use other methods to obtain
samples. One such method is called a convenience sample. Here a researcher uses sub-
jects that are convenient. For example, the researcher may interview subjects entering a
local mall to determine the nature of their visit or perhaps what stores they will be patron-
izing. This sample is probably not representative of the general customers for several rea-
sons. For one thing, it was probably taken at a specific time of day, so not all customers
entering the mall have an equal chance of being selected since they were not there when
the survey was being conducted. But convenience samples can be representative of the
population. If the researcher investigates the characteristics of the population and deter-
mines that the sample is representative, then it can be used.

Other sampling techniques, such as sequential sampling, double sampling, and multi-
stage sampling, are explained in Chapter 14, along with a more detailed explanation of the
four basic sampling techniques.

Applying the Concepts 1=3

American Culture and Drug Abuse

Assume you are a member of the Family Research Council and have become increasingly
concerned about the drug use by professional sports players. You set up a plan and conduct a
survey on how people believe the American culture (television, movies, magazines, and
popular music) influences illegal drug use. Your survey consists of 2250 adults and adolescents
from around the country. A consumer group petitions you for more information about your
survey. Answer the following questions about your survey.

. What type of survey did you use (phone, mail, or interview)?

. What are the advantages and disadvantages of the surveying methods you did not use?

. What type of scores did you use? Why?

Did you use a random method for deciding who would be in your sample?

. Which of the methods (stratified, systematic, cluster, or convenience) did you use?

. Why was that method more appropriate for this type of data collection?

. If a convenience sample were obtained, consisting of only adolescents, how would the
results of the study be affected?

See page 33 for the answers.

Observational and Experimental Studies

There are several different ways to classify statistical studies. This section explains two
types of studies: observational studies and experimental studies.

In an observational study, the researcher merely observes what is happening or what
has happened in the past and tries to draw conclusions based on these observations.

1-13
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The safest day of the
week for driving is
Tuesday.

For example, data from the Motorcycle Industry Council (USA TODAY) stated that
“Motorcycle owners are getting older and richer.” Data were collected on the ages and
incomes of motorcycle owners for the years 1980 and 1998 and then compared. The find-
ings showed considerable differences in the ages and incomes of motorcycle owners for
the two years.

In this study, the researcher merely observed what had happened to the motorcycle
owners over a period of time. There was no type of research intervention.

In an experimental study, the researcher manipulates one of the variables and tries to
determine how the manipulation influences other variables.

For example, a study conducted at Virginia Polytechnic Institute and presented in
Psychology Today divided female undergraduate students into two groups and had the
students perform as many sit-ups as possible in 90 sec. The first group was told only to
“Do your best,” while the second group was told to try to increase the actual number of
sit-ups done each day by 10%. After four days, the subjects in the group who were given
the vague instructions to “Do your best” averaged 43 sit-ups, while the group that was
given the more specific instructions to increase the number of sit-ups by 10% averaged
56 sit-ups by the last day’s session. The conclusion then was that athletes who were given
specific goals performed better than those who were not given specific goals.

This study is an example of a statistical experiment since the researchers intervened
in the study by manipulating one of the variables, namely, the type of instructions given
to each group.

In a true experimental study, the subjects should be assigned to groups randomly.
Also, the treatments should be assigned to the groups at random. In the sit-up study, the
article did not mention whether the subjects were randomly assigned to the groups.

Sometimes when random assignment is not possible, researchers use intact groups.
These types of studies are done quite often in education where already intact groups are
available in the form of existing classrooms. When these groups are used, the study is said
to be a quasi-experimental study. The treatments, though, should be assigned at random.
Most articles do not state whether random assignment of subjects was used.

Statistical studies usually include one or more independent variables and one depen-
dent variable.

The independent variable in an experimental study is the one that is being manipulated
by the researcher. The independent variable is also called the explanatory variable.
The resultant variable is called the dependent variable or the outcome variable.

The outcome variable is the variable that is studied to see if it has changed significantly
due to the manipulation of the independent variable. For example, in the sit-up study, the
researchers gave the groups two different types of instructions, general and specific. Hence,
the independent variable is the type of instruction. The dependent variable, then, is the
resultant variable, that is, the number of sit-ups each group was able to perform after four
days of exercise. If the differences in the dependent or outcome variable are large and other
factors are equal, these differences can be attributed to the manipulation of the independent
variable. In this case, specific instructions were shown to increase athletic performance.

In the sit-up study, there were two groups. The group that received the special
instruction is called the treatment group while the other is called the control group. The
treatment group receives a specific treatment (in this case, instructions for improvement)
while the control group does not.

Both types of statistical studies have advantages and disadvantages. Experimental
studies have the advantage that the researcher can decide how to select subjects and how
to assign them to specific groups. The researcher can also control or manipulate the
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independent variable. For example, in studies that require the subjects to consume a certain
amount of medicine each day, the researcher can determine the precise dosages and, if
necessary, vary the dosage for the groups.

There are several disadvantages to experimental studies. First, they may occur in
unnatural settings, such as laboratories and special classrooms. This can lead to several
problems. One such problem is that the results might not apply to the natural setting. The
age-old question then is, “This mouthwash may kill 10,000 germs in a test tube, but how
many germs will it kill in my mouth?”

Another disadvantage with an experimental study is the Hawthorne effect. This
effect was discovered in 1924 in a study of workers at the Hawthorne plant of the Western
Electric Company. In this study, researchers found that the subjects who knew they were
participating in an experiment actually changed their behavior in ways that affected the
results of the study.

Another problem is called confounding of variables.

A confounding variable is one that influences the dependent or outcome variable but
was not separated from the independent variable.

Researchers try to control most variables in a study, but this is not possible in some
studies. For example, subjects who are put on an exercise program might also improve
their diet unbeknownst to the researcher and perhaps improve their health in other ways
not due to exercise alone. Then diet becomes a confounding variable.

Observational studies also have advantages and disadvantages. One advantage of an
observational study is that it usually occurs in a natural setting. For example, researchers
can observe people’s driving patterns on streets and highways in large cities. Another
advantage of an observational study is that it can be done in situations where it would be
unethical or downright dangerous to conduct an experiment. Using observational studies,
researchers can study suicides, rapes, murders, etc. In addition, observational studies can
be done using variables that cannot be manipulated by the researcher, such as drug users
versus nondrug users and right-handedness versus left-handedness.

Observational studies have disadvantages, too. As mentioned previously, since the
variables are not controlled by the researcher, a definite cause-and-effect situation cannot
be shown since other factors may have had an effect on the results. Observational studies
can be expensive and time-consuming. For example, if one wanted to study the habitat of
lions in Africa, one would need a lot of time and money, and there would be a certain
amount of danger involved. Finally, since the researcher may not be using his or her own
measurements, the results could be subject to the inaccuracies of those who collected the
data. For example, if the researchers were doing a study of events that occurred in
the 1800s, they would have to rely on information and records obtained by others from a
previous era. There is no way to ensure the accuracy of these records.

When you read the results of statistical studies, decide if the study was observational
or experimental. Then see if the conclusion follows logically, based on the nature of these
studies.

No matter what type of study is conducted, two studies on the same subject some-
times have conflicting conclusions. Why might this occur? An article entitled “Bottom
Line: Is It Good for You?” (USA TODAY Weekend ) states that in the 1960s studies sug-
gested that margarine was better for the heart than butter since margarine contains less
saturated fat and users had lower cholesterol levels. In a 1980 study, researchers found
that butter was better than margarine since margarine contained trans-fatty acids, which
are worse for the heart than butter’s saturated fat. Then in a 1998 study, researchers found
that margarine was better for a person’s health. Now, what is to be believed? Should one
use butter or margarine?
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Objective
Explain how statistics

can be used and
misused.

The answer here is that you must take a closer look at these studies. Actually, it is
not a choice between butter or margarine that counts, but the type of margarine used. In
the 1980s, studies showed that solid margarine contains trans-fatty acids, and scientists
believe that they are worse for the heart than butter’s saturated fat. In the 1998 study, lig-
uid margarine was used. It is very low in trans-fatty acids, and hence it is more healthful
than butter because trans-fatty acids have been shown to raise cholesterol. Hence, the
conclusion is to use liquid margarine instead of solid margarine or butter.

Before decisions based on research studies are made, it is important to get all the
facts and examine them in light of the particular situation.

Applying the Concepts 1-4

Just a Pinch Between Your Cheek and Gum

As the evidence on the adverse effects of cigarette smoke grew, people tried many different
ways to quit smoking. Some people tried chewing tobacco or, as it was called, smokeless
tobacco. A small amount of tobacco was placed between the cheek and gum. Certain
chemicals from the tobacco were absorbed into the bloodstream and gave the sensation of
smoking cigarettes. This prompted studies on the adverse effects of smokeless tobacco.

One study in particular used 40 university students as subjects. Twenty were given smokeless
tobacco to chew, and twenty given a substance that looked and tasted like smokeless tobacco,
but did not contain any of the harmful substances. The students were randomly assigned to
one of the groups. The students’ blood pressure and heart rate were measured before they
started chewing and 20 minutes after they had been chewing. A significant increase in heart
rate occurred in the group that chewed the smokeless tobacco. Answer the following
questions.

1. What type of study was this (observational, quasi-experimental, or experimental)?
2. What are the independent and dependent variables?

3. Which was the treatment group?
4

. Could the students’ blood pressures be affected by knowing that they are part of
a study?

5. List some possible confounding variables.
6. Do you think this is a good way to study the effect of smokeless tobacco?

See page 33 for the answers.

Uses and Misuses of Statistics

As explained previously, statistical techniques can be used to describe data, compare two
or more data sets, determine if a relationship exists between variables, test hypotheses,
and make estimates about population characteristics. However, there is another aspect of
statistics, and that is the misuse of statistical techniques to sell products that don’t work
properly, to attempt to prove something true that is really not true, or to get our attention
by using statistics to evoke fear, shock, and outrage.

There are two sayings that have been around for a long time that illustrate this point:

“There are three types of lies—lies, damn lies, and statistics.”
“Figures don’t lie, but liars figure.”
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Just because we read or hear the results of a research study or an opinion poll in the
media, this does not mean that these results are reliable or that they can be applied to any
and all situations. For example, reporters sometimes leave out critical details such as the
size of the sample used or how the research subjects were selected. Without this infor-
mation, you cannot properly evaluate the research and properly interpret the conclusions
of the study or survey.

It is the purpose of this section to show some ways that statistics can be misused. You
should not infer that all research studies and surveys are suspect, but that there are many
factors to consider when making decisions based on the results of research studies and
surveys. Here are some ways that statistics can be misrepresented.

Suspect Samples

The first thing to consider is the sample that was used in the research study. Sometimes
researchers use very small samples to obtain information. Several years ago, advertise-
ments contained such statements as “Three out of four doctors surveyed recommend
brand such and such.” If only 4 doctors were surveyed, the results could have been
obtained by chance alone; however, if 100 doctors were surveyed, the results might be
quite different.

Not only is it important to have a sample size that is large enough, but also it is
necessary to see how the subjects in the sample were selected. Studies using volunteers
sometimes have a built-in bias. Volunteers generally do not represent the population at
large. Sometimes they are recruited from a particular socioeconomic background, and
sometimes unemployed people volunteer for research studies to get a stipend. Studies
that require the subjects to spend several days or weeks in an environment other than
their home or workplace automatically exclude people who are employed and cannot
take time away from work. Sometimes only college students or retirees are used in
studies. In the past, many studies have used only men, but have attempted to general-
ize the results to both men and women. Opinion polls that require a person to phone
or mail in a response most often are not representative of the population in general,
since only those with strong feelings for or against the issue usually call or respond
by mail.

Another type of sample that may not be representative is the convenience sample.
Educational studies sometimes use students in intact classrooms since it is convenient.
Quite often, the students in these classrooms do not represent the student population of
the entire school district.

When results are interpreted from studies using small samples, convenience sam-
ples, or volunteer samples, care should be used in generalizing the results to the entire
population.

Ambiguous Averages

In Chapter 3, you will learn that there are four commonly used measures that are loosely
called averages. They are the mean, median, mode, and midrange. For the same data set,
these averages can differ markedly. People who know this can, without lying, select the
one measure of average that lends the most evidence to support their position.

Changing the Subject

Another type of statistical distortion can occur when different values are used to repre-
sent the same data. For example, one political candidate who is running for reelection
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might say, “During my administration, expenditures increased a mere 3%.” His oppo-
nent, who is trying to unseat him, might say, “During my opponent’s administration,
expenditures have increased a whopping $6,000,000.” Here both figures are correct;
however, expressing a 3% increase as $6,000,000 makes it sound like a very large
increase. Here again, ask yourself, Which measure better represents the data?

Detached Statistics

A claim that uses a detached statistic is one in which no comparison is made. For exam-
ple, you may hear a claim such as “Our brand of crackers has one-third fewer calories.”
Here, no comparison is made. One-third fewer calories than what? Another example is a
claim that uses a detached statistic such as “Brand A aspirin works four times faster.”
Four times faster than what? When you see statements such as this, always ask yourself,
Compared to what?

Implied Connections

Many claims attempt to imply connections between variables that may not actually exist.
For example, consider the following statement: “Eating fish may help to reduce your
cholesterol.” Notice the words may help. There is no guarantee that eating fish will def-
initely help you reduce your cholesterol.

“Studies suggest that using our exercise machine will reduce your weight.” Here the
word suggest is used; and again, there is no guarantee that you will lose weight by using
the exercise machine advertised.

Another claim might say, “Taking calcium will lower blood pressure in some
people.” Note the word some is used. You may not be included in the group of “some”
people. Be careful when you draw conclusions from claims that use words such as may,
in some people, and might help.

Misleading Graphs

Statistical graphs give a visual representation of data that enables viewers to analyze and
interpret data more easily than by simply looking at numbers. In Chapter 2, you will see
how some graphs are used to represent data. However, if graphs are drawn inappropri-
ately, they can misrepresent the data and lead the reader to draw false conclusions. The
misuse of graphs is also explained in Chapter 2.

Faulty Survey Questions
When analyzing the results of a survey using questionnaires, you should be sure that
the questions are properly written since the way questions are phrased can often influ-
ence the way people answer them. For example, the responses to a question such as
“Do you feel that the North Huntingdon School District should build a new football
stadium?”” might be answered differently than a question such as “Do you favor increas-
ing school taxes so that the North Huntingdon School District can build a new football
stadium?” Each question asks something a little different, and the responses could be
radically different. When you read and interpret the results obtained from question-
naire surveys, watch out for some of these common mistakes made in the writing of the
survey questions.

In Chapter 14, you will find some common ways that survey questions could be
misinterpreted by those responding and could therefore result in incorrect conclusions.
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To restate the premise of this section, statistics, when used properly, can be beneficial
in obtaining much information, but when used improperly, can lead to much misinfor-
mation. It is like your automobile. If you use your automobile to get to school or work or
to go on a vacation, that’s good. But if you use it to run over your neighbor’s dog because
it barks all night long and tears up your flower garden, that’s not so good!

Computers and Calculators

In the past, statistical calculations were done with pencil and paper. However, with the
advent of calculators, numerical computations became much easier. Computers do all
the numerical calculation. All one does is to enter the data into the computer and use
the appropriate command; the computer will print the answer or display it on the screen.
Now the TI-83 Plus or TI-84 Plus graphing calculator accomplishes the same thing.

There are many statistical packages available; this book uses MINITAB and Microsoft
Excel. Instructions for using MINITAB, the TI-83 Plus or TI-84 Plus graphing calculator,
and Excel have been placed at the end of each relevant section, in subsections entitled
Technology Step by Step.

You should realize that the computer and calculator merely give numerical answers
and save the time and effort of doing calculations by hand. You are still responsible for
understanding and interpreting each statistical concept. In addition, you should realize
that the results come from the data and do not appear magically on the computer. Doing
calculations using the procedure tables will help you reinforce this idea.

The author has left it up to instructors to choose how much technology they will
incorporate into the course.

Step by Step

MINITAB
Step by Step

General Information

MINITAB statistical software provides a wide range of statistical analysis and graphing
capabilities.

Take Note

In this text you will see captured screen images from computers running MINITAB Release 14.
If you are using an earlier release of MINITAB, the screens you see on your computer may bear
slight visual differences from the screens pictured in this text. But don’t be alarmed! All the
Step by Step operations described in this text, including the commands, the menu options, and
the functionality, will work just fine on your computer.

Start the Program
1. Click the Windows XP Start Menu, then All Programs.

2. Click the MINITAB 14 folder and then click == MINITAE 14 | the program icon. The program
screen will look similar to the one shown here. You will see the Session Window, the
Worksheet Window, and perhaps the Project Manager Window.

3. Click the Project Manager icon on the toolbar to bring the project manager to the front.
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To use the program, data must be entered from the keyboard or from a file.

Entering Data in MINITAB

In MINITAB, all the data for one variable are stored in a column. Step by step instructions for
entering these data follow.

Data
213 208 203 215 222

1. Click in row 1 of Worksheet 1***. This makes the worksheet the active window and puts
the cursor in the first cell. The small data entry arrow in the upper left-hand corner of the
worksheet should be pointing down. If it is not, click it to change the direction in which the
cursor will move when you press the [Enter] key.

2. Type in each number, pressing [Enter] after each entry, including the last number typed.

3. Optional: Click in the space above row 1 to type in Weight, the column label.

Save a Worksheet File
4. Click on the File Menu. Note: This is not the same as clicking the disk icon =
5. Click Save Current Worksheet As ...
6. In the dialog box you will need to verify three items:

a) Save in: Click on or type in the disk drive and directory where you will store your
data. For a floppy disk this would be A:.

b) File Name: Type in the name of the file, such as MyData.

c) Save as Type: The default here is MINITAB. An extension of mtw is added to the
name.

Click [Save]. The name of the worksheet will change from Worksheet 1*** to
MyData.MTW.

Open the Databank File

The raw data are shown in Appendix D. There is a row for each person’s data and a column for
each variable. MINITAB data files comprised of data sets used in this book, including the
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Databank, are available on the accompanying CD-ROM or at the Online Learning Center
(www.mhhe.com/bluman). Here is how to get the data from a file into a worksheet.

1. Click File>Open Worksheet. A sequence of menu instructions will be shown this way.

Note: This is not the same as clicking the file icon (= . Ifthe dialog box says
Open Project instead of Open Worksheet, click [Cancel] and use the correct menu item.
The Open Worksheet dialog box will be displayed.

2. You must check three items in this dialog box.
a) The Look In: dialog box should show the directory where the file is located.
b) Make sure the Files of Type: shows the correct type, MINITAB [*.mtw].

¢) Double-click the file name in the list box Databank.mtw. A dialog box may inform you
that a copy of this file is about to be added to the project. Click on the checkbox if you
do not want to see this warning again.

3. Click the [OK] button. The data will be copied into a second worksheet. Part of the
worksheet is shown here.

T8 Databank MTW ***

+ 1 (=] L= 3 1 s (=3 cr ce [a] c1w cnT cnT ~
AGE EDLEVEL SMOKING EXERCISE WEIGHT SERUM. SYSTOLIC 10 SODIUM GENDER MARITAL ST

1 1 z 2 1 1 120 19 1% 18 1% F M

2 2 18 1 o 1 145 20 120 105 17 W s

3 3 2 2 0 1} 18 196 123 15 15 F M

a) You may maximize the window and scroll if desired.

b) C12-T Marital Status has a T appended to the label to indicate alphanumeric data.
MyData.MTW is not erased or overwritten. Multiple worksheets can be available;
however, only the active worksheet is available for analysis.

4. To switch between the worksheets, select Window>MyData.MTW.
5. Select File>Exit to quit. To save the project, click [Yes].
6. Type in the name of the file, Chapter01. The Data Window, the Session Window, and
settings are all in one file called a project. Projects have an extension of mpj instead of mtw.
Clicking the disk icon & on the menu bar is the same as selecting File>Save Project.
Clicking the file icon (= is the same as selecting File>Open Project.

7. Click [Save]. The mpj extension will be added to the name. The computer will return to
the Windows desktop. The two worksheets, the Session Window results, and settings are
saved in this project file. When a project file is opened, the program will start up right
where you left off.

TI-83 Plus or

TI-84 Plus
Step by Step

The TI-83 Plus or TI-84 Plus graphing calculator can be used for a variety of statistical graphs
and tests.

General Information
To turn calculator on:
Press ON key.
To turn calculator off:
Press 2nd [OFF].
To reset defaults only:
1. Press 2nd, then [MEM].
2. Select 7, then 2, then 2.
Optional. To reset settings on calculator and clear memory: (Note: This will clear all settings
and programs in the calculator’s memory.)

Press 2nd, then [MEM]. Then press 7, then 1, then 2.
(Also, the contrast may need to be adjusted after this.)
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To adjust contrast (if necessary):

Press 2nd. Then press and hold A to darken or W to lighten contrast.

To clear screen:

Press CLEAR.

(Note: This will return you to the screen you were using.)

To display a menu:

Press appropriate menu key. Example: STAT.

To return to home screen:

Press 2nd, then [QUIT].

To move around on the screens:

Use the arrow keys.

To select items on the menu:

Press the corresponding number or move the cursor to the item, using the arrow keys. Then
press ENTER.

(Note: In some cases, you do not have to press ENTER, and in other cases you may need to
press ENTER twice.)

Entering Data
To enter single-variable data (if necessary, clear the old list):

1. Press STAT to display the Edit menu.
2. Press ENTER to select 1:Edit.
3. Enter the data in L, and press ENTER after each value.
4. After all data values are entered, press STAT to get back to the Edit menu or 2nd [QUIT)]
to end.
Example TI1-1
Enter the following data values in L,: 213, 208, 203, 215, 222. Output
To enter multiple-variable data: L1 Lz Lz 1
The TI-83 Plus or TI-84 Plus will take up to six lists TR R
designated L,, L,, L, L4, Lg, and L. %gg
1. To enter more than one set of data values, complete the g1%
preceding steps. Then move the cursor to L, by E
pressing the p»key. | _m=====
LitEr=

2. Repeat the steps in the preceding part.

Editing Data
To correct a data value before pressing ENTER, use € and retype the value and press ENTER.

To correct a data value in a list after pressing ENTER, move cursor to incorrect value in list
and type in the correct value. Then press ENTER.

To delete a data value in a list:

Move cursor to value and press DEL.

To insert a data value in a list:
1. Move cursor to position where data value is to be inserted, then press 2nd [INS].
2. Type data value; then press ENTER.

To clear a list:

1. Press STAT, then 4.
2. Enter list to be cleared. Example: To clear L,, press 2nd [L,]. Then press ENTER.

(Note: To clear several lists, follow step 1, but enter each list to be cleared, separating them
with commas.)
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Sorting Data
To sort the data in a list:

1. Enter the datain L.
2. Press STAT 2 to get SortA to sort the list in ascending order.
3. Then press 2nd [L,] ENTER.

S Output
The calculator will display Done.
L1 Lz L= 1
4. Press STAT ENTER to display sorted list. R D
(Note: The SortD or 3 sorts the list in descending order.) EEE
ik
Example TI1-2
Sort in ascending order the data values entered in
Example TI1-1. LitaI=
Excel General Information
Step hy Step Microsoft Excel 2007 has two different ways to solve statistical problems. First, there are

built-in functions, such as STDEV and CHITEST, available from the standard toolbar by

clicking Formulas, then selecting the Insert Function icon ;é« Another feature of Excel that is
useful for calculating multiple statistical measures and performing statistical tests for a set of
data is the Data Analysis command found in the Analysis Tool-Pak Add-in.

To load the Analysis Tool-Pak:

Click the Microsoft Office button '~ , then select Excel Options.

Excel's Analysis 1. Click Add-Ins, and select Add-ins from the list of options on the left side of the options box.
ToolPak Add-In 2. Select the Analysis Tool-Pak, then click the Go button at the bottom of the options box.
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Analysis group on the Data tab.

3. After loading the Analysis Tool-Pak, the Data Analysis command is available in the

MegaStat

www.mhhe.com/bluman.

associated help file on your computer’s hard drive.

program opens to load the Add-in, choose the Enable Macros option.

Add-ins tab on the Excel toolbar.

Entering Data

values into a single column.

2. Type each data value and press [Enter] or [Tab] on your keyboard.

icon 4 located at the bottom of an open workbook.

1. Open the Microsoft Office Excel 2007 program.

1. Save the Zip file containing the MegaStat Excel Add-in file (MegaStat.xls) and the

2. After opening the Zip file, double-click the MegaStat Add-in file, then Extract the
MegaStat program to your computer’s hard drive. After extracting the file, you can load
the MegaStat Add-in to Excel by double-clicking the MegaStat.xls file. When the Excel

3. After installation of the add-in, you will be able to access MegaStat by selecting the

You can also add more worksheets to an Excel workbook by clicking the Insert Worksheet

Example XL1-1: Opening an existing Excel workbook/worksheet

Later in this text you will encounter a few Excel Technology Step by Step operations that will
require the use of the MegaStat Add-in for Excel. MegaStat can be downloaded from the
CD that came with your textbook as well as from the text’s Online Learning Center at

4. If MegaStat is not listed under Add-ins when you reopen the Excel program, then you can
access MegaStat by double-clicking the MegaStat.xls file at any time.

1. Select a cell at the top of a column on an Excel worksheet where you want to enter data.
When working with data values for a single variable, you will usually want to enter the
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~ Hame Inser Page Layout Formulas Data Review View Add-ing L x
i = [sBlcennedions 3l ?Iﬂ ( G Clear ~ == Zjosavaldabon - = Goup*  “2 |[lData Analyiis
=| % froperties Al 1 W neapph S - [Bs Consalidate + Ungroup = 2
GetExtermal | Retresh i) sem | mmer Tedto  Pemove P
Data - ¥ s £t Link A 0 Advanced | Cojumns Duplicates L0 What It Anatviks = || ] Subtotal
Cannsdon Sot & Filter Data Taals Dutline Analyus
| Al - (2 £ %
4 B c 1] E F G H | 4 K M N (s} .
=
2
3
4
s Dista Analysic
] fnalysis Tooks E
7 Anenvat Snghe: Factor -
Anrva; Two-Factor With Replcation B
8 Ancrat Tusn-Factar Withaut Repke;
] Correlation
s G
Descriptive Stakistics
1 Expanential Smoothing
FeTest Two-Sample for Variances. 2
2 Fouries Andlysis %
13 Hestogram 2
b
15
16
17
12
13
20
21
22



www.mhhe.com/bluman

1 (A d

The chance that
someone will attempt
to burglarize your
home in any given
yearis 1in 20.
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2. Click the Microsoft Click Office button ' , then click the Open file function. The Open
dialog box will be displayed.

3. In the Look in box, click the folder where the Excel workbook file is located.

4. Double-click the file name in the list box. The selected workbook file will be opened in
Excel for editing.

Summary

The two major areas of statistics are descriptive and inferential. Descriptive statistics
includes the collection, organization, summarization, and presentation of data. Inferential
statistics includes making inferences from samples to populations, estimations and
hypothesis testing, determining relationships, and making predictions. Inferential statis-
tics is based on probability theory.

Since in most cases the populations under study are large, statisticians use subgroups
called samples to get the necessary data for their studies. There are four basic methods
used to obtain samples: random, systematic, stratified, and cluster.

Data can be classified as qualitative or quantitative. Quantitative data can be either
discrete or continuous, depending on the values they can assume. Data can also be mea-
sured by various scales. The four basic levels of measurement are nominal, ordinal,
interval, and ratio.

There are two basic types of statistical studies: observational studies and experi-
mental studies. When conducting observational studies, researchers observe what is hap-
pening or what has happened and then draw conclusions based on these observations.
They do not attempt to manipulate the variables in any way.

When conducting an experimental study, researchers manipulate one or more of the
independent or explanatory variables and see how this manipulation influences the
dependent or outcome variable.

Finally, the applications of statistics are many and varied. People encounter them in
everyday life, such as in reading newspapers or magazines, listening to the radio, or watch-
ing television. Since statistics is used in almost every field of endeavor, the educated indi-
vidual should be knowledgeable about the vocabulary, concepts, and procedures of statistics.

Today, computers and calculators are used extensively in statistics to facilitate the
computations.

LAFF - A - DAY

“We’ve polled the entire populace, Your
Majesty, and we’ve come up with
exactly the results you ordered!”

Source: © 1993 King Features Syndicate, Inc. World
Rights reserved. Reprinted with special permission of
King Features Syndicate.
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important Terms

cluster sample 12 experimental study 14

confounding variable 15 explanatory variable 14
continuous variables 6 Hawthorne effect 15
control group 14 hypothesis testing 4
convenience sample 13
data 3

dataset 3

independent variable 14
inferential statistics 4

interval level of

data value or datum 3 measurement 8

dependent variable 14 measurement scales 7

nominal level of

descriptive statistics 4
measurement 7

discrete variables 6

Review Exercises

Note: All odd-numbered problems and even-numbered
problems marked with “ans” are included in the answer
section at the end of this book.

1. Name and define the two areas of statistics.

2. What is probability? Name two areas where probability
is used.

3. Suggest some ways statistics can be used in everyday
life.

4. Explain the differences between a sample and a
population.

5. Why are samples used in statistics?

6. (ans) In each of these statements, tell whether
descriptive or inferential statistics have been used.

a. Inthe year 2010, 148 million Americans will be en-
rolled in an HMO (Source: US4 TODAY).

b. Nine out of ten on-the-job fatalities are men
(Source: USA TODAY Weekend).

c. Expenditures for the cable industry were $5.66 bil-
lion in 1996 (Source: USA TODAY).

d. The median household income for people aged
25-34 is $35,888 (Source: USA TODAY).

e. Allergy therapy makes bees go away
(Source: Prevention).

1. Drinking decaffeinated coffee can raise
cholesterol levels by 7% (Source: American
Heart Association).
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observational study 13 random variable 3

ratio level of
measurement 8

ordinal level of
measurement 8

outcome variable 14 sample 4

population 4 statistics 3

probability 4 stratified sample 12

qualitative variables 6 systematic sample 11

quantitative variables 6 treatment group 14

quasi-experimental variable 3

study 14

random sample 10

g. The national average annual medicine expenditure
per person is $1052 (Source: The Greensburg
Tribune Review).

h. Experts say that mortgage rates may soon hit bottom
(Source: USA TODAY).

7. Classify each as nominal-level, ordinal-level, interval-
level, or ratio-level measurement.

a. Pages in the city of Cleveland telephone book.

b. Rankings of tennis players.

Weights of air conditioners.

Temperatures inside 10 refrigerators.

Salaries of the top five CEOs in the United States.

Ratings of eight local plays (poor, fair, good,

excellent).

Times required for mechanics to do a tune-up.

Ages of students in a classroom.

i. Marital status of patients in a physician’s
office.

J. Horsepower of tractor engines.

e R0

© 09

8. (ans) Classify each variable as qualitative or
quantitative.

a. Number of bicycles sold in 1 year by a large sporting
goods store.

Colors of baseball caps in a store.

Times it takes to cut a lawn.

Capacity in cubic feet of six truck beds.
Classification of children in a day care center

(infant, toddler, preschool).

Weights of fish caught in Lake George.

Marital status of faculty members in a large
university.

SN

0



9. Classify each variable as discrete or continuous.

a. Number of doughnuts sold each day by Doughnut
Heaven.

b. Water temperatures of six swimming pools in
Pittsburgh on a given day.

c. Weights of cats in a pet shelter.

d. Lifetime (in hours) of 12 flashlight
batteries.

e. Number of cheeseburgers sold each day by a
hamburger stand on a college campus.

/- Number of DVDs rented each day by a video
store.

g. Capacity (in gallons) of six reservoirs in Jefferson
County.

10. Give the boundaries of each value.

42.8 miles.
1.6 milliliters.
5.36 ounces.
18 tons.

93.8 ounces.
40 inches.

SR RN =R

11. Name and define the four basic sampling methods.

12. (ans) Classify each sample as random, systematic,
stratified, or cluster.

a. In alarge school district, all teachers from two
buildings are interviewed to determine whether they
believe the students have less homework to do now
than in previous years.

b. Every seventh customer entering a shopping mall is
asked to select her or his favorite store.

c. Nursing supervisors are selected using random
numbers to determine annual salaries.

d. Every 100th hamburger manufactured is checked to
determine its fat content.

e. Mail carriers of a large city are divided into four
groups according to gender (male or female) and
according to whether they walk or ride on their
routes. Then 10 are selected from each group and
interviewed to determine whether they have been
bitten by a dog in the last year.

13. Give three examples each of nominal, ordinal, interval,
and ratio data.

14. For each of these statements, define a population and
state how a sample might be obtained.

a. The average cost of an airline meal is $4.55
(Source: Everything Has Its Price, Richard E.
Donley, Simon and Schuster).

b. More than 1 in 4 United States children have
cholesterol levels of 180 milligrams or higher
(Source: The American Health Foundation).

c. Every 10 minutes, 2 people die in car crashes and 170
are injured (Source: National Safety Council estimates).

15.

16.

17.

Review Exercises 27

d. When older people with mild to moderate
hypertension were given mineral salt for 6 months,
the average blood pressure reading dropped by
8 points systolic and 3 points diastolic
(Source: Prevention).

e. The average amount spent per gift for Mom on
Mother’s Day is $25.95 (Source: The Gallup
Organization).

Select a newspaper or magazine article that involves a
statistical study, and write a paper answering these
questions.

a. Is this study descriptive or inferential? Explain your
answer.

b. What are the variables used in the study? In your
opinion, what level of measurement was used to
obtain the data from the variables?

c¢. Does the article define the population? If so, how is
it defined? If not, how could it be defined?

d. Does the article state the sample size and how the
sample was obtained? If so, determine the size of
the sample and explain how it was selected. If not,
suggest a way it could have been obtained.

e. Explain in your own words what procedure (survey,
comparison of groups, etc.) might have been used
to determine the study’s conclusions.

/. Do you agree or disagree with the conclusions?
State your reasons.

Information from research studies is sometimes taken
out of context. Explain why the claims of these studies
might be suspect.

a. The average salary of the graduates of the class of
1980 is $32,500.

b. It is estimated that in Podunk there are 27,256 cats.

¢. Only 3% of the men surveyed read Cosmopolitan
magazine.

d. Based on a recent mail survey, 85% of the
respondents favored gun control.

e. Arecent study showed that high school dropouts
drink more coffee than students who graduated;
therefore, coffee dulls the brain.

/. Since most automobile accidents occur within
15 miles of a person’s residence, it is safer to make
long trips.

Identify each study as being either observational or
experimental.

a. Subjects were randomly assigned to two groups,
and one group was given an herb and the other
group a placebo. After 6 months, the numbers of
respiratory tract infections each group had were
compared.

b. Aresearcher stood at a busy intersection to see if
the color of the automobile that a person drives is
related to running red lights.
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18.

19.

20.

21.

22.

23.

Chapter 1 The Nature of Probability and Statistics

c. Aresearcher finds that people who are more hostile
have higher total cholesterol levels than those who
are less hostile.

d. Subjects are randomly assigned to four groups.
Each group is placed on one of four special
diets—a low-fat diet, a high-fish diet, a combination
of low-fat diet and high-fish diet, and a regular diet.
After 6 months, the blood pressures of the groups
are compared to see if diet has any effect on blood
pressure.

Identify the independent variable(s) and the
dependent variable for each of the studies in
Exercise 17.

For each of the studies in Exercise 17, suggest possible
confounding variables.

Beneficial Bacteria According to a pilot study of

20 people conducted at the University of Minnesota,
daily doses of a compound called arabinogalactan over
a period of 6 months resulted in a significant increase in
the beneficial lactobacillus species of bacteria. Why
can’t it be concluded that the compound is beneficial for
the majority of people?

Comment on the following statement, taken from a
magazine advertisement: “In a recent clinical study,
Brand ABC (actual brand will not be named) was
proved to be 1950% better than creatine!”

In an ad for women, the following statement was made:
“For every 100 women, 91 have taken the road less
traveled.” Comment on this statement.

In many ads for weight loss products, under the product
claims and in small print, the following statement is
made: “These results are not typical.” What does this
say about the product being advertised?

Extending the Concepts

30.

31.

Find an article that describes a statistical study, and
identify the study as observational or experimental.

For the article that you used in Exercise 30, identify the
independent variable(s) and dependent variable for the
study.
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24.

25.

26.

27.

28.

29.

32.

In an ad for moisturizing lotion, the following claim is
made: “. . . it’s the number 1 dermatologist-recommended
brand.” What is misleading about this claim?

An ad for an exercise product stated: “Using this
product will burn 74% more calories.” What is
misleading about this statement?

“Vitamin E is a proven antioxidant and may help in
fighting cancer and heart disease.” Is there anything
ambiguous about this claim? Explain.

“Just 1 capsule of Brand X can provide 24 hours of acid
control.” (Actual brand will not be named.) What needs
to be more clearly defined in this statement?

“. .. Male children born to women who smoke during
pregnancy run a risk of violent and criminal behavior
that lasts well into adulthood.” Can we infer that
smoking during pregnancy is responsible for criminal
behavior in people?

Caffeine and Health In the 1980s, a study linked
coffee to a higher risk of heart disease and pancreatic
cancer. In the early 1990s, studies showed that drinking
coffee posed minimal health threats. However, in 1994,
a study showed that pregnant women who drank 3 or
more cups of tea daily may be at risk for spontaneous
abortion. In 1998, a study claimed that women who
drank more than a half-cup of caffeinated tea every day
may actually increase their fertility. In 1998, a study
showed that over a lifetime, a few extra cups of coffee
a day can raise blood pressure, heart rate, and stress
(Source: “Bottom Line: Is It Good for You? Or Bad?”
by Monika Guttman, USA TODAY Weekend ). Suggest
some reasons why these studies appear to be conflicting.

For the article that you selected in Exercise 30, suggest
some confounding variables that may have an effect on
the results of the study.
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Are We Improving Our Diet?—Revisited

Researchers selected a sample of 23,699 adults in the United States, using phone numbers

selected at random, and conducted a telephone survey. All respondents were asked six questions:

1. How often do you drink juices such as orange, grapefruit, or tomato?

A U A W N

usually eat?

. How often do you eat carrots?

. How often do you eat green salad?

. Not counting juice, how often do you eat fruit?

. How often do you eat potatoes (not including french fries, fried potatoes, or potato chips)?

. Not counting carrots, potatoes, or salad, how many servings of vegetables do you

Researchers found that men consumed fewer servings of fruits and vegetables per day
(3.3) than women (3.7). Only 20% of the population consumed the recommended 5 or more
daily servings. In addition, they found that youths and less-educated people consumed an even

lower amount than the average.

Based on this study, they recommend that greater educational efforts are needed to
improve fruit and vegetable consumption by Americans and to provide environmental and
institutional support to encourage increased consumption.

Source: Mary K. Serdula, M.D., et al., “Fruit and Vegetable Intake Among Adults in 16 States: Results of a Brief Telephone
Survey,” American Journal of Public Health 85, no. 2. Copyright by the American Public Health Association.

Chapter Quiz

Determine whether each statement is true or false. If the
statement is false, explain why.

1.

Probability is used as a basis for inferential
statistics.

. The height of President Lincoln is an example of a

variable.

. The highest level of measurement is the interval

level.

. When the population of college professors is divided

into groups according to their rank (instructor, assistant
professor, etc.) and then several are selected from each
group to make up a sample, the sample is called a cluster
sample.

. The variable age is an example of a qualitative

variable.

. The weight of pumpkins is considered to be a continuous

variable.

. The boundary of a value such as 6 inches would be

5.9-6.1 inches.

Select the best answer.

8.

10.

The number of absences per year that a worker has is an
example of what type of data?

a. Nominal
b. Qualitative
c. Discrete
d. Continuous

. What are the boundaries of 25.6 ounces?

a. 25-26 ounces

b. 25.55-25.65 ounces
c. 25.5-25.7 ounces

d. 20-39 ounces

A researcher divided subjects into two groups according
to gender and then selected members from each group
for her sample. What sampling method was the
researcher using?

a. Cluster

b. Random

c. Systematic
d. Stratified

1-29
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11. Data that can be classified according to color are
measured on what scale?

a. Nominal

b. Ratio
c¢. Ordinal
d. Interval

12. A study that involves no researcher intervention is
called

An experimental study.

b. A noninvolvement study.

c.  An observational study.

d. A quasi-experimental study.

|

13. A variable that interferes with other variables in the
study is called

a. A confounding variable.
b. An explanatory variable.
¢. An outcome variable.

d. An interfering variable.

Use the best answer to complete these statements.

14. Two major branches of statistics are and

15. Two uses of probability are and

16. The group of all subjects under study is called a(n)

17. A group of subjects selected from the group of all
subjects under study is called a(n)

18. Three reasons why samples are used in statistics are
a. b. c.

19. The four basic sampling methods are
a. b. c. d.

20. A study that uses intact groups when it is not possible
to randomly assign participants to the groups is called
a(n) study.
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21. In a research study, participants should be assigned to

22.

23.

24.

25.

groups using

methods, if possible.

For each statement, decide whether descriptive or
inferential statistics is used.

a.

b.

The average life expectancy in New Zealand is 78.49
years. Source: World Factbook 2004.

A diet high in fruits and vegetables will lower blood
pressure. Source: Institute of Medicine.

The total amount of estimated losses from hurricane
Hugo was $4.2 billion. Source: Insurance Service
Office.

Researchers stated that the shape of a person’s ears
is related to the person’s aggression. Source:
American Journal of Human Biology.

In 2013, the number of high school graduates will
be 3.2 million students. Source: National Center for
Education.

Classify each as nominal-level, ordinal-level, interval-
level, or ratio-level measurement.

a.
b.

C.

d.

e.

Rating of movies as G, PG, and R.

Number of candy bars sold on a fund drive.
Classification of automobiles as subcompact,
compact, standard, and luxury.

Temperatures of hair dryers.

Weights of suitcases on a commercial airline.

Classify each variable as discrete or continuous.

a.

b.

Ages of people working in a large factory.
Number of cups of coffee served at a

restaurant.

The amount of a drug injected into a guinea

pig.

The time it takes a student to drive to

school.

The number of gallons of milk sold each day at a
grocery store.

Give the boundaries of each.

SRS

48 seconds.
0.56 centimeter.
9.1 quarts.

13.7 pounds.

7 feet.



Critical Thinking Challenges

1.

World’s Busiest Airports A study of the world’s
busiest airports was conducted by Airports Council
International. Describe three variables that one could
use to determine which airports are the busiest. What
units would one use to measure these variables? Are
these variables categorical, discrete, or continuous?

. Smoking and Criminal Behavior The results of a

study published in Archives of General Psychiatry stated
that male children born to women who smoke during
pregnancy run a risk of violent and criminal behavior that
lasts into adulthood. The results of this study were
challenged by some people in the media. Give several
reasons why the results of this study would be
challenged.

. Piano Lessons Improve Math Ability The results of a

study published in Neurological Research stated that
second-graders who took piano lessons and played a
computer math game more readily grasped math
problems in fractions and proportions than a similar
group who took an English class and played the same
math game. What type of inferential study was this?
Give several reasons why the piano lessons could
improve a student’s math ability.

. ACL Tears in Collegiate Soccer Players A study

of 2958 collegiate soccer players showed that in

46 anterior cruciate ligament (ACL) tears, 36 were in
women. Calculate the percentages of tears for each
gender.

Critical Thinking Challenges

a. Can it be concluded that female athletes tear their
knees more often than male athletes?

b. Comment on how this study’s conclusion might
have been reached.

5. Anger and Snap Judgments Read the article entitled
“Anger Can Cause Snap Judgments” and answer the
following questions.

a. s the study experimental or observational?

b. What is the independent variable?

c¢. What is the dependent variable?

d. Do you think the sample sizes are large enough to
merit the conclusion?

e. Based on the results of the study, what changes
would you recommend to persons to help them
reduce their anger?

6. Hostile Children Fight Unemployment Read the

article entitled “Hostile Children Fight Unemployment”

and answer the following questions.

Is the study experimental or observational?
What is the independent variable?
What is the dependent variable?

U SR

influenced the results of the study.
e. Identify the three groups of subjects used in the
study.

Anger can make a normally
unbiased person act with
prejudice, according to a forthcoming
study in the journal Psychological
Science.

Assistant psychology professors
David DeSteno at Northeastern
University in Boston and Nilanjana
Dasgupta at the University of
Massachusetts, Amherst, randomly
divided 81 study participants into two
groups and assigned them a writing
task designed to induce angry, sad or
neutral feelings. In a subsequent test
to uncover nonconscious associations,

IXT:1 CAN CAUSE SNAP JUDGMENTS

angry subjects were quicker to connect
negatively charged words—Iike war,
death and vomit—with members of the
opposite group—even though the
groupings were completely arbitrary.
“These automatic responses guide
our behavior when we’re not paying
attention,” says DeSteno, and they can
lead to discriminatory acts when there
is pressure to make a quick decision.
“If you’re aware that your emotions
might be coloring these gut reactions,”
he says, “you should take time to
consider that possibility and adjust
your actions accordingly.”
—Eric Strand

Source: Reprinted with permission from Psychology Today, Copyright © (2004) Sussex Publishers, Inc.
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Suggest some confounding variables that may have
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UNEMPLOYMENT

ggressive children may be

destined for later long-term
unemployment. In a study that began
in 1968, researchers at the University
of Jyvaskyla in Finland examined
about 300 participants at ages
8, 14, 27, and 36. They looked for
aggressive behaviors like hurting
other children, kicking objects when
angry, or attacking others without
reason.

Their results, published recently in
the International Journal of Behavioral
Development, suggest that children
with low self-control of emotion
—especially aggression—were
significantly more prone to long-term
unemployment. Children with
behavioral  inhibitions—such  as
passive and anxious behaviors—were
also indirectly linked to unemployment

Hostile Children Fight Unemployment

as they lacked the preliminary initiative
needed for school success. And while
unemployment rates were high in
Finland during the last data collection,
jobless  participants who  were
aggressive as children were less likely
to have a job two years later than their
nonaggressive counterparts.

Ongoing unemployment can have
serious psychological consequences,
including depression, anxiety and
stress. But lead researcher Lea
Pulkkinen, Ph.D., a Jyvaskyla
psychology professor, does have
encouraging news for parents:
Aggressive children with good social
skills and child-centered parents were
significantly  less likely to be
unemployed for more than two years
as adults.

—Tanya Zimbardo

Source: Reprinted with permission from Psychology Today, Copyright © (2001) Sussex Publishers, Inc.

@ Data Projects

1. Business and Finance Investigate the types of data

that are collected regarding stock and bonds, for
example, price, earnings ratios, and bond ratings. Find
as many types of data as possible. For each, identify the
level of measure as nominal, ordinal, interval, or ratio.
For any quantitative data, also note if they are discrete
or continuous.

. Sports and Leisure Select a professional sport.
Investigate the types of data that are collected about that
sport, for example, in baseball, the level of play (A, AA,
AAA, Major League), batting average, and home-run
hits. For each, identify the level of measure as nominal,
ordinal, interval, or ratio. For any quantitative data, also
note if they are discrete or continuous.

. Technology Music organization programs on
computers and music players maintain information
about a song, such as the writer, song length, genre, and
your personal rating. Investigate the types of data
collected about a song. For each, identify the level of
measure as nominal, ordinal, interval, or ratio. For any
quantitative data, also note if they are discrete or
continuous.
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4. Health and Wellness Think about the types of data

that can be collected about your health and wellness,
things such as blood type, cholesterol level, smoking
status, and BMI. Find as many data items as you can.
For each, identify the level of measure as nominal,
ordinal, interval, or ratio. For any quantitative data, also
note if they are discrete or continuous.

. Politics and Economics Every 10 years since 1790, the

federal government has conducted a census of U.S.
residents. Investigate the types of data that were
collected in the 2000 census. For each, identify the level
of measure as nominal, ordinal, interval, or ratio. For
any quantitative data, also note if they are discrete or
continuous. Use the library or a genealogy website to
find a census form from 1860. What types of data were
collected? How do the types of data differ?

. Your Class Your school probably has a database that

contains information about each student, such as age,
county of residence, credits earned, and ethnicity.
Investigate the types of student data that your college
collects and reports. For each, identify the level of
measure as nominal, ordinal, interval, or ratio. For any
quantitative data, also note if they are discrete or
continuous.
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Answers to Applying the Concepts

Section 1-1 Attendance and Grades

1. The variables are grades and attendance.

. The data consist of specific grades and attendance

numbers.

. These are descriptive statistics.

4. The population under study is students at Manatee

Community College (MCC).

. While not specified, we probably have data from a

sample of MCC students.

. Based on the data, it appears that, in general, the better

your attendance the higher your grade.

Section 1-2 Safe Travel

1.

The variables are industry and number of job-related
injuries.

. The type of industry is a qualitative variable, while the

number of job-related injuries is quantitative.

. The number of job-related injuries is discrete.

4. Type of industry is nominal, and the number of job-

related injuries is ratio.

. The railroads do show fewer job-related injuries;

however, there may be other things to consider. For
example, railroads employ fewer people than the other
transportation industries in the study.

. A person’s choice of transportation might also be

affected by convenience issues, cost, service, etc.

. Answers will vary. One possible answer is that the

railroads have the fewest job-related injuries, while the
airline industry has the most job-related injuries (more
than twice those of the railroad industry). The numbers
of job-related injuries in the subway and trucking
industries are fairly comparable.

Section 1-3 American Culture and Drug Abuse

Answers will vary, so this is one possible answer.

1.

I used a telephone survey. The advantage to my survey
method is that this was a relatively inexpensive survey
method (although more expensive than using the mail)
that could get a fairly sizable response. The disadvan-
tage to my survey method is that [ have not included
anyone without a telephone. (Note: My survey used a
random dialing method to include unlisted numbers
and cell phone exchanges.)

. A mail survey also would have been fairly inexpensive,

but my response rate may have been much lower than

what I got with my telephone survey. Interviewing
would have allowed me to use follow-up questions and
to clarify any questions of the respondents at the time of
the interview. However, interviewing is very labor- and
cost-intensive.

. Tused ordinal data on a scale of 1 to 5. The scores

were | = strongly disagree, 2 = disagree, 3 = neutral,
4 = agree, 5 = strongly agree.

. The random method that I used was a random dialing

method.

. To include people from each state, I used a stratified

random sample, collecting data randomly from each of
the area codes and telephone exchanges available.

. This method allowed me to make sure that I had

representation from each area of the United States.

. Convenience samples may not be representative of the

population, and a convenience sample of adolescents
would probably differ greatly from the general
population with regard to the influence of American
culture on illegal drug use.

Section 1-4 Just a Pinch Between Your
Cheek and Gum

1.

This was an experiment, since the researchers imposed
a treatment on each of the two groups involved in the
study.

. The independent variable is whether the participant

chewed tobacco or not. The dependent variables are the
students’ blood pressures and heart rates.

. The treatment group is the tobacco group—the other

group was used as a control.

. A student’s blood pressure might not be affected by

knowing that he or she was part of a study. However,
if the student’s blood pressure were affected by this
knowledge, all the students (in both groups) would be
affected similarly. This might be an example of the
placebo effect.

. Answers will vary. One possible answer is that

confounding variables might include the way that the
students chewed the tobacco, whether or not the
students smoked (although this would hopefully have
been evened out with the randomization), and that all
the participants were university students.

. Answers will vary. One possible answer is that the study

design was fine, but that it cannot be generalized
beyond the population of university students (or people
around that age).
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Organize data using a frequency distribution.

Represent data in frequency distributions
graphically using histograms, frequency
polygons, and ogives.

Represent data using bar graphs, Pareto
charts, time series graphs, and pie graphs.

Draw and interpret a stem and leaf plot.
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How Your Identity Can Be Stolen

Identity fraud is a big business today. The total amount of the fraud in 2006 was $56.6 bil-
lion. The average amount of the fraud for a victim is $6383, and the average time to cor-
rect the problem is 40 hours. The ways in which a person’s identity can be stolen are
presented in the following table:

Lost or stolen wallet, checkbook, or credit card 38%
Friends, acquaintances 15
Corrupt business employees 15
Computer viruses and hackers 9
Stolen mail or fraudulent change of address 8
Online purchases or transactions 4
Other methods 11

Source: Javelin Strategy & Research; Council of Better Business Bureau, Inc.

Looking at the numbers presented in a table does not have the same impact as pre-
senting numbers in a well-drawn chart or graph. The article did not include any graphs.
This chapter will show you how to construct appropriate graphs to represent data and
help you to get your point across to your audience.

See Statistics Today—Revisited at the end of the chapter for some suggestions on
how to represent the data graphically.

Introduction

When conducting a statistical study, the researcher must gather data for the particular vari-
able under study. For example, if a researcher wishes to study the number of people who
were bitten by poisonous snakes in a specific geographic area over the past several years,
he or she has to gather the data from various doctors, hospitals, or health departments.

To describe situations, draw conclusions, or make inferences about events, the
researcher must organize the data in some meaningful way. The most convenient method
of organizing data is to construct a frequency distribution.

After organizing the data, the researcher must present them so they can be under-
stood by those who will benefit from reading the study. The most useful method of
presenting the data is by constructing statistical charts and graphs. There are many
different types of charts and graphs, and each one has a specific purpose.
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This chapter explains how to organize data by constructing frequency distributions
and how to present the data by constructing charts and graphs. The charts and graphs
illustrated here are histograms, frequency polygons, ogives, pie graphs, Pareto charts,
and time series graphs. A graph that combines the characteristics of a frequency distribu-
tion and a histogram, called a stem and leaf plot, is also explained.

Organizing Data
Wealthy People

Suppose a researcher wished to do a study on the ages of the top 50 wealthiest
o people in the world. The researcher first would have to get the data on the ages of

the people. In this case, these ages are listed in Forbes Magazine. When the data
are in original form, they are called raw data and are listed next.

49 57 38 73 81
74 59 76 65 69
54 56 69 68 78
65 85 49 69 61
48 81 68 37 43
78 82 43 64 67
52 56 81 77 79
85 40 85 59 80
60 71 57 61 69
61 83 90 87 74

Since little information can be obtained from looking at raw data, the researcher
organizes the data into what is called a frequency distribution. A frequency distribution
consists of classes and their corresponding frequencies. Each raw data value is placed
into a quantitative or qualitative category called a class. The frequency of a class then is
the number of data values contained in a specific class. A frequency distribution is shown
for the preceding data set.

Class limits Tally Frequency
3541 1/ 3
42-48 /1] 3
49-55 /! 4
56-62 TRLTIH 10
63-69 TR T 10
70-76 L 5
77-83 TRRLTIH 10
84-90 T 5

Total 50

Now some general observations can be made from looking at the frequency distri-
bution. For example, it can be stated that the majority of the wealthy people in the study
are over 55 years old.

A frequency distribution is the organization of raw data in table form, using classes
and frequencies.

The classes in this distribution are 35-41, 4248, etc. These values are called class
limits. The data values 35, 36, 37, 38, 39, 40, 41 can be tallied in the first class; 42, 43, 44,
45, 46, 47, 48 in the second class; and so on.

2-3
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Two types of frequency distributions that are most often used are the categorical
frequency distribution and the grouped frequency distribution. The procedures for con-
structing these distributions are shown now.

Categorical Frequency Distributions

The categorical frequency distribution is used for data that can be placed in specific cate-
gories, such as nominal- or ordinal-level data. For example, data such as political affiliation,
religious affiliation, or major field of study would use categorical frequency distributions.

Distribution of Blood Types

Twenty-five army inductees were given a blood test to determine their blood type. The
data set is

A B B AB (0]
O (0] B AB B
B B O A (0]
A (0] O (0] AB
AB A o B A

Construct a frequency distribution for the data.

Solution

Since the data are categorical, discrete classes can be used. There are four blood types:
A, B, O, and AB. These types will be used as the classes for the distribution.

The procedure for constructing a frequency distribution for categorical data is
given next.

Step 1 Make a table as shown.

A B C D
Class Tally Frequency Percent
A
B
0)

AB

Step 2 Tally the data and place the results in column B.
Step 3 Count the tallies and place the results in column C.
Step 4 Find the percentage of values in each class by using the formula
% = L. 100%
n
where f = frequency of the class and n = total number of values. For
example, in the class of type A blood, the percentage is

5
0y = — . 0 = 0,
% 25 100% = 20%

Percentages are not normally part of a frequency distribution, but they can
be added since they are used in certain types of graphs such as pie graphs.
Also, the decimal equivalent of a percent is called a relative frequency.

Step 5 Find the totals for columns C (frequency) and D (percent). The completed
table is shown.
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A B C D
Class Tally Frequency Percent
A T 5 20
B T 7 28
@) T 9 36
AB I 4 16
Total 25 100

For the sample, more people have type O blood than any other type.

Grouped Frequency Distributions

When the range of the data is large, the data must be grouped into classes that are more
than one unit in width, in what is called a grouped frequency distribution. For exam-
ple, a distribution of the number of hours that boat batteries lasted is the following.

Class Class
limits boundaries Tally Frequency
24-30 23.5-30.5 1/l 3
31-37 30.5-37.5 / 1
38-44 37.5-44.5 T 5
45-51 44.5-51.5 S 9
52-58 51.5-58.5 TR/ 6
59-65 58.5-65.5 / 1

5

The procedure for constructing the preceding frequency distribution is given in
Example 2-2; however, several things should be noted. In this distribution, the values 24
and 30 of the first class are called class limits. The lower class limit is 24; it represents
the smallest data value that can be included in the class. The upper class limit is 30; it
represents the largest data value that can be included in the class. The numbers in the sec-
ond column are called class boundaries. These numbers are used to separate the classes
so that there are no gaps in the frequency distribution. The gaps are due to the limits; for
example, there is a gap between 30 and 31.

Students sometimes have difficulty finding class boundaries when given the class
limits. The basic rule of thumb is that the class limits should have the same decimal
place value as the data, but the class boundaries should have one additional place value
and end in a 5. For example, if the values in the data set are whole numbers, such as 24,
32, and 18, the limits for a class might be 31-37, and the boundaries are 30.5-37.5. Find
the boundaries by subtracting 0.5 from 31 (the lower class limit) and adding 0.5 to 37
(the upper class limit).

Lower limit — 0.5 = 31 — 0.5 = 30.5 = lower boundary
Upper limit + 0.5 = 37 + 0.5 = 37.5 = upper boundary

If the data are in tenths, such as 6.2, 7.8, and 12.6, the limits for a class hypotheti-
cally might be 7.8-8.8, and the boundaries for that class would be 7.75-8.85. Find these
values by subtracting 0.05 from 7.8 and adding 0.05 to 8.8.

Finally, the class width for a class in a frequency distribution is found by subtract-
ing the lower (or upper) class limit of one class from the lower (or upper) class limit of
the next class. For example, the class width in the preceding distribution on the duration
of boat batteries is 7, found from 31 — 24 = 7.
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The class width can also be found by subtracting the lower boundary from the upper

boundary for any given class. In this case, 30.5 — 23.5 = 7.

Note: Do not subtract the limits of a single class. It will result in an incorrect answer.
The researcher must decide how many classes to use and the width of each class. To

construct a frequency distribution, follow these rules:

1. There should be between 5 and 20 classes. Although there is no hard-and-fast rule

for the number of classes contained in a frequency distribution, it is of the utmost
importance to have enough classes to present a clear description of the collected
data.

2. It is preferable but not absolutely necessary that the class width be an odd number.

This ensures that the midpoint of each class has the same place value as the data.
The class midpoint X, is obtained by adding the lower and upper boundaries and
dividing by 2, or adding the lower and upper limits and dividing by 2:

lower boundary + upper boundary

X, =

2
or
lower limit + upper limit
an =
2
For example, the midpoint of the first class in the example with boat batteries is
+ .5 + 30.
24230:27 or 2352305:27

The midpoint is the numeric location of the center of the class. Midpoints are
necessary for graphing (see Section 2-2). If the class width is an even number, the
midpoint is in tenths. For example, if the class width is 6 and the boundaries are 5.5
and 11.5, the midpoint is

5.5+ 115 17 _

) 2 8.5

Rule 2 is only a suggestion, and it is not rigorously followed, especially when a
computer is used to group data.

. The classes must be mutually exclusive. Mutually exclusive classes have

nonoverlapping class limits so that data cannot be placed into two classes. Many
times, frequency distributions such as

Age
10-20
20-30

3040
40-50

are found in the literature or in surveys. If a person is 40 years old, into which class
should she or he be placed? A better way to construct a frequency distribution is to
use classes such as
Age

1020

21-31

3242

43-53

. The classes must be continuous. Even if there are no values in a class, the class

must be included in the frequency distribution. There should be no gaps in a
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frequency distribution. The only exception occurs when the class with a zero
frequency is the first or last class. A class with a zero frequency at either end can be
omitted without affecting the distribution.

5. The classes must be exhaustive. There should be enough classes to accommodate all
the data.

6. The classes must be equal in width. This avoids a distorted view of the data.

One exception occurs when a distribution has a class that is open-ended. That is,
the class has no specific beginning value or no specific ending value. A frequency
distribution with an open-ended class is called an open-ended distribution. Here
are two examples of distributions with open-ended classes.

Age Frequency Minutes Frequency
10-20 3 Below 110 16
21-31 6 110-114 24
3242 4 115-119 38
43-53 10 120-124 14
54 and above 8 125-129 5

The frequency distribution for age is open-ended for the last class, which means
that anybody who is 54 years or older will be tallied in the last class. The
distribution for minutes is open-ended for the first class, meaning that any minute
values below 110 will be tallied in that class.

Example 2-2 shows the procedure for constructing a grouped frequency distribution,
i.e., when the classes contain more than one data value.

Record High Temperatures

These data represent the record high temperatures in degrees Fahrenheit (°F) for
each of the 50 states. Construct a grouped frequency distribution for the data using
7 classes.

112 100 127 120 134 118 105 110 109 112
110 118 117 116 118 122 114 114 105 109
107 112 114 115 118 117 118 122 106 110
116 108 110 121 113 120 119 111 104 111
120 113 120 117 105 110 118 112 114 114

Source: The World Almanac and Book of Facts.

Solution

The procedure for constructing a grouped frequency distribution for numerical data
follows.

Step 1 Determine the classes.

Find the highest value and lowest value: H = 134 and L = 100.

Find the range: R = highest value — lowest value = H — L, so

R =134 — 100 = 34

Select the number of classes desired (usually between 5 and 20). In this case,
7 is arbitrarily chosen.

Find the class width by dividing the range by the number of classes.

R M _ 49

Width = number of classes - 7
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Step 2
Step 3

Round the answer up to the nearest whole number if there is a remainder:

4.9 = 5. (Rounding up is different from rounding off. A number is rounded up if
there is any decimal remainder when dividing. For example, 85 +~ 6 = 14.167
and is rounded up to 15. Also, 53 + 4 = 13.25 and is rounded up to 14. Also,
after dividing, if there is no remainder, you will need to add an extra class to
accommodate all the data.)

Select a starting point for the lowest class limit. This can be the smallest data
value or any convenient number less than the smallest data value. In this case,
100 is used. Add the width to the lowest score taken as the starting point to
get the lower limit of the next class. Keep adding until there are 7 classes, as
shown, 100, 105, 110, etc.

Subtract one unit from the lower limit of the second class to get the upper
limit of the first class. Then add the width to each upper limit to get all the
upper limits.

105 — 1 =104

The first class is 100—104, the second class is 105-109, etc.

Find the class boundaries by subtracting 0.5 from each lower class limit and
adding 0.5 to each upper class limit:

99.5-104.5, 104.5-109.5, etc.
Tally the data.

Find the numerical frequencies from the tallies.

The completed frequency distribution is

Class Class

limits boundaries Tally Frequency
100-104 99.5-104.5 // 2
105-109 104.5-109.5 LI 8
110-114 109.5-114.5 TRLTIC TR T 18
115-119 114.5-119.5 TRLTIL 1] 13
120-124 119.5-124.5 T/
125-129 124.5-129.5 / 1
130-134 129.5-134.5 / 1

The frequency distribution shows that the class 109.5-114.5 contains
the largest number of temperatures (18) followed by the class 114.5-119.5
with 13 temperatures. Hence, most of the temperatures (31) fall between
109.5 and 119.5°F.

Sometimes it is necessary to use a cumulative frequency distribution. A cumulative
frequency distribution is a distribution that shows the number of data values less than
or equal to a specific value (usually an upper boundary). The values are found by adding
the frequencies of the classes less than or equal to the upper class boundary of a specific
class. This gives an ascending cumulative frequency. In this example, the cumulative fre-
quency for the first class is 0 + 2 = 2; for the second class itis 0 + 2 + 8 = 10; for the
third class itis 0 + 2 + 8 + 18 = 28. Naturally, a shorter way to do this would be to just
add the cumulative frequency of the class below to the frequency of the given class. For
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example, the cumulative frequency for the number of data values less than 114.5 can be
found by adding 10 + 18 = 28. The cumulative frequency distribution for the data in this
example is as follows:

Cumulative frequency

Less than 99.5 0
Less than 104.5 2
Less than 109.5 10
Less than 114.5 28
Less than 119.5 41
Less than 124.5 48
Less than 129.5 49
Less than 134.5 50

Cumulative frequencies are used to show how many data values are accumulated up
to and including a specific class. In Example 2-2, 28 of the total record high tempera-
tures are less than or equal to 114°F. Forty-eight of the total record high temperatures are
less than or equal to 124°F.

After the raw data have been organized into a frequency distribution, it will be ana-
lyzed by looking for peaks and extreme values. The peaks show which class or classes
have the most data values compared to the other classes. Extreme values, called outliers,
show large or small data values that are relative to other data values.

When the range of the data values is relatively small, a frequency distribution can be
constructed using single data values for each class. This type of distribution is called an
ungrouped frequency distribution and is shown next.

MPGs for SUVs

The data shown here represent the number of miles per gallon (mpg) that 30 selected
four-wheel-drive sports utility vehicles obtained in city driving. Construct a
frequency distribution, and analyze the distribution.

12 17 12 14 16 18
16 18 12 16 17 15
15 16 12 15 16 16
12 14 15 12 15 15
19 13 16 18 16 14

Source: Model Year Fuel Economy Guide. United States
Environmental Protection Agency.

Solution

Step 1 Determine the classes. Since the range of the data set is small (19 — 12 = 7),
classes consisting of a single data value can be used. They are 12, 13, 14, 15,
16, 17, 18, 19.
Note: If the data are continuous, class boundaries can be used. Subtract 0.5
from each class value to get the lower class boundary, and add 0.5 to each
class value to get the upper class boundary.

Step 2 Tally the data.

Step 3 Find the numerical frequencies from the tallies, and find the cumulative
frequencies.
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The completed ungrouped frequency distribution is

Class Class
limits boundaries Tally Frequency
12 11.5-12.5 L/ 6
13 12.5-13.5 / 1
14 13.5-14.5 /1 3
15 14.5-15.5 L/ 6
16 15.5-16.5 LT 8
17 16.5-17.5 // 2
18 17.5-18.5 /1 3
19 18.5-19.5 / 1

In this case, almost one-half (14) of the vehicles get 15 or 16 miles per gallon.
The cumulative frequencies are

Cumulative frequency

Less than 11.5 0
Less than 12.5 6
Less than 13.5 7
Less than 14.5 10
Less than 15.5 16
Less than 16.5 24
Less than 17.5 26
Less than 18.5 29
Less than 19.5 30

The steps for constructing a grouped frequency distribution are summarized in the
following Procedure Table.

Procedure Table

Constructing a Grouped Frequency Distribution

Step1  Determine the classes.
Find the highest and lowest values.
Find the range.
Select the number of classes desired.
Find the width by dividing the range by the number of classes and rounding up.

Select a starting point (usually the lowest value or any convenient number less
than the lowest value); add the width to get the lower limits.

Find the upper class limits.
Find the boundaries.
Step 2 Tally the data.

Step3  Find the numerical frequencies from the tallies, and find the cumulative
frequencies.

When you are constructing a frequency distribution, the guidelines presented in this
section should be followed. However, you can construct several different but correct

2-10



Male dogs bite
children more often
than female dogs do;
however, female cats
bite children more
often than male

cats do.
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frequency distributions for the same data by using a different class width, a different
number of classes, or a different starting point.

Furthermore, the method shown here for constructing a frequency distribution is not
unique, and there are other ways of constructing one. Slight variations exist, especially
in computer packages. But regardless of what methods are used, classes should be mutu-
ally exclusive, continuous, exhaustive, and of equal width.

In summary, the different types of frequency distributions were shown in this section.
The first type, shown in Example 2—1, is used when the data are categorical (nominal),
such as blood type or political affiliation. This type is called a categorical frequency dis-
tribution. The second type of distribution is used when the range is large and classes
several units in width are needed. This type is called a grouped frequency distribution and
is shown in Example 2—-2. Another type of distribution is used for numerical data and
when the range of data is small, as shown in Example 2-3. Since each class is only one
unit, this distribution is called an ungrouped frequency distribution.

All the different types of distributions are used in statistics and are helpful when one
is organizing and presenting data.

The reasons for constructing a frequency distribution are as follows:

1. To organize the data in a meaningful, intelligible way.
2. To enable the reader to determine the nature or shape of the distribution.

3. To facilitate computational procedures for measures of average and spread (shown
in Sections 3—1 and 3-2).

4. To enable the researcher to draw charts and graphs for the presentation of data
(shown in Section 2-2).

5. To enable the reader to make comparisons among different data sets.

The factors used to analyze a frequency distribution are essentially the same
as those used to analyze histograms and frequency polygons, which are shown in
Section 2-2.

Applying the Concepts 2=1

Ages of Presidents at Inauguration
The data represent the ages of our Presidents at the time they were first inaugurated.

57 61 57 57 58 57 61 54 68
51 49 64 50 48 65 52 56 46
54 49 50 47 55 55 54 42 51
56 55 54 51 60 62 43 55 56
61 52 69 64 46 54

. Were the data obtained from a population or a sample? Explain your answer.
. What was the age of the oldest President?
. What was the age of the youngest President?

AW N =

. Construct a frequency distribution for the data. (Use your own judgment as to the number
of classes and class size.)

|9}

. Are there any peaks in the distribution?
6. ldentify any possible outliers.
7. Write a brief summary of the nature of the data as shown in the frequency distribution.

See page 101 for the answers.

2-11
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. List five reasons for organizing data into a frequency
distribution.

. Name the three types of frequency distributions, and
explain when each should be used.

. Find the class boundaries, midpoints, and widths for
each class.

a. 12-18

b. 56-74

c. 695-705
d. 13.6-14.7
e. 2.15-3.93

. How many classes should frequency distributions have?
Why should the class width be an odd number?

. Shown here are four frequency distributions. Each is
incorrectly constructed. State the reason why.

a. Class Frequency
27-32 1
33-38 0
39-44 6
45-49 4
50-55 2

b. Class Frequency

5-9 1
9-13 2
13-17 5
17-20 6
20-24 3

c. Class Frequency
123-127 3
128-132 7
138-142 2
143-147 19

d. Class Frequency

9-13 1
14-19 6
20-25 2
26-28 5
29-32 9

. What are open-ended frequency distributions? Why are
they necessary?

. Trust in Internet Information A survey was taken on
how much trust people place in the information they
read on the Internet. Construct a categorical frequency
distribution for the data. A = trust in everything they
read, M = trust in most of what they read, H = trust in

2-12

about one-half of what they read, S = trust in a small
portion of what they read. (Based on information from
the UCLA Internet Report.)

M M M A H M §S M H M
S M M M M A M M A M
M M H M M M H M H M
A M M M H M M M M M

8. State Gasoline Tax The state gas tax in cents per

gallon for 25 states is given below. Construct a
grouped frequency distribution and a cumulative
frequency distribution with 5 classes.

7.5 16 23.5 17 22

21.5 19 20 27.1 20
22 20.7 17 28 20
23 18.5 253 24 31

14.5 259 18 30 31.5
Source: The World Almanac and Book of Facts.

9. Weights of the NBA’s Top 50 Players Listed are

the weights of the NBA’s top 50 players. Construct a
grouped frequency distribution and a cumulative
frequency distribution with 8§ classes. Analyze the
results in terms of peaks, extreme values, etc.

240 210 220 260 250 195 230 270 325 225
165 295 205 230 250 210 220 210 230 202
250 265 230 210 240 245 225 180 175 215
215 235 245 250 215 210 195 240 240 225
260 210 190 260 230 190 210 230 185 260

Source: www.msn.foxsports.com

10. Stories in the World’s Tallest Buildings The

number of stories in each of the world’s 30 tallest
buildings is listed below. Construct a grouped frequency
distribution and a cumulative frequency distribution
with 7 classes.

88 88 110 88 80 69 102 78 70 55
79 8 80 100 60 90 77 55 75 55
54 60 75 64 105 56 71 70 65 72

Source: New York Times Almanac.

11. GRE Scores at Top-Ranked Engineering

Schools The average quantitative GRE scores for the
top 30 graduate schools of engineering are listed.
Construct a grouped frequency distribution and a
cumulative frequency distribution with 5 classes.

767 770 761 760 771 768 776 771 756 770
763 760 747 766 754 771 771 178 766 762
780 750 746 764 769 759 757 753 758 746

Source: U.S. News & World Report Best Graduate Schools.


www.msn.foxsports.com

12. Airline Passengers The number of passengers

(in thousands) for the leading U.S. passenger airlines in
2004 is indicated below. Use the data to construct a
grouped frequency distribution and a cumulative
frequency distribution with a reasonable number of
classes and comment on the shape of the distribution.

91,570 86,755 81,066 70,786 55,373 42,400

40,551 21,119 16,280 14,869 13,659 13,417

13,170 12,632 11,731 10,420 10,024 9,122
7,041 6,954 6,406 6,362 5930 5,585
5,427

Source: The World Almanac and Book of Facts.

13. Ages of Declaration of Independence Signers

The ages of the signers of the Declaration of
Independence are shown. (Age is approximate since
only the birth year appeared in the source, and one
has been omitted since his birth year is unknown.)
Construct a grouped frequency distribution and a
cumulative frequency distribution for the data using
7 classes. (The data for this exercise will be used
for Exercise 5 in Section 2-2 and Exercise 23 in
Section 3—1.)

41 54 47 40 39 35 50 37 49 42 70 32
44 52 39 50 40 30 34 69 39 45 33 42
44 63 60 27 42 34 50 42 52 38 36 45
35 43 48 46 31 27 55 63 46 33 60 62
35 46 45 34 53 50 50

Source: The Universal Almanac.

14. Online Gambling Online computer gaming has

become a popular leisure time activity. Fifty-six
percent of the 117 million active gamers play games
online. Below are listed the numbers of players playing
a free online game at various times of the day. Construct
a grouped frequency distribution and a cumulative
frequency distribution with 6 classes.

3907 3629 3640 3839 3446 2313 2537 2037 3194
3739 3886 3698 3898 2101 1525 2311 3344 3647

Source: www.msn.tech.com

15. Presidential Vetoes The number of total vetoes

exercised by the past 20 Presidents is listed below. Use
the data to construct a grouped frequency distribution
and a cumulative frequency distribution with 5 classes.
What is challenging about this set of data?

44 39 37 21 31 170 44 632 30 78
42 6 250 43 44 82 50 181 66 37

Source: World Almanac and Book of Facts.

16. U.S. National Park Acreage The acreage of the

39 U.S. National Parks under 900,000 acres (in
thousands of acres) is shown here. Construct a grouped
frequency distribution and a cumulative frequency
distribution for the data using 8 classes. (The data in
this exercise will be used in Exercise 11 in Section 2-2.)
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41 66 233 775 169
36 338 233 236 64
183 61 13 308 77
520 77 27 217 5
650 462 106 52 52
505 94 75 265 402
196 70 132 28 220
760 143 46 539

Source: The Universal Almanac.

17. Heights of Alaskan Volcanoes The heights (in feet
above sea level) of the major active volcanoes in Alaska
are given here. Construct a grouped frequency distribution
and a cumulative frequency distribution for the data using

10 classes. (The data in this exercise will be used in
Exercise 9 in Section 3—1 and Exercise 17 in Section 3-2.)

4,265 3,545 4,025 7,050 11,413

3,490 5,370 4,885 5,030 6,830

4,450 5,775 3,945 7,545 8,450

3,995 10,140 6,050 10,265 6,965
150 8,185 7,295 2,015 5,055

5,315 2,945 6,720 3,465 1,980

2,560 4,450 2,759 9,430

7,985 7,540 3,540 11,070

5,710 885 8,960 7,015

Source: The Universal Almanac.

18. Home Run Record Breakers During the 1998

baseball season, Mark McGwire and Sammy Sosa
both broke Roger Maris’s home run record of 61. The
distances (in feet) for each home run follow. Construct
a grouped frequency distribution and a cumulative
frequency distribution for each player, using 8 classes.
(The information in this exercise will be used for
Exercise 12 in Section 2-2, Exercise 10 in Section 3—1,
and Exercise 14 in Section 3-2.)

McGwire Sosa

306 370 370 430 371 350 430 420
420 340 460 410 430 434 370 420
440 410 380 360 440 410 420 460
350 527 380 550 400 430 410 370
478 420 390 420 370 410 380 340
425 370 480 390 350 420 410 415
430 388 423 410 430 380 380 366
360 410 450 350 500 380 390 400
450 430 461 430 364 430 450 440
470 440 400 390 365 420 350 420
510 430 450 452 400 380 380 400
420 380 470 398 370 420 360 368
409 385 369 460 430 433 388 440
390 510 500 450 414 482 364 370
470 430 458 380 400 405 433 390
430 341 385 410 480 480 434 344
420 380 400 440 410 420

377 370

Source: USA TODAY.
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Extending the Concepts

19. JFK Assassination A researcher conducted a survey The results were as follows: 73% said yes, 19% said no,
asking people if they believed more than one person and 9% had no opinion. Is there anything suspicious
was involved in the assassination of John F. Kennedy. about the results?

Step by Step
M | N |TAB Make a Categorical Frequency Table
Step by Step (Qualitative or Discrete Data)

1. Type in all the blood types from Example 2—1 down C1 of the worksheet.
ABBABOOOBABBBBOAOAOOOABABAOBA

2. Click above row | and name the column BloodType.
3. Select Stat>Tables>Tally Individual Values.

The cursor should be blinking in the Variables dialog box. If not, click inside the dialog
box.

4. Double-click C1 in the Variables list.
5. Check the boxes for the statistics: Counts, Percents, and Cumulative percents.

6. Click [OK]. The results will be displayed in the Session Window as shown.

Tally for Discrete Variables: BloodType
BloodType Count Percent CumPct

A 5 20.00 20.00
AB 4 16.00 36.00

B 7 28.00 64.00

@) 9 36.00 100.00
N= 25

Make a Grouped Frequency Distribution
(Quantitative Variable)

1. Select FilesSNew>New Worksheet. A new worksheet will be added to the project.
2. Type the data used in Example 2-2 into C1. Name the column TEMPERATURES.
3. Use the instructions in the textbook to determine the class limits.

In the next step you will create a new column of data, converting the numeric variable to text
categories that can be tallied.

4. Select Data>Code>Numeric to Text.

a) The cursor should be blinking in Code data from columns. If not, click inside the box,
then double-click C1 Temperatures in the list. Only quantitative variables will be
shown in this list.

b) Click in the Into columns: then type the name of the new column, TempCodes.
¢) Press [Tab] to move to the next dialog box.
d) Type in the first interval 100:104.

Use a colon to indicate the interval from 100 to 104 with no spaces before or after the
colon.

e) Press [Tab] to move to the New: column, and type the text category 100-104.

f) Continue to tab to each dialog box, typing the interval and then the category until the
last category has been entered.

2-14



5.

7.

Section 2-1 Organizing Data 49

The dialog box should look like the one shown.

Code  Humeric to Text

Code data from columns:
TEWPERATURES
Intn eolumns:
[TenpCodea
Driginal values [eg. 1:4 12): New:
|100:104 j100 — 104
[105:109 fios = 109
[110:114 [110 - 114
[115.119 {115 - 119
[120-124 [120 - 124
128:129 128 - 129
[130:134 [130 =134
P | [ |
Help I [ oKk | Cancel

Click [OK]. In the worksheet, a new column of data will be created in the first empty
column, C2. This new variable will contain the category for each value in C1. The column
C2-T contains alphanumeric data.

. Click Stat>Tables>Tally Individual Values, then double-click TempCodes in the

Variables list.

a) Check the boxes for the desired statistics, such as Counts, Percents, and Cumulative
percents.

b) Click [OKI.

The table will be displayed in the Session Window. Eighteen states have high
temperatures between 110 and 114°F. Eighty-two percent of the states have record high
temperatures less than or equal to 119°F.

Tally for Discrete Variables: TempCodes
TempCodes Count Percent CumPct

100-104 2 4.00 4.00
105-109 8 16.00 20.00
110-114 18 36.00 56.00
115-119 13 26.00 82.00
120-124 7 14.00 96.00
125-129 1 2.00 98.00
130-134 1 2.00 100.00
N= 50

Click File>Save Project As . . ., and type the name of the project file, Ch2-2. This will
save the two worksheets and the Session Window.

Excel
Step by Step

Categorical Frequency Table (Qualitative or Discrete Data)

1.

A N A W N

In an open workbook select cell A1 and type in all the blood types from Example 2—1
down column A.

. Type in the variable name Blood Type in cell B1.
. Select cell B2 and type in the four different blood types down the column.
. Type in the name Count in cell C1.

. Select cell C2. From the toolbar, select the Formulas tab on the toolbar.

F

. Select the Insert Function icon =, then select the Statistical category in the Insert Function

dialog box.

. Select the Countif function from the function name list.
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8. In the dialog box, type A1:A25 in the Range box. Type in the blood type “A” in quotes in
the Criteria box. The count or frequency of the number of data corresponding to the blood
type should appear below the input. Repeat for the remaining blood types.

9. After all the data have been counted, select cell C6 in the worksheet.

10. From the toolbar select Formulas, then AutoSum and type in C2:C5 to insert the total
frequency into cell C6.

Function Arguments

COUNTIF
Range |1:425 - RO A O IO

Criteria " - A

-5

Counks the number of calls with K"\E mest the gh it
Criteria is the condition in the form of & number, expression, or text that

defines which csls vll be counted.
Formeda resl = §

P e =2

After entering data or a heading into a worksheet, you can change the width of a column to fit
the input. To automatically change the width of a column to fit the data:

1. Select the column or columns that you want to change.
2. On the Home tab, in the Cells group, select Format.
3. Under Cell Size, click Autofit Column Width.

Making a Grouped Frequency Distribution (Quantitative Data)
. Press [Ctrl]-N for a new workbook.

. Enter the raw data from Example 2-2 in column A, one number per cell.

. Enter the upper class boundaries in column B.

. From the toolbar select the Data tab, then click Data Analysis.

. In the Analysis Tools, select Histogram and click [OK].

. In the Histogram dialog box, type A1:A50 in the Input Range box and type B1:B7 in the
Bin Range box.

7. Select New Worksheet Ply, and check the Cumulative Percentage option. Click [OK].

A N A W N =

8. You can change the label for the column containing the upper class boundaries and expand
the width of the columns automatically after relabeling:

Select the Home tab from the toolbar.
Highlight the columns that you want to change.
Select Format, then AutoFit Column Width.

{0a) R = £3£2-2 - Neossh Exrel nen-commerial i -
“ | e Ll Pagt Lirinst Formnsien L) Perirm Yoow R - . x
TR e PR L I SEE e w— l gl | St K-
B MR 103 oy L i
il 4 - 2 Vaumanng - o tuoies e [Ti0omto] - v seen
Opbasd 5 i e - v : s i I |
| & g £ | Boundaries Hal B | I}
S B e O [ E o ] [ 1 X Pl R ]
i Sveenhuis [uiiy - CuikoRiiing ¥ ) 4 Comn g
T s £l Ao astafpl Cansmn midin
' 1003 ' 20 Gt v
4 nas i 8.00%
3 pELE) n LR
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Note: By leaving the Chart Output unchecked, a new worksheet will display the table only.
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m Histograms, Frequency Polygons, and Ogives

After you have organized the data into a frequency distribution, you can present them in
Objective E graphical form. The purpose of graphs in statistics is to convey the data to the viewers
in pictorial form. It is easier for most people to comprehend the meaning of data pre-
sented graphically than data presented numerically in tables or frequency distributions.
This is especially true if the users have little or no statistical knowledge.

Statistical graphs can be used to describe the data set or to analyze it. Graphs are
also useful in getting the audience’s attention in a publication or a speaking presenta-
tion. They can be used to discuss an issue, reinforce a critical point, or summarize a data
set. They can also be used to discover a trend or pattern in a situation over a period
of time.

The three most commonly used graphs in research are

Represent data

in frequency
distributions
graphically using
histograms, frequency
polygons, and ogives.

1. The histogram.
2. The frequency polygon.
3. The cumulative frequency graph, or ogive (pronounced o-jive).

An example of each type of graph is shown in Figure 2—-1. The data for each graph

are the distribution of the miles that 20 randomly selected runners ran during a given
week.

The Histogram

The histogram is a graph that displays the data by using contiguous vertical bars
(unless the frequency of a class is 0) of various heights to represent the frequencies of
the classes.

Example 2—-4 Record High Temperatures

Construct a histogram to represent the data shown for the record high temperatures for
each of the 50 states (see Example 2-2).

Class boundaries Frequency

99.5-104.5 2
104.5-109.5 8
109.5-114.5 18
114.5-119.5 13
119.5-124.5 7
124.5-129.5 1
129.5-134.5 1

Solution

Step 1 Draw and label the x and y axes. The x axis is always the horizontal axis, and
the y axis is always the vertical axis.
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Examples of
Commonly Used
Graphs

2-18

Histogram for Runners’ Times

Frequency

55 10.5 15.5 20.5 255 30.5 355 40.5
Class boundaries

(a) Histogram

Frequency Polygon for Runners’ Times

Frequency
w

8 13 18 23 28 33 38
Class midpoints

[

(b) Frequency polygon

Ogive for Runners’ Times

20 +
18
16 1
14
12+
10 +
g 1
61

Cumulative frequency

5.5 105 155 205 255 305 355 405
Class boundaries
(c) Cumulative frequency graph



Histogram for
Example 2-4

ﬂistorical Note

Graphs originated
when ancient
astronomers drew the
position of the stars in
the heavens. Roman
surveyors also used
coordinates to locate
landmarks on their
maps.

The development
of statistical graphs
can be traced to
William Playfair
(1748-1819), an
engineer and drafter
who used graphs to
present economic
data pictorially.
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Record High Temperatures

— —_
o o
| |

—
N
|

Frequency

99.5°

104.5° 109.5° 114.5° 119.6°

Temperature (°F)

124.5° 129.5° 134.5°

Step 2 Represent the frequency on the y axis and the class boundaries on the x axis.

Step 3 Using the frequencies as the heights, draw vertical bars for each class. See
Figure 2-2.

As the histogram shows, the class with the greatest number of data values (18) is
109.5-114.5, followed by 13 for 114.5-119.5. The graph also has one peak with the data
clustering around it.

The Frequency Polygon
Another way to represent the same data set is by using a frequency polygon.

The frequency polygon is a graph that displays the data by using lines that connect
points plotted for the frequencies at the midpoints of the classes. The frequencies are
represented by the heights of the points.

Example 2—-5 shows the procedure for constructing a frequency polygon.

Record High Temperatures
Using the frequency distribution given in Example 2—4, construct a frequency polygon.

Solution
Step 1 Find the midpoints of each class. Recall that midpoints are found by adding
the upper and lower boundaries and dividing by 2:
99.5 +2104.5 — 10 104.5 + 109.5 — 107
and so on. The midpoints are
Class boundaries Midpoints Frequency
99.5-104.5 102 2
104.5-109.5 107 8
109.5-114.5 112 18
114.5-119.5 117 13
119.5-124.5 122 7
124.5-129.5 127 1
129.5-134.5 132 1
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o 1
Frequency Polygon for
Example 2-5

Record High Temperatures

Frequency
> © o o o>
1 1 1 1 1
T T T T T

w
L
T

® ® X
0 p. I I I I I I I

102°  107°  112° 117°  122°  127°  132°
Temperature (°F)

Step 2 Draw the x and y axes. Label the x axis with the midpoint of each class, and
then use a suitable scale on the y axis for the frequencies.

Step 3 Using the midpoints for the x values and the frequencies as the y values, plot
the points.

Step 4 Connect adjacent points with line segments. Draw a line back to the x axis at

the beginning and end of the graph, at the same distance that the previous and
next midpoints would be located, as shown in Figure 2-3.

The frequency polygon and the histogram are two different ways to represent the
same data set. The choice of which one to use is left to the discretion of the researcher.

The Ogive

The third type of graph that can be used represents the cumulative frequencies for
the classes. This type of graph is called the cumulative frequency graph, or ogive. The
cumulative frequency is the sum of the frequencies accumulated up to the upper bound-
ary of a class in the distribution.

The ogive is a graph that represents the cumulative frequencies for the classes in a
frequency distribution.

Example 2—6 shows the procedure for constructing an ogive.

Example 2-6

2-20

Record High Temperatures

Construct an ogive for the frequency distribution described in Example 2—4.
Solution
Step 1 Find the cumulative frequency for each class.

Cumulative frequency

Less than 99.5 0
Less than 104.5 2
Less than 109.5 10
Less than 114.5 28
Less than 119.5 41
Less than 124.5 48
Less than 129.5 49
Less than 134.5 50



Plotting the Cumulative
Frequency for
Example 2-6

[y 1
Ogive for Example 2-6
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Temperature (°F)

104.5° 109.5°

Step 2 Draw the x and y axes. Label the x axis with the class boundaries. Use an
appropriate scale for the y axis to represent the cumulative frequencies.
(Depending on the numbers in the cumulative frequency columns, scales such
as0,1,2,3,...,0r5,10, 15,20, ..., or 1000, 2000, 3000, . . . can be used.
Do not label the y axis with the numbers in the cumulative frequency
column.) In this example, a scale of 0, 5, 10, 15, . . . will be used.

Step 3 Plot the cumulative frequency at each upper class boundary, as shown in
Figure 2—4. Upper boundaries are used since the cumulative frequencies
represent the number of data values accumulated up to the upper boundary
of each class.

Step 4 Starting with the first upper class boundary, 104.5, connect adjacent points
with line segments, as shown in Figure 2—5. Then extend the graph to the first
lower class boundary, 99.5, on the x axis.

Cumulative frequency graphs are used to visually represent how many values are
below a certain upper class boundary. For example, to find out how many record high
temperatures are less than 114.5°F, locate 114.5°F on the x axis, draw a vertical line up
until it intersects the graph, and then draw a horizontal line at that point to the y axis. The
y axis value is 28, as shown in Figure 2—6.
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Finding a Specific
Cumulative Frequency

Twenty-two percent
of Americans sleep
6 hours a day or fewer.
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Record High Temperatures

Cumulative
frequency
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Temperature (°F)
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The steps for drawing these three types of graphs are shown in the following
Procedure Table.

Procedure Table

Constructing Statistical Graphs
Step1 Draw and label the x and y axes.

Step2 Choose a suitable scale for the frequencies or cumulative frequencies, and label it
on the y axis.

Step3  Represent the class boundaries for the histogram or ogive, or the midpoint for the
frequency polygon, on the x axis.

Step 4  Plot the points and then draw the bars or lines.

Relative Frequency Graphs

The histogram, the frequency polygon, and the ogive shown previously were constructed
by using frequencies in terms of the raw data. These distributions can be converted to dis-
tributions using proportions instead of raw data as frequencies. These types of graphs are
called relative frequency graphs.

Graphs of relative frequencies instead of frequencies are used when the proportion
of data values that fall into a given class is more important than the actual number of data
values that fall into that class. For example, if you wanted to compare the age distribu-
tion of adults in Philadelphia, Pennsylvania, with the age distribution of adults of Erie,
Pennsylvania, you would use relative frequency distributions. The reason is that since the
population of Philadelphia is 1,478,002 and the population of Erie is 105,270, the bars
using the actual data values for Philadelphia would be much taller than those for the same
classes for Erie.

To convert a frequency into a proportion or relative frequency, divide the frequency
for each class by the total of the frequencies. The sum of the relative frequencies will
always be 1. These graphs are similar to the ones that use raw data as frequencies, but the
values on the y axis are in terms of proportions. Example 2—7 shows the three types of
relative frequency graphs.



Section 2-2 Histograms, Frequency Polygons, and Ogives 57

m Miles Run per Week

Construct a histogram, frequency polygon, and ogive using relative frequencies for the
distribution (shown here) of the miles that 20 randomly selected runners ran during a

given week.
Class boundaries Frequency
5.5-10.5 1
10.5-15.5 2
15.5-20.5 3
20.5-25.5 5
25.5-30.5 4
30.5-35.5 3
35.5-40.5 2
20
Solution
Step 1 Convert each frequency to a proportion or relative frequency by dividing the

Step 2

frequency for each class by the total number of observations.

For class 5.5-10.5, the relative frequency is 33 = 0.05; for class 10.5-15.5,
the relative frequency is 5 = 0.10; for class 15.5-20.5, the relative frequency
is 3 = 0.15; and so on.

Place these values in the column labeled Relative frequency.

Class Relative
boundaries Midpoints frequency

5.5-10.5 8 0.05
10.5-15.5 13 0.10
15.5-20.5 18 0.15
20.5-25.5 23 0.25
25.5-30.5 28 0.20
30.5-35.5 33 0.15
35.5-40.5 38 0.10
1.00

Find the cumulative relative frequencies. To do this, add the frequency in each
class to the total frequency of the preceding class. In this case, 0 + 0.05 =
0.05,0.05 + 0.10 = 0.15, 0.15 + 0.15 = 0.30, 0.30 + 0.25 = 0.55, etc. Place
these values in the column labeled Cumulative relative frequency.

An alternative method would be to find the cumulative frequencies and
then convert each one to a relative frequency.

Cumulative
Cumulative relative
frequency frequency
Less than 5.5 0 0.00
Less than 10.5 1 0.05
Less than 15.5 3 0.15
Less than 20.5 6 0.30
Less than 25.5 11 0.55
Less than 30.5 15 0.75
Less than 35.5 18 0.90
Less than 40.5 20 1.00
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Step 3 Draw each graph as shown in Figure 2—7. For the histogram and ogive,
use the class boundaries along the x axis. For the frequency polygon,
use the midpoints on the x axis. The scale on the y axis uses

proportions.

Figure 2-7 y Histogram for Runners’ Times
Graphs for 0.25
Example 2-7
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Figure 2-8

Distribution Shapes
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Distribution Shapes

When one is describing data, it is important to be able to recognize the shapes of the dis-
tribution values. In later chapters you will see that the shape of a distribution also deter-
mines the appropriate statistical methods used to analyze the data.

A distribution can have many shapes, and one method of analyzing a distribution is
to draw a histogram or frequency polygon for the distribution. Several of the most com-
mon shapes are shown in Figure 2-8: the bell-shaped or mound-shaped, the uniform-
shaped, the J-shaped, the reverse J-shaped, the positively or right-skewed shape, the
negatively or left-skewed shape, the bimodal-shaped, and the U-shaped.

Distributions are most often not perfectly shaped, so it is not necessary to have an
exact shape but rather to identify an overall pattern.

A bell-shaped distribution shown in Figure 2—8(a) has a single peak and tapers off
at either end. It is approximately symmetric; i.e., it is roughly the same on both sides of
a line running through the center.

l \<
>

(a) Bell-shaped (b) Uniform

(c) J-shaped (d) Reverse J-shaped

<

(e) Right-skewed (f) Left-skewed

4

(g) Bimodal (h) U-shaped
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A uniform distribution is basically flat or rectangular. See Figure 2—8(b).

A J-shaped distribution is shown in Figure 2-8(c), and it has a few data values on
the left side and increases as one moves to the right. A reverse J-shaped distribution is
the opposite of the J-shaped distribution. See Figure 2—8(d).

When the peak of a distribution is to the left and the data values taper off to the
right, a distribution is said to be positively or right-skewed. See Figure 2—8(e). When
the data values are clustered to the right and taper off to the left, a distribution is said to
be negatively or left-skewed. See Figure 2—8(f). Skewness will be explained in detail
in Chapter 3. Distributions with one peak, such as those shown in Figure 2-8(a), (e),
and (f), are said to be unimodal. (The highest peak of a distribution indicates where the
mode of the data values is. The mode is the data value that occurs more often than any
other data value. Modes are explained in Chapter 3.) When a distribution has two peaks
of the same height, it is said to be bimodal. See Figure 2—8(g). Finally, the graph shown
in Figure 2—8(h) is a U-shaped distribution.

Distributions can have other shapes in addition to the ones shown here; however,
these are some of the more common ones that you will encounter in analyzing data.

When you are analyzing histograms and frequency polygons, look at the shape of the
curve. For example, does it have one peak or two peaks? Is it relatively flat, or is it
U-shaped? Are the data values spread out on the graph, or are they clustered around
the center? Are there data values in the extreme ends? These may be outliers. (See
Section 3-3 for an explanation of outliers.) Are there any gaps in the histogram, or does
the frequency polygon touch the x axis somewhere other than at the ends? Finally, are the
data clustered at one end or the other, indicating a skewed distribution?

For example, the histogram for the record high temperatures shown in Figure 2-2
shows a single peaked distribution, with the class 109.5-114.5 containing the largest
number of temperatures. The distribution has no gaps, and there are fewer temperatures
in the highest class than in the lowest class.

Applying the Concepts 2—2

Selling Real Estate

Assume you are a realtor in Bradenton, Florida. You have recently obtained a listing of the selling
prices of the homes that have sold in that area in the last 6 months. You wish to organize that data
so you will be able to provide potential buyers with useful information. Use the following data to
create a histogram, frequency polygon, and cumulative frequency polygon.

142,000 127,000 99,600 162,000 89,000 93,000 99,500

73,800 135,000 119,500 67,900 156,300 104,500 108,650
123,000 91,000 205,000 110,000 156,300 104,000 133,900
179,000 112,000 147,000 321,550 87,900 88,400 180,000
159,400 205,300 144,400 163,000 96,000 81,000 131,000
114,000 119,600 93,000 123,000 187,000 96,000 80,000
231,000 189,500 177,600 83,400 77,000 132,300 166,000

1. What questions could be answered more easily by looking at the histogram rather than the
listing of home prices?

2. What different questions could be answered more easily by looking at the frequency
polygon rather than the listing of home prices?

3. What different questions could be answered more easily by looking at the cumulative
frequency polygon rather than the listing of home prices?

4. Are there any extremely large or extremely small data values compared to the other data values?
5. Which graph displays these extremes the best?
6. Is the distribution skewed?

See page 101 for the answers.




1. Do Students Need Summer Development? For 108
randomly selected college applicants, the following
frequency distribution for entrance exam scores was
obtained. Construct a histogram, frequency polygon,
and ogive for the data. (The data for this exercise will
be used for Exercise 13 in this section.)

Class limits Frequency
90-98 6
99-107 22

108-116 43
117-125 28
126-134 9

Applicants who score above 107 need not enroll
in a summer developmental program. In this group,
how many students do not have to enroll in the
developmental program?

2. Number of College Faculty The number of faculty
listed for a variety of private colleges which offer only
bachelor’s degrees is listed below. Use these data to
construct a frequency distribution with 7 classes, a
histogram, a frequency polygon, and an ogive. Discuss
the shape of this distribution. What proportion of
schools have 180 or more faculty?

165 221 218 206 138 135 224 204

70 210 207 154 155 82 120 116
176 162 225 214 93 389 77 135
221 16l 128 310

Source: World Almanac and Book of Facts.

3. Counties, Divisions, or Parishes for 50 States The
number of counties, divisions, or parishes for each of
the 50 states is given below. Use the data to construct
a grouped frequency distribution with 6 classes, a
histogram, a frequency polygon, and an ogive. Analyze
the distribution.

67 27 15 75 58 o4 8 67 159

102 44 92 99 105 120 64 16 23 14
8 87 82 114 56 93 16 10 21 33
62 100 53 88 77 36 67 5 46 66
95 254 29 14 95 39 55 72 23 3

Source: World Almanac and Book of Facts.

4. NFL Salaries The salaries (in millions of dollars) for
31 NFL teams for a specific season are given in this

frequency distribution.

Class limits Frequency
39.9-42.8 2
42.9-45.8 2
45.9-48.8 5
48.9-51.8 5
51.9-54.8 12
54.9-57.8 5

Source: NFL.com

Section 2-2 Histograms, Frequency Polygons, and Ogives 61

Construct a histogram, a frequency polygon, and an
ogive for the data; and comment on the shape of the
distribution.

5. Automobile Fuel Efficiency Thirty automobiles were
tested for fuel efficiency, in miles per gallon (mpg).

The following frequency distribution was obtained.
Construct a histogram, a frequency polygon, and an
ogive for the data.
Class boundaries Frequency
7.5-12.5 3

12.5-17.5 5

17.5-22.5 15

225275 5

27.5-32.5 2

6. Construct a frequency histogram, a frequency polygon,
and an ogive for the data in Exercise 9 in Section 2—1.
Analyze the results.

7. Air Quality Standards The number of days that
selected U.S. metropolitan areas failed to meet
acceptable air quality standards is shown below
for 1998 and 2003. Construct grouped frequency
distributions and a histogram for each set of data, and
compare your results.

1998 | 2003
43 76 51 14 0 10 10 11 14 20 15 6
20 0 5 17 67 25 17 0 5 19 127 4
38 0 56 8 0 9 31 5 8 1 1 16
14 5 37 14 95 20 14 19 20 9 138 22
23 12 33 0 3 45 13 10 20 20 20 12
Source: World Almanac.

8. How Quick Are Dogs? In a study of reaction times of
dogs to a specific stimulus, an animal trainer obtained
the following data, given in seconds. Construct a
histogram, a frequency polygon, and an ogive for the
data; analyze the results. (The histogram in this exercise
will be used for Exercise 18 in this section, Exercise 16
in Section 3—1, and Exercise 26 in Section 3-2.)

Class limits Frequency
23-29 10
3.0-3.6 12
3.743 6
44-5.0 8
5.1-5.7 4
5.8-6.4 2
9. Quality of Health Care The scores of health care

quality as calculated by a professional risk management
company are listed on the next page for selected states.
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Use the data to construct a frequency distribution, a
histogram, a frequency polygon, and an ogive.

118.2 114.6 113.1 111.9 110.0 108.8 108.3 107.7 107.0 106.7

105.3 103.7 103.2 102.8 101.6 99.8 98.1
92.5 91.0 90.0 87.1

10.

96.6 95.7 93.6
83.1

Source: New York Times Almanac.

Making the Grade The frequency distributions shown
indicate the percentages of public school students in
fourth-grade reading and mathematics who performed at
or above the required proficiency levels for the 50 states
in the United States. Draw histograms for each, and
decide if there is any difference in the performance of
the students in the subjects.

11.

12.

13.

14.

Reading Math
Class frequency frequency
17.5-22.5 7 5
22.5-27.5 6 9
27.5-32.5 14 11
32.5-37.5 19 16
37.5-42.5 3 8
42.5-47.5 1 1

Source: National Center for Educational Statistics.

Construct a histogram, a frequency polygon, and an
ogive for the data in Exercise 16 in Section 2—1, and
analyze the results.

For the data in Exercise 18 in Section 2—1, construct
a histogram for the home run distances for each
player and compare them. Are they basically the
same, or are there any noticeable differences?
Explain your answer.

For the data in Exercise 1 in this section, construct a
histogram, a frequency polygon, and an ogive, using
relative frequencies. What proportion of the applicants
needs to enroll in the summer development program?

For the data for 2003 in Exercise 4 in this section,
construct a histogram, a frequency polygon, and an
ogive, using relative frequencies.

15. Cereal Calories The number of calories per
serving for selected ready-to-eat cereals is listed here.
Construct a frequency distribution using 7 classes. Draw
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17.

18.

a histogram, a frequency polygon, and an ogive for the
data, using relative frequencies. Describe the shape of
the histogram.

130
210
190
190
115

190
130
210
240
210

140
100
120

80
110

80
90
200
120
225

100
210
130

90
190

120
120
180
190
130

220
200
260
200

220
120
270
210

110
180
100
190

100
120
160
180

Source: The Doctor's Pocket Calorie, Fat, and Carbohydrate Counter.

16. Protein Grams in Fast Food The amount of

protein (in grams) for a variety of fast-food
sandwiches is reported here. Construct a frequency
distribution using 6 classes. Draw a histogram, a
frequency polygon, and an ogive for the data, using
relative frequencies. Describe the shape of the
histogram.

23 30 20 27 44 26 35 20 29 29
25 15 18 27 19 22 12 26 34 15
27 35 26 43 35 14 24 12 23 31
40 35 38 57 22 42 24 21 27 33

Source: The Doctor's Pocket Calorie, Fat, and Carbohydrate Counter.

For the data for year 2003 in Exercise 7 in this section,
construct a histogram, a frequency polygon, and an
ogive, using relative frequencies.

How Quick Are Older Dogs? The animal trainer in
Exercise 8 in this section selected another group of dogs
who were much older than the first group and measured
their reaction times to the same stimulus. Construct

a histogram, a frequency polygon, and an ogive for

the data.

Class limits

2.3-29
3.0-3.6
3.743
44-5.0
5.1-5.7
5.8-6.4

Frequency

—_——
AN W=

Analyze the results and compare the histogram for
this group with the one obtained in Exercise 8 in this
section. Are there any differences in the histograms?
(The data in this exercise will be used for Exercise 16
in Section 3—1 and Exercise 26 in Section 3-2.)
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-Extending the Concepts

19. Using the histogram shown here, do the following. a. Construct a frequency distribution; include class
limits, class frequencies, midpoints, and cumulative
v frequencies.

T b. Construct a frequency polygon.
61 c. Construct an ogive.

>

2 T 20. Using the results from Exercise 19, answer these

AT questions.

3T a. How many values are in the class 27.5-30.5?
2T b. How many values fall between 24.5 and 36.5?
T X c. How many values are below 33.5?
0 d. How many values are above 30.5?

215 245 275 305 335 365 395 425
Class boundaries

Step by Step = _

M | N |TAB Construct a Histogram
Step hy Step . Enter the data from Example 2-2, the high temperatures for the 50 states.
. Select Graph>Histogram.

. Select [Simple], then click [OK].

. Click C1 TEMPERATURES in the Graph variables dialog box.

. Click [Labels]. There are two tabs, Title/Footnote and Data Labels.

a) Click in the box for Title, and type in Your Name and Course Section.

b) Click [OK]. The Histogram dialog box is still open.

6. Click [OK]. A new graph window
on | T _mwe |

containing the histogram will open.
MutpleBiaghe | Dpapions |

N K W N =

7. Click the File menu to print B | |Histogram of TEMPERATURES
or save the graph.

Frequency
> = N W A BB N @ B B
i B G

] T | T T T .
100 105 110 118 120 1= 130 135
TEMPERATIRES
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8. Click File>Exit.
9. Save the project as Ch2-3.mpj.

TI-83 Plus or

TI-84 Plus
Step by Step

Input

WINDOW
RKmin=168
amax=135
#scl=5
Ymin=-9
Ymax=20
Yscl=3
Rres=1

Input

Plotz Flot3
Bl
gpes L L=~ Wi
Wil IR |~

Klistili
Freqil

.

Output

Fi:d

rin=100¢
max<{i05 =2
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Constructing a Histogram

To display the graphs on the screen, enter the appropriate values in the calculator, using the
WINDOW menu. The default valuesare X . = —10,X = +10,Y . = —10,andY__ = +10.

min max > £ min max

The X, changes the distance between the tick marks on the x axis and can be used to change
the class width for the histogram.

To change the values in the WINDOW:
1. Press WINDOW.

2. Move the cursor to the value that needs to be changed. Then type in the desired value and
press ENTER.

3. Continue until all values are appropriate.
4. Press [2nd] [QUIT] to leave the WINDOW menu.
To plot the histogram from raw data:
1. Enter the datain L,.
. Make sure WINDOW values are appropriate for the histogram.
. Press [2nd] [STAT PLOT] ENTER.
. Press ENTER to turn the plot on, if necessary.
. Move cursor to the Histogram symbol and press ENTER, if necessary.
. Make sure Xlist is L,.
. Make sure Freq is 1.
. Press GRAPH to display the histogram.

o L 9 SN N AW N

. To obtain the number of data values in each class, press the TRACE key, followed by
<« or P> keys.

Example TI2-1
Plot a histogram for the following data from Examples 2-2 and 2—4.

112 100 127 120 134 118 105 110 109 112
110 118 117 116 118 122 114 114 105 109
107 112 114 115 118 117 118 122 106 110
116 108 110 121 113 120 119 111 104 111
120 113 120 117 105 110 118 112 114 114

Press TRACE and use the arrow keys to determine the number of values in each group.
To graph a histogram from grouped data:
1. Enter the midpoints into L,.
. Enter the frequencies into L,,.
. Make sure WINDOW values are appropriate for the histogram.
. Press [2nd] [STAT PLOT] ENTER.
. Press ENTER to turn the plot on, if necessary.
. Move cursor to the histogram symbol, and press ENTER, if necessary.
. Make sure Xlist is L.
. Make sure Freq is L,.
. Press GRAPH to display the histogram.

o @0 9 SN N R W N
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Example TI2-2
Plot a histogram for the data from Examples 2—4 and 2-5.
Class boundaries Midpoints Frequency
99.5-104.5 102 2
104.5-109.5 107 8
109.5-114.5 112 18
114.5-119.5 117 13
119.5-124.5 122 7
124.5-129.5 127 1
129.5-134.5 132 1
Input Input Output
L1 Lz L 1 Flokz  Flakz
off
o TR R ﬁfe: Lo L= i
i1 18 Hh- b |~
¥ 31ist il
AE Frea:il:
=13z

To graph a frequency polygon from grouped data, follow the same steps as for the histogram

except change the graph type from histogram (third graph) to a line graph (second graph).

To graph an ogive from grouped data, modify the procedure for the histogram as follows:

1. Enter the upper class boundaries into L.

2. Enter the cumulative frequencies into L.

3. Change the graph type from histogram (third graph) to line (second graph).

4. Change the Y, ,, from the WINDOW menu to the sample size.

Excel
Step by Step

Constructing a Histogram

A N A W N =

Bin Range box.

‘Histogram

. Press [Ctrl]-N for a new workbook.
. Enter the data from Example 2-2 in column A, one number per cell.

. Enter the upper boundaries into column B.

. In Data Analysis, select Histogram and click [OK].

. From the toolbar, select the Data tab, then select Data Analysis.

Input
Input Range:

Ein Range:!
[ Labels

CQukput options
D Qubput Range:

Chart Cutput

(%) Mew Worksheet Ply:
() Mews Wiorkbook

[]Pareta (sorted histogram)
|:| Cumulative Percentage

. In the Histogram dialog box, type A1:A50 in the Input Range box and type B1:B7 in the
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7. Select New Worksheet Ply and Chart Output. Click [OK].

Histogram

Frequency

®m Frequency

Editing the Histogram

To move the vertical bars of the histogram closer together:
1. Right-click one of the bars of the histogram, and select Format Data Series.
2. Move the Gap Width bar to the left to narrow the distance between bars.

To change the label for the horizontal axis:
1. Left-click the mouse over any region of the histogram.
2. Select the Chart Tools tab from the toolbar.
3. Select the Layout tab, Axis Titles and Primary Horizontal Axis Title.

@ Ho-n- s C2E2-2 - Microsoft Excel non-commercial use  Chart Teals
- Home  lnset  Pagelayout  Formulas  Data  Revew  View  Adddns Design | Layeut | Format

o | TSI O TR

By Format Serection
Picture Shapes Test Chart [“Axis SiLegend Data  Dats bxes  Gridiines

Trendi
&4 Reset 1o Maten styte = Box | Tiew (Titlesv| - Labels® Table~ area ol
Qurrent Selection Insert |u‘J Primary Horizontal Axis Title » None Anakyin
|_ Chart1 - Fa |;ﬂ Primary Yertieal s Titse. * .;:J Do nolifliptiyan Aods e
| . o [ ol (R S NN, | S5y s [ PO L Tem | Title Beiow Axis ) | N
¥ '_',] Display Title belaw Horizantal dxis and
Bia__frequen | Hist |\__ oasa ot n :
104.5] 2| | Istogram 2 —
ey 3 | 5 More Primary Horizontal Asis Title Options...
1145 18 | 15
11935 13 1 :
;"; : Wiz i W Freauency
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pacie 2 Ao Thle
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-
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z
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Properties
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Once the Axis Title text box is selected, you can type in the name of the variable represented on
the horizontal axis.

Constructing a Frequency Polygon
1. Press [Ctrl]-N for a new workbook.

2. Enter the midpoints of the data from Example 2-2 into column A. Enter the frequencies
into column B.
| A : B |_

1_:Midp0int5 Freguencies
2 102 2
3| 107 s[
al 12 18
3 | 117 13
6 | 122 7
¥ | 127 1
8 132 3

3. Highlight the Frequencies (including the label) from column B.
4. Select the Insert tab from the toolbar and the Line Chart option.
5. Select the 2-D line chart type.

;’@ H9 o b C2E2-2 - Microsoft Excel non-commercial use - 2

\-- Home | Inset  Pageloyout  Fommuls  Dals  Renew  View  Asddns G- x
s —— " _ Ty = || &, = ey
e e g

Paste | ~|| -t A | i || 53~ - | Conditional Format  Cell Sort & Find &
ey (B2 p-(E-|O- A EER|FE D (s-% @A Formatting ~ 35 Table = Stytes ~ | EIEOmMOt= | (2= Figer= Select~

| Clipposrg Font & Alignment 0 Number W Styles Cells Eaditing

| €20 - fe %

s ] s FRGE o [ & [ ¢ [ o J w [ v [ o [ & [ o [ w ] n [ olff
1 Midpoints Freguencies
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We will need to edit the graph so that the midpoints are on the horizontal axis and the
frequencies are on the vertical axis.

1. Right-click the mouse on any region of the graph.
2. Select the Select Data option.
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68 Chapter 2 Frequency Distributions and Graphs

3. Select Edit from the Horizontal Axis Labels and highlight the midpoints from column A,
then click [OK].

4. Click [OK] on the Select Data Source box.

Inserting Labels on the Axes
1. Click the mouse on any region of the graph.
2. Select Chart Tools and then Layout on the toolbar.

3. Select Axis Titles to open the horizontal and vertical axis text boxes. Then manually type
in labels for the axes.

Changing the Title
1. Select Chart Tools, Layout from the toolbar.
2. Select Chart Title.

3. Choose one of the options from the Chart Title menu and edit.

Polygon

/l \ —Frequencies

102 107 112 117 122 127 132

Temperatures

Constructing an Ogive

To create an ogive, you can use the upper class boundaries (horizontal axis) and cumulative
frequencies (vertical axis) from the frequency distribution.

1. Type the upper class boundaries and cumulative frequencies into adjacent columns of an
Excel worksheet.

2. Highlight the cumulative frequencies (including the label) and select the Insert tab from
the toolbar.

3. Select Line Chart, then the 2-D Line option.

As with the frequency polygon, you can insert labels on the axes and a chart title for the ogive.

Ogive
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50 | /__——-—
40
- K 7z
.- 30 4
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0 + c
/ Fregquencies
10 T /
ol . ,
1045109.5114.5119.5124.5129.5134.5
Temperalures

m Other Types of Graphs

In addition to the histogram, the frequency polygon, and the ogive, several other types of
graphs are often used in statistics. They are the bar graph, Pareto chart, time series graph,
and pie graph. Figure 2-9 shows an example of each type of graph.
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Other Types of Graphs

Used in Statistics
uto

Bus

Trolley

Walk

Train

How People Get to Work

(a) Bar graph

60° +

50° +

Temperature (°F)

45°

People

Temperature over a 9-Hour Period

(c) Time series graph

Objective
Represent data using
bar graphs, Pareto

Bar Graphs

When the data are qualitative or categorical, bar graphs can be used to represent the data.
A bar graph can be drawn using either horizontal or vertical bars.
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How People Get to Work

Frequency
N N w
o [$3] o

—_
(S,

—_
o

Auto  Bus Trolley Train  Walk

(b) Pareto chart

Marital Status of Employees
at Brown’s Department Store

Widowed
5%

(d) Pie graph

charts, time series
graphs, and
pie graphs.

A bar graph represents the data by using vertical or horizontal bars whose heights or
lengths represent the frequencies of the data.

Example 2-8 College Spending for First-Year Students

The table shows the average money spent by first-year college students. Draw a

horizontal and vertical bar graph for the data.

Electronics $728
Dorm decor 344
Clothing 141
Shoes 72

Source: The National Retail Federation.

2-35



70 Chapter 2 Frequency Distributions and Graphs

Solution

1. Draw and label the x and y axes. For the horizontal bar graph place the frequency
scale on the x axis, and for the vertical bar graph place the frequency scale on the
y axis.

2. Draw the bars corresponding to the frequencies. See Figure 2—10.

m ,  First-Year College Student Spending y Average Amount Spent

Bar Graphs for $800 +
Example 2-8 —
Electronics §700
$600 1
$400 1
Clothing $300 1
$200 1
Shoes ' $100 +
S $0 | : X
$0 $100 $200 $300 $400 $500 $600 $700 $800 Shoes  Clothing  Dorm  Electronics

decor

The graphs show that first-year college students spend the most on electronic equipment
including computers.

Pareto Charts

When the variable displayed on the horizontal axis is qualitative or categorical, a Pareto
chart can also be used to represent the data.

A Pareto chart is used to represent a frequency distribution for a categorical variable,
and the frequencies are displayed by the heights of vertical bars, which are arranged in
order from highest to lowest.

Example 2-9 Turnpike Costs

The table shown here is the average cost per mile for passenger vehicles on state
turnpikes. Construct and analyze a Pareto chart for the data.

State Number
Indiana 2.9¢
Oklahoma 4.3
Florida 6.0
Maine 3.8
Pennsylvania 5.8

Source: Pittsburgh Tribune Review.
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~_%[istorical Note

Vilfredo Pareto
(1848-1923) was an
Italian scholar who
developed theories in
economics, statistics,
and the social
sciences. His
contributions to
statistics include the
development of a
mathematical function
used in economics.
This function has many
statistical applications
and is called the
Pareto distribution.

In addition, he
researched income
distribution, and his
findings became
known as Pareto’s law.

Pareto Chart for
Example 2-9
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Solution

Step 1 Arrange the data from the largest to smallest according to frequency.

State Number
Florida 6.0¢
Pennsylvania 5.8
Oklahoma 43
Maine 38
Indiana 2.9

Step 2 Draw and label the x and y axes.

Step 3 Draw the bars corresponding to the frequencies. See Figure 2—11. The Pareto
chart shows that Florida has the highest cost per mile. The cost is more than
twice as high as the cost for Indiana.

Suggestions for Drawing Pareto Charts

1. Make the bars the same width.
2. Arrange the data from largest to smallest according to frequency.
3. Make the units that are used for the frequency equal in size.

When you analyze a Pareto chart, make comparisons by looking at the heights of
the bars.

The Time Series Graph

When data are collected over a period of time, they can be represented by a time series
graph.

Average Cost per Mile on State Turnpikes

Cost
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72 Chapter 2 Frequency Distributions and Graphs

A time series graph represents data that occur over a specific period of time.

Example 2—10 shows the procedure for constructing a time series graph.

Example 2-10 Arson Damage to Churches

The arson damage to churches for the years 2001 through 2005 is shown. Construct
and analyze a time series graph for the data.

(| oricat INote -

Time series graphs are
over 1000 years old.
The first ones were
used to chart the
movements of the
planets and the sun.

Time Series Graph for
Example 2-10

2-38

Step 1
Step 2
Step 3
Step 4

Year Damage (in millions)
2001 $2.8
2002 33
2003 34
2004 5.0
2005 8.5

Source: U.S. Fire Administration.

Draw and label the x and y axes.
Label the x axis for years and the y axis for the damage.
Plot each point according to the table.

Draw line segments connecting adjacent points. Do not try to fit a smooth
curve through the data points. See Figure 2—12. The graph shows a steady
increase over the 5-year period.

Arson Damage to Churches

ol
gl
-
61
51
L
sl
Al

Damage in millions of dollars

0 t t t t t
2001 2002 2003 2004 2005
Year

When you analyze a time series graph, look for a trend or pattern that occurs over
the time period. For example, is the line ascending (indicating an increase over time) or
descending (indicating a decrease over time)? Another thing to look for is the slope, or
steepness, of the line. A line that is steep over a specific time period indicates a rapid

increase or decrease over that period.
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oy e 1 y Snow Shovel Sales
Two Time Series
Graphs for Comparison 30 +
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Two data sets can be compared on the same graph (called a compound time series
graph) if two lines are used, as shown in Figure 2—13. This graph shows the number of
snow shovels sold at a store for two seasons.

The Pie Graph

Pie graphs are used extensively in statistics. The purpose of the pie graph is to show the
relationship of the parts to the whole by visually comparing the sizes of the sections.
Percentages or proportions can be used. The variable is nominal or categorical.

A pie graph is a circle that is divided into sections or wedges according to the
percentage of frequencies in each category of the distribution.

Example 2—11 shows the procedure for constructing a pie graph.

m Super Bowl Snack Foods

This frequency distribution shows the number of pounds of each snack food eaten
during the Super Bowl. Construct a pie graph for the data.

Snack Pounds (frequency)
Potato chips 11.2 million
Tortilla chips 8.2 million
Pretzels 4.3 million
Popcorn 3.8 million
Snack nuts 2.5 million

Total » = 30.0 million

Source: USA TODAY Weekend.
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Cell Phone Subscribers

_ 180 +
[}
Cell Phone Usage 160
o
The graph shows the estimated number z 140 1 °
(in millions) of cell phone subscribers é 120 1 °
since 1995. How do you think the growth < 1004 -~
will affect our way of living? For =
. = 80 + @
example, emergencies can be handled =
faster since people are using their cell A ° ¢
phones to call 911. 01 e
[ ]
95 9% '97 98 99 00 'O1 02 03 04

Year

Source: Cellular Telecommunications and Internet Association.

Solution

Step 1 Since there are 360° in a circle, the frequency for each class must be
converted into a proportional part of the circle. This conversion is done by
using the formula

Degrees = ]i 360°

where /= frequency for each class and » = sum of the frequencies. Hence,
the following conversions are obtained. The degrees should sum to 360°.*

Potato chips % - 360° = 134°
. . 8.2 R R
Tortilla chips 30 360° = 98
43 0 o
Pretzels 30 360° = 52
3.8 o e
Popcorn 30 360° = 46
2.5 0 ano
Snack nuts 30 360° = ﬁ
Total 360°

Step 2 Each frequency must also be converted to a percentage. Recall from
Example 2—1 that this conversion is done by using the formula

% i 100%

n

Hence, the following percentages are obtained. The percentages should sum
to 100%."
. 11.2
Potato chips =0 100% = 37.3%
. . 2
Tortilla chips 2—0 - 100% = 27.3%

*Note: The degrees column does not always sum to 360° due to rounding.
Note: The percent column does not always sum to 100% due to rounding.
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4.

Pretzels 3—3 - 100% = 14.3%
3.8

Popcorn 30 100% = 12.7%
2.5

Snack nuts 30 100% = 8.3%

Total 99.9%

Step 3 Next, using a protractor and a compass, draw the graph using the appropriate
degree measures found in step 1, and label each section with the name and
percentages, as shown in Figure 2—14.

Pie Graph for
Example 2-11

Tortilla chips
27.3%

m Construct a pie graph showing the blood types of the army inductees described in

Example 2—1. The frequency distribution is repeated here.

Class Frequency Percent
A 5 20
B 7 28
0] 9 36
AB 4 16
25 100

Solution

Step 1 Find the number of degrees for each class, using the formula
Degrees = 5 - 360°

For each class, then, the following results are obtained.

5

A % 360° = 72
7 o __ o
B %5 360° = 100.8
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[y 1
Pie Graph for
Example 2-12

2-42

O -360° = 129.6°

2

25

AB  2.360°=57.6°
25

Step 2 Find the percentages. (This was already done in Example 2—1.)

Step 3 Using a protractor, graph each section and write its name and corresponding
percentage, as shown in Figure 2—15.

Blood Types for Army Inductees

The graph in Figure 2—15 shows that in this case the most common blood type is
type O.

To analyze the nature of the data shown in the pie graph, look at the size of the
sections in the pie graph. For example, are any sections relatively large compared to
the rest?

Figure 2—15 shows that among the inductees, type O blood is more prevalent than
any other type. People who have type AB blood are in the minority. More than twice as
many people have type O blood as type AB.

Misleading Graphs

Graphs give a visual representation that enables readers to analyze and interpret data
more easily than they could simply by looking at numbers. However, inappropriately
drawn graphs can misrepresent the data and lead the reader to false conclusions. For
example, a car manufacturer’s ad stated that 98% of the vehicles it had sold in the past
10 years were still on the road. The ad then showed a graph similar to the one in
Figure 2—-16. The graph shows the percentage of the manufacturer’s automobiles still on
the road and the percentage of its competitors’ automobiles still on the road. Is there a
large difference? Not necessarily.

Notice the scale on the vertical axis in Figure 2—16. It has been cut off (or truncated)
and starts at 95%. When the graph is redrawn using a scale that goes from 0 to 100%, as
in Figure 2—17, there is hardly a noticeable difference in the percentages. Thus, changing
the units at the starting point on the y axis can convey a very different visual representa-
tion of the data.
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Graph of Automaker’s

100 +
Claim Using a Scale
from 95 to 100%
9+
=
8
5
o 981
8
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automobiles automobiles automobiles

Figure 2-17 y Vehicles on the Road

Graph in Figure 2-16 100 -
Redrawn Using a Scale
from 0 to 100%

80

(=2}
o
|

Percent of cars on road

S
o
|

20

Manufacturer’s Competitor I's Competitor II’s
automobiles automobiles automobiles

It is not wrong to truncate an axis of the graph; many times it is necessary to do so.
However, the reader should be aware of this fact and interpret the graph accordingly. Do
not be misled if an inappropriate impression is given.
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Figure 2-18

Projected Miles per
Gallon

2-44

Let us consider another example. The projected required fuel economy in miles per
gallon for General Motors vehicles is shown. In this case, an increase from 21.9 to
23.2 miles per gallon is projected.

Year | 2008 2009 2010 2011
Projected
MPG 21.9 22.6 22.9 232

Source: National Highway Traffic Safety Administration.

When you examine the graph shown in Figure 2—18(a) using a scale of 0 to 25 miles
per gallon, the graph shows a slight increase. However, when the scale is changed to 21

Projected Miles per Gallon

N
[$3]
L
T

Ny
o
|
T

Miles per gallon

0 f f f f
2008 2009 2010 2011

Year

Projected Miles per Gallon

23 +

22 1

Miles per gallon

21 1

2008 2009 2010 2011
Year

(b)



[y e
Comparison of Costs
for a 30-Second Super
Bowl Commercial

A Graph with No Units
on the y Axis
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to 24 miles per gallon, the graph shows a much larger increase even though the data
remain the same. See Figure 2—18(b). Again, by changing the units or starting point on
the y axis, one can change the visual representation.

Another misleading graphing technique sometimes used involves exaggerating a
one-dimensional increase by showing it in two dimensions. For example, the average
cost of a 30-second Super Bowl commercial has increased from $42,000 in 1967 to
$2.5 million in 2006 (Source: US4 TODAY).

The increase shown by the graph in Figure 2—19(a) represents the change by a com-
parison of the heights of the two bars in one dimension. The same data are shown two-
dimensionally with circles in Figure 2—19(b). Notice that the difference seems much
larger because the eye is comparing the areas of the circles rather than the lengths of the
diameters.

Note that it is not wrong to use the graphing techniques of truncating the scales or
representing data by two-dimensional pictures. But when these techniques are used, the
reader should be cautious of the conclusion drawn on the basis of the graphs.

Cost of 30-Second Cost of 30-Second

Super Bowl Commercial y Super Bowl Commercial
= 25T __ 257
E E
= =
220+ 2 204
o o
S S
= 151 = 151
2 104 2 104
(5] o

e X $ X
1967 2006 1967 2006
Year Year

(a) Graph using bars (b) Graph using circles

Another way to misrepresent data on a graph is by omitting labels or units on the
axes of the graph. The graph shown in Figure 2—20 compares the cost of living, economic
growth, population growth, etc., of four main geographic areas in the United States.
However, since there are no numbers on the y axis, very little information can be gained
from this graph, except a crude ranking of each factor. There is no way to decide the
actual magnitude of the differences.

N W W E W
W S S N
E N N
S E E S
Cost of Economic Population Crime
living growth growth rate
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[y 1
Summary of Graphs
and Uses of Each

Objective 7Y
Draw and interpret a
stem and leaf plot.

Finally, all graphs should contain a source for the information presented. The inclu-
sion of a source for the data will enable you to check the reliability of the organization
presenting the data. A summary of the types of graphs and their uses is shown in

Figure 2-21.

(a) Histogram; frequency polygon; ogive
Used when the data are contained in a grouped frequency distribution.

(b) Pareto chart
Used to show frequencies for
nominal or qualitative variables.

(c) Time series graph

occurs over a period of time.

Stem and Leaf Plots

Used to show a pattern or trend that

(d) Pie graph

Used to show the relationship
between the parts and the whole.
(Most often uses percentages.)

The stem and leaf plot is a method of organizing data and is a combination of sorting and
graphing. It has the advantage over a grouped frequency distribution of retaining the

actual data while showing them in graphical form.

A stem and leaf plot is a data plot that uses part of the data value as the stem and part

of the data value as the leaf to form groups or classes.

Example 2—13 shows the procedure for constructing a stem and leaf plot.
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25 31 20 32 13
14 43 02 57 23
36 32 33 32 44
32 52 44 51 45

At an outpatient testing center, the number of cardiograms performed each day
for 20 days is shown. Construct a stem and leaf plot for the data.



How Much Paper Money Is in

Circulation Today?

The Federal Reserve estimated that during
a recent year, there were 22 billion bills

in circulation. About 35% of them were
$1 bills, 3% were $2 bills, 8% were

$5 bills, 7% were $10 bills, 23% were

$20 bills, 5% were $50 bills, and 19%
were $100 bills. It costs about 3¢ to print

each $1 bill.

The average life of a $1 bill is

22 months, a $10 bill 3 years, a $20 bill
4 years, a $50 bill 9 years, and a $100 bill
9 years. What type of graph would you
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use to represent the average lifetimes of

the bills?

Stem and Leaf Plot for

Example 2-13

0l 2

1] 3 4

2 0 3 5

31 122 2 2 3 6
41 3 4 4 5

5 1.2 7

Solution

Step 1

Step 2

Step 3

Arrange the data in order:

02, 13, 14, 20, 23, 25, 31, 32, 32, 32,
32,33, 36, 43, 44, 44, 45, 51, 52, 57

Note: Arranging the data in order is not essential and can be cumbersome
when the data set is large; however, it is helpful in constructing a stem
and leaf plot. The leaves in the final stem and leaf plot should be arranged
in order.

Separate the data according to the first digit, as shown.

02 13, 14 20, 23,25 31,32,32,32,32,33,36
43,44, 44, 45 51,52,57

A display can be made by using the leading digit as the stem and the trailing
digit as the leaf. For example, for the value 32, the leading digit, 3, is the stem
and the trailing digit, 2, is the leaf. For the value 14, the 1 is the stem and the
4 is the leaf. Now a plot can be constructed as shown in Figure 2-22.

Leading digit (stem) Trailing digit (leaf)
0 2
1 34
2 035
3 1222236
4 3445
5 127
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Figure 2-22 shows that the distribution peaks in the center and that there are no gaps
in the data. For 7 of the 20 days, the number of patients receiving cardiograms was
between 31 and 36. The plot also shows that the testing center treated from a minimum
of 2 patients to a maximum of 57 patients in any one day.

If there are no data values in a class, you should write the stem number and leave the
leaf row blank. Do not put a zero in the leaf row.

Example 2-14

Stem and Leaf Plot for
Example 2-14

112 3 3
6 77 8 9

~N N o o o o
o Do Do O

5
3
56 6 7 8 9 9
3
5

m—;:;’m

The average number
of pencils and index
cards David Letterman
tosses over his
shoulder during one
show is 4.
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o An insurance company researcher conducted a survey on the number of car
thefts in a large city for a period of 30 days last summer. The raw data are
shown. Construct a stem and leaf plot by using classes 50-54, 55-59, 60—64, 65—69,
7074, and 75-79.

52 62 51 50 69

58 77 66 53 57

75 56 55 67 73

79 59 68 65 72

57 51 63 69 75

65 53 78 66 55
Solution

Step 1 Arrange the data in order.

50, 51, 51, 52, 53, 53, 55, 55, 56, 57, 57, 58, 59, 62, 63,
65, 65, 66, 66, 67, 68, 69, 69, 72, 73,75, 75,77, 78, 719

Step 2 Separate the data according to the classes.

50, 51, 51, 52, 53, 53 55,55, 56, 57, 57, 58, 59
62, 63 65, 65, 66, 66, 67, 68, 69, 69 72,73
75,75,77,78,79

Step 3 Plot the data as shown here.

Leading digit (stem) Trailing digit (leaf)

5 011233
5567789
23
55667899
23
55789

~N 3O W

The graph for this plot is shown in Figure 2-23.

When the data values are in the hundreds, such as 325, the stem is 32 and the leaf
is 5. For example, the stem and leaf plot for the data values 325, 327, 330, 332, 335, 341,
345, and 347 looks like this.

32 57
33 025
34 157

When you analyze a stem and leaf plot, look for peaks and gaps in the distribution.
See if the distribution is symmetric or skewed. Check the variability of the data by look-
ing at the spread.



[
Back-to-Back Stem
and Leaf Plot for
Example 2-15
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Related distributions can be compared by using a back-to-back stem and leaf plot.
The back-to-back stem and leaf plot uses the same digits for the stems of both distribu-
tions, but the digits that are used for the leaves are arranged in order out from the stems
on both sides. Example 2—15 shows a back-to-back stem and leaf plot.

o The number of stories in two selected samples of tall buildings in Atlanta and
Philadelphia is shown. Construct a back-to-back stem and leaf plot, and compare
the distributions.

Atlanta Philadelphia
55 70 44 36 40 61 40 38 32 30
63 40 44 34 38 58 40 40 25 30
60 47 52 32 32 54 40 36 30 30
50 53 32 28 31 53 39 36 34 33
52 32 34 32 50 50 38 36 39 32

26 29

Source: The World Almanac and Book of Facts.

Solution
Step 1 Arrange the data for both data sets in order.

Step 2 Construct a stem and leaf plot using the same digits as stems. Place the digits
for the leaves for Atlanta on the left side of the stem and the digits for the
leaves for Philadelphia on the right side, as shown. See Figure 2—24.

Atlanta Philadelphia
986 | 2 | 5
8644222221 |3 |1000022346668899
74400 | 4 (0000
532200 | 5|1 0348
3016 |1
017

Step 3 Compare the distributions. The buildings in Atlanta have a large variation in the
number of stories per building. Although both distributions are peaked in the
30- to 39-story class, Philadelphia has more buildings in this class. Atlanta has
more buildings that have 40 or more stories than Philadelphia does.

Stem and leaf plots are part of the techniques called exploratory data analysis. More
information on this topic is presented in Chapter 3.

Applying the Concepts 2=3

Leading Cause of Death

The following shows approximations of the leading causes of death among men ages
25-44 years. The rates are per 100,000 men. Answer the following questions about
the graph.
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Leading Causes of Death
for Men 25-44 Years

y HIV infection
70 1+
60 +
50 + Accidents
2 401
(o'

30+ / Heart disease
Cancer

20 +
10 1
. . / . . . . IStrokes X
1984 1986 1988 1990 1992 1994
Year

. What are the variables in the graph?

. Are the variables qualitative or quantitative?

. Are the variables discrete or continuous?

. What type of graph was used to display the data?
. Could a Pareto chart be used to display the data?
. Could a pie chart be used to display the data?

. List some typical uses for the Pareto chart.

0 N N L AW N =

. List some typical uses for the time series chart.

See page 101 for the answers.

1. Women’s Softball Champions The NCAA Women’s MASS PA9 SC4
Softball Division 1 Champions since 1982 are listed NH 3 RI2 CT4
below. Use the data to construct a Pareto chart and a VA7 NY 4 DE 3
vertical bar graph. MD 4 GA3
’82 UCLA ’94 Arizona NIS NC3
*83 Texas A&M 95 UCLA Source: New York Times Almanac.
"84 UCLA ’96 Arizona 3. Internet Connections The following data represent the
"85 UCLA ’97 Arizona estimated number (in millions) of computers connected
’86 Cal St — Fullerton "98 Fresno State to the Internet worldwide. Construct a Pareto chart and
’87 Texas A&M 99 UCLA a horizontal bar graph for the data. Based on the data,
’88 UCLA ’00 Oklahoma suggest the best place to market appropriate Internet
’89 UCLA ’01 Arizona products.
90 UCLA 02 California Location Number of computers
’91 Arizona ’03 UCLA
’92 UCLA 04 UCLA Homes 240
’93 Arizona ’05 Michigan Small companies 102
Source: New York Times Almanac. Large companies 148

Government agencies 33
2. Delegates Who Signed the Declaration of Independence Schools 47

The state represented by each delegate who signed the

Source: IDC.

Declaration of Independence is indicated. Organize the data
in a Pareto chart and a vertical bar graph and comment on 4. Roller Coaster Mania The World Roller Coaster

the results.
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Census Report lists the following number of roller



coasters on each continent. Represent the data
graphically, using a Pareto chart and a horizontal bar
graph.

Africa 17
Asia 315
Australia 22
Europe 413
North America 643
South America 45

Source: www.rcdb.com

. World Energy Use The following percentages indicate
the source of energy used worldwide. Construct a Pareto
chart and a vertical bar graph for the energy used.

10.
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respondents said they voted in the 2004 election. Give
possible reasons for the discrepancy.

1964 95.83 1980 76.53 1996 65.97
1968 89.65 1984 74.63 2000 67.50
1972 79.85 1988 72.48 2004 64.0
1976  77.64 1992 78.04

Source: New York Times Almanac.

Reasons We Travel The following data are based on a
survey from American Travel Survey on why people
travel. Construct a pie graph for the data and analyze the
results.

Number | 109 109 109

Source: The World Almanac and Book of Facts.

104 104 104

. Percentage of Voters in Presidential Elections

Listed are the percentages of voters who voted in past
Presidential elections since 1964. Illustrate the data with
a time series graph. The day before the 2006 election, a
website published a survey where 90% of the

Purpose Number
Petroleum 39.8% Personal business 146
Coal 23.2 Visit friends or relatives 330
Dry natural gas 224 Work-related 225
Hydroelectric 7.0 Leisure 299
Nuclear . 6.4 Source: USA TODAY.
Other (wind, solar, etc.) 1.2
Source: New York Times Almanac. 11. Characteristics of the Population 65 and Over Two
L . ) characteristics of the population aged 65 and over are
. Airline Departures Draw a time series graph to shown below for 2004. Illustrate each characteristic
represent the data for the number of airline departures with a pie graph.
(in millions) for the given years. Over the years, is the
number of departures increasing, decreasing, or about Marital status Educational attainment
2
the same? Never married  3.9% Less than ninth grade  13.9%
Married 57.2  Completed 9-12 but
Yo 1 1 1 1 2 2001 2002 . .
car | 996 1997 1998 1999 2000 2001 200 Widowed 30.8 no diploma 13.0
Number of ‘ Divorced 8.1  H.S. graduate 36.0
departures 79 99 105 109 11.0 9.8 10.1 Some college/
Source: The World Almanac and Book of Facts. associates degree 18.4
Bachelor’s/advanced
7. Average Global Temperatures Represent these degree 18.7
average global temperatures in a time series graph. Source: New York Times Almanac.
1900—09 56.5 1960—69 57.1 12. Components of the Earth’s Crust The following
1910-19 56.6 1970—79 57.0 elements comprise the earth’s crust, the outermost solid
1920-29 56.7 1980-89 57.4 layer. Illustrate the composition of the earth’s crust with
1930-39 57.0 1990-99 57.6 a pie graph.
1940-49 57.1 Oxygen 45.6%
1950-59  57.1 Silicon 273
Source: World Almanac. Aluminum 8.4
. . Iron 6.2
. Nuclear Power Reactors Draw a time series graph for Calcium 4.7
the data shown and comment on the trend. The data Other 7' g
represent the number of active nuclear reactors. '
Source: New York Times Almanac.
Year | 19921994 1996 1998 2000 2002 13. Workers Switch Jobs In a recent survey, 3 in 10

people indicated that they are likely to leave their jobs
when the economy improves. Of those surveyed, 34%
indicated that they would make a career change, 29%
want a new job in the same industry, 21% are going to
start a business, and 16% are going to retire. Make a pie
chart and a Pareto chart for the data. Which chart do
you think better represents the data?

Source: National Survey Institute.
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State which graph (Pareto chart, time series graph, or
pie graph) would most appropriately represent the given
situation.

a. The number of students enrolled at a local college
for each year during the last 5 years.

b. The budget for the student activities department at a
certain college for each year during the last 5 years.

c.  The means of transportation the students use to get
to school.

d. The percentage of votes each of the four candidates
received in the last election.

e. The record temperatures of a city for the last 30 years.

/. The frequency of each type of crime committed in a
city during the year.

15. Presidents’ Ages at Inauguration The age at
inauguration for each U.S. President is shown.
Construct a stem and leaf plot and analyze the data.

57 54 52 55 51 56
61 68 56 55 54 61
57 51 46 54 51 52
57 49 54 42 60 69
58 64 49 51 62 64
57 48 50 56 43 46
61 65 47 55 55 54

Source: New York Times Almanac.

16. Calories in Salad Dressings A listing of

calories per one ounce of selected salad dressings
(not fat-free) is given below. Construct a stem and leaf
plot for the data.

100 130 130 130
140 170 160 130

110
160

110
120

120
150

130
100

140 100
145 145

145 115
160 120

120
140

100
150

120
190

160
150

140
180

120
160

180 100

Extending the Concepts

20.

21.

Successful Space Launches The number of successful
space launches by the United States and Japan for the
years 1993-1997 is shown here. Construct a compound
time series graph for the data. What comparison can be
made regarding the launches?

Year 1993 1994 1995 1996 1997
United

States 29 27 24 32 37
Japan 1 4 2 1 2

Source: The World Almanac and Book of Facts.

Meat Production Meat production for veal and lamb
for the years 1960-2000 is shown here. (Data are in
millions of pounds.) Construct a compound time series
graph for the data. What comparison can be made
regarding meat production?
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17. Twenty Days of Plant Growth The growth (in
centimeters) of two varieties of plant after 20 days is
shown in this table. Construct a back-to-back stem and

leaf plot for the data, and compare the distributions.

Variety 1 | Variety 2
20 12 39 38 18 45 62 59
41 43 51 52 53 25 13 57
59 55 53 39 42 55 56 38
50 58 35 38 41 36 50 62
23 32 43 53 45 55

18. Math and Reading Achievement Scores The

math and reading achievement scores from the
National Assessment of Educational Progress for

selected states are listed below. Construct a back-to-
back stem and leaf plot with the data and compare the
distributions.

Math | Reading
52 66 69 62 61 65 76 76 66 67
63 57 59 59 55 71 70 70 66 61
55 59 74 72 73 61 69 78 76 77
68 76 73 77 77 80

Source: World Almanac.

19.

22.

The sales of recorded music in 2004 by genre are listed

below. Represent the data with an appropriate graph.

Rock 23.9 Jazz 2.7
Country 13.0 Classical 2.0
Rap/hip-hop  12.1 Oldies 1.4
R&B/urban  11.3 Soundtracks 1.1
Pop 10.0 New age 1.0
Religious 6.0 Other 8.9
Children’s 2.8

Source: World Almanac.

Year 1960 1970 1980 1990 2000
Veal 1109 588 400 327 225
Lamb 769 551 318 358 234

Source: The World Almanac and Book of Facts.

Top 10 Airlines The top 10 airlines with the most
aircraft are listed. Represent these data with an

appropriate graph.

American 714 Continental 364
United 603 Southwest 327
Delta 600 British Airways 268
Northwest 424 American Eagle 245
U.S. Airways 384 Lufthansa (Ger.) 233

Source: Top 10 of Everything.
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23. Nobel Prizes in Physiology or Medicine The top 24. Cost of Milk The graph shows the increase in the price of
prize-winning countries for Nobel Prizes in Physiology a quart of milk. Why might the increase appear to be larger
or Medicine are listed here. Represent the data with an than it really is?
appropriate graph. Cost of Wik
United States 80 Denmark 5 v
United Kingdom 24 Austria 4 $2.00
Germany 16 Belgium 4 $1.59
Sweden 8 Italy 3
France 7 Australia 3 $150¢
Switzerland 6
Source: Top 10 of Everything. $1.08

$1.00 +
$0.50 1
X

No dodbt. Yo'l each dew your own oy m—
Conclusions From this chart..,

25. Boom in Number of Births The graph shows the
projected boom (in millions) in the number of births.
Cite several reasons why the graph might be misleading.

Projected Boom in the Number of Births (in millions)

45+
é 4.37
=]
k]
5 40 T
£
= 3.98
351 %
Source: Cartoon by Bradford Veley, Marquette, Michigan. Used with 20I03 20I1 2
permission.
Year
Step by Step
M | N |TAB Construct a Pie Chart
Step by Step 1. Enter the summary data for snack foods and frequencies from Example 2—11 into C1 and C2.

Pie Chart - Data Source

+ | ar | a
Snack f
| | | Chot Ogtivers... i Labek,
2 | Tortilla chips 82 = 3
3 _Pralzels 43 wﬁmphl Dafa Oplions... |
4 _Pupl:em 38
5 |Snark mits 25
5 Heln | oK | Cancal

2-53



88 Chapter 2 Frequency Distributions and Graphs

2. Name them Snack and f.
3. Select Graph>Pie Chart.
a) Click the option for Chart summarized data.

b) Press [Tab] to move to Categorical variable, then double-click C1 to select it.

¢) Press [Tab] to move to Summary variables, and select the column with the frequencies f.

Tiles/Footnotes  Shos Labeks |

Labed pie shices with:

¥ Category name:

¥ Diequency

™ Peent ! Relisehet

7 |Draw 2 lirws from Labed to shes!
Snack
Petuts chipe
Tortls chips
Prelzels
Popgorm
Sench it

Help I oK I Cancel I .

4. Click the [Labels] tab, then Titles/Footnotes.
a) Type in the title: Super Bowl Snacks.
b) Click the Slice Labels tab, then the options for Category name and Frequency.
c¢) Click the option to Draw a line from label to slice.
d) Click [OK] twice to create the chart.

Construct a Bar Chart
The procedure for constructing a bar chart is similar to that for the pie chart.
1. Select Graph>Bar Chart.
a) Click on the drop-down list in Bars Represent: then select values from a table.

b) Click on the Simple chart, then click [OK]. The dialog box will be similar to the Pie
Chart Dialog Box.

2. Select the frequency column C2 f for Graph variables: and Snack for the Categorical
variable.

Bf | chartoff [_Tolx]

1998 Super Bowl Snacks

Potatn chips Tortlls chips Popcomn Snsck nuts

Dl
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3. Click on [Labels], then type the title in the Titles/Footnote tab: 1998 Super Bowl Snacks.

4. Click the tab for Data Labels, then click the option to Use labels from column: and select
C1 Snacks.

5. Click [OK] twice.

Construct a Pareto Chart

Pareto charts are a quality control tool. They are similar to a bar chart with no gaps between
the bars, and the bars are arranged by frequency.

1. Select Stat>Quality Tools>Pareto.
2. Click the option to Chart defects table.
3. Click in the box for the Labels in: and select Snack.

4. Click on the frequencies column C2 f.

IPareta Chart of Snack

Count
AT EEEEERE
Percent

Defect  Powbchps Tortlachips Preels Popcom  Snacknuts
8.2 4.3 38

Count. 1.2 25
Percent 373 73 14.3 127 a3
Cum % el 4.7 9.0 9.7 100.0

5. Click on [Options].

a) Check the box for Cumulative percents.

b) Type in the title, 1998 Super Bowl Snacks.
6. Click [OK] twice. The chart is completed.

Construct a Time Series Plot

The data used are for the number of vehicles that used the Pennsylvania Turnpike.
Year | 1999 2000 2001 2002 2003
Number | 156.2 160.1 1623 1728 1794

1. Add a blank worksheet to the project by selecting File>SNew>New Worksheet.

2. To enter the dates from 1999 to 2003 in C1, select Calc>Make Patterned
Data>Simple Set of Numbers.

a) Type Year in the text box for Store patterned data in.
b) From first value: should be 1999.
¢) To Last value: should be 2003.

d) In steps of should be 1 (for every other year). The last two boxes should be 1, the
default value.

e) Click [OK]. The sequence from 1999 to 2003 will be entered in C1 whose label will be
Year.

3. Type Vehicles (in millions) for the label row above row 1 in C2.
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4. Type 156.2 for the first number, then press [Enter]. Never enter the commas for large
numbers!

5. Continue entering the value in each row of C2.

Time Series Plot of Vehicles (in millions)
180 4
1754
—
{4}
=
5
= 170 4
=
g
= 165 4
=
(]
>
160
155 R T T T T T
1999 2000 2001 2002 20032
Year

6. To make the graph, select Graph>Time series plot, then Simple, and press [OK].
a) For Series select Vehicles (in millions), then click [Time/scale].
b) Click the Stamp option and select Year for the Stamp column.
c¢) Click the Gridlines tab and select all three boxes, Y major, Y minor, and X major.
d) Click [OK] twice. A new window will open that contains the graph.

e) To change the title, double-click the title in the graph window. A dialog box will open,
allowing you to edit the text.

Construct a Stem and Leaf Plot
1. Type in the data for Example 2—14. Label the column CarThefts.

2. Select STAT>SEDA>Stem-and-Leaf. This is the same as Graph>Stem-and-Leaf.
3. Double-click on C1 CarThefts in the column list.
4. Click in the Increment text box, and enter the class width of 5.
5. Click [OK]. This character graph will be displayed in the session window.
Stom-and Loaf - Stem-and-Leaf Display: CarThefts
R TR Stem-and-leaf of CarThefts N =230
CarThedts Leaf Unit=1.0
6 5 011233
] 13 5 5567789
R 15 6 23
7 oo 15 6 55667899
7 7 23
Increment |5
| 5 7 55789
Help I oK Cancel
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TI-83 Plus or

TI-84 Plus
Step by Step

To graph a time series, follow the procedure for a frequency polygon from Section 22, using
the following data for the number of outdoor drive-in theaters

1988 1990 1992 1994 1996 1998
1497 910 870 859 826 750

2000
637

Year |

Number |

Output

Excel
Step by Step

Constructing a Pie Chart

To make a pie chart:
1. Enter the blood types from Example 2—12 into column A of a new worksheet.
2. Enter the frequencies corresponding to each blood type in column B.

3. Highlight the data in columns A and B and select Insert from the toolbar, then select the
Pie chart type.

Bookl - Microsoft Excel non-commeraal use
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. Click on any region of the chart. Then select Design from the Chart Tools tab on the toolbar.
. Select Formulas from the chart Layouts tab on the toolbar.

. To change the title of the chart, click on the current title of the chart.

. When the text box containing the title is highlighted, click the mouse in the text box and

change the title.

2-57



92

2-58

Chapter 2 Frequency Distributions and Graphs

{b:a) = B da v B Bookl - Microsaft Excel non-cammercaal use | Chart Toals = T
S weme | nsen mgelwowt  Fomubi  OM)  Resew  View  ASSI  Deign  wowt  Fomat - x
| " = e D R o 1 v i S e =) a2 insen =

:34: Safen “_ -"'.“"I_l: _.-&' g : kd 3 5 + Delete = ]7 )
TP I P L B i S Rl B "’""'.'.'":." Aol ([T 4". rv;;;ﬂ ek

| Clipyeama ™= Fant o) Algrmant . Huniber Styles Cetli Eading

| crens - @ £ |7
_:-"A!I;__D_!;FIG__H__I_J;K_L_M__NI_D_P.
1 chass Frequincy

2 A s

ie 7

4o 3

5 a8 4

L]

7

&

pe. 1|

L

|

12

Constructing a Pareto Chart
To make a Pareto chart:

1. Enter the snack food categories from Example 2—11 into column A of a new worksheet.

2. Enter the corresponding frequencies in column B. The data should be entered in
descending order according to frequency.

3. Highlight the data from columns A and B and select the Insert tab from the toolbar.
4. Select the Column Chart type.
5. To change the title of the chart, click on the current title of the chart.

6. When the text box containing the title is highlighted, click the mouse in the text box and
change the title.
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Constructing a Time Series Plot
To make a time series chart:
1. Enter the years 1999 through 2003 from Example 2—-10 in column A of a new worksheet.
2. Enter the corresponding frequencies in column B.
3. Highlight the data from column B and select the Insert tab from the toolbar.
4. Select the Line chart type.

Resdy

6’3) I R €254 - Micrasoft Excel non-commercial use Chait Tosls - =
—=" Home et Fage Layaut Farmulas Data Review  View Add-Im3 Design Layout Format - 7x
RIEE S sl E
Change  Save As Switch Sebect ——— | | = = | Move
Chart Type Template | Row/Column  [iata Cham

Type Data Chadt Layoutt Chart Styles Location
[ enmz -G & =
A B G D E F G H I fl K L M N [} 'i

1 Year Number
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3 2000] 160.1
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5 2002] 1728
7
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5. Right-click the mouse on any region of the graph.
6. Select the Select Data option.

7. Select Edit from the Horizontal Axis Labels and highlight the years from column A, then
click [OK].

8. Click [OK] on the Select Data Source box.

9. Create a title for your chart, such as Number of Vehicles Using the Pennsylvania Turnpike
Between 1999 and 2003. Right-click the mouse on any region of the chart. Select the
Chart Tools tab from the toolbar, then Layout.

10. Select Chart Title and highlight the current title to change the title.

11. Select Axis Titles to change the horizontal and vertical axis labels.
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Summary

When data are collected, they are called raw data. Since very little knowledge can be
obtained from raw data, they must be organized in some meaningful way. A frequency
distribution using classes is the solution. Once a frequency distribution is constructed,
the representation of the data by graphs is a simple task. The most commonly used
graphs in research statistics are the histogram, frequency polygon, and ogive. Other
graphs, such as the bar graph, Pareto chart, time series graph, and pie graph, can also be
used. Some of these graphs are seen frequently in newspapers, magazines, and various
statistical reports.

Finally, a stem and leaf plot uses part of the data values as stems and part of the
data values as leaves. This graph has the advantages of a frequency distribution and a
histogram.

~Important Terms

bar graph 69

categorical frequency
distribution 38

class 37

class boundaries 39
class midpoint 40
class width 39

cumulative frequency 54
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cumulative frequency
distribution 42

frequency 37
frequency distribution 37
frequency polygon 53

grouped frequency
distribution 39

histogram 51

lower class limit 39

ogive 54

open-ended distribution 41
Pareto chart 70

pie graph 73

raw data 37

relative frequency graph 56

stem and leaf plot 80
time series graph 72

ungrouped frequency
distribution 43

upper class limit 39



Important Formulas

Formula for the percentage of values in each class:

% =£' 100%
n

where
f = frequency of the class
n = total number of values

Formula for the range:
R = highest value — lowest value
Formula for the class width:

Class width = upper boundary — lower boundary

Review Exercises

1. How People Get Their News The Brunswick Research
Organization surveyed 50 randomly selected individuals
and asked them the primary way they received the daily
news. Their choices were via newspaper (N), television
(T), radio (R), or Internet (I). Construct a categorical
frequency distribution for the data and interpret the
results. The data in this exercise will be used for
Exercise 2 in this section.

N N T T T 1 R R 1 T
I N R R 1 N N I T N
I R T T T T N R R 1
R R I N T R T I I T
T I N T T 1 R N R T

2. Construct a pie graph for the data in Exercise 1, and
analyze the results.

3. Ball Sales A sporting goods store kept a record of sales
of five items for one randomly selected hour during a
recent sale. Construct a frequency distribution for the
data (B = baseballs, G = golf balls, T = tennis balls,

S = soccer balls, F = footballs). (The data for this
exercise will be used for Exercise 4 in this section.)

F B B B G T F
G G F S G T
F T T T S T
F S S G S B

4. Draw a pie graph for the data in Exercise 3 showing the
sales of each item, and analyze the results.

5. BUN Count The blood urea nitrogen (BUN) count
of 20 randomly selected patients is given here in

Review Exercises 95

Formula for the class midpoint:

_ lower boundary + upper boundary

X,
" 2
lower limit + upper limit
X, = 3

Formula for the degrees for each section of a pie graph:

Degrees = 5 - 360°

milligrams per deciliter (mg/dl). Construct an
ungrouped frequency distribution for the data. (The data
for this exercise will be used for Exercise 6.)

17 18 13 14
12 17 11 20
13 18 19 17
14 16 17 12
16 15 19 22

. Construct a histogram, a frequency polygon, and an

ogive for the data in Exercise 5 in this section, and
analyze the results.

. The percentage (rounded to the nearest whole percent)

of persons from each state completing 4 years or more
of college is listed below. Organize the data into a
grouped frequency distribution with 5 classes.

Percentage of persons completing 4 years of college

23 25 24 34 22 24 27 37 33 24
26 23 38 24 24 17 28 23 30 25
30 22 33 24 28 36 24 19 25 3l
34 31 27 24 29 28 21 25 26 15
26 22 27 21 25 28 24 21 25 26

Source: New York Times Almanac.

. Using the data in Exercise 7, construct a histogram, a

frequency polygon, and an ogive.

9. NFL Franchise Values The data shown (in

millions of dollars) are the values of the 30 National
Football League franchises. Construct a frequency
distribution for the data using 8 classes. (The data for
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10.

12.

13.

14.

15.

Chapter 2 Frequency Distributions and Graphs

this exercise will be used for Exercises 10 and 12 in this
section.)

170 191 171 235 173 187 181 191
200 218 243 200 182 320 184 239
186 199 186 210 209 240 204 193
211 186 197 204 188 242

Source: Pittsburgh Post-Gazette.

Construct a histogram, a frequency polygon, and an
ogive for the data in Exercise 9 in this section, and
analyze the results.

11. Ages of the Vice Presidents at the Time of Their
Death The ages of the Vice Presidents of the United
States at the time of their death are listed below. Use the
data to construct a frequency distribution, histogram,

frequency polygon, and ogive, using relative
frequencies. Use 6 classes.

9 83 8 73 70 51 68 79 70 71
72 74 67 54 81 66 62 63 68 57
66 96 78 55 60 66 57 71 60 85
76 98 77 88 78 81 64 66 77 70

Source: New York Times Almanac.

Construct a histogram, frequency polygon, and ogive by
using relative frequencies for the data in Exercise 9 in
this section.

NBA Champions The NBA Champions from 1985 on
are listed below. Use the data to construct a Pareto chart
and a vertical bar graph.

1985 Los Angeles
1986 Boston
1987 Los Angeles
1988 Detroit
1989 Detroit
1990 Detroit

1991 Chicago
1992 Chicago
1993 Chicago
1994 Houston
1995 Houston

Source: World Almanac.

1996 Chicago
1997 Chicago
1998 Chicago
1999 San Antonio
2000 Los Angeles
2001 Los Angeles
2002 Los Angeles
2003 San Antonio
2004 Detroit
2005 San Antonio

Trial-Ready Cases Construct a Pareto chart and a
horizontal bar graph for the number of trial-ready civil
action and equity cases decided in less than 6 months
for the selected counties in southwestern Pennsylvania.

County Number of cases
Westmoreland 427
Washington 298
Green 151
Fayette 106
Somerset 87

Source: Pittsburgh Tribune-Review.

Minimum Wage The given data represent the federal
minimum hourly wage in the years shown. Draw a
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16.

17.

18.

19.

time series graph to represent the data and analyze the
results.

Year Wage
1960 $1.00
1965 1.25
1970 1.60
1975 2.10
1980 3.10
1985 3.35
1990 3.80
1995 4.25
2000 5.15
2005 5.15

Source: The World Almanac and Book of Facts.

Farm Data Construct a time series graph for each set
of data and analyze the results.

No. of farms

Year (millions) Avg. size (acres)
1940 6.35 174
1950 5.65 213
1960 3.96 297
1970 2.95 374
1980 2.44 426
1990 2.15 460
2000 2.17 436

Source: World Almanac.

Presidential Debates The data show the number (in
millions) of viewers who watched the first and second
Presidential debates. Construct two time series graphs
and compare the results.

Year | 1992 1996 2000 2004
First debate 62.4 36.1 46.6 62.5
Second debate 69.9 36.3 37.6 46.7

Source: Nielson Media Research.

Working Women In a study of 100 women, the
numbers shown here indicate the major reason why each
woman surveyed worked outside the home. Construct a
pie graph for the data and analyze the results.

Reason Number of women
To support self/family 62
For extra money 18
For something different to do 12
Other 8

Career Changes A survey asked if people would like
to spend the rest of their careers with their present
employers. The results are shown. Construct a pie graph
for the data and analyze the results.

Answer Number of people
Yes 660
No 260
Undecided 80



20. Museum Visitors The number of visitors to the
Railroad Museum during 24 randomly selected hours is
shown here. Construct a stem and leaf plot for the data.

Data Analysis 97

22. Job Aptitude Test A special aptitude test is given
to job applicants. The data shown here represent the
scores of 30 applicants. Construct a stem and leaf plot

for the data and summarize the results.

67 62 38 73 34 43 72 35

53 55 58 63 47 42 51 62 204 210 227 218 254

32 29 47 62 29 38 36 41 256 238 242 253 227

e 251 24 2 251 241

21. Public Libraries The numbers of public libraries 227 5 4§ 2?? 232 231
in operation for selected states are listed below. 218 212 217 207 209

Organize the data with a stem and leaf plot. 260 230 228 242 200

102 176 210 142 189 176 108 113 205

209 184 144 108 192 176

Source: World Almanac.

How Your Identity Can Be Stolen—Revisited

Data presented in numerical form do not convey an easy-to-interpret conclusion; however,
when data are presented in graphical form, readers can see the visual impact of the numbers. In
the case of identity fraud, the reader can see that most of the identity frauds are due to lost or
stolen wallets, checkbooks, or credit cards, and very few identity frauds are caused by online

Statistics
Today

purchases or transactions.

Online purchases or
transactions 4%

Stolen mail or fraudulent
change of address
8%

Data Analysis

A Data Bank is found in Appendix D, or on the
World Wide Web by following links from
www.mhhe.com/math/stat/bluman

1. From the Data Bank located in Appendix D, choose
one of the following variables: age, weight, cholesterol
level, systolic pressure, 1Q, or sodium level. Select
at least 30 values. For these values, construct a grouped
frequency distribution. Draw a histogram, frequency
polygon, and ogive for the distribution. Describe briefly
the shape of the distribution.

Computer viruses

Identity Fraud

Other methods
1%

Lost or stolen wallet,
checkbook, or credit card
38%

and hackers
9%

Corrupt
business Friends,
employees acquaintances
15% 15%

2. From the Data Bank, choose one of the following
variables: educational level, smoking status, or exercise.
Select at least 20 values. Construct an ungrouped
frequency distribution for the data. For the distribution,
draw a Pareto chart and describe briefly the nature of
the chart.

3. From the Data Bank, select at least 30 subjects and
construct a categorical distribution for their marital
status. Draw a pie graph and describe briefly the
findings.
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4. Using the data from Data Set IV in Appendix D,

construct a frequency distribution and draw a histogram.

Describe briefly the shape of the distribution of the
tallest buildings in New York City.

5. Using the data from Data Set XI in Appendix D,
construct a frequency distribution and draw a frequency
polygon. Describe briefly the shape of the distribution
for the number of pages in statistics books.

6. Using the data from Data Set IX in Appendix D, divide
the United States into four regions, as follows:

Northeast CT ME MA NH NJNY PARI VT
Midwest  IL IN IA KS MI MN MS NE ND OH SD WI

Chapter Quiz

Determine whether each statement is true or false. If the
statement is false, explain why.
1. In the construction of a frequency distribution, it is a

good idea to have overlapping class limits, such as
10-20, 20-30, 30-40.

2. Histograms can be drawn by using vertical or horizontal
bars.

3. It is not important to keep the width of each class the
same in a frequency distribution.

4. Frequency distributions can aid the researcher in
drawing charts and graphs.

5. The type of graph used to represent data is determined
by the type of data collected and by the researcher’s
purpose.

6. In construction of a frequency polygon, the class limits
are used for the x axis.

7. Data collected over a period of time can be graphed by
using a pie graph.
Select the best answer.
8. What is another name for the ogive?

a. Histogram

b. Frequency polygon

¢.  Cumulative frequency graph
d. Pareto chart

9. What are the boundaries for 8.6-8.8?

a. 89

b. 85-8.9

c. 8.55-8.85
d. 8.65-8.75

10. What graph should be used to show the relationship
between the parts and the whole?

a. Histogram
b. Pie graph
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South AL AR DE DC FL GAKY LAMD NC OK SC
TNTX VAWV

West AKAZ CACOHIID MTNV NM OR UT
WA WY

Find the total population for each region, and draw a
Pareto chart and a pie graph for the data. Analyze the
results. Explain which chart might be a better
representation for the data.

7. Using the data from Data Set I in Appendix D, make a
stem and leaf plot for the record low temperatures in the
United States. Describe the nature of the plot.

c. Pareto chart
d. Ogive

11. Except for rounding errors, relative frequencies should
add up to what sum?

a. 0

b. 1

c. 50
d. 100

Complete these statements with the best answers.

12. The three types of frequency distributions are
, and

13. In a frequency distribution, the number of classes
should be between and

14. Data such as blood types (A, B, AB, O) can be organized
into a(n) frequency distribution.

15. Data collected over a period of time can be graphed
using a(n) graph.

16. A statistical device used in exploratory data analysis
that is a combination of a frequency distribution and a
histogram is called a(n)

17. On a Pareto chart, the frequencies should be represented
on the axis.

18. Housing Arrangements A questionnaire on housing
arrangements showed this information obtained from
25 respondents. Construct a frequency distribution for
the data (H = house, A = apartment, M = mobile
home, C = condominium).

H C H M H A C A

cC M C A M A C C
C C H A H H M

M
M

19. Construct a pie graph for the data in Problem 18.

20. Items Purchased at a Convenience Store When
30 randomly selected customers left a convenience



store, each was asked the number of items he or she
purchased. Construct an ungrouped frequency
distribution for the data.

2 9 4 3 6
6 2 8 6 5
7 5 3 8 6
6 2 3 2 4
6 9 9 8 9
4 2 1 7 4

21. Construct a histogram, a frequency polygon, and an
ogive for the data in Problem 20.

22. Murders in Selected Cities For a recent year, the

number of murders in 25 selected cities is shown.
Construct a frequency distribution using 9 classes, and
analyze the nature of the data in terms of shape, extreme
values, etc. (The information in this exercise will be
used for Exercise 23 in this section.)

248 348 74 514 597
270 71 226 41 39
366 73 241 46 34
149 68 73 63 65
109 598 278 69 27

Source: Pittsburgh Tribune Review.

23. Construct a histogram, frequency polygon, and ogive
for the data in Problem 22. Analyze the histogram.

24. Recycled Trash Construct a Pareto chart and a
horizontal bar graph for the number of tons (in millions)

Critical Thinking Challenges

1. Water Usage The graph shows the average number of
gallons of water a person uses for various activities.

25.

Critical Thinking Challenges 99

of trash recycled per year by Americans based on an
Environmental Protection Agency study.

Type Amount
Paper 320.0
Iron/steel 292.0
Aluminum 276.0
Yard waste 242.4
Glass 196.0
Plastics 41.6

Source: US4 TODAY.

Trespasser Fatalities The data show the number of fatal
trespasser casualties on railroad property in the United
States. Draw a time series graph and explain any trend.

Year | 1998 1999 2000 2001
Number | 536 463 511 540

Source: Federal Railroad Administration.

26. Museum Visitors The number of visitors to the
Historic Museum for 25 randomly selected hours is
shown. Construct a stem and leaf plot for the data.

15 53 48 19 38
86 63 98 79 38
62 89 67 39 26
28 35 54 88 76
31 47 53 41 68

Can you see anything misleading about the way the
graph is drawn?

Average Amount of Water Used

25T 23gal

20 gal
20 1+ JL S

15+

10+ . l

Gallons

6 gal

5 +
2 gal
0 e ! ! ! @ ! X

Shower Washing
dishes

Flush Brushing
toilet teeth
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2. The Great Lakes Shown are various statistics about

and summary statements, write a report analyzing

the Great Lakes. Using appropriate graphs (your choice) the data.
Superior Michigan Huron Erie Ontario

Length (miles) 350 307 206 241 193

Breadth (miles) 160 118 183 57 53

Depth (feet) 1,330 923 750 210 802

Volume (cubic miles) 2,900 1,180 850 116 393

Area (square miles) 31,700 22,300 23,000 9,910 7,550

Shoreline (U.S., miles) 863 1,400 580 431 300

Source: The World Almanac and Book of Facts.

3. Teacher Strikes In Pennsylvania there were more c. In what year was the average duration of the strikes
teacher strikes in 2004 than there were in all other states the longest? What was it?
combined. Because of the disruptions, state legislators d. In what year was the average duration of the strikes
want to pass a bill outlawing teacher strikes and the shortest? What was it?
submitting contract disputes to binding arb.itrati.on. e. In what year was the number of teacher strikes the
;l:he gralph gho;vs t}}lle nlilmbler of teall;};e;r Strél(()%zllb same as the average duration of the strikes?
t;;g:zp;ag 1n2£vzretlslzs§(zluz:?ifns o ose /- Find the difference in the number of strikes for the
i ’ ) school years 1992—-1993 and 2004-2005.
a. Inwhat year did the largest number of strikes g. Do you think teacher strikes should be outlawed?
occur? How many were there? Justify your conclusions.

b. In what year(s) did the smallest number of teacher

strikes occur? How many were there?

Teacher Strikes in Pennsylvania

y
® ® Strikes
0T o-———=e Avg. No. of Days
° Q
_ 151 p”ﬂ\ .
8 / \ A .\ A /’
E / N\ / \ / T 4
=101 ¢ \ /N 4 RNV
\ J, ° ‘o ,/ ® °
\0’ Y )
54 [ 4
X
0 f f f f f f f f f f f f f
92- 93- 94- 95- 96- 97- 98- 99- 00- 01— 02- 03— 04-
93 94 95 96 97 98 99 00 O1 02 03 04 05
School year
Source: Pennsylvania School Boards Associations.

@ Data Projects

Where appropriate, use MINITAB, the TI-83 Plus, the
TI-84 Plus, Excel, or a computer program of your choice
to complete the following exercises.

1. Business and Finance Consider the 30 stocks listed as
the Dow Jones Industrials. For each, find their earnings
per share. Randomly select 30 stocks traded on the
NASDAQ. For each, find their earnings per share.
Create a frequency table with 5 categories for each data
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set. Sketch a histogram for each. How do the two data
sets compare?

. Sports and Leisure Use systematic sampling to create
a sample of 25 National League and 25 American
League baseball players from the most recently
completed season. Find the number of home runs for
each player. Create a frequency table with 5 categories
for each data set. Sketch a histogram for each. How do
the two leagues compare?



3.

Technology Randomly select 50 songs from your
music player or music organization program. Find the
length (in seconds) for each song. Use these data to
create a frequency table with 6 categories. Sketch a
frequency polygon for the frequency table. Is the shape
of the distribution of times uniform, skewed, or bell-
shaped? Also note the genre of each song. Create a
Pareto chart showing the frequencies of the various
categories. Finally, note the year each song was
released. Create a pie chart organized by decade to

show the percentage of songs from various time periods.

. Health and Wellness Use information from the Red

Cross to create a pie chart depicting the percentages of
Americans with various blood types. Also find
information about blood donations and the percentage

Answers to Applying the Concepts 101

of each type donated. How do the charts compare? Why
is the collection of type O blood so important?

. Politics and Economics Consider the U.S. Electoral

College System. For each of the 50 states, determine the
number of delegates received. Create a frequency table
with 8 classes. Is this distribution uniform, skewed, or
bell-shaped?

. Your Class Have each person in class take his or her

pulse and determine the heart rate (beats in one minute).
Use the data to create a frequency table with 6 classes.
Then have everyone in the class do 25 jumping jacks
and immediately take the pulse again after the activity.
Create a frequency table for those data as well.
Compare the two results. Are they similarly distributed?
How does the range of scores compare?

Answers to Applying the Concepts

Section 2-1 Ages of Presidents
at Inauguration

1.

The data were obtained from the population of all
Presidents at the time this text was written.

2. The oldest inauguration age was 69 years old.

3. The youngest inauguration age was 42 years old.

4. Answers will vary. One possible answer is

Age at
inauguration Frequency

42-45 2
4649 6
50-53 7
54-57 16
58-61 5
62-65 4
66—69 2

. Answers will vary. For the frequency distribution given

in Exercise 4, there is a peak for the 54-57 bin.

. Answers will vary. This frequency distribution shows

no outliers. However, if we had split our frequency into
14 bins instead of 7, then the ages 42, 43, 68, and 69
might appear as outliers.

. Answers will vary. The data appear to be unimodal and

fairly symmetric, centering on 55 years of age.

Section 2-2 Selling Real Estate

1.

A histogram of the data gives price ranges and the
counts of homes in each price range. We can also talk
about how the data are distributed by looking at a
histogram.

2.

A frequency polygon shows increases or decreases in
the number of home prices around values.

. A cumulative frequency polygon shows the number of

homes sold at or below a given price.

. The house that sold for $321,550 is an extreme value in

this data set.

. Answers will vary. One possible answer is that the

histogram displays the outlier well since there is a gap
in the prices of the homes sold.

6. The distribution of the data is skewed to the right.

Section 2-3 Leading Cause of Death

1.

The variables in the graph are the year, cause of death,
and rate of death per 100,000 men.

. The cause of death is qualitative, while the year and

death rates are quantitative.

. Year is a discrete variable, and death rate is continuous.

Since cause of death is qualitative, it is neither discrete
nor continuous.

4. Aline graph was used to display the data.

5. No, a Pareto chart could not be used to display the data,

since we can only have one quantitative variable and
one categorical variable in a Pareto chart.

. We cannot use a pie chart for the same reasons as given

for the Pareto chart.

. A Pareto chart is typically used to show a categorical

variable listed from the highest-frequency category to
the category with the lowest frequency.

. A time series chart is used to see trends in the data. It

can also be used for forecasting and predicting.
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I obicctives

After completing this chapter, you should be able to

Summarize data, using measures of central
tendency, such as the mean, median, mode,
and midrange.

Describe data, using measures of variation,
such as the range, variance, and standard
deviation.

Identify the position of a data value in a data
set, using various measures of position, such
as percentiles, deciles, and quartiles.

Use the techniques of exploratory data
analysis, including boxplots and five-number
summaries, to discover various aspects

of data.

Data Description

Introduction

Measures of Central Tendency
Measures of Variation
Measures of Position
Exploratory Data Analysis

Summary
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Statistics
Today

niere no 1'd

A person has on
average 1460 dreams
in 1 year.

How Long Are You Delayed by Road Congestion?

No matter where you live, at one time or another, you have been stuck in traffic. To see
whether there are more traffic delays in some cities than in others, statisticians make
comparisons using descriptive statistics. A statistical study by the Texas Transportation
Institute found that a driver is delayed by road congestion an average of 36 hours per
year. To see how selected cities compare to this average, see Statistics Today—Revisited
at the end of the chapter.

This chapter will show you how to obtain and interpret descriptive statistics such as
measures of average, measures of variation, and measures of position.

Introduction

Chapter 2 showed how you can gain useful information from raw data by organizing
them into a frequency distribution and then presenting the data by using various graphs.
This chapter shows the statistical methods that can be used to summarize data. The most
familiar of these methods is the finding of averages.

For example, you may read that the average speed of a car crossing midtown
Manhattan during the day is 5.3 miles per hour or that the average number of minutes an
American father of a 4-year-old spends alone with his child each day is 42.'

In the book American Averages by Mike Feinsilber and William B. Meed, the
authors state:

“Average” when you stop to think of it is a funny concept. Although it describes all of us it
describes none of us. . . . While none of us wants to be the average American, we all want to
know about him or her.

The authors go on to give examples of averages:

The average American man is five feet, nine inches tall; the average woman is five feet,

3.6 inches.

The average American is sick in bed seven days a year missing five days of work.

On the average day, 24 million people receive animal bites.

By his or her 70th birthday, the average American will have eaten 14 steers, 1050 chickens,
3.5 lambs, and 25.2 hogs.”

“Harper’s Index,” Harper s magazine.
*Mike Feinsilber and William B. Meed, American Averages (New York: Bantam Doubleday Dell).



Section 3—1 Measures of Central Tendency 105

In these examples, the word average is ambiguous, since several different methods
can be used to obtain an average. Loosely stated, the average means the center of the
distribution or the most typical case. Measures of average are also called measures of
central tendency and include the mean, median, mode, and midrange.

Knowing the average of a data set is not enough to describe the data set entirely.
Even though a shoe store owner knows that the average size of a man’s shoe is size 10,
she would not be in business very long if she ordered only size 10 shoes.

As this example shows, in addition to knowing the average, you must know how the
data values are dispersed. That is, do the data values cluster around the mean, or are they
spread more evenly throughout the distribution? The measures that determine the spread
of the data values are called measures of variation, or measures of dispersion. These
measures include the range, variance, and standard deviation.

Finally, another set of measures is necessary to describe data. These measures are
called measures of position. They tell where a specific data value falls within the data set
or its relative position in comparison with other data values. The most common position
measures are percentiles, deciles, and quartiles. These measures are used extensively in
psychology and education. Sometimes they are referred to as norms.

The measures of central tendency, variation, and position explained in this chapter
are part of what is called traditional statistics.

Section 3—4 shows the techniques of what is called exploratory data analysis. These
techniques include the boxplot and the five-number summary. They can be used to explore
data to see what they show (as opposed to the traditional techniques, which are used to
confirm conjectures about the data).

Measures of Central Tendency

Chapter 1 stated that statisticians use samples taken from populations; however, when
populations are small, it is not necessary to use samples since the entire population can
be used to gain information. For example, suppose an insurance manager wanted to know
the average weekly sales of all the company’s representatives. If the company employed
a large number of salespeople, say, nationwide, he would have to use a sample and make
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Objective [E}
Summarize data,
using measures of

central tendency, such

as the mean, median,
mode, and midrange.

In 1796, Adolphe
Quetelet investigated
the characteristics
(heights, weights, etc.)
of French conscripts
to determine the
“average man!
Florence Nightingale
was so influenced by
Quetelet's work that
she began collecting
and analyzing medical
records in the military
hospitals during the
Crimean War. Based
on her work, hospitals
began keeping
accurate records on
their patients.

an inference to the entire sales force. But if the company had only a few salespeople, say,
only 87 agents, he would be able to use all representatives’ sales for a randomly chosen
week and thus use the entire population.

Measures found by using all the data values in the population are called parameters.
Measures obtained by using the data values from samples are called statistics; hence, the
average of the sales from a sample of representatives is a statistic, and the average of sales
obtained from the entire population is a parameter.

A statistic is a characteristic or measure obtained by using the data values from a sample.

A parameter is a characteristic or measure obtained by using all the data values from a
specific population.

These concepts as well as the symbols used to represent them will be explained in
detail in this chapter.

General Rounding Rule In statistics the basic rounding rule is that when computa-
tions are done in the calculation, rounding should not be done until the final answer is
calculated. When rounding is done in the intermediate steps, it tends to increase the dif-
ference between that answer and the exact one. But in the textbook and solutions manual,
it is not practical to show long decimals in the intermediate calculations; hence, the
values in the examples are carried out to enough places (usually three or four) to obtain
the same answer that a calculator would give after rounding on the last step.

The Mean

The mean, also known as the arithmetic average, is found by adding the values of the
data and dividing by the total number of values. For example, the mean of 3, 2, 6, 5, and
4 is found by adding 3 + 2 + 6 + 5 + 4 = 20 and dividing by 5; hence, the mean of the
data is 20 + 5 = 4. The values of the data are represented by X’s. In this data set, X; = 3,
X, =2,X;=06,X, =15, and X; = 4. To show a sum of the total X values, the symbol =
(the capital Greek letter sigma) is used, and 2X means to find the sum of the X values in
the data set. The summation notation is explained in Appendix A.

The mean is the sum of the values, divided by the total number of values. The symbol X
represents the sample mean.

o Xt Xt Xot o 4 X, 35X
n n

where n represents the total number of values in the sample.
For a population, the Greek letter u (mu) is used for the mean.

X F Xgt Xet o+ Xy 3X
H N N
where N represents the total number of values in the population.

In statistics, Greek letters are used to denote parameters, and Roman letters are used
to denote statistics. Assume that the data are obtained from samples unless otherwise
specified.

Days Off per Year

O The data represent the number of days off per year for a sample of individuals
selected from nine different countries. Find the mean.

20, 26, 40, 36, 23, 42, 35, 24, 30

Source: World Tourism Organization.
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The average time it
takes a person to find a
new job is 5.9 months.
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Solution

- +26 4+ 40 + 36 + 23 + 42 + 35+ 24 +
X:%XZZO 26 + 40 + 36 293 42 +35+ 24 30:%=30.7days

Hence, the mean of the number of days off is 30.7 days.

Area Boat Registrations

The data shown represent the number of boat registrations for six counties in
southwestern Pennsylvania. Find the mean.

3782 6367 9002 4208 6843 11,008

Source: Pennsylvania Fish and Boat Commission.

Solution

Y= E_XZ 3782 + 6367 + 9002 + 4208 + 6843 + 11,008 _ 41,210
n 6

The mean for the six county boat registrations is 6868.3.

= 6868.3

The mean, in most cases, is not an actual data value.

Rounding Rule for the Mean The mean should be rounded to one more decimal
place than occurs in the raw data. For example, if the raw data are given in whole num-
bers, the mean should be rounded to the nearest tenth. If the data are given in tenths, the
mean should be rounded to the nearest hundredth, and so on.

The procedure for finding the mean for grouped data uses the midpoints of the classes.
This procedure is shown next.

Miles Run per Week
Using the frequency distribution for Example 2—7, find the mean. The data represent the
number of miles run during one week for a sample of 20 runners.

Solution

The procedure for finding the mean for grouped data is given here.
Step 1 Make a table as shown.

A B C D
Class Frequency f Midpoint X, X,

5.5-10.5
10.5-15.5
15.5-20.5
20.5-25.5
25.5-30.5
30.5-35.5
35.5-40.5

|NW-I>UIL»JN»—-

3
Il
)
=)

Step 2 Find the midpoints of each class and enter them in column C.

S+ 10. S+ 15,
y 35105 o 10.5+155

1 .
. > > 3 etc
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1 d 4,

A person looks, on
average, at about
14 homes before he
or she buys one.

Step 3

Step 4
Step 5

For each class, multiply the frequency by the midpoint, as shown, and place
the product in column D.

1-8=28 2-13=26 etc.
The completed table is shown here.

A B C D

Class Frequency f Midpoint X, X,
5.5-10.5 1 8 8
10.5-15.5 2 13 26
15.5-20.5 3 18 54
20.5-25.5 5 23 115
25.5-30.5 4 28 112
30.5-35.5 3 33 99
35.540.5 2 38 76
n =20 2f-X, =490

Find the sum of column D.
Divide the sum by #» to get the mean.
S/ X, _ 490

X= . = 20 = 24.5 miles

The procedure for finding the mean for grouped data assumes that the mean of all the
raw data values in each class is equal to the midpoint of the class. In reality, this is not true,
since the average of the raw data values in each class usually will not be exactly equal to
the midpoint. However, using this procedure will give an acceptable approximation of the
mean, since some values fall above the midpoint and other values fall below the midpoint
for each class, and the midpoint represents an estimate of all values in the class.

The steps for finding the mean for grouped data are summarized in the next
Procedure Table.

Procedure Table

Finding the Mean for Grouped Data
Step 1

Step 2
Step 3

Step 4
Step 5

Make a table as shown.

A B C D
Class Frequency f Midpoint X, f-X,

Find the midpoints of each class and place them in column C.

Multiply the frequency by the midpoint for each class, and place the product in
column D.

Find the sum of column D.

Divide the sum obtained in column D by the sum of the frequencies obtained in
column B.

The formula for the mean is

2f- X,
n

X=

[Note: The symbols 2f - X,, mean to find the sum of the product of the frequency (/) and the
midpoint (X,,) for each class.]
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Speaking of

Statistics

@

® e R
Nk o

Ages of the Top 50 Wealthiest People

The histogram shows the ages of the top
50 wealthiest individuals according to
Forbes Magazine for a recent year. The
mean age is 66.04 years. The median
age is 68 years. Explain why these two
statistics are not enough to adequately
describe the data.

Ages of the Top 50 Wealthiest Persons

15+
14+
13+
12+
1+
10+
9__
8__
7__
6__
5__
4__

Frequency

2__
14+

34.5 44.5 54.5 64.5 74.5 84.5 94.5
Age (years)

The Median

An article recently reported that the median income for college professors was $43,250.
This measure of central tendency means that one-half of all the professors surveyed
earned more than $43,250, and one-half earned less than $43,250.

The median is the halfway point in a data set. Before you can find this point, the data
must be arranged in order. When the data set is ordered, it is called a data array. The
median either will be a specific value in the data set or will fall between two values, as
shown in Examples 3—4 through 3-8.

The median is the midpoint of the data array. The symbol for the median is MD.

Steps in computing the median of a data array
Step 1 Arrange the data in order.
Step 2 Seclect the middle point.
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Example 3—-4

Hotel Rooms

The number of rooms in the seven hotels in downtown Pittsburgh is 713, 300, 618,
595, 311, 401, and 292. Find the median.

Source: Interstate Hotels Corporation.
Solution

Step 1 Arrange the data in order.
292,300, 311, 401, 595, 618, 713

Step 2 Select the middle value.
292,300, 311, 4(’)[*17 595, 618, 713

Median
Hence, the median is 401 rooms.

National Park Vehicle Pass Costs

Find the median for the daily vehicle pass charge for five U.S. National Parks. The costs
are $25, $15, $15, $20, and $15.

Source: National Park Service.
Solution

$15 $15 $15 $20 $25
T
Median

The median cost is $15.

Examples 3—4 and 3-5 each had an odd number of values in the data set; hence, the
median was an actual data value. When there are an even number of values in the data set,
the median will fall between two given values, as illustrated in Examples 3—6, 3—7, and 3-8.

Example 3—-6

Tornadoes in the United States
o The number of tornadoes that have occurred in the United States over an 8-year
period follows. Find the median.
684, 764, 656, 702, 856, 1133, 1132, 1303

Source: The Universal Almanac.

Solution

656, 684, 702, 764, 856, 1132, 1133, 1303
T
Median
Since the middle point falls halfway between 764 and 856, find the median MD by
adding the two values and dividing by 2.
764 + 856 _ 1620
2 2
The median number of tornadoes is 810.

MD = = 810




Section 3—-1 Measures of Central Tendency 111

Example 3-7

Cloudy Days

The number of cloudy days for the top 10 cloudiest cities is shown. Find the
median.

209, 223,211, 227, 213, 240, 240, 211, 229, 212

Source: National Climatic Data Center.

Solution

Arrange the data in order.
209,211, 211,212, 213, 223, 227, 229, 240, 240

T
Median
MD = 213 J2r 223 —18

Hence, the median is 218 days.

Example 3-8

Magazines Purchased

Six customers purchased these numbers of magazines: 1, 7, 3, 2, 3, 4. Find the

median.
Solution
1,2,3,3,4,7 MD=m=3
2
T
Median

Hence, the median number of magazines purchased is 3.

The Mode

The third measure of average is called the mode. The mode is the value that occurs most
often in the data set. It is sometimes said to be the most typical case.

The value that occurs most often in a data set is called the mode.

A data set that has only one value that occurs with the greatest frequency is said to
be unimodal.

If a data set has two values that occur with the same greatest frequency, both values
are considered to be the mode and the data set is said to be bimodal. If a data set has more
than two values that occur with the same greatest frequency, each value is used as the
mode, and the data set is said to be multimodal. When no data value occurs more than
once, the data set is said to have no mode. A data set can have more than one mode or no
mode at all. These situations will be shown in some of the examples that follow.

Example 3-9

NFL Signing Bonuses

° Find the mode of the signing bonuses of eight NFL players for a specific year.
The bonuses in millions of dollars are

18.0, 14.0, 34.5, 10, 11.3, 10, 12.4, 10
Source: USA TODAY.
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Solution
It is helpful to arrange the data in order although it is not necessary.

10, 10, 10, 11.3, 12.4, 14.0, 18.0, 34.5

Since $10 million occurred 3 times—a frequency larger than any other number—the
mode is $10 million.

Example 3-10

3-10

Coal Employees in Pennsylvania

o Find the mode for the number of coal employees per county for 10 selected
counties in southwestern Pennsylvania.

110, 731, 1031, 84, 20, 118, 1162, 1977, 103, 752

Source: Pittsburgh Tribune-Review.

Solution

Since each value occurs only once, there is no mode.
Note: Do not say that the mode is zero. That would be incorrect, because in some
data, such as temperature, zero can be an actual value.

Licensed Nuclear Reactors

The data show the number of licensed nuclear reactors in the United States for a recent
15-year period. Find the mode.

Source: The World Almanac and Book of Facts.

104 104 104 104 104
107 109 109 109 110
109 111 112 111 109

Solution

Since the values 104 and 109 both occur 5 times, the modes are 104 and 109. The data
set is said to be bimodal.

The mode for grouped data is the modal class. The modal class is the class with the
largest frequency.

Miles Run per Week

Find the modal class for the frequency distribution of miles that 20 runners ran in one
week, used in Example 2—-7.

Class Frequency

5.5-10.5 1
10.5-15.5 2
15.5-20.5 3
20.5-25.5 5 < Modeal class
25.5-30.5 4
30.5-35.5 3
35.5-40.5 2
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Solution

The modal class is 20.5-25.5, since it has the largest frequency. Sometimes the
midpoint of the class is used rather than the boundaries; hence, the mode could also be
given as 23 miles per week.

The mode is the only measure of central tendency that can be used in finding the
most typical case when the data are nominal or categorical.

Student Majors

A survey showed this distribution for the number of students enrolled in each field. Find
the mode.

Business 1425
Liberal arts 878
Computer science 632
Education 471
General studies 95

Solution

Since the category with the highest frequency is business, the most typical case is a
business major.

An extremely high or extremely low data value in a data set can have a striking effect
on the mean of the data set. These extreme values are called outliers. This is one reason
why when analyzing a frequency distribution, you should be aware of any of these
values. For the data set shown in Example 3—14, the mean, median, and mode can be
quite different because of extreme values. A method for identifying outliers is given in
Section 3-3.

Example 3-14

Salaries of Personnel

A small company consists of the owner, the manager, the salesperson, and two
technicians, all of whose annual salaries are listed here. (Assume that this is the
entire population.)

Staff Salary
Owner $50,000
Manager 20,000
Salesperson 12,000
Technician 9,000
Technician 9,000

Find the mean, median, and mode.

Solution
=X 50,000 + 20,000 + 12,000 + 9000 + 9000

N 5
Hence, the mean is $20,000, the median is $12,000, and the mode is $9,000.

= $20,000

3-11
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In Example 3—-14, the mean is much higher than the median or the mode. This is so
because the extremely high salary of the owner tends to raise the value of the mean. In
this and similar situations, the median should be used as the measure of central tendency.

The Midrange

The midrange is a rough estimate of the middle. It is found by adding the lowest and
highest values in the data set and dividing by 2. It is a very rough estimate of the aver-
age and can be affected by one extremely high or low value.

The midrange is defined as the sum of the lowest and highest values in the data set,
divided by 2. The symbol MR is used for the midrange.

__lowest value + highest value

MR 5

Water-Line Breaks

In the last two winter seasons, the city of Brownsville, Minnesota, reported these
numbers of water-line breaks per month. Find the midrange.

2,3,6,8,4,1
Solution
1+8 9
MR=—==-=4
2 2 >

Hence, the midrange is 4.5.

If the data set contains one extremely large value or one extremely small value, a
higher or lower midrange value will result and may not be a typical description of the
middle.

Example 3-16

3-12

NFL Signing Bonuses

Find the midrange of data for the NFL signing bonuses in Example 3-9. The bonuses in
millions of dollars are

18.0, 14.0, 34.5, 10, 11.3, 10, 12.4, 10

Solution
The smallest bonus is $10 million and the largest bonus is $34.5 million.

_10+345 445

MR > >

= $22.25 million

Notice that this amount is larger than seven of the eight amounts and is not typical of
the average of the bonuses. The reason is that there is one very high bonus, namely,
$34.5 million.
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The average American
drives about 10,000
miles a year.
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In statistics, several measures can be used for an average. The most common mea-
sures are the mean, median, mode, and midrange. Each has its own specific purpose and
use. Exercises 39 through 41 show examples of other averages, such as the harmonic
mean, the geometric mean, and the quadratic mean. Their applications are limited to spe-
cific areas, as shown in the exercises.

The Weighted Mean

Sometimes, you must find the mean of a data set in which not all values are equally repre-
sented. Consider the case of finding the average cost of a gallon of gasoline for three taxis.
Suppose the drivers buy gasoline at three different service stations at a cost of $3.22, $3.53,
and $3.63 per gallon. You might try to find the average by using the formula
v 2X
n

_3.22+3.53+3.63 _ 10.38
3 3

But not all drivers purchased the same number of gallons. Hence, to find the true aver-
age cost per gallon, you must take into consideration the number of gallons each driver
purchased.

The type of mean that considers an additional factor is called the weighted mean, and
it is used when the values are not all equally represented.

= $3.46

Find the weighted mean of a variable X by multiplying each value by its corresponding
weight and dividing the sum of the products by the sum of the weights.

X = wiXy+woXo + - - -+ w X, 2wX
Wi+ wy+ - -+ w, >w
where wy, w,, ..., w, are the weights and X, X,, . . ., X, are the values.

Example 3—17 shows how the weighted mean is used to compute a grade point average.
Since courses vary in their credit value, the number of credits must be used as weights.

Example 3-17

Grade Point Average

A student received an A in English Composition I (3 credits), a C in Introduction to
Psychology (3 credits), a B in Biology I (4 credits), and a D in Physical Education
(2 credits). Assuming A = 4 grade points, B = 3 grade points, C = 2 grade points,
D = 1 grade point, and F = 0 grade points, find the student’s grade point average.

Solution

Course Credits (w) Grade (X)
English Composition I 3 A (4 points)
Introduction to Psychology 3 C (2 points)
Biology I 4 B (3 points)
Physical Education 2 D (1 point)

— . + . + . + .

X:EWX:3 4+3-2+4-3+2 12222.7

2w 3+3+4+2 12

The grade point average is 2.7.

3-13
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Table 3—1 summarizes the measures of central tendency.

3-1  Summary of Measures of Central Tendency

Of people in the

United States, 45% Measure Definition Symbol(s)

live within 15 minutes Mean Sum of values, divided by total number of values w, X

of their best friend. Median Middle point in data set that has been ordered MD
Mode Most frequent data value None
Midrange Lowest value plus highest value, divided by 2 MR

Researchers and statisticians must know which measure of central tendency is being
used and when to use each measure of central tendency. The properties and uses of the
four measures of central tendency are summarized next.

Properties and Uses of Central Tendency

The Mean
1. The mean is found by using all the values of the data.

2. The mean varies less than the median or mode when samples are taken from the same
population and all three measures are computed for these samples.

3. The mean is used in computing other statistics, such as the variance.
4. The mean for the data set is unique and not necessarily one of the data values.

5. The mean cannot be computed for the data in a frequency distribution that has an
open-ended class.

6. The mean is affected by extremely high or low values, called outliers, and may not be the
appropriate average to use in these situations.

The Median
1. The median is used to find the center or middle value of a data set.

2. The median is used when it is necessary to find out whether the data values fall into the
upper half or lower half of the distribution.

3. The median is used for an open-ended distribution.
4. The median is affected less than the mean by extremely high or extremely low values.

The Mode
1. The mode is used when the most typical case is desired.
2. The mode is the easiest average to compute.

3. The mode can be used when the data are nominal, such as religious preference, gender,
or political affiliation.

4. The mode is not always unique. A data set can have more than one mode, or the mode
may not exist for a data set.

The Midrange
1. The midrange is easy to compute.
2. The midrange gives the midpoint.
3. The midrange is affected by extremely high or low values in a data set.

3-14
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Mode Median Mean
(a) Positively skewed or right-skewed

Mean Mean Median Mode
Median
Mode

(c) Negatively skewed or left-skewed

Distribution Shapes
Frequency distributions can assume many shapes. The three most important shapes are pos-
itively skewed, symmetric, and negatively skewed. Figure 3—1 shows histograms of each.

In a positively skewed or right-skewed distribution, the majority of the data values
fall to the left of the mean and cluster at the lower end of the distribution; the “tail” is to the
right. Also, the mean is to the right of the median, and the mode is to the left of the median.

For example, if an instructor gave an examination and most of the students did
poorly, their scores would tend to cluster on the left side of the distribution. A few high
scores would constitute the tail of the distribution, which would be on the right side.
Another example of a positively skewed distribution is the incomes of the population of
the United States. Most of the incomes cluster about the low end of the distribution; those
with high incomes are in the minority and are in the tail at the right of the distribution.

In a symmetric distribution, the data values are evenly distributed on both sides of
the mean. In addition, when the distribution is unimodal, the mean, median, and mode
are the same and are at the center of the distribution. Examples of symmetric distribu-
tions are 1Q scores and heights of adult males.

When the majority of the data values fall to the right of the mean and cluster at
the upper end of the distribution, with the tail to the left, the distribution is said to be
negatively skewed or left-skewed. Also, the mean is to the left of the median, and the
mode is to the right of the median. As an example, a negatively skewed distribution
results if the majority of students score very high on an instructor’s examination. These
scores will tend to cluster to the right of the distribution.

When a distribution is extremely skewed, the value of the mean will be pulled toward
the tail, but the majority of the data values will be greater than the mean or less than the
mean (depending on which way the data are skewed); hence, the median rather than the
mean is a more appropriate measure of central tendency. An extremely skewed distribu-
tion can also affect other statistics.

A measure of skewness for a distribution is discussed in Exercise 48 in Section 3—2.

3-15
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Applying the Concepts 3—1

Teacher Salaries

The following data represent salaries (in dollars) from a school district in Greenwood, South

Carolina.
10,000 11,000 11,000 12,500 14,300 17,500
18,000 16,600 19,200 21,560 16,400 107,000

. First, assume you work for the school board in Greenwood and do not wish to raise taxes

to increase salaries. Compute the mean, median, and mode, and decide which one would
best support your position to not raise salaries.

. Second, assume you work for the teachers’ union and want a raise for the teachers. Use the

best measure of central tendency to support your position.

. Explain how outliers can be used to support one or the other position.

4. If the salaries represented every teacher in the school district, would the averages be

parameters or statistics?

5. Which measure of central tendency can be misleading when a data set contains outliers?

6. When you are comparing the measures of central tendency, does the distribution display

any skewness? Explain.

See page 180 for the answers.

For Exercises 1 through 8, find () the mean, (b) the
median, (c) the mode, and (d) the midrange.

1. Grade Point Averages The average undergraduate
grade point average (GPA) for the 25 top-ranked
medical schools is listed below.

3.80 3.77 3.70 3.74 3.70
3.86 3.76 3.68 3.67 3.57
3.83 3.70 3.80 3.74 3.67
3.78 3.74 3.73 3.65 3.66
3.75 3.64 3.78 3.73 3.64

Source: U.S. News & World Report Best Graduate Schools.

2. Heights of the Highest Waterfalls The heights

(in feet) of the 20 highest waterfalls in the world are
shown here. (Note: The height of Niagara Falls is
182 feet!)

3212 2800 2625 2540 2499 2425 2307 2151 2123 2000
1904 1841 1650 1612 1536 1388 1215 1198 1182 1170

Source: New York Times Almanac.

3. High Temperatures The reported high temperatures

(in degrees Fahrenheit) for selected world cities on an
October day are shown below. Which measure of central
tendency do you think best describes these data?

62 72 66 79 83 61 62 8 72 64 74 71
42 38 91 66 77 90 74 63 64 68 42

Source: www.accuweather.com
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4. Observers in the Frogwatch Program The number

of observers in the Frogwatch USA program (a wildlife
conservation program dedicated to helping conserve
frogs and toads) for the top 10 states with the most
observers is 484, 483, 422, 396, 378, 352, 338, 331, 318,
and 302. The top 10 states with the most active watchers
list these numbers of visits: 634, 464, 406, 267, 219, 194,
191, 150, 130, and 114. Compare the measures of central
tendency for these two groups of data.

Source: www.nwf.org/frogwatch

5. Expenditures per Pupil for Selected States The

expenditures per pupil for selected states are listed
below. Based on these data, what do you think of the
claim that the average expenditure per pupil in the
United States exceeds $10,000?

6,300 11,847 8,319 9,344 9,870

10,460 7,491 7,552 12,568 8,632
7,552 12,568 8,632 11,057 10,454
8,109

Source: New York Times Almanac.

6. Earnings of Nonliving Celebrities Forbes

magazine prints an annual Top-Earning Nonliving
Celebrities list (based on royalties and estate earnings).
Find the measures of central tendency for these data and
comment on the skewness. Figures represent millions of
dollars.


www.nwf.org/frogwatch
www.accuweather.com

10.

Kurt Cobain 50 Ray Charles 10
Elvis Presley 42 Marilyn Monroe 8
Charles M. Schulz 35 Johnny Cash 8
John Lennon 24 J.R.R. Tolkien 7
Albert Einstein 20 George Harrison 7
Andy Warhol 19 Bob Marley 7
Theodore Geisel 10
(Dr. Seuss)

Source: articles.moneycentral.msn.com

7. Earthquake Strengths Twelve major earthquakes
had Richter magnitudes shown here.

7.0,6.2,7.7,8.0,6.4,6.2,
72,54,64,65,72,54

Which would you consider the best measure of average?

Source: The Universal Almanac.

8. Top-Paid CEOs The data shown are the total

compensation (in millions of dollars) for the 50 top-paid
CEOs for a recent year. Compare the averages, and state
which one you think is the best measure.

17.5 18.0 36.8 31.7 31.7
17.3 243 47.7 385 17.0
23.7 16.5 25.1 17.4 18.0
37.6 19.7 21.4 28.6 21.6
19.3 20.0 16.9 25.2 19.8
25.0 17.2 20.4 20.1 29.1
19.1 25.2 232 259 24.0
41.7 24.0 16.8 26.8 314
16.9 17.2 24.1 352 19.1
229 18.2 25.4 354 25.5

Source: USA TODAY.

. Find the (a) mean, (») median, (c) mode, and

(d) midrange for the data in Exercise 17 in Section 2—1.
Is the distribution symmetric or skewed? Use the
individual data values.

Find the (@) mean, (b) median, (c¢) mode, and
(d) midrange for the distances of the home runs for
McGwire and Sosa, using the data in Exercise 18 in
Section 2—1.

Compare the means. Decide if the means are
approximately equal or if one of the players is hitting
longer home runs. Use the individual data values.

11. Populations of Selected Cities Populations for
towns and cities of 5000 or more (based on the 2004
figures) in the 15XXX zip code area are listed here for
two different years. Find the mean, median, mode, and
midrange for each set of data. What do your findings

suggest?
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2004 1990
11,270 8,825 7,439 13,374 9,200 8,133
8,220 5,132 8,395 9,278 4,768 9,135
5,463 8,174 5,044 6,113 9,656 5,784
8,739 5,282 7,869 9,229 21,923 8,286
6,199 5,307 10,493 10,687 5,319 9,126
10,309 14,925 8,397 11,221 15,174 9,901
9,964 14,849 5,094 10,823 15,864 5,445
14,340 5,707 6,672 14,292 5,748 6,961

Source: World Almanac.

For Exercises 12 through 21, find the (¢) mean and
(b) modal class.

12.

13.

14.

Exam Scores For 108 randomly selected college
students, this exam score frequency distribution was
obtained. (The data in this exercise will be used in
Exercise 18 in Section 3-2.)

Class limits Frequency
90-98 6
99-107 22

108-116 43
117-125 28
126-134 9

Hourly Compensation for Production Workers The
hourly compensation costs (in U.S. dollars) for
production workers in selected countries are represented
below. Find the mean and modal class.

Class Frequency
2.48-7.48 7
7.49-12.49 3

12.50-17.50 1
17.51-22.51 7
22.52-27.52 5
27.53-32.53 5

Compare the mean of these grouped data to the U.S.
mean of $21.97.

Source: New York Times Almanac.

Automobile Fuel Efficiency Thirty automobiles were
tested for fuel efficiency (in miles per gallon). This
frequency distribution was obtained. (The data in this
exercise will be used in Exercise 20 in Section 3-2.)

Class boundaries Frequency
7.5-12.5 3
12.5-17.5 5
17.5-22.5 15
22.5-27.5 5
27.5-32.5 2
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15.

16.

17.

18.

19.
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Percentage of Foreign-Born People The percentage
of foreign-born population for each of the 50 states is
represented below. Find the mean and modal class. Do
you think the mean is the best average for this set of
data? Explain.

Percentage Frequency
0.84.4 26
4.5-8.1 11
8.2-11.8 4

11.9-15.5 5
15.6-19.2 2
19.3-22.9 1
23.0-26.6 1

Source: World Almanac.

Find the mean and modal class for each set of data in
Exercises 8 and 18 in Section 2-2. Is the average about
the same for both sets of data?

Percentage of College-Educated Population over 25
Below are the percentages of the population over

25 years of age who have completed 4 years of college
or more for the 50 states and the District of Columbia.
Find the mean and modal class.

Percentage Frequency
15.2-19.6 3
19.7-24.1 15
24.2-28.6 19
28.7-33.1 6
33.2-37.6 7
37.7-42.1 0
42.2-46.6 1

Source: New York Times Almanac.

Net Worth of Corporations These data represent
the net worth (in millions of dollars) of 45 national
corporations.

Class limits Frequency
1020 2
21-31 8
3242 15
43-53 7
54-64 10
65-75 3

Cost per Load of Laundry Detergents The cost
per load (in cents) of 35 laundry detergents tested
by a consumer organization is shown. (The data in
this exercise will be used for Exercise 19 in
Section 3-2.)
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20.

21.

22.

23.

24.

Class limits Frequency
13-19 2
20-26 7
27-33 12
34-40 5
41-47 6
48-54 1
55-61 0
62-68 2

Commissions Earned This frequency distribution
represents the commission earned (in dollars) by
100 salespeople employed at several branches of a
large chain store.

Class limits Frequency
150-158 5
159-167 16
168-176 20
177-185 21
186194 20
195-203 15
204-212 3

Copier Service Calls This frequency distribution
represents the data obtained from a sample of 75
copying machine service technicians. The values
represent the days between service calls for various
copying machines.

Class boundaries Frequency
15.5-18.5 14
18.5-21.5 12
21.5-24.5 18
24.5-27.5 10
27.5-30.5 15
30.5-33.5 6

Use the data from Exercise 14 in Section 2—1 and find the
mean and modal class.

Find the mean and modal class for the data in Exercise 13
in Section 2—1.

Use the data from Exercise 3 in Section 2-2 and find the
mean and modal class.

25. Enrollments for Selected Independent

Religiously Controlled 4-Year Colleges Listed below
are the enrollments for selected independent religiously
controlled 4-year colleges which offer bachelor’s
degrees only. Construct a grouped frequency
distribution with six classes and find the mean and
modal class.

1013 1867 1268 1666 2309 1231 3005 2895 2166 1136
1532 1461 1750 1069 1723 1827 1155 1714 2391 2155
1412 1688 2471 1759 3008 2511 2577 1082 1067 1062
1319 1037 2400

Source: World Almanac.



26. Find the weighted mean price of three models of
automobiles sold. The number and price of each model
sold are shown in this list.

Model Number Price
A 8 $10,000
B 10 12,000
C 12 8,000

27. Fat Grams Using the weighted mean, find the average
number of grams of fat per ounce of meat or fish that a

person would consume over a 5-day period if he ate these:

Meat or fish Fat (g/oz)
3 oz fried shrimp 333
3 oz veal cutlet (broiled) 3.00
2 oz roast beef (lean) 2.50
2.5 oz fried chicken drumstick 4.40
4 oz tuna (canned in oil) 1.75

Source: The World Almanac and Book of Facts.

28. Diet Cola Preference A recent survey of a new diet
cola reported the following percentages of people
who liked the taste. Find the weighted mean of the
percentages.

Area % Favored Number surveyed
1 40 1000
2 30 3000
3 50 800

29. Costs of Helicopters The costs of three models of
helicopters are shown here. Find the weighted mean
of the costs of the models.

Model Number sold Cost

Sunscraper 9 $427,000
Skycoaster 6 365,000
High-flyer 12 725,000

30. Final Grade An instructor grades exams, 20%; term
paper, 30%; final exam, 50%. A student had grades of
83, 72, and 90, respectively, for exams, term paper, and
final exam. Find the student’s final average. Use the
weighted mean.

Extending the Concepts
36. If the mean of five values is 64, find the sum of the
values.

37. If the mean of five values is 8.2 and four of the values
are 6, 10, 7, and 12, find the fifth value.

38. Find the mean of 10, 20, 30, 40, and 50.

a. Add 10 to each value and find the mean.

b. Subtract 10 from each value and find the mean.
¢. Multiply each value by 10 and find the mean.

31.

32.

33.

34.

35.

39.
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Final Grade Another instructor gives four 1-hour exams
and one final exam, which counts as two 1-hour exams.
Find a student’s grade if she received 62, 83, 97, and 90
on the 1-hour exams and 82 on the final exam.

For these situations, state which measure of central
tendency—mean, median, or mode—should be
used.

a. The most typical case is desired.
b. The distribution is open-ended.

c. There is an extreme value in the data set.

d. The data are categorical.

e. Further statistical computations will be needed.

f The values are to be divided into two approximately

equal groups, one group containing the larger values
and one containing the smaller values.

Describe which measure of central tendency—mean,
median, or mode—was probably used in each
situation.

a. One-half of the factory workers make more than
$5.37 per hour, and one-half make less than
$5.37 per hour.

b. The average number of children per family in the
Plaza Heights Complex is 1.8.

c¢.  Most people prefer red convertibles over any other
color.

d. The average person cuts the lawn once a week.

e. The most common fear today is fear of speaking in
public.

f- The average age of college professors is 42.3 years.

What types of symbols are used to represent sample
statistics? Give an example. What types of symbols are
used to represent population parameters? Give an example.

A local fast-food company claims that the average
salary of its employees is $13.23 per hour. An employee
states that most employees make minimum wage. If
both are being truthful, how could both be correct?

d. Divide each value by 10 and find the mean.
e. Make a general statement about each situation.

The harmonic mean (HM) is defined as the number of
values divided by the sum of the reciprocals of each
value. The formula is

HM =S

3-19
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For example, the harmonic mean of 1, 4, 5, and 2 is

4

UM = a5 +12

2.05

This mean is useful for finding the average speed.
Suppose a person drove 100 miles at 40 miles per hour
and returned driving 50 miles per hour. The average
miles per hour is not 45 miles per hour, which is found
by adding 40 and 50 and dividing by 2. The average is
found as shown.

Since

Time = distance —+ rate
then

Time 1 = % = 2.5 hours to make the trip

Time 2 = % = 2 hours to return

Hence, the total time is 4.5 hours, and the total miles
driven are 200. Now, the average speed is

_ distance _ 200

Rate =
4.5

- = 44 .44 miles per hour

time

This value can also be found by using the harmonic
mean formula

HM = 44.44

= 1/40 + 1/50

Using the harmonic mean, find each of these.

a. A salesperson drives 300 miles round trip at
30 miles per hour going to Chicago and 45 miles
per hour returning home. Find the average miles
per hour.

b. Abus driver drives the 50 miles to West Chester at
40 miles per hour and returns driving 25 miles per
hour. Find the average miles per hour.

¢. A carpenter buys $500 worth of nails at $50 per
pound and $500 worth of nails at $10 per pound.
Find the average cost of 1 pound of nails.

The geometric mean (GM) is defined as the nth root of
the product of n values. The formula is

GM = V(X)) (X,)(X3) -+ (X,)
The geometric mean of 4 and 16 is

GM =V/4)(16) = V64 =8

The geometric mean of 1, 3, and 9 is

GM =v(1)3)9) =Vv27 =3

The geometric mean is useful in finding the
average of percentages, ratios, indexes, or growth
rates. For example, if a person receives a 20% raise
after 1 year of service and a 10% raise after the
second year of service, the average percentage raise
per year is not 15 but 14.89%, as shown.

GM = V/(1.2)(1.1) = 1.1489
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or

GM = \/(120)(110) = 114.89%
His salary is 120% at the end of the first year and 110%
at the end of the second year. This is equivalent to an
average of 14.89%, since 114.89% — 100% = 14.89%.

This answer can also be shown by assuming that
the person makes $10,000 to start and receives two
raises of 20 and 10%.

Raise 1 = 10,000 - 20% = $2000

Raise 2 = 12,000 - 10% = $1200
His total salary raise is $3200. This total is equivalent to

$10,000 - 14.89% = $1489.00
$11,489 - 14.89% = 1710.71

$3199.71 = $3200
Find the geometric mean of each of these.

a. The growth rates of the Living Life Insurance
Corporation for the past 3 years were 35, 24,
and 18%.

b. A person received these percentage raises in salary
over a 4-year period: 8, 6, 4, and 5%.

c. A stock increased each year for 5 years at these
percentages: 10, 8, 12, 9, and 3%.

d. The price increases, in percentages, for the cost of
food in a specific geographic region for the past
3 years were 1, 3, and 5.5%.

A useful mean in the physical sciences (such as voltage)
is the quadratic mean (QM), which is found by taking
the square root of the average of the squares of each
value. The formula is

>X?
n

QM =

The quadratic mean of 3, 5, 6, and 10 is

324524+ 6%+ 10°
M =
S —

=1/42.5 =6.52
Find the quadratic mean of §, 6, 3, 5, and 4.

An approximate median can be found for data that have
been grouped into a frequency distribution. First it is
necessary to find the median class. This is the class that
contains the median value. That is the n/2 data value.
Then it is assumed that the data values are evenly
distributed throughout the median class. The formula is

n/2 — cf
A

where  n = sum of frequencies
cf = cumulative frequency of class
immediately preceding the median class
w = width of median class
/= frequency of median class
L,, = lower boundary of median class

MD =

(w) + L,

Using this formula, find the median for data in the
frequency distribution of Exercise 15.
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Step by Step = :

Excel
Step by Step

Finding Measures of Central Tendency
Example XL3-1

Find the mean, mode, and median of the data from Example 3—11. The data represent the
population of licensed nuclear reactors in the United States for a recent 15-year period.

104 104 104 104 104
107 109 109 109 110
109 111 112 111 109

1. On an Excel worksheet enter the numbers in cells A2—A16. Enter a label for the variable in
cell A1,

On the same worksheet as the data:
2. Compute the mean of the data: key in =AVERAGE(A2:A16) in a blank cell.
3. Compute the mode of the data: key in =MODE(A2:A16) in a blank cell.
4. Compute the median of the data: key in =MEDIAN(A2:A16) in a blank cell.

These and other statistical functions can also be accessed without typing them into the
worksheet directly.

fe
1. Select the Formulas tab from the toolbar and select the Insert Function Icon ...
2. Select the Statistical category for statistical functions.
3. Scroll to find the appropriate function and click [OK].

A o c
Number of Reactors
104 107.7333 mean
104 104 mode
104 108 median

104
104
107
109
109
109
110
109
111
112
111
109

{_iab}.’;.ﬁﬁﬁguuueuhuup

Measures of Variation

In statistics, to describe the data set accurately, statisticians must know more than the
measures of central tendency. Consider Example 3—18.

Example 3-18

Objective [E)

Describe data, using
measures of variation,
such as the range,
variance, and
standard deviation.

Comparison of Outdoor Paint

o A testing lab wishes to test two experimental brands of outdoor paint to see how
long each will last before fading. The testing lab makes 6 gallons of each paint
to test. Since different chemical agents are added to each group and only six cans are
involved, these two groups constitute two small populations. The results (in months) are
shown. Find the mean of each group.
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Brand A Brand B
10 35
60 45
50 30
30 35
40 40
20 25

Solution

The mean for brand A is

>X 210

B= T = 35 months
The mean for brand B is
>X 210

K= T = 35 months

Since the means are equal in Example 3—18, you might conclude that both brands of
paint last equally well. However, when the data sets are examined graphically, a some-
what different conclusion might be drawn. See Figure 3-2.

As Figure 3-2 shows, even though the means are the same for both brands, the
spread, or variation, is quite different. Figure 3—2 shows that brand B performs more con-
sistently; it is less variable. For the spread or variability of a data set, three measures are
commonly used: range, variance, and standard deviation. Each measure will be dis-
cussed in this section.

Range
The range is the simplest of the three measures and is defined now.

The range is the highest value minus the lowest value. The symbol R is used for the range.

R = highest value — lowest value

[y Variation of paint (in months)
Examining Data Sets —] [—] [—] [—) == ==
Graphically A A A A A A
1I0 2I0 3I0 3I5 4I0 5I0 6I0
(a) Brand A

Variation of paint (in months)

20 25 30 35 40 45 50
(b) Brand B
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Example 3-19 Comparison of Outdoor Paint

Find the ranges for the paints in Example 3—18.
Solution

For brand A, the range is

R =60 — 10 = 50 months
For brand B, the range is

R =45 — 25 = 20 months

Make sure the range is given as a single number.

The range for brand A shows that 50 months separate the largest data value from
the smallest data value. For brand B, 20 months separate the largest data value from the
smallest data value, which is less than one-half of brand A’s range.

One extremely high or one extremely low data value can affect the range markedly,
as shown in Example 3-20.

Example 3-20 Employee Salaries

o The salaries for the staff of the XYZ Manufacturing Co. are shown here. Find

the range.

Staff Salary

Owner $100,000

Manager 40,000

Sales representative 30,000

Workers 25,000
15,000
18,000

Solution

The range is R = $100,000 — $15,000 = $85,000.

Since the owner’s salary is included in the data for Example 3—20, the range is a large
number. To have a more meaningful statistic to measure the variability, statisticians use
measures called the variance and standard deviation.

Population Variance and Standard Deviation

Before the variance and standard deviation are defined formally, the computational
procedure will be shown, since the definition is derived from the procedure.

Rounding Rule for the Standard Deviation The rounding rule for the standard
deviation is the same as that for the mean. The final answer should be rounded to one
more decimal place than that of the original data.

m Comparison of Outdoor Paint

Find the variance and standard deviation for the data set for brand A paint in
Example 3-18.

10, 60, 50, 30, 40, 20
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Solution

Step 1 Find the mean for the data.

_SX_10+60+50+30+40+20 210 _
N 6 6

Step 2 Subtract the mean from each data value.
10 — 35 = -25 50 —35=+15 40 — 35 = +5
60 — 35 = +25 30 -35=-5 20 — 35=—15
Step 3 Square each result.
(—25)* = 625 (+15)* = 225 (+5)* =25
(+25 =625  (=5)° =25 (—15)* = 225

Step 4 Find the sum of the squares.
625 + 625 + 225 + 25 + 25 + 225 = 1750
Step 5 Divide the sum by N to get the variance.
Variance = 1750 + 6 = 291.7

Step 6 Take the square root of the variance to get the standard deviation. Hence, the
standard deviation equals \/291.7, or 17.1. It is helpful to make a table.

A B C
Values X X—p X -t
10 —25 625
60 +25 625
50 +15 225
30 -5 25
40 +5 25
20 —15 225
1750

Column A contains the raw data X. Column B contains the differences X — w obtained
in step 2. Column C contains the squares of the differences obtained in step 3.

The preceding computational procedure reveals several things. First, the square root
of the variance gives the standard deviation; and vice versa, squaring the standard devi-
ation gives the variance. Second, the variance is actually the average of the square of the
distance that each value is from the mean. Therefore, if the values are near the mean, the
variance will be small. In contrast, if the values are far from the mean, the variance will
be large.

You might wonder why the squared distances are used instead of the actual distances.
One reason is that the sum of the distances will always be zero. To verify this result for
a specific case, add the values in column B of the table in Example 3-21. When each
value is squared, the negative signs are eliminated.

Finally, why is it necessary to take the square root? The reason is that since the dis-
tances were squared, the units of the resultant numbers are the squares of the units of the
original raw data. Finding the square root of the variance puts the standard deviation in
the same units as the raw data.

When you are finding the square root, always use its positive or principal value, since
the variance and standard deviation of a data set can never be negative.
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The variance is the average of the squares of the distance each value is from the mean.
The symbol for the population variance is o2 (o is the Greek lowercase letter sigma).
The formula for the population variance is
X — p)?
N

2 —

where

X = individual value
n = population mean
N = population size

The standard deviation is the square root of the variance. The symbol for the
population standard deviation is o.
The corresponding formula for the population standard deviation is

0.=\/0.*2=\/E(X+V“)2

m Comparison of Outdoor Paint

Find the variance and standard deviation for brand B paint data in Example 3—18.
The months were

35, 45, 30, 35, 40, 25
Solution

Step 1 Find the mean.
:Z_X:35+45+30+35+40+25:&:35
Y 6 6

Step 2 Subtract the mean from each value, and place the result in column B of the table.

Step 3 Square each result and place the squares in column C of the table.

A B C
X X—p X — p)y
35 0 0
45 10 100
30 -5 25
35 0 0
40 5 25
25 —10 100

m Step 4 Find the sum of the squares in column C.
tcrORr

Each person receives
on average 598
pieces of mail per year.

SX— @) =0+ 100+ 25+ 0 + 25 + 100 = 250
Step 5 Divide the sum by N to get the variance.
,  2X —w?* 250

e e Y
7 N 6

Step 6 Take the square root to get the standard deviation.
E _ 2
o= % =\VAl7=65

Hence, the standard deviation is 6.5.
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Since the standard deviation of brand A is 17.1 (see Example 3-21) and the standard
deviation of brand B is 6.5, the data are more variable for brand A. In summary, when the
means are equal, the larger the variance or standard deviation is, the more variable the
data are.

Sample Variance and Standard Deviation

When computing the variance for a sample, one might expect the following expression
to be used:

S(X — X)?
n

where X is the sample mean and 7 is the sample size. This formula is not usually used,
however, since in most cases the purpose of calculating the statistic is to estimate the
corresponding parameter. For example, the sample mean X is used to estimate the
population mean w. The expression

SX — X)?

n

does not give the best estimate of the population variance because when the population
is large and the sample is small (usually less than 30), the variance computed by this for-
mula usually underestimates the population variance. Therefore, instead of dividing by
n, find the variance of the sample by dividing by n — 1, giving a slightly larger value and
an unbiased estimate of the population variance.

The formula for the sample variance, denoted by s?, is

L SX— X)?
s2="—""
n—1

where
X = sample mean

n = sample size

To find the standard deviation of a sample, you must take the square root of the
sample variance, which was found by using the preceding formula.

Formula for the Sample Standard Deviation

The standard deviation of a sample (denoted by s) is

—_ )2
s == \[2E X
n—1
where
X = individual value

X = sample mean
n = sample size

Shortcut formulas for computing the variance and standard deviation are presented
next and will be used in the remainder of the chapter and in the exercises. These formu-
las are mathematically equivalent to the preceding formulas and do not involve using
the mean. They save time when repeated subtracting and squaring occur in the original
formulas. They are also more accurate when the mean has been rounded.
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Shortcut or Computational Formulas for s? and s

The shortcut formulas for computing the variance and standard deviation for data obtained
from samples are as follows.

Variance Standard deviation

oA X2 4 [a5X) = X7
nn — 1) nn — 1)

Examples 3-23 and 3-24 explain how to use the shortcut formulas.

m European Auto Sales

Find the sample variance and standard deviation for the amount of European auto
sales for a sample of 6 years shown. The data are in millions of dollars.

11.2,11.9,12.0,12.8,13.4, 14.3

Source: US4 TODAY.

Solution
Step 1 Find the sum of the values.
2X=112+ 119+ 12.0 + 128 + 13.4 + 143 =756
Step 2 Square each value and find the sum.
SX? = 1122 + 11.9% + 12.0° + 12.8* + 13.4> + 14.37 = 958.94
Step 3 Substitute in the formulas and solve.

o nEX?) — (S

nn—1)
6(958.94) — 75.6
B 6(6 — 1)
_5753.64 — 5715.36
B 6(5)
_ 3828
30
=1.276

The variance is 1.28 rounded.
s=1128 =1.13

Hence, the sample standard deviation is 1.13.

Note that X? is not the same as (2X)*. The notation SX* means to square the values
first, then sum; (2X)* means to sum the values first, then square the sum.

Variance and Standard Deviation for Grouped Data

The procedure for finding the variance and standard deviation for grouped data is simi-
lar to that for finding the mean for grouped data, and it uses the midpoints of each class.
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Example 3—-24 Miles Run per Week

Find the variance and the standard deviation for the frequency distribution of the data
in Example 2—7. The data represent the number of miles that 20 runners ran during

one week.
Class Frequency Midpoint
5.5-10.5 1 8
10.5-15.5 2 13
15.5-20.5 3 18
20.5-25.5 5 23
25.5-30.5 4 28
30.5-35.5 3 33
35.5-40.5 2 38
Solution

Step 1 Make a table as shown, and find the midpoint of each class.

A B C D E
Frequency Midpoint
Class f X, X, A6

d (i Dld 5.5-10.5 1 8
At birth men outnum- 10.5-15.5 2 13
ber women by 2%. By 15.5-20.5 3 18
age 25, the number of 20.5-25.5 5 23
men living is about 25.5-30.5 4 28
equal to the number of 30.5-35.5 3 33
35.5-40.5 2 38

women living. By age
65, there are 14%
more women living
than men.

Step 2 Multiply the frequency by the midpoint for each class, and place the products
in column D.

1-8=8 2-13=26 2-38=76

Step 3 Multiply the frequency by the square of the midpoint, and place the products
in column E.
1-8 =64 213 =338 2 -38% = 2888

Step 4 Find the sums of columns B, D, and E. The sum of column B is #, the sum of
column D is 2f+ X, and the sum of column E is Zf+ X72. The completed table

is shown.
A B C D E

Class Frequency Midpoint X, X3
5.5-10.5 1 8 8 64
10.5-15.5 2 13 26 338
15.5-20.5 3 18 54 972
20.5-25.5 5 23 115 2,645
25.5-30.5 4 28 112 3,136
30.5-35.5 3 33 99 3,267
35.5-40.5 2 38 76 2,888
n=20 Sf- X, = 490 SfX2 = 13310
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The average number of
times that a man cries

in a month is 1.4.
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Step 5 Substitute in the formula and solve for s to get the variance.

, _nEf-X2) - Ef-X,)?
2=
nmn—1)

~20(13,310) — 4902

o 2020—1)

266,200 — 240,100

- 20(19)

26,100

380

= 68.7

Step 6 Take the square root to get the standard deviation.
s =168.7=283

Be sure to use the number found in the sum of column B (i.e., the sum of the
frequencies) for n. Do not use the number of classes.

The steps for finding the variance and standard deviation for grouped data are
summarized in this Procedure Table.

Procedure Table - "

Finding the Sample Variance and Standard Deviation for Grouped Data
Step1  Make a table as shown, and find the midpoint of each class.

A B C D E
Class Frequency Midpoint X, X2

Step2  Multiply the frequency by the midpoint for each class, and place the products in
column D.

Step 3  Multiply the frequency by the square of the midpoint, and place the products in
column E.

Step 4 Find the sums of columns B, D, and E. (The sum of column B is #. The sum of
column D is 3f - X,,. The sum of column E is 3f - X?2.)

Step 5 Substitute in the formula and solve to get the variance.

oSS XE) = O X,
nn —1)

Step 6  Take the square root to get the standard deviation.

The three measures of variation are summarized in Table 3-2.

3-2  Summary of Measures of Variation

Measure Definition Symbol(s)
Range Distance between highest value and lowest value R
Variance Average of the squares of the distance that each value

is from the mean o2 s?
Standard deviation Square root of the variance a,s

3-29



132

Chapter 3 Data Description

Uses of the Variance and Standard Deviation

1. As previously stated, variances and standard deviations can be used to determine the
spread of the data. If the variance or standard deviation is large, the data are more
dispersed. This information is useful in comparing two (or more) data sets to determine
which is more (most) variable.

2. The measures of variance and standard deviation are used to determine the consistency
of a variable. For example, in the manufacture of fittings, such as nuts and bolts, the
variation in the diameters must be small, or the parts will not fit together.

3. The variance and standard deviation are used to determine the number of data values that
fall within a specified interval in a distribution. For example, Chebyshev’s theorem
(explained later) shows that, for any distribution, at least 75% of the data values will fall
within 2 standard deviations of the mean.

4. Finally, the variance and standard deviation are used quite often in inferential statistics.
These uses will be shown in later chapters of this textbook.

Coefficient of Variation
Whenever two samples have the same units of measure, the variance and standard devia-
tion for each can be compared directly. For example, suppose an automobile dealer wanted
to compare the standard deviation of miles driven for the cars she received as trade-ins
on new cars. She found that for a specific year, the standard deviation for Buicks was
422 miles and the standard deviation for Cadillacs was 350 miles. She could say that the
variation in mileage was greater in the Buicks. But what if a manager wanted to compare
the standard deviations of two different variables, such as the number of sales per sales-
person over a 3-month period and the commissions made by these salespeople?

A statistic that allows you to compare standard deviations when the units are differ-
ent, as in this example, is called the coefficient of variation.

The coefficient of variation, denoted by CVar, is the standard deviation divided by the
mean. The result is expressed as a percentage.

For samples, For populations,
CVar = = - 100% CVar =Z - 100%
X M

m Sales of Automobiles

3-30

The mean of the number of sales of cars over a 3-month period is 87, and the standard
deviation is 5. The mean of the commissions is $5225, and the standard deviation is
$773. Compare the variations of the two.

Solution

The coefficients of variation are

Ky 5
C - = =_"__. 0/ — . 0
Var 7 100% = 5.7% sales

773 o) _ o .
CVar = 3225 100% = 14.8% commissions

Since the coefficient of variation is larger for commissions, the commissions are more
variable than the sales.
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Example 3—-26 Pages in Women'’s Fitness Magazines

The mean for the number of pages of a sample of women’s fitness magazines is 132,
with a variance of 23; the mean for the number of advertisements of a sample of
women’s fitness magazines is 182, with a variance of 62. Compare the variations.

Solution

The coefficients of variation are

V2
CVar = ?23 - 100% = 3.6% pages

CVar = W622 - 100% = 4.3% advertisements

The number of advertisements is more variable than the number of pages since the
coefficient of variation is larger for advertisements.

Range Rule of Thumb

The range can be used to approximate the standard deviation. The approximation is called
the range rule of thumb.

The Range Rule of Thumb

A rough estimate of the standard deviation is

range
, - range

4

In other words, if the range is divided by 4, an approximate value for the standard
deviation is obtained. For example, the standard deviation for the data set 5, 8, 8, 9, 10,
12, and 13 is 2.7, and the range is 13 — 5 = 8. The range rule of thumb is s = 2. The
range rule of thumb in this case underestimates the standard deviation somewhat; how-
ever, it is in the ballpark.

A note of caution should be mentioned here. The range rule of thumb is only an
approximation and should be used when the distribution of data values is unimodal and
roughly symmetric.

The range rule of thumb can be used to estimate the largest and smallest data values
of a data set. The smallest data value will be approximately 2 standard deviations below
the mean, and the largest data value will be approximately 2 standard deviations above
the mean of the data set. The mean for the previous data set is 9.3; hence,

Smallest data value = X — 25 = 9.3 — 2(2.8) = 3.7

Largest data value = X + 25 = 9.3 + 2(2.8) = 14.9
Notice that the smallest data value was 5, and the largest data value was 13. Again,
these are rough approximations. For many data sets, almost all data values will fall within

2 standard deviations of the mean. Better approximations can be obtained by using
Chebyshev’s theorem and the empirical rule. These are explained next.
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Chebyshev’s Theorem

As stated previously, the variance and standard deviation of a variable can be used to
determine the spread, or dispersion, of a variable. That is, the larger the variance or stan-
dard deviation, the more the data values are dispersed. For example, if two variables
measured in the same units have the same mean, say, 70, and the first variable has a stan-
dard deviation of 1.5 while the second variable has a standard deviation of 10, then the
data for the second variable will be more spread out than the data for the first variable.
Chebyshev's theorem, developed by the Russian mathematician Chebyshev (1821-1894),
specifies the proportions of the spread in terms of the standard deviation.

Chebyshev’s theorem The proportion of values from a data set that will fall within &
standard deviations of the mean will be at least 1 — 1/k?, where k is a number greater
than 1 (k is not necessarily an integer).

This theorem states that at least three-fourths, or 75%, of the data values will fall
within 2 standard deviations of the mean of the data set. This result is found by substi-
tuting £ = 2 in the expression.

1 1 1
1—E or 1__:1_4_1243_1:75%

For the example in which variable 1 has a mean of 70 and a standard deviation of
1.5, at least three-fourths, or 75%, of the data values fall between 67 and 73. These val-
ues are found by adding 2 standard deviations to the mean and subtracting 2 standard
deviations from the mean, as shown:

70 +2(1.5)=70+3 =173
and
70 — 2(1.5) =70 — 3 = 67

For variable 2, at least three-fourths, or 75%, of the data values fall between 50 and 90.
Again, these values are found by adding and subtracting, respectively, 2 standard devia-
tions to and from the mean.

70 + 2(10) = 70 + 20 = 90
and
70 — 2(10) =70 — 20 = 50

Furthermore, the theorem states that at least eight-ninths, or 88.89%, of the data
values will fall within 3 standard deviations of the mean. This result is found by letting
k = 3 and substituting in the expression.

1 1 1 8
I—E or 1—§=1—§=§=88.89%

For variable 1, at least eight-ninths, or 88.89%, of the data values fall between 65.5 and
74.5, since
70 + 3(1.5) = 70 + 4.5 =745
and
70 — 3(1.5) =70 — 4.5 =655
For variable 2, at least eight-ninths, or 88.89%, of the data values fall between 40 and 100.
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I At least |
| 88.89% !

| At least |

I 75% I

-2s X X+2s X+3s

I
I

-3s

This theorem can be applied to any distribution regardless of its shape (see
Figure 3-3).
Examples 3—-27 and 3-28 illustrate the application of Chebyshev’s theorem.

Example 3-27

Prices of Homes

The mean price of houses in a certain neighborhood is $50,000, and the standard
deviation is $10,000. Find the price range for which at least 75% of the houses
will sell.

Solution

Chebyshev’s theorem states that three-fourths, or 75%, of the data values will fall within
2 standard deviations of the mean. Thus,

$50,000 + 2($10,000) = $50,000 + $20,000 = $70,000
and
$50,000 — 2($10,000) = $50,000 — $20,000 = $30,000

Hence, at least 75% of all homes sold in the area will have a price range from $30,000
to $70,000.

Chebyshev’s theorem can be used to find the minimum percentage of data values that
will fall between any two given values. The procedure is shown in Example 3-28.

Example 3—-28

Travel Allowances

A survey of local companies found that the mean amount of travel allowance for executives
was $0.25 per mile. The standard deviation was $0.02. Using Chebyshev’s theorem, find
the minimum percentage of the data values that will fall between $0.20 and $0.30.

3-33



136 Chapter 3 Data Description

The Empirical Rule

3-34

Solution

Step 1

Step 2

Step 3

Subtract the mean from the larger value.
$0.30 — $0.25 = $0.05

Divide the difference by the standard deviation to get k.

005

—m—ZS

Use Chebyshev’s theorem to find the percentage.
1 1 1
2

l—m=l-5a=1-xs

= —_ = 0,
e 75 1 —-0.16 =0.84 or 84%

Hence, at least 84% of the data values will fall between $0.20 and $0.30.

The Empirical (Normal) Rule
Chebyshev’s theorem applies to any distribution regardless of its shape. However, when
a distribution is bell-shaped (or what is called normal), the following statements, which
make up the empirical rule, are true.

Approximately 68% of the data values will fall within 1 standard deviation of
the mean.

Approximately 95% of the data values will fall within 2 standard deviations of
the mean.

Approximately 99.7% of the data values will fall within 3 standard deviations of
the mean.

For example, suppose that the scores on a national achievement exam have a mean of
480 and a standard deviation of 90. If these scores are normally distributed, then approx-
imately 68% will fall between 390 and 570 (480 + 90 = 570 and 480 — 90 = 390).
Approximately 95% of the scores will fall between 300 and 660 (480 + 2 - 90 = 660
and 480 — 2 - 90 = 300). Approximately 99.7% will fall between 210 and 750 (480 +
3-90 = 750 and 480 — 3 - 90 = 210). See Figure 3—4. (The empirical rule is explained
in greater detail in Chapter 6.)

} 99.7% |

| 0
| 95% |

— 68% —

-1s X X+1s  X+25s X+3s

i
I
I

-3s -2s
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Applying the Concepts 3—2

Blood Pressure

The table lists means and standard deviations. The mean is the number before the plus/minus,
and the standard deviation is the number after the plus/minus. The results are from a study
attempting to find the average blood pressure of older adults. Use the results to answer the
questions.

Normotensive Hypertensive
Men Women Men Women
(n = 1200) (n = 1400) (n = 1100) (n = 1300)
Age 5510 55 =10 60 = 10 64 = 10
Blood pressure (mm Hg)
Systolic 123 =9 121 =11 153 = 17 156 £ 20
Diastolic 78 =7 76 =7 91 = 10 88 = 10

1. Apply Chebyshev’s theorem to the systolic blood pressure of normotensive men. At least
how many of the men in the study fall within 1 standard deviation of the mean?

2. At least how many of those men in the study fall within 2 standard deviations of the mean?

Assume that blood pressure is normally distributed among older adults. Answer the following
questions, using the empirical rule instead of Chebyshev’s theorem.

3. Give ranges for the diastolic blood pressure (normotensive and hypertensive) of older
women.

4. Do the normotensive, male, systolic blood pressure ranges overlap with the hypertensive,
male, systolic blood pressure ranges?

See page 180 for the answers.

. What is the relationship between the variance and the For Exercises 7-13, find the range, variance, and standard

standard deviation?

deviation. Assume the data represent samples, and use the
shortcut formula for the unbiased estimator to compute

2. Why might the range not be the best estimate of the variance and standard deviation.

variability?

3. What are the symbols used to represent the population
variance and standard deviation?

7. Police Calls in Schools The number of incidents in
which police were needed for a sample of 10 schools in
Allegheny County is 7, 37, 3, 8, 48, 11, 6, 0, 10, 3. Are
the data consistent or do they vary? Explain your

4. What are the symbols used to represent the sample answer.
variance and standard deviation? Source: U.S. Department of Education.
5. Why is the unbiased estimator of variance used? 8. Cigarette Taxes The increases (in cents) in

6. The three data sets have the same mean and range,

but is the variation the same? Prove your answer by
computing the standard deviation. Assume the data were
obtained from samples.

a 5,7,9,11,13,15,17

cigarette taxes for 17 states in a 6-month period are

60, 20, 40, 40, 45, 12, 34, 51, 30, 70, 42, 31, 69, 32,
8,18, 50
Use the range rule of thumb to estimate the standard

deviation. Compare the estimate to the actual standard
deviation.

b. 5,6,7,11,15,16,17
c 555 11.17.17.17 Source: Federation of Tax Administrators.
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9. Precipitation and High Temperatures The normal
daily high temperatures (in degrees Fahrenheit) in
January for 10 selected cities are as follows.

50,37, 29, 54, 30, 61, 47, 38, 34, 61

The normal monthly precipitation (in inches) for these
same 10 cities is listed here.

48,26,1.5,18,1.8,3.3,5.1,1.1,1.8,2.5
Which set is more variable?

Source: New York Times Almanac.

10. Size of U.S. States The total surface area (in square
miles) for each of six selected Eastern states is listed here.

28,995 PA 37,534 FL
31,361 NY 27,087 VA
20,966 ME 37,741 GA

The total surface area for each of six selected Western
states is listed (in square miles).

72,964 AZ 70,763 NV
101,510 CA 62,161 OR
66,625 CcO 54,339 UT

Which set is more variable?

Source: New York Times Almanac.

11. Stories in the Tallest Buildings The number of

stories in the 13 tallest buildings for two different
cities is listed below. Which set of data is more
variable?

Houston: 75, 71, 64, 56, 53, 55, 47, 55, 52, 50, 50, 50, 47
Pittsburgh: 64, 54, 40, 32, 46, 44, 42, 41, 40, 40, 34, 32, 30

Source: World Almanac.

12. Starting Teachers’ Salaries Starting teacher

salaries (in equivalent U.S. dollars) for upper
secondary education in selected countries are listed
below. Which set of data is more variable? (The U.S.
average starting salary at this time was $29,641.)

Europe Asia

Sweden $48,704 Korea $26,852
Germany 41,441 Japan 23,493
Spain 32,679 India 18,247
Finland 32,136 Malaysia 13,647
Denmark 30,384 Philippines 9,857
Netherlands 29,326 Thailand 5,862
Scotland 27,789

Source: World Almanac.

13. The average age of U.S. astronaut candidates in the past
has been 34, but candidates have ranged in age from 26
to 46. Use the range rule of thumb to estimate the
standard deviation of the applicants’ ages.

Source: www.nasa.gov

14. Home Runs Find the range, variance, and standard
deviation for the distances of the home runs for
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McGwire and Sosa, using the data in Exercise 18 in
Section 2—1. Compare the ranges and standard
deviations. Decide which is more variable or if the
variability is about the same. (Use individual data.)

15. Use the data for Exercise 11 in Section 3—1. Find the
range, variance, and standard deviation for each set of
data. Which set of data is more variable?

16. Deficient Bridges in U.S. States The Federal

Highway Administration reported the number of
deficient bridges in each state. Find the range, variance,
and standard deviation.

15,458 1,055 5,008 3,598 8,984
1,337 4,132 10,618 17,361 6,081
6,482 25,090 12,681 16,286 18,832

12,470 17,842 16,601 4,587 47,196

23,205 25,213 23,017 27,768 2,686
7,768 25,825 4,962 22,704 2,694
4,131 13,144 15,582 7,279 12,613

810 13,350 1,208 22,242 7,477

10,902 2,343 2,333 2,979 6,578

14,318 4,773 6,252 734 13,220

Source: USA TODAY.

17. Find the range, variance, and standard deviation for the
data in Exercise 17 of Section 2—1.

For Exercises 18 through 27, find the variance and
standard deviation.

18. Baseball Team Batting Averages Team batting
averages for major league baseball in 2005 are
represented below. Find the variance and standard
deviation for each league. Compare the results.

NL AL
0.252-0.256 4 0.256-0.261 2
0.257-0.261 6 0.262-0.267 5
0.262-0.266 1 0.268-0.273 4
0.267-0.271 4 0.274-0.279 2
0.272-0.276 1 0.280-0.285 1

Source: World Almanac.

19. Cost per Load of Laundry Detergents The costs per
load (in cents) of 35 laundry detergents tested by a
consumer organization are shown here.

Class limits Frequency
13-19 2
20-26 7
27-33 12
34-40 5
4147 6
48-54 1
55-61 0
62-68 2


www.nasa.gov

20.

21.

22,

23.

24,

Automotive Fuel Efficiency Thirty automobiles were
tested for fuel efficiency (in miles per gallon). This
frequency distribution was obtained.

Class boundaries Frequency
7.5-12.5 3
12.5-17.5 5
17.5-22.5 15
22.5-27.5 5
27.5-32.5 2

Murders in Cities The data show the number of
murders in 25 selected cities.

Class limits Frequency
34-96 13
97-159 2
160-222 0

223-285 5
286-348 1
349411 1
412-474 0
475-537 1
538-600 2

Reaction Times In a study of reaction times to a specific
stimulus, a psychologist recorded these data (in seconds).
Class limits Frequency

2.1-2.7 12

2834 13

3.54.1 7

42438 5

4.9-5.5 2

5.6-6.2 1

Lightbulb Lifetimes Eighty randomly selected
lightbulbs were tested to determine their lifetimes
(in hours). This frequency distribution was obtained.

Class boundaries Frequency
52.5-63.5 6
63.5-74.5 12
74.5-85.5 25
85.5-96.5 18
96.5-107.5 14

107.5-118.5 5

Murder Rates The data represent the murder rate per
100,000 individuals in a sample of selected cities in the
United States.

Class Frequency
5-11 8
12-18 5
19-25 7
26-32 1
33-39 1
40-46 3

Source: FBI and U.S. Census Bureau.

25.

26.

27.

28.

29.
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Battery Lives Eighty randomly selected batteries were
tested to determine their lifetimes (in hours). The
following frequency distribution was obtained.

Class boundaries Frequency
62.5-73.5 5
73.5-84.5 14
84.5-95.5 18
95.5-106.5 25

106.5-117.5 12
117.5-128.5 6

Can it be concluded that the lifetimes of these brands of
batteries are consistent?

Find the variance and standard deviation for the two
distributions in Exercises 8 and 18 in Section 2-2.
Compare the variation of the data sets. Decide if one
data set is more variable than the other.

Word Processor Repairs This frequency distribution
represents the data obtained from a sample of word
processor repairers. The values are the days between
service calls on 80 machines.

Class boundaries Frequency
25.5-28.5 5
28.5-31.5 9
31.5-34.5 32
34.5-37.5 20
37.5-40.5 12
40.5-43.5 2

Exam Scores The average score of the students in one
calculus class is 110, with a standard deviation of 5; the
average score of students in a statistics class is 106, with
a standard deviation of 4. Which class is more variable in
terms of scores?

Suspension Bridges The lengths (in feet) of the main
span of the longest suspension bridges in the United
States and the rest of the world are shown below. Which
set of data is more variable?

United States: 4205, 4200, 3800, 3500, 3478, 2800, 2800, 2310
World: 6570, 5538, 5328, 4888, 4626, 4544, 4518, 3970

30.

31.

Source: World Almanac.

Exam Scores The average score on an English final
examination was 85, with a standard deviation of 5;
the average score on a history final exam was 110,
with a standard deviation of 8. Which class was more
variable?

Ages of Accountants The average age of the
accountants at Three Rivers Corp. is 26 years,

with a standard deviation of 6 years; the average
salary of the accountants is $31,000, with a standard
deviation of $4000. Compare the variations of age
and income.
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32.

33.

34.

35.

36.

37.

Chapter 3 Data Description

Using Chebyshev’s theorem, solve these problems
for a distribution with a mean of 80 and a standard
deviation of 10.

a. At least what percentage of values will fall between
60 and 100?

b. At least what percentage of values will fall between
65 and 95?

The mean of a distribution is 20 and the standard
deviation is 2. Use Chebyshev’s theorem.

a. At least what percentage of the values will fall
between 10 and 30?

b. At least what percentage of the values will fall
between 12 and 28?

In a distribution of 160 values with a mean of 72, at
least 120 fall within the interval 67-77. Approximately
what percentage of values should fall in the interval
62—82? Use Chebyshev’s theorem.

Calories The average number of calories in a regular-
size bagel is 240. If the standard deviation is 38 calories,
find the range in which at least 75% of the data will lie.
Use Chebyshev’s theorem.

Time Spent Online Americans spend an average of
3 hours per day online. If the standard deviation is
32 minutes, find the range in which at least 88.89%
of the data will lie. Use Chebyshev’s theorem.

Source: www.cs.cmu.edu

Solid Waste Production The average college student
produces 640 pounds of solid waste each year including
500 disposable cups and 320 pounds of paper. If the
standard deviation is approximately 85 pounds, within
what weight limits will at least 88.89% of all students’
garbage lie?

Source: Environmental Sustainability Committee, www.esc.mtu.edu

Extending the Concepts

43. Serum Cholesterol Levels For this data set,
find the mean and standard deviation of the variable.
The data represent the serum cholesterol levels of
30 individuals. Count the number of data values that
fall within 2 standard deviations of the mean. Compare
this with the number obtained from Chebyshev’s
theorem. Comment on the answer.

211 240 255 219 204
200 212 193 187 205
256 203 210 221 249
231 212 236 204 187
201 247 206 187 200
237 227 221 192 196
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38.

39.

40.

41.

42.

Sale Price of Homes The average sale price of new
one-family houses in the United States for 2003 was
$246,300. Find the range of values in which at least
75% of the sale prices will lie if the standard deviation
is $48,500.

Source: New York Times Almanac.

Trials to Learn a Maze The average of the number of
trials it took a sample of mice to learn to traverse a maze
was 12. The standard deviation was 3. Using Chebyshev’s
theorem, find the minimum percentage of data values that
will fall in the range of 4 to 20 trials.

Farm Sizes The average farm in the United States in
2004 contained 443 acres. The standard deviation is
42 acres. Use Chebyshev’s theorem to find the
minimum percentage of data values that will fall in
the range of 338—548 acres.

Source: World Almanac.

Citrus Fruit Consumption The average U.S. yearly
per capita consumption of citrus fruit is 26.8 pounds.
Suppose that the distribution of fruit amounts consumed
is bell-shaped with a standard deviation equal to

4.2 pounds. What percentage of Americans would

you expect to consume more than 31 pounds of citrus
fruit per year?

Source: USDA/Economic Research Service.

Work Hours for College Faculty The average full-time
faculty member in a post-secondary degree-granting
institution works an average of 53 hours per week.

a. If we assume the standard deviation is 2.8 hours,
what percentage of faculty members work more
than 58.6 hours a week?

b. If we assume a bell-shaped distribution, what
percentage of faculty members work more than
58.6 hours a week?

Source: National Center for Education Statistics.

44. Ages of Consumers For this data set, find the
mean and standard deviation of the variable. The data
represent the ages of 30 customers who ordered a product
advertised on television. Count the number of data
values that fall within 2 standard deviations of the mean.
Compare this with the number obtained from Chebyshev’s
theorem. Comment on the answer.

42 44 62 35 20
30 56 20 23 41
55 22 31 27 66
21 18 24 42 25
32 50 31 26 36
39 40 18 36 22


www.cs.cmu.edu
www.esc.mtu.edu

4s.

46.

Using Chebyshev’s theorem, complete the table to find

the minimum percentage of data values that fall within

k standard deviations of the mean.

k | 15 2 25 3

Percent |

Use this data set: 10, 20, 30, 40, 50

a. Find the standard deviation.

b. Add 5 to each value, and then find the standard
deviation.

c. Subtract 5 from each value and find the standard
deviation.

d. Multiply each value by 5 and find the standard
deviation.

e. Divide each value by 5 and find the standard

deviation.

Generalize the results of parts b through e.

g.  Compare these results with those in Exercise 38 of
Exercises 3—1.

3.5

o 47. The mean deviation is found by using this formula:

- SIX - X
Mean deviation = %
where
X = value
X = mean

n = number of values
| | = absolute value

48.

49.
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Find the mean deviation for these data.
5,9,10, 11, 11, 12, 15, 18, 20, 22
A measure to determine the skewness of a distribution is

called the Pearson coefficient of skewness. The formula is

3(X — MD)
S

Skewness =

The values of the coefficient usually range from —3 to
+3. When the distribution is symmetric, the coefficient
is zero; when the distribution is positively skewed, it is
positive; and when the distribution is negatively
skewed, it is negative.

Using the formula, find the coefficient of skewness
for each distribution, and describe the shape of the
distribution.

a. Mean = 10, median = 8, standard deviation = 3.
b. Mean = 42, median = 45, standard deviation = 4.
c¢. Mean = 18.6, median = 18.6, standard

deviation = 1.5.
d. Mean = 98, median = 97.6, standard deviation = 4.

All values of a data set must be within s\/n — 1 of the
mean. If a person collected 25 data values that had a
mean of 50 and a standard deviation of 3 and you

saw that one data value was 67, what would you
conclude?

Step by Step ' _

Excel
Step by Step

Example XL3-2

1.2 119 120 128

AW N =

worksheet directly.

1
?
3
4
5
6
7
R
9

Finding Measures of Variation

sales (in millions $)

Find the variance, standard deviation, and range of the data from Example 3-23. The data
represent the amount (in millions of dollars) of European auto sales for a sample of 6 years.

13.4
. On an Excel worksheet enter the data in cells A2—A7. Enter a label for the variable in cell A1.
. For the sample variance, enter =VAR(A2:A7).

. For the sample standard deviation, enter =STDEV(A2:A7).

. For the range, compute the difference between the maximum and the minimum values by
entering =MAX(A2:A7) — MIN(A2:A7).

These and other statistical functions can also be accessed without typing them into the

14.3

2. Select the Statistical category for statistical functions.
3. Scroll to find the appropriate function and click [OK].

A B & [

1.2/6 variance

11.2 11296027 standard deviation

119
12

128

134 4]

14.3

3.1 range
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Objective [E}]
Identify the position of
a data value in a data
set, using various
measures of position,
such as percentiles,
deciles, and quartiles.

Measures of Position

In addition to measures of central tendency and measures of variation, there are measures
of position or location. These measures include standard scores, percentiles, deciles, and
quartiles. They are used to locate the relative position of a data value in the data set. For
example, if a value is located at the 80th percentile, it means that 80% of the values fall
below it in the distribution and 20% of the values fall above it. The median is the value
that corresponds to the 50th percentile, since one-half of the values fall below it and one-
half of the values fall above it. This section discusses these measures of position.

Standard Scores

There is an old saying, “You can’t compare apples and oranges.” But with the use of
statistics, it can be done to some extent. Suppose that a student scored 90 on a music test
and 45 on an English exam. Direct comparison of raw scores is impossible, since the
exams might not be equivalent in terms of number of questions, value of each question,
and so on. However, a comparison of a relative standard similar to both can be made.
This comparison uses the mean and standard deviation and is called a standard score or
z score. (We also use z scores in later chapters.)

A standard score or z score tells how many standard deviations a data value is above
or below the mean for a specific distribution of values. If a standard score is zero, then
the data value is the same as the mean.

A z score or standard score for a value is obtained by subtracting the mean from the
value and dividing the result by the standard deviation. The symbol for a standard score
is z. The formula is
S value — mean
standard deviation

For samples, the formula is
CX-X
s

z

For populations, the formula is
X —
z=A—E
(o

The z score represents the number of standard deviations that a data value falls above or
below the mean.

For the purpose of this section, it will be assumed that when we find z scores, the
data were obtained from samples.

Example 3-29

mi:;m

The average number

of faces that a person
learns to recognize and
remember during his or
her lifetime is 10,000.

3-40

Test Scores

A student scored 65 on a calculus test that had a mean of 50 and a standard deviation

of 10; she scored 30 on a history test with a mean of 25 and a standard deviation of 5.

Compare her relative positions on the two tests.

Solution

First, find the z scores. For calculus the z score is

X—-X_ 65-50
s 10

1.5

z
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For history the z score is

30 — 25
7= ————=

1.0
5

Since the z score for calculus is larger, her relative position in the calculus class is
higher than her relative position in the history class.

Note that if the z score is positive, the score is above the mean. If the z score is 0, the
score is the same as the mean. And if the z score is negative, the score is below the mean.

Example 3-30

Test Scores

Find the z score for each test, and state which is higher.

TestA | X=38 X =40 s=35

TestB | X=94 X=100 s=10
Solution
For test A,

Z:X—X:38—4O:_0‘4

N 5
For test B,
94 — 100
Z—T—_O.6

The score for test A is relatively higher than the score for test B.

When all data for a variable are transformed into z scores, the resulting distribution
will have a mean of 0 and a standard deviation of 1. A z score, then, is actually the num-
ber of standard deviations each value is from the mean for a specific distribution. In
Example 3-29, the calculus score of 65 was actually 1.5 standard deviations above the
mean of 50. This will be explained in greater detail in Chapter 6.

Percentiles

Percentiles are position measures used in educational and health-related fields to indicate
the position of an individual in a group.

Percentiles divide the data set into 100 equal groups.

In many situations, the graphs and tables showing the percentiles for various mea-
sures such as test scores, heights, or weights have already been completed. Table 3-3
shows the percentile ranks for scaled scores on the Test of English as a Foreign Lan-
guage. If a student had a scaled score of 58 for section 1 (listening and comprehension),
that student would have a percentile rank of 81. Hence, that student did better than 81%
of the students who took section 1 of the exam.

3-41
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niere no ' A

The highest recorded
temperature on earth
was 136°F in Libya

in 1922, The lowest
recorded temperature
on earth was —129°F
in Antarctica in 1983.

3-42

3-3  Percentile Ranks and Scaled Scores on the Test of English

as a Foreign Language*®

Section 2: Section 3:
Section 1: Structure Vocabulary Total
Scaled Listening and written and reading scaled Percentile
score comprehension expression comprehension score rank
68 99 98
66 98 96 98 660 99
64 96 94 96 640 97
62 92 90 93 620 94
60 87 84 88 600 89
—58 81 76 81 580 82
56 73 68 72 560 73
54 64 58 61 540 62
52 54 48 50 520 50
50 42 38 40 500 39
48 32 29 30 480 29
46 22 21 23 460 20
44 14 15 16 440 13
42 9 10 11 420 9
40 5 7 8 400 5
38 3 4 5 380 3
36 2 3 3 360 1
34 1 2 2 340 1
32 1 1 320
30 1 1 300
Mean 51.5 52.2 51.4 517 Mean
S.D. 7.1 7.9 7.5 68 S.D.

*Based on the total group of 1,178,193 examinees tested from July 1989 through June 1991.

Source: Reprinted by permission of Educational Testing Service, the copyright owner.

Figure 3—5 shows percentiles in graphical form of weights of girls from ages 2 to 18.
To find the percentile rank of an 11-year-old who weighs 82 pounds, start at the 82-pound
weight on the left axis and move horizontally to the right. Find 11 on the horizontal axis
and move up vertically. The two lines meet at the 50th percentile curved line; hence, an
11-year-old girl who weighs 82 pounds is in the 50th percentile for her age group. If the
lines do not meet exactly on one of the curved percentile lines, then the percentile rank
must be approximated.

Percentiles are also used to compare an individual’s test score with the national
norm. For example, tests such as the National Educational Development Test (NEDT) are
taken by students in ninth or tenth grade. A student’s scores are compared with those of
other students locally and nationally by using percentile ranks. A similar test for elemen-
tary school students is called the California Achievement Test.

Percentiles are not the same as percentages. That is, if a student gets 72 correct
answers out of a possible 100, she obtains a percentage score of 72. There is no indication
of her position with respect to the rest of the class. She could have scored the highest, the
lowest, or somewhere in between. On the other hand, if a raw score of 72 corresponds to
the 64th percentile, then she did better than 64% of the students in her class.
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[P — 90
b S i
Weights of Girls by 190
Age and Percentile 95th 1
Rankings 180 > L 80
Source: Distributed by Mead 4 -
Johnson Nutritional Division. 170
Reprinted with permission.
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Percentiles are symbolized by
PP, Py, ..., Py

and divide the distribution into 100 groups.

Smallest Largest
data data
value P1 P2 P3 P‘37 P98 ng value
: L L L Y ° ° : L L ]

1% 1% 1% 1% 1% 1%

Percentile graphs can be constructed as shown in Example 3-31. Percentile graphs use

the same values as the cumulative relative frequency graphs described in Section 2-2,
except that the proportions have been converted to percents.

3-43
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3-44

Systolic Blood Pressure

The frequency distribution for the systolic blood pressure readings (in millimeters of
mercury, mm Hg) of 200 randomly selected college students is shown here. Construct
a percentile graph.

A B C D
Class Cumulative Cumulative

boundaries Frequency frequency percent
89.5-104.5 24
104.5-119.5 62
119.5-134.5 72
134.5-149.5 26
149.5-164.5 12
164.5-179.5 4
200

Solution

Step 1 Find the cumulative frequencies and place them in column C.

Step 2 Find the cumulative percentages and place them in column D. To do this step,
use the formula

lative fi
cumula 1Vf; requency . no.

Cumulative % =

For the first class,

Cumulative % = 24 - 100% = 12%
200

The completed table is shown here.

A B C D
Class Cumulative Cumulative

boundaries Frequency frequency percent
89.5-104.5 24 24 12
104.5-119.5 62 86 43
119.5-134.5 72 158 79
134.5-149.5 26 184 92
149.5-164.5 12 196 98
164.5-179.5 4 200 100

200

Step 3 Graph the data, using class boundaries for the x axis and the percentages for
the y axis, as shown in Figure 3—6.

Once a percentile graph has been constructed, one can find the approximate corre-
sponding percentile ranks for given blood pressure values and find approximate blood
pressure values for given percentile ranks.

For example, to find the percentile rank of a blood pressure reading of 130, find
130 on the x axis of Figure 3—6, and draw a vertical line to the graph. Then move hori-
zontally to the value on the y axis. Note that a blood pressure of 130 corresponds to
approximately the 70th percentile.

If the value that corresponds to the 40th percentile is desired, start on the y axis at
40 and draw a horizontal line to the graph. Then draw a vertical line to the x axis and read
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100

80 1
70

60 T
50 T
40
30 1

Cumulative percentages

20 +
10 1

89.5 104.5 119.5 134.5 149.5 164.5
Class boundaries

179.5

the value. In Figure 36, the 40th percentile corresponds to a value of approximately 118.
Thus, if a person has a blood pressure of 118, he or she is at the 40th percentile.

Finding values and the corresponding percentile ranks by using a graph yields only
approximate answers. Several mathematical methods exist for computing percentiles for
data. These methods can be used to find the approximate percentile rank of a data value
or to find a data value corresponding to a given percentile. When the data set is large
(100 or more), these methods yield better results. Examples 3—32 through 3-35 show

these methods.

Percentile Formula

The percentile corresponding to a given value X is computed by using the following formula:

+ 0.
Percentile — (number of values below X) + 0.5 . 100%
total number of values

Test Scores

o A teacher gives a 20-point test to 10 students. The scores are shown here. Find

the percentile rank of a score of 12.
18,15,12,6,8, 2,3, 5,20, 10

Solution

Arrange the data in order from lowest to highest.
2,3,5,6,8,10,12, 15, 18, 20
Then substitute into the formula.

fval low X) + 0.
Percentile — (number of values below X) + 0.5 . 100%
total number of values

Since there are six values below a score of 12, the solution is
6+ 0.5

Percentile = - 100% = 65th percentile

Thus, a student whose score was 12 did better than 65% of the class.
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Note: One assumes that a score of 12 in Example 3-32, for instance, means theoret-
ically any value between 11.5 and 12.5.

Using the data in Example 3-32, find the percentile rank for a score of 6.

Solution
There are three values below 6. Thus

3+05
10

Percentile = - 100% = 35th percentile

A student who scored 6 did better than 35% of the class.

Examples 3-34 amd 3-35 show a procedure for finding a value corresponding to a
given percentile.

Example 3-34 Test Scores

Using the scores in Example 3-32, find the value corresponding to the 25th percentile.

Solution

Step 1 Arrange the data in order from lowest to highest.
2,3,5,6,8,10,12, 15, 18, 20

Step2 Compute

_n-p
“~ 700
where

n = total number of values
p = percentile

Thus,
_10-25

c= 100 2.5

Step 3 If ¢ is not a whole number, round it up to the next whole number; in this case,
¢ = 3. (If ¢ is a whole number, see Example 3—35.) Start at the lowest value
and count over to the third value, which is 5. Hence, the value 5 corresponds
to the 25th percentile.

m Using the data set in Example 3-32, find the value that corresponds to the 60th percentile.

Solution

Step 1 Arrange the data in order from smallest to largest.
2,3,5,6,8,10,12, 15, 18, 20
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Step 2 Substitute in the formula.

=n~p=10~60=
“7 700 " 100

Step 3 If ¢ is a whole number, use the value halfway between the ¢ and ¢ + 1 values
when counting up from the lowest value—in this case, the 6th and 7th values.

2,3,5,6,8,10,12, 15, 18, 20
7N
6th value 7th value

The value halfway between 10 and 12 is 11. Find it by adding the two values and

dividing by 2.
10 + 12
=1

Hence, 11 corresponds to the 60th percentile. Anyone scoring 11 would have
done better than 60% of the class.

The steps for finding a value corresponding to a given percentile are summarized in
this Procedure Table.

Procedure Table

Finding a Data Value Corresponding to a Given Percentile

Step 1  Arrange the data in order from lowest to highest.

Step 2  Substitute into the formula

_n-p
100

where
n = total number of values
p = percentile

@

Step 3A If ¢ is not a whole number, round up to the next whole number. Starting at the
lowest value, count over to the number that corresponds to the rounded-up value.

Step 3B If c is a whole number, use the value halfway between the cth and (¢ + 1)st values
when counting up from the lowest value.

Quartiles and Deciles
Quartiles divide the distribution into four groups, separated by Q,, O,, O-.

Note that O, is the same as the 25th percentile; O, is the same as the 50th percentile,
or the median; Q5 corresponds to the 75th percentile, as shown:

Smallest Largest
data MD data
value & G Qs value
25% 25% 25% 25%
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Example 3-36 o Find Q,, O,, and Q, for the data set 15, 13, 6, 5, 12, 50, 22, 18.

Solution

3-48
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Quartiles can be computed by using the formula given for computing percentiles on
page 148. For O, use p = 25. For O, use p = 50. For O, use p = 75. However, an easier

method for finding quartiles is found in this Procedure Table.

Procedure Table

Finding Data Values Corresponding to &,, Q,, and 4,

Step 1
Step 2
Step 3
Step 4

Example 3-36 shows how to find the values of Q,, O,, and Q;.

Arrange the data in order from lowest to highest.

Find the median of the data values. This is the value for Q,.
Find the median of the data values that fall below Q,. This is the value for Q,.
Find the median of the data values that fall above Q,. This is the value for Q.

Step 1

Step 2

Step 3

Step 4

Arrange the data in order.

5,6,12,13, 15, 18,22, 50

Find the median (Q,).
5,6,12,13, 15, 18,22, 50
T
MD
MD = 13+15 _ 14
2
Find the median of the data values less than 14.
5,6,12,13
T
o
6+ 12
0,="5"=9
So O, is 9.
Find the median of the data values greater than 14.
15, 18,22, 50
T
0s
_18+22

0; 2 20

Here O, is 20. Hence, O, = 9, O, = 14, and O, = 20.
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In addition to dividing the data set into four groups, quartiles can be used as a rough
measurement of variability. The interquartile range (IQR) is defined as the difference
between O, and Q; and is the range of the middle 50% of the data.

The interquartile range is used to identify outliers, and it is also used as a measure of
variability in exploratory data analysis, as shown in Section 3—4.

Deciles divide the distribution into 10 groups, as shown. They are denoted by D,,
D,, etc.

Smallest Largest
data data
value D D, Dy Dy Dy Dy Dy Dy Dy value

10% 10% 10% 10% 10% 10% 10% 10% 10% 10%

Note that D, corresponds to P,,; D, corresponds to P,; etc. Deciles can be found by
using the formulas given for percentiles. Taken altogether then, these are the relation-
ships among percentiles, deciles, and quartiles.

Deciles are denoted by D,, D,, D5, . . ., D,, and they correspond to
Pyg, Py, Pyg, - . -, Poy.

Quartiles are denoted by Q,, O,, O, and they correspond to P,s, Py, Ps.
The median is the same as P, or O, or Ds.

The position measures are summarized in Table 3—4.

3-4  Summary of Position Measures

Measure Definition Symbol(s)

Standard score Number of standard deviations that a data value is z

or z score above or below the mean

Percentile Position in hundredths that a data value holds in P,

the distribution

Decile Position in tenths that a data value holds in the distribution D,

Quartile Position in fourths that a data value holds in the distribution 0,
Outliers

A data set should be checked for extremely high or extremely low values. These values
are called outliers.

An outlier is an extremely high or an extremely low data value when compared with the
rest of the data values.

An outlier can strongly affect the mean and standard deviation of a variable. For
example, suppose a researcher mistakenly recorded an extremely high data value. This
value would then make the mean and standard deviation of the variable much larger than
they really were. Outliers can have an effect on other statistics as well.

There are several ways to check a data set for outliers. One method is shown in this
Procedure Table.
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Procedure Table

Procedure for Identifying Outliers
Step 1

Step 2
Step 3
Step 4
Step 5

Arrange the data in order and find O, and Q;.

Find the interquartile range: IQR = O; — O,.

Multiply the IQR by 1.5.

Subtract the value obtained in step 3 from O, and add the value to O;.

Check the data set for any data value that is smaller than O, — 1.5(IQR)
or larger than Q5 + 1.5(IQR).

This procedure is shown in Example 3-37.

Example 3-37 o Check the following data set for outliers.

3-50

Solution

5,6,12,13, 15, 18, 22, 50

The data value 50 is extremely suspect. These are the steps in checking for an outlier.

Step 1
Step 2

Step 3

Step 4

Step 5

Find Q, and Q;. This was done in Example 3-36; O, is 9 and Q; is 20.
Find the interquartile range (IQR), which is O; — O,.
IQR=0,—0,=20—-9=11

Multiply this value by 1.5.

1.5(11) = 16.5

Subtract the value obtained in step 3 from Q,, and add the value obtained in
step 3 to 0.

9—-165=-75 and 20 + 16.5 = 36.5

Check the data set for any data values that fall outside the interval from —7.5
to 36.5. The value 50 is outside this interval; hence, it can be considered an
outlier.

There are several reasons why outliers may occur. First, the data value may have
resulted from a measurement or observational error. Perhaps the researcher measured the
variable incorrectly. Second, the data value may have resulted from a recording error.
That is, it may have been written or typed incorrectly. Third, the data value may have
been obtained from a subject that is not in the defined population. For example, suppose
test scores were obtained from a seventh-grade class, but a student in that class was
actually in the sixth grade and had special permission to attend the class. This student
might have scored extremely low on that particular exam on that day. Fourth, the data
value might be a legitimate value that occurred by chance (although the probability is
extremely small).
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There are no hard-and-fast rules on what to do with outliers, nor is there complete
agreement among statisticians on ways to identify them. Obviously, if they occurred as a
result of an error, an attempt should be made to correct the error or else the data value
should be omitted entirely. When they occur naturally by chance, the statistician must
make a decision about whether to include them in the data set.

When a distribution is normal or bell-shaped, data values that are beyond 3 standard
deviations of the mean can be considered suspected outliers.

Applying the Concepts 3=3

Determining Dosages

In an attempt to determine necessary dosages of a new drug (HDL) used to control sepsis,
assume you administer varying amounts of HDL to 40 mice. You create four groups and label
them low dosage, moderate dosage, large dosage, and very large dosage. The dosages also
vary within each group. After the mice are injected with the HDL and the sepsis bacteria, the
time until the onset of sepsis is recorded. Your job as a statistician is to effectively
communicate the results of the study.

1. Which measures of position could be used to help describe the data results?

2. If 40% of the mice in the top quartile survived after the injection, how many mice would
that be?

3. What information can be given from using percentiles?
4. What information can be given from using quartiles?
5. What information can be given from using standard scores?

See page 180 for the answers.

. What is a z score?

2. Define percentile rank.

3. What is the difference between a percentage and a

percentile?

4. Define quartile.

5. What is the relationship between quartiles and

percentiles?

6. What is a decile?

7. How are deciles related to percentiles? 11.

Canada 26 days
Italy 42 days
United States 13 days

Source: www.infoplease.com

10. Age of Senators The average age of senators in
the 108th Congress was 59.5 years. If the standard
deviation was 11.5 years, find the z scores
corresponding to the oldest and youngest senators:
Robert C. Byrd (D, WV), 86, and John Sununu
(R, NH), 40.

Source: CRS Report for Congress.

Exam Scores A final examination for a psychology
course has a mean of 84 and a standard deviation of 4.

8. To which percentile, quartile, and decile does the
median correspond?

9. Vacation Days If the average number of vacation
days for a selection of various countries has a mean
0f 29.4 days and a standard deviation of 8.6, find the
z scores for the average number of vacation days in
each of these countries.

12.

Find the corresponding z score for each raw score.

a. 87 d. 76
b. 79 e. 82
c. 93

Teacher’s Salary The average teacher’s salary in a
particular state is $54,166. If the standard deviation is
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13.

14.

15.

16.

17.

18.
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$10,200, find the salaries corresponding to the
following z scores.

a. 2 d 25
b. —1 e. —1.6
c. 0

Which has a better relative position: a score of 75 on a
statistics test with a mean of 60 and a standard deviation
of 10 or a score of 36 on an accounting test with a mean
of 30 and a variance of 16?

Test Scores A student scores 60 on a mathematics test
that has a mean of 54 and a standard deviation of 3, and
she scores 80 on a history test with a mean of 75 and a
standard deviation of 2. On which test did she perform
better?

Which score indicates the highest relative position?

a. Ascore of 3.2 on a test with X = 4.6 and
s=1.5

b. A score of 630 on a test with X = 800 and
s =200

¢. Ascore of 43 on a test with X = 50 and s = 5

College Room and Board Costs Room and board
costs for selected schools are summarized in this
distribution. Find the approximate cost of room and
board corresponding to each of the following
percentiles.

Costs (in dollars) Frequency
3000.5-4000.5 5
4000.5-5000.5 6
5000.5-6000.5 18
6000.5-7000.5 24
7000.5-8000.5 19
8000.5-9000.5 8
9000.5-10,000.5 5
a. 30th percentile

b. 50th percentile

c. 75th percentile

d. 90th percentile

Source: World Almanac.

Using the data in Exercise 16, find the approximate
percentile rank of each of the following costs.

a. 5500

b. 7200
c. 6500
d. 8300

Achievement Test Scores (ans) The data shown
represent the scores on a national achievement test for a
group of 10th-grade students. Find the approximate
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19.

20.

21.

percentile ranks of these scores by constructing a
percentile graph.

a. 220 d. 280
b. 245 e. 300
c. 276

Score Frequency
196.5-217.5 5
217.5-238.5 17
238.5-259.5 22
259.5-280.5 48
280.5-301.5 22
301.5-322.5 6

For the data in Exercise 18, find the approximate scores
that correspond to these percentiles.

a. 15th d. 65th
b. 29th e. 80th
c. 43rd

Airplane Speeds (ans) The airborne speeds in miles
per hour of 21 planes are shown. Find the approximate
values that correspond to the given percentiles by
constructing a percentile graph.

Class Frequency
366-386 4
387407 2
408428 3
429449 2
450-470 1
471491 2
492-512 3
513-533 4

21
Source: The World Almanac and Book of Facts.
a. 9th d. 60th
b. 20th e. 75th
c. 45th

Using the data in Exercise 20, find the approximate
percentile ranks of the following miles per hour (mph).

a. 380 mph d. 505 mph
b. 425 mph e. 525 mph
c. 455 mph

22. Average Weekly Earnings The average weekly
earnings in dollars for various industries are listed

below. Find the percentile rank of each value.

23.

804 736 659 489 777 623 597 524 228

Source: New York Times Almanac.

For the data from Exercise 22, what value corresponds
to the 40th percentile?



25.

26.

27.

29.

24. Test Scores Find the percentile rank for each test
score in the data set.

12, 28, 35, 42, 47, 49, 50

In Exercise 24, what value corresponds to the 60th
percentile?

Hurricane Damage Find the percentile rank for
each value in the data set. The data represent the values
in billions of dollars of the damage of 10 hurricanes.

1.1,1.7,19,2.1,2.2,2.5,3.3,6.2,6.8,20.3

Source: Insurance Services Office.

What value in Exercise 26 corresponds to the 40th
percentile?

28. Test Scores Find the percentile rank for each test
score in the data set.

5,12, 15, 16, 20, 21

What test score in Exercise 28 corresponds to the 33rd
percentile?

e RS SR
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30. Using the procedure shown in Example 3-37,
check each data set for outliers.

16, 18,22, 19, 3,21, 17, 20

24,32,54,31, 16, 18, 19, 14, 17, 20

321, 343, 350, 327, 200

88, 72,97, 84, 86, 85, 100

145, 119, 122, 118, 125, 116

14, 16, 27, 18, 13, 19, 36, 15, 20

31. Another measure of average is called the

midquartile; it is the numerical value halfway
between O, and Q,, and the formula is

+
Midquartile = %
Using this formula and other formulas, find Q,, O,,

05, the midquartile, and the interquartile range for each
data set.

a. 5,12,16,25,32,38
b. 53,62,78,94, 96,99, 103

Step by Step =

MINITAB
Step by Step

Example MT3-1

Help

Calculate Descriptive Statistics from Data

1. Enter the data from Example 3-23 into C1 of MINITAB. Name the column AutoSales.
2. Select Stat>Basic Statistics>Display Descriptive Statistics.

3. The cursor will be blinking in the Variables text box. Double-click C1 AutoSales.

4. Click [Statistics] to view the statistics that can be calculated with this command.

a) Check the boxes for Mean, Standard deviation, Variance, Coefficient of variation,
Median, Minimum, Maximum, and N nonmissing.

Descriptive Statistics - Statistics

W Mean [~ Trimmed mean ¥ N nonmissing
I~ SE of mean [~ Sum [~ N missing

¥ Standard deviati 72 I~ Ntatal

W Variance ¥ Maximum ™ Cumulative N

¥ Coefficient of variation

™ First quartile

¥ Median

I Third quartile

™ Interquartile range

I~ Percent
I~ Cumulative percent

I~ Range

I~ Sum of squares
I~ Skewness

I Kurtosic

I~ MSED

0K Cancel

F

b) Remove the checks from other options.
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5. Click [OK] twice. The results will be displayed in the session window as shown.

Descriptive Statistics: AutoSales
Variable N Mean Median StDev  Variance  CoefVar Minimum Maximum
AutoSales 6 12.6 12.4 1.12960 1.276 8.96509 11.2 14.3

Session window results are in text format. A high-resolution graphical window displays the
descriptive statistics, a histogram, and a boxplot.

6. Select Stat>Basic Statistics>Graphical Summary.
7. Double-click C1 AutoSales.
8. Click [OK].

Summary for AutoSales =] ]
Summary for AutoSales
e Test
ASquared 019
P-akie 0816
Mo 12600
Sty 1130
B Varkace 137
howess 08
-~ \ Hintoshs OETIRH
iy N @
] i Hinimum 11200
- =1 15t Quartiie: 1
Modiony 12400
= i & = [ i wiQuatle 13625
| " | Harimmn 14.300
et for Moans
s 2o us 5o 85 "o 1415 11785
B5% Confidmce Ieteval for Medion:
95%o Confid Intervals 1043 13979
ey 95 StDey
0705 27
wean{ | |
[ 1
1ns o us oo ns Ho

The graphical summary will be displayed in a separate window as shown.

Calculate Descriptive Statistics from a Frequency Distribution

Multiple menu selections must be used to calculate the statistics from a table. We will use data
given in Example 3-24.

Enter Midpoints and Frequencies
1. Select FilesSNew>New Worksheet to open an empty worksheet.

2. To enter the midpoints into C1, select Calc>Make Patterned Data>Simple Set of
Numbers.

a) Type X to name the column.
b) Type in 8 for the First value, 38 for the Last value, and 5 for Steps.
¢) Click [OK].

3. Enter the frequencies in C2. Name the column f.

Calculate Columns for f-X and f-X?
4. Select Calc>Calculator.
a) Type in fX for the variable and f*X in the Expression dialog box. Click [OK].

b) Select Edit>Edit Last Dialog and type in X2 for the variable and f*X**2 for the
expression.

¢) Click [OK]. There are now four columns in the worksheet.
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Calculator | Column Statistics

- ‘s Store result in variable: [fx Statistic
Expression: * Sum " Mes
E'om X " Mean " Sun
| " Standard deviation ~ Nt
 Minimum T Nm
 Maximum T Nm
" Range
Calculate the Column Sums Input variable: [t
5. Select Cale>Column Statistics.

Store resultin: |n
This command stores results in constants, not

columns.
Click [OK] after each step. Help A

a) Click the option for Sum; then select C2 f
for the Input column, and type n for Store result in.

b) Select Edit>Edit Last Dialog; then select C3 fX for the column and type sumX for
storage.

c) Edit the last dialog box again. This time select C4 fX2 for the column, then type
sumX2 for storage.

To verify the results, navigate to the Project Manager window, then the constants folder of the
worksheet. The sums are 20, 490, and 13,310.

Calculate the Mean, Variance, and Standard Deviation
6. Select Calc>Calculator.

a) Type Mean for the variable, then click in the box for the Expression and type sumX/n.
Click [OK]. If you double-click the constants instead of typing them, single quotes will
surround the names. The quotes are not required unless the column name has spaces.

b) Click the EditLast Dialog icon and type Variance for the variable.
¢) In the expression box type in
(sumX2-sumX**2/n)/(n-1)

Calculator

Stare result in variahle: IS

gi gz Expression.

C5 Hean sqrt( (sunkZ-sumX=*2/n)/(n-1))|
Cé Variance

K1 n

K2 suni

K3 sun¥2

Functions.
1 -

d) Edit the last dialog box and type S for the variable. In the expression box, drag the
mouse over the previous expression to highlight it.

e) Click the button in the keypad for parentheses. Type SQRT at the beginning
of the line, upper- or lowercase will work. The expression should be
SQRT((sumX2-sumX**2/n)/(n-1)).

f) Click [OK].

Display Results
g) Select Data>Display Data, then highlight all columns and constants in the list.
h) Click [Select] then [OK].

The session window will display all our work! Create the histogram with instructions from
Chapter 2.
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Data Display

n

Row

NOoO Ok ON =

X

8
13
18
23
28
33
38

20.0000
sumX 490.000
sumX2 13310.0

f

N WA OTWwWN =

X
8
26
54
115
112
99
76

fX2 Mean Variance S
64 245 68.6842 8.28759 5

338
972
2645
3136
3267
2888

Histogram of ¥

x i
&8

TI-83 Plus or

TI-84 Plus
Step by Step
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Calculating Descriptive Statistics
To calculate various descriptive statistics:
1. Enter data into L.
2. Press STAT to get the menu.

3. Press P to move cursor to CALC; then press 1 for 1-Var Stats.

4. Press 2nd [L,], then ENTER.

The calculator will display

X
2x
Sx?

sample mean

sum of the data values

sum of the squares of the data values
sample standard deviation
population standard deviation
number of data values

smallest data value

lower quartile

median

upper quartile

largest data value

Example TI3-1

Find the various descriptive statistics for the auto sales data from Example 3-23:

11.2,11.9,12.0, 12.8, 13.4, 14.3

Output Output
1-Var Stats 1-Yar Stats
®=12.6 Th=g
Ty mins=11.2
=xe=955, 34 1=11.9
Sw=1. 1296417 Med=12.4
Jx=1.B831138553 Hz=13.4
Lh=6 maxsa=14.3
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Following the steps just shown, we obtain these results, as shown on the screen:

The mean is 12.6.

The sum of x is 75.6.

The sum of x? is 958.94.

The sample standard deviation S is 1.1296017.
The population standard deviation o, is 1.031180553.
The sample size n is 6.

The smallest data value is 11.2.

0,is 11.9.

The median is 12.4.

0, is 13.4.

The largest data value is 14.3.

To calculate the mean and standard deviation from grouped data:

1.
. Enter the frequencies into L,.

. Press STAT to get the menu.

. Use the arrow keys to move the cursor to CALC; then press 1 for 1-Var Stats.
. Press 2nd [L1], 2nd [L2], then ENTER.

nNn A W N

Enter the midpoints into L,.

Example TI3-2

Calculate the mean and standard deviation for the data given in Examples 3—3 and 3-24.

Class Frequency Midpoint
5.5-10.5 1 8
10.5-15.5 2 13
15.5-20.5 3 18
20.5-25.5 5 23
25.5-30.5 4 28
30.5-35.5 3 33
35.5-40.5 2 38
Input Input Output
Li Lz Lz 1 1-ar Stats Li.L 1-Mar Stats
- [ A $i2da
i i Zx2=13310
| j Sx=8. 287093772
S Z J,EEEE LEFYTAZLL
Lt =58

The sample mean is 24.5, and the sample standard deviation is 8.287593772.

To graph a percentile graph, follow the procedure for an ogive but
use the cumulative percent in L,, 100 for ¥,
Example 3-31.

and the data from Output

max?
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Excel
Step by Step

3-58

Measures of Position
Example XL3-3
Find the z scores for each value of the data from Example 3-23. The data represent the amount

(in millions of dollars) of European auto sales for a sample of 6 years.

11.2 119 12.0 128 134 143

1. On an Excel worksheet enter the data in cells A2—A7. Enter a label for the variable in
cell A1.
. Label cell B1 as z score.

. Select cell B2.

n A W N

. Select the Statistical category for statistical functions and scroll in the function list to
STANDARDIZE and click [OK].

In the STANDARDIZE dialog box:

6. Type A2 for the X value.
7. Type average(A2:A7) for the Mean.
8. Type stdev(A2:A7) for the Standard_dev. Then click [OK].

9. Repeat the procedure above for each data value in column A.

STANDWROIZC

X a2 = 12

Mean | mvmagelaz.a?) - 126

Standard_dev | ide{e?ia7) = 11236017
- 1.239374906
e e e e B R e
dard_dev ik th dard of the a positive

Formula resoll = -1, 239374906
Help on this function I o l Canel

Example XL3-4

Find the percentile rank for each value of the data from Example 3-23. The data represent the
amount (in millions of dollars) of European auto sales for a sample of 6 years.

11.2 119 12.0 128 134 143

. On an Excel worksheet enter the data in cells A2—A7. Enter a label for the variable in cell A1.
. Label cell B1 as z score.
. Select cell B2.

N oA W N =

. Select the Statistical category for statistical functions and scroll in the function list to
PERCENTRANK and click [OK].

In the PERCENTRANK dialog box:

6. Type A2:A7 for the Array.
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7. Type A2 for the X value, then click [OK].
8. Repeat the procedure above for each data value in column A.
The PERCENTRANK function returns the percentile rank as a decimal. To convert this to a

percentage, multiply the function output by 100. Make sure to select a new column before
multiplying the percentile rank by 100.

PLRCENTRANK
Array |a7:a? [ = tiaitgizizniosieal
¥ a2
R
| Returns the rank of a value in a data set ac a percentage of the data set.
® 15 the valus for which you wank to know the rank,

| Formula resuk = 0

ek on i o o] [Csemeal ]

Descriptive Statistics in Excel

Example XL3-5

Excel Analysis Tool-Pak Add-in Data Analysis includes an item called Descriptive Statistics
that reports many useful measures for a set of data.

1. Enter the data set shown in cells A1 to A9 of a new worksheet.
12 17 15 16 16 14 18 13 10

See the Excel Step by Step in Chapter 1 for the instructions on loading the Analysis Tool-Pak
Add-in.
2. Select the Data tab on the toolbar and select Data Analysis.
3. In the Analysis Tools dialog box, scroll to Descriptive Statistics, then click [OK].
4. Type A1:A9 in the Input Range box and check the Grouped by Columns option.
5. Select the Output Range option and type in cell C1.
6

. Check the Summary statistics option and click [OK].

Meccriptive Statistice

Inpukt

Input Ranga: $ag1:4a49 E]

Grouped By: @ Columins
Otow o]

[ Labels in first row

Cukput options

@ utput Range: o
O New Workshest Ply: |
© Now Workbook k

[ 5ummary statistics:

[ Confidence Level for Mean: d *®

| kth 1 argest: 1

] ¥th Spallect:
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3-4
Objective

Use the techniques
of exploratory data
analysis, including
boxplots and five-
number summaries,
to discover various
aspects of data.

3-60

Below is the summary output for this data set.

Columnl

Mean 14.55555556
Standard Error 0.85165054-
Median 15
Mode 16
Standard Deviation  2.554951619
Sample Variance 6.527777778
Kurtosis -0.3943866
Skewness -0.51631073
Range 8
Minimum 10
Maximum 18
Sum 131
Count 9

Exploratory Data Analysis

In traditional statistics, data are organized by using a frequency distribution. From this
distribution various graphs such as the histogram, frequency polygon, and ogive can be
constructed to determine the shape or nature of the distribution. In addition, various sta-
tistics such as the mean and standard deviation can be computed to summarize the data.

The purpose of traditional analysis is to confirm various conjectures about the nature
of'the data. For example, from a carefully designed study, a researcher might want to know
if the proportion of Americans who are exercising today has increased from 10 years ago.
This study would contain various assumptions about the population, various definitions
such as of exercise, and so on.

In exploratory data analysis (EDA), data can be organized using a stem and leaf
plot. (See Chapter 2.) The measure of central tendency used in EDA is the median. The
measure of variation used in EDA is the interquartile range O, — Q,. In EDA the data
are represented graphically using a boxplot (sometimes called a box-and-whisker plot).
The purpose of exploratory data analysis is to examine data to find out what information
can be discovered about the data such as the center and the spread. Exploratory data
analysis was developed by John Tukey and presented in his book Exploratory Data
Analysis (Addison-Wesley, 1977).

The Five-Number Summary and Boxplots

A boxplot can be used to graphically represent the data set. These plots involve five
specific values:

1. The lowest value of the data set (i.e., minimum)

2. 0,
3. The median

4. O,

5. The highest value of the data set (i.e., maximum)

These values are called a five-number summary of the data set.

A boxplot is a graph of a data set obtained by drawing a horizontal line from the
minimum data value to Q,, drawing a horizontal line from Q; to the maximum data value,
and drawing a box whose vertical sides pass through Q, and Q, with a vertical line inside
the box passing through the median or Q,,.
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Procedure for constructing a boxplot

1. Find the five-number summary for the data values, that is, the maximum and
minimum data values, O, and Q,, and the median.

2. Draw a horizontal axis with a scale such that it includes the maximum and
minimum data values.

3. Draw a box whose vertical sides go through Q, and Q,, and draw a vertical line
though the median.

4. Draw a line from the minimum data value to the left side of the box and a line from
the maximum data value to the right side of the box.

Example 3-38

e 1
Boxplot for
Example 3-38

Number of Meteorites Found

The number of meteorites found in 10 states of the United States is 89, 47, 164, 296, 30,
215, 138, 78, 48, 39. Construct a boxplot for the data.

Source: Natural History Museum.

Solution

Step 1 Arrange the data in order:
30, 39,47, 48, 78, 89, 138, 164, 215, 296
Step 2 Find the median.
30, 39, 47, 48, 78, 89, 138, 164, 215, 296
T
Median
78 +89 _

Median = 2

83.5

Step3 Find Q,.
30, 39,47, 48,78
T

0,
Step4 Find O,.
89, 138, 164, 215, 296

0;
Step 5 Draw a scale for the data on the x axis.
Step 6 Located the lowest value, Q,, median, O, and the highest value on the scale.

Step 7 Draw a box around Q, and Q5, draw a vertical line through the median, and
connect the upper value and the lower value to the box. See Figure 3—7.

47 83.5 164
30 296
[ ®
0 100 200 300

The distribution is somewhat positively skewed.
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Information Obtained from a Boxplot

1. a. If the median is near the center of the box, the distribution is approximately symmetric.
b. If the median falls to the left of the center of the box, the distribution is positively

skewed.

If the median falls to the right of the center, the distribution is negatively skewed.

If the lines are about the same length, the distribution is approximately symmetric.
If the right line is larger than the left line, the distribution is positively skewed.
If the left line is larger than the right line, the distribution is negatively skewed.

o8 0

The boxplot in Figure 3—7 indicates that the distribution is slightly positively skewed.

If the boxplots for two or more data sets are graphed on the same axis, the distribu-
tions can be compared. To compare the averages, use the location of the medians. To com-
pare the variability, use the interquartile range, i.e., the length of the boxes. Example 3-39
shows this procedure.

Example 3-39

3-62

Sodium Content of Cheese

o A dietitian is interested in comparing the sodium content of real cheese with the
sodium content of a cheese substitute. The data for two random samples are
shown. Compare the distributions, using boxplots.

Real cheese | Cheese substitute
310 420 45 40 270 180 250 290
220 240 180 90 130 260 340 310

Source: The Complete Book of Food Counts.

Solution
Step 1 Find Q,, MD, and Q, for the real cheese data.
40 45 90 180 220 240 310 420

T T T
o MD 0
+ +
Ql:u:mj MD:M:ZOO
2 2
+
. _ 240 - 310 — 975

Step 2 Find Q,, MD, and Q, for the cheese substitute data.
130 180 250 260 270 290 310 340

T T T
Ql MD Q3
+ +
Q1=180 250:215 MD=26O 270:265
2 2
+
) _ 290 ; 310 _ 300

Step 3 Draw the boxplots for each distribution on the same graph. See Figure 3-8.



Figure 3-8

Boxplots for
Example 3-39
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Step 4 Compare the plots. It is quite apparent that the distribution for the cheese
substitute data has a higher median than the median for the distribution for
the real cheese data. The variation or spread for the distribution of the real
cheese data is larger than the variation for the distribution of the cheese
substitute data.

Real cheese
67.5 200 275
40 420
o L ]
Cheese substitute
215 265 300
130 340
@ @
0 100 200 300 400 500

A modified boxplot can be drawn and used to check for outliers. See Exercise 18 in
Extending the Concepts in this section.

In exploratory data analysis, hinges are used instead of quartiles to construct box-
plots. When the data set consists of an even number of values, hinges are the same as
quartiles. Hinges for a data set with an odd number of values differ somewhat from quar-
tiles. However, since most calculators and computer programs use quartiles, they will be
used in this textbook.

Another important point to remember is that the summary statistics (median and
interquartile range) used in exploratory data analysis are said to be resistant statistics. A
resistant statistic is relatively less affected by outliers than a nonresistant statistic. The
mean and standard deviation are nonresistant statistics. Sometimes when a distribution
is skewed or contains outliers, the median and interquartile range may more accurately
summarize the data than the mean and standard deviation, since the mean and standard
deviation are more affected in this case.

Table 3—5 shows the correspondence between the traditional and the exploratory data
analysis approach.

3-5 Traditional versus EDA Techniques

Traditional Exploratory data analysis
Frequency distribution Stem and leaf plot
Histogram Boxplot

Mean Median

Standard deviation Interquartile range
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Applying the Concepts 3—4

The Noisy Workplace

Assume you work for OSHA (Occupational Safety and Health Administration) and have
complaints about noise levels from some of the workers at a state power plant. You charge the
power plant with taking decibel readings at six different areas of the plant at different times of
the day and week. The results of the data collection are listed. Use boxplots to initially explore
the data and make recommendations about which plant areas workers must be provided with
protective ear wear. The safe hearing level is at approximately 120 decibels.

Area 1 Area 2 Area 3 Area 4 Area s Area 6
30 64 100 25 59 67
12 99 59 15 63 80
35 87 78 30 81 99
65 59 97 20 110 49
24 23 84 61 65 67
59 16 64 56 112 56
68 94 53 34 132 80
57 78 59 22 145 125

100 57 89 24 163 100
61 32 88 21 120 93
32 52 94 32 84 56
45 78 66 52 99 45
92 59 57 14 105 80
56 55 62 10 68 34
44 55 64 33 75 21

See page 180 for the answers.

For Exercises 1-6, identify the five-number summary ° 4. 147,243,156, 632, 543, 303
and find the interquartile range.

o 1. 8,12,32,6,27,19, 54 o 5. 14.6,19.8,16.3, 15.5, 18.2

° 2. 19,16,48,22,7 ° 6. 9.7,46,22,3.7,6.2,94,3.8

° 3. 362, 589, 437, 316, 192, 188 For Exercises 7-10, use each boxplot to identify the
maximum value, minimum value, median, first quartile,

third quartile, and interquartile range.
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8.
L —— —e
200 225 250 275 300 325
9.
L —— —
50 55 60 65 70 75 80 85 90 95 100
10.

1000 2000 3000 4000

11. Earned Run Average—Number of Games

Pitched Construct a boxplot for the following data
and comment on the shape of the distribution
representing the number of games pitched by major
league baseball’s earned run average (ERA) leaders for
the past few years.

30 34 29 30 34 29 31 33 34 27
30 27 34 32

Source: World Almanac.

12. Innings Pitched Construct a boxplot for the

following data which represents the number of innings
pitched by the ERA leaders for the past few years.
Comment on the shape of the distribution.

192 228 186 199 238 217 213 234 264 187
214 115 238 246

Source: World Almanac.

13. State Sites for Frogwatch Construct a boxplot
for these numbers of state sites for Frogwatch USA. Is
the distribution symmetric?
421 395 314 294 289 253 242 238 235 199

Source: www.nwf.org/frogwatch
14. Median Household Incomes Construct a boxplot

and comment on the skewness of these data which
represent median household income (in dollars) for the

5000 6000

top 10 educated cities (based on the percent of the
population with a college degree or higher).

49,297 48,131 43,731 39,752 55,637
57,496 47,221 41,829 42,562 42,442

Source: www.encarta.msn.com

15. Tornadoes in 2005 Construct a boxplot and
comment on its skewness for the number of tornadoes
recorded each month in 2005.

33 10 62 132 123 316 138 123 133 18
150 26

Source: Storm Prediction Center.

16. Size of Dams These data represent the volumes in

cubic yards of the largest dams in the United States
and in South America. Construct a boxplot of the data
for each region and compare the distributions.

United States South America

125,628 311,539
92,000 274,026
78,008 105,944
71,700 102,014
66,500 56,242
62,850 46,563
52,435
50,000

Source: New York Times Almanac.
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- 17. Number of Tornadoes A four-month record for
the number of tornadoes in 20032005 is given here.

2005 2004 2003
April 132 125 157
May 123 509 543
June 316 268 292
July 138 124 167

a. Which month had the highest mean number of

tornadoes for this 3-year period?

b.  Which year has the highest mean number of
tornadoes for this 4-month period?

c. Construct three boxplots and compare the
distributions.

Source: NWS, Storm Prediction Center.

Extending the Concepts

- 18. Unhealthful Smog Days A modified boxplot can
be drawn by placing a box around Q, and Q, and then
extending the whiskers to the largest and/or smallest
values within 1.5 times the interquartile range

Extreme
outliers )

G

(ie., O; — Q). Mild outliers are values between
1.5(IQR) and 3(IQR). Extreme outliers are data
values beyond 3(IQR).

Mild

I outliers |

H—J

1.5(10R)

For the data shown here, draw a modified boxplot and
identify any mild or extreme outliers. The data represent
the number of unhealthful smog days for a specific year for
the highest 10 locations.

[«<—IQR—I

Extreme
0y outliers
Mild
I outliers |
1.5(1QR)
97 39 43 66 91

43 54 42 53 39

Source: U.S. Public Interest Research
Group and Clean Air Network.

NY ) ANY = _I :

MINITAB
Step by Step 1.

Construct a Boxplot

. Click on [Labels].

3-66

Type in the data 33, 38, 43, 30, 29, 40, 51, 27, 42, 23, 31. Label the column Clients.
2. Select Stat>EDA>Boxplot.

3. Double-click Clients to select it for the Y variable.
4

a) Inthe Title 1: of the Title/Footnotes folder, type Number of Clients.
b) Press the [Tab] key and type Your Name in the text box for Subtitle 1:.
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5. Click [OK] twice. The graph will be displayed in a graph window.

MNumber of Clients
Your Name

504

454

40

clients
-
]

304

254

20

Example MT3-2

. Select Stat>EDA>Boxplot.

A N A W N =

. Click [OK] twice.

Boxplot Dialog Box and Boxplot

Boxplot

S-tneer | Graph Y 1] vs X vl
Graph ¥ x f]
1 " CARS-THEFT'
2
3 B
Data display:
Item | Display |¥| Foreach H Group variable ﬂ
1 IQRange Box|Graph 1 |
2 Outlier S>> Graph
3 L=
Edit Atributes... |
Seleot | Annotation Frame E Regions El

Help

| Cancel l

. Enter the data for Example 2—13 in Section 2-3. Label the column CARS-THEFT.
. Double-click CARS-THEFT to select it for the Y variable.

. Click on the drop-down arrow for Annotation.

. Click on Title, then enter an appropriate title such as Car Thefts for Large City, U.S.A.

A high-resolution graph will be displayed in a graph window.

Boxplot CARS-THEFT

Car Thefts for Large City, US.A

CARS-THEFT

TI-83 Plus or

TI-84 Plus
Step by Step

Constructing a Boxplot
To draw a boxplot:
1. Enter data into L.

to0and Y, to l.

4. Press ENTER to turn Plot 1 on.

2. Change values in WINDOW menu, if necessary. (Note: Make X,
the smallest data value and X, ,, somewhat larger than the largest data value.) Change Y, ;,

somewhat smaller than

in

3. Press [2nd] [STAT PLOT], then 1 for Plot 1.

5. Move cursor to Boxplot symbol (fifth graph) on the Type: line, then press ENTER.
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. Make sure Xlist is L,.
. Make sure Freq is 1.
. Press GRAPH to display the boxplot.

. Press TRACE followed by <« or P to obtain the values from the five-number summary on
the boxplot.

o 0 I3 &

To display two boxplots on the same display, follow the above steps and use the 2: Plot 2 and
L, symbols.
Example TI3-3
Construct a boxplot for the data values:
33, 38, 43, 30, 29, 40, 51, 27, 42, 23, 31

Input Input
otz Flok:

W I OO
Aamin=2H D
AMax=a05 Fe
Asc1=0
Ymin=

)
“rﬁrﬁ

L=
H IH |_

o
mlistil
Fres:

Using the TRACE key along with the <« and P> keys, we obtain the five-number summary. The
minimum value is 23; O, is 29; the median is 33; O, is 42; the maximum value is 51.

Output
Fi:L1
— :+: L
Hed=Z22 .
Excel Constructing a Stem and Leaf Plot and a Boxplot

Step by Step Example XL3-6

Excel does not have procedures to produce stem and leaf plots or boxplots. However, you may
construct these plots by using the MegaStat Add-in available on your CD or from the Online
Learning Center. If you have not installed this add-in, refer to the instructions in the Excel
Step by Step section of Chapter 1.
To obtain a boxplot and stem and leaf plot:
1. Enter the data values 33, 38, 43, 30, 29, 40, 51, 27, 42, 23, 31 into column A of a new Excel
worksheet.

2. Select the Add-Ins tab, then MegaStat from the toolbar.
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3. Select Descriptive Statistics from the MegaStat menu.
4. Enter the cell range A1:A11 in the Input range.

5. Check both Boxplot and Stem and Leaf Plot. Note: You may leave the other output
options unchecked for this example. Click [OK].

'-csufpll\ie ctatistics

| atan E@ = Tt rangn II]
Seleet el | SeeulfChaar Al Clear
[ 1san ™ sum, sum of sauares, 55% _Canel_|
[ Sample yariance and standard deviati I Standard errar of the mean Hedit
I Wi, ez, g | I~ Popudation vesiance sl ol sl devisdion
[ Megdan, quartiles, mods, outhers I Confidence Interval | 55 'l
[ poxplot I empirical e
[~ ottt (Maxdots o 4l e ) I tolerance nterval
¥ Stem and Leat Plot ([ Splk stem) I Sewmess, lurtosis, CV
I R Pl 1 Suggested inlerval wic |l Ror fresuency distrilnion
I mormal curve goodness of fit
The stem and leaf plot and the boxplot are shown below.
Stem and Leaf plot for #1
stem unit = 10 BoxPlot
leal unit = 1
Frequency Stem Leaf i
3 2are || e e Y
4 3 0138 20 25 30 35 40 45 50 55
3 4 023 #19
1 51
1
Summary

This chapter explains the basic ways to summarize data. These include measures of
central tendency, measures of variation or dispersion, and measures of position. The
three most commonly used measures of central tendency are the mean, median, and
mode. The midrange is also used occasionally to represent an average. The three most
commonly used measurements of variation are the range, variance, and standard
deviation.

The most common measures of position are percentiles, quartiles, and deciles. This
chapter explains how data values are distributed according to Chebyshev’s theorem and
the empirical rule. The coefficient of variation is used to describe the standard deviation
in relationship to the mean. These methods are commonly called traditional statistical
methods and are primarily used to confirm various conjectures about the nature of
the data.

Other methods, such as the boxplot and five-number summaries, are part of exploratory
data analysis; they are used to examine data to see what they reveal.

After learning the techniques presented in Chapter 2 and this chapter, you will have
a substantial knowledge of descriptive statistics. That is, you will be able to collect, orga-
nize, summarize, and present data.
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important Terms

bimodal 111

boxplot 162

Chebyshev’s theorem 134
coefficient of variation 132
data array 109

decile 151

empirical rule 136

exploratory data
analysis (EDA) 162

five-number summary 162

interquartile range (IQR) 151
mean 106

median 109

midrange 114

modal class 112

mode 111

multimodal 111

negatively skewed or left-
skewed distribution 117

outlier 151

Important Formulas

Formula for the mean for individual data:

X
n M_N

>

Formula for the mean for grouped data:

_2f X,

n

|

Formula for the weighted mean:

SwX
>w

|

Formula for the midrange:

MR
2

Formula for the range:

_ lowest value + highest value

R = highest value — lowest value

Formula for the variance for population data:

S(X — p)?

2=
. N

Formula for the variance for sample data (shortcut formula

for the unbiased estimator):

, _ n(EX?) = (2X)?
$ = nn—1)

Formula for the variance for grouped data:

2= n(Eeri) - (Ef)(m)z

nln—1)
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symmetric
distribution 117

unimodal 111

parameter 106
percentile 143

positively skewed or right-
skewed distribution 117

quartile 149

variance 127
weighted mean 115

z score or standard
score 142

range 124

range rule of thumb 133
resistant statistic 165
standard deviation 127
statistic 106

Formula for the standard deviation for population data:

X — p)?

g = N

Formula for the standard deviation for sample data
(shortcut formula):

_ 4 /n(EX?) = (2X)?
$= nln—1)

Formula for the standard deviation for grouped data:

_ \/n@f-x,z,) —(3f X,)?
$= nn—1)

Formula for the coefficient of variation:

CVar==-100% or CVar=Z-100%
X n

Range rule of thumb:
__range
T

Expression for Chebyshev’s theorem: The proportion of
values from a data set that will fall within k standard
deviations of the mean will be at least

1
1=z
where £ is a number greater than 1.
Formula for the z score (standard score):

X — X-X
=P o =
a S




Formula for the cumulative percentage:
cumulative

f
Cumulative % = m - 100%

Formula for the percentile rank of a value X:
number of values
below X + 0.5

total number
of values

Percentile = - 100%

Review EXxercises

1. Hospitals The following set of data represents the

number of hospitals for selected states. Find the mean,
median, mode, midrange, range, variance, and standard
deviation for the data.

53 84 28 78 35 111 40 166
87 84 74 80 62

Source: World Almanac.

108 60 123

2. Elementary and Secondary Schools These data
represent the number of both elementary and
secondary schools for selected states.

Elementary | Secondary
938 977 194 518 403 423 85 156
711 599 1196 497 424 327 401 362
824 885 137 575 240 333 44 205
139 913 417 849 43 274 223 285
For each set of data find:
a. Mean e. Range
b. Median f- Variance
c. Mode g. Standard deviation
d. Midrange

Which set of data is more variable?

Source: World Almanac.

3. Battery Lives Twelve batteries were tested to see how
many hours they would last. The frequency distribution
is shown here.

Hours Frequency

1-3 1

4-6 4

7-9 5
10-12 1
13-15 1

Find each of these.

c. Variance
d. Standard deviation

a. Mean
b. Modal class

Review Exercises 173

Formula for finding a value corresponding to a given
percentile:

Formula for interquartile range:

IQR = Q; — 0,

4. SAT Scores The mean SAT math scores for

selected states are represented below. Find the mean
class, modal class, variance, and standard deviation, and
comment on the shape of the data.

Score Frequency
478-504 4
505-531 6
532-558 2
559-585 2
586-612 2

Source: World Almanac.

5. Rise in Tides Shown here is a frequency distribution
for the rise in tides at 30 selected locations in the United
States.

Rise in tides (inches)

12.5-27.5
27.5-42.5
42.5-57.5
57.5-72.5
72.5-87.5
87.5-102.5

Find each of these.

Frequency

N OGN O W WO

c. Variance
d. Standard deviation

a. Mean
b. Modal class

6. Fuel Capacity The fuel capacity in gallons of 50
randomly selected 1995 cars is shown here.

Class Frequency
10-12 6
13-15 4
16-18 14
1921 15
22-24 8
25-27 2
28-30 1

50
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10.

11.

Chapter 3 Data Description

Find each of these.

c. Variance
d. Standard deviation

a. Mean
b. Modal class

. Number of Cavities In a dental survey of third-grade

students, this distribution was obtained for the number
of cavities found. Find the average number of cavities
for the class. Use the weighted mean.

Number of students Number of cavities

12 0
8 1
5 2
5 3

. Investment Earnings An investor calculated these

percentages of each of three stock investments with
payoffs as shown. Find the average payoff. Use the
weighted mean.

Stock Percent Payoff
A 30 $10,000
B 50 3,000
C 20 1,000

. Years of Service of Employees In an advertisement, a

transmission service center stated that the average years
of service of its employees were 13. The distribution is
shown here. Using the weighted mean, calculate the
correct average.

Number of employees Years of service

8 3
1 6
1 30

Textbooks in Professors’ Offices If the average
number of textbooks in professors’ offices is 16, the
standard deviation is 5, and the average age of the
professors is 43, with a standard deviation of 8, which
data set is more variable?

Magazines in Bookstores A survey of bookstores
showed that the average number of magazines carried is
56, with a standard deviation of 12. The same survey
showed that the average length of time each store had
been in business was 6 years, with a standard deviation
of 2.5 years. Which is more variable, the number of
magazines or the number of years?

12. Years of Service of Supreme Court Members

The number of years served by selected past members
of the U.S. Supreme Court is listed below. Find the
percentile rank for each value. Which value corresponds
to the 40th percentile? Construct a boxplot for the data
and comment on their shape.

19, 15, 16, 24, 17,4, 3, 31, 23, 5, 33

Source: World Almanac.
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13.

NFL Salaries The salaries (in millions of dollars) for
29 NFL teams for the 1999-2000 season are given in
this frequency distribution.

Class limits Frequency
39.9-42.8 2
42.9-45.8 2
45.9-48.8 5
48.9-51.8 5
51.9-54.8 12
54.9-57.8 3

Source: www.NFL.com

a. Construct a percentile graph.

b. Find the values that correspond to the 35th, 65th, and
85th percentiles.

c. Find the percentile of values 44, 48, and 54.

Q 14. Check each data set for outliers.

15.

16.

17.

18.

19.

a. 506,511,517, 514, 400, 521
b. 3,7,9,6,8, 10, 14, 16, 20, 12

c. 14,18,27,26,19,13,5,25

d. 112,157,192, 116, 153, 129, 131

Cost of Car Rentals A survey of car rental agencies
shows that the average cost of a car rental is $0.32 per
mile. The standard deviation is $0.03. Using
Chebyshev’s theorem, find the range in which at least
75% of the data values will fall.

Average Earnings of Workers The average earnings
of year-round full-time workers 25-34 years old with a
bachelor’s degree or higher were $58,500 in 2003. If the
standard deviation is $11,200, what can you say about
the percentage of these workers who earn

a. Between $47,300 and $69,700?

b. More than $80,900?

c. How likely is it that someone earns more than
$100,000?

Source: New York Times Almanac.

Labor Charges The average labor charge for
automobile mechanics is $54 per hour. The standard
deviation is $4. Find the minimum percentage of data
values that will fall within the range of $48 to $60. Use
Chebyshev’s theorem.

Costs to Train Employees For a certain type of job, it
costs a company an average of $231 to train an employee
to perform the task. The standard deviation is $5.

Find the minimum percentage of data values that will
fall in the range of $219 to $243. Use Chebyshev’s
theorem.

Delivery Charges The average delivery charge for a
refrigerator is $32. The standard deviation is $4. Find
the minimum percentage of data values that will fall

in the range of $20 to $44. Use Chebyshev’s theorem.


www.NFL.com

20. Exam Grades Which of these exam grades has a better

relative position?

a. Agrade of 82 on a test with X = 85 and s = 6
b. A grade of 56 on atest with X = 60 and s = 5

21. Top Movie Sites The number of sites at which the

top nine movies (based on the daily gross earnings)
opened in a particular week is indicated below.

22,
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Hours Worked The data shown here represent the
number of hours that 12 part-time employees at a toy store
worked during the weeks before and after Christmas.
Construct two boxplots and compare the distributions.

Before | 38 16 18 24 12 30 35 32 31 30 24 35

After

23.

26 15 12 18 24 32 14 18 16 18 22 12

Commuter Times The mean of the times it takes a

3017 3687 2525 commuter to get to work in Baltimore is 29.7 minutes.
2516 2820 2579 If the standard deviation is 6 minutes, within what limits
3211 3044 2330 would you expect approximately 68% of the times to

Construct a boxplot for the data.

The 10th movie on the list opened at only 909 theaters.

Add this number to the above set of data and construct a
boxplot. Comment on the changes that occur.

Source: www.showbizdata.com

fall? Assume the distribution is approximately bell-
shaped.

Statistics  How Long Are You Delayed by Road Congestion?—Revisited
Todav The average number of hours per year that a driver is delayed by road congestion is listed here.
Los Angeles 56
Atlanta 53
Seattle 53
Houston 50
Dallas 46
Washington 46
Austin 45
Denver 45
St. Louis 44
Orlando 42
U.S. average 36

Source: Texas Transportation Institute.

By making comparisons using averages, you can see that drivers in these 10 cities are
delayed by road congestion more than the national average.

Data Analysis

A Data Bank is found in Appendix D, or on the
World Wide Web by following links from
www.mhhe.com/math/stat/bluman/

4. Randomly select 10 values from the number of
suspensions in the local school districts in southwestern
Pennsylvania in Data Set V in Appendix D. Find the

1. From the Data Bank, choose one of the following
variables: age, weight, cholesterol level, systolic
pressure, 1Q, or sodium level. Select at least 30 values,
and find the mean, median, mode, and midrange. State
which measurement of central tendency best describes
the average and why.

2. Find the range, variance, and standard deviation for the
data selected in Exercise 1.

3. From the Data Bank, choose 10 values from any
variable, construct a boxplot, and interpret the results.

mean, median, mode, range, variance, and standard
deviation of the number of suspensions by using the
Pearson coefficient of skewness.

. Using the data from Data Set VII in Appendix D, find

the mean, median, mode, range, variance, and standard
deviation of the acreage owned by the municipalities.
Comment on the skewness of the data, using the
Pearson coefficient of skewness.
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Chapter Quiz

Determine whether each statement is true or false. If the
statement is false, explain why.

1.

When the mean is computed for individual data, all
values in the data set are used.

. The mean cannot be found for grouped data when there

is an open class.

. A single, extremely large value can affect the median

more than the mean.

. One-half of all the data values will fall above the mode,

and one-half will fall below the mode.

5. In a data set, the mode will always be unique.

6. The range and midrange are both measures

of variation.

. One disadvantage of the median is that it is

not unique.

. The mode and midrange are both measures

of variation.

. If a person’s score on an exam corresponds to the

75th percentile, then that person obtained 75 correct
answers out of 100 questions.

Select the best answer.

10.

11.

12.

13.

14.

What is the value of the mode when all values in the
data set are different?

a 0

b. 1

c. There is no mode.

d. It cannot be determined unless the data values are
given.

When data are categorized as, for example, places of
residence (rural, suburban, urban), the most appropriate
measure of central tendency is the

a. Mean c. Mode

b. Median d. Midrange

Py, corresponds to

a 0,

b. Dj

c. IQR

d. Midrange

Which is not part of the five-number summary?

0, and O,

a
b. The mean

¢. The median

d. The smallest and the largest data values

A statistic that tells the number of standard deviations a
data value is above or below the mean is called

a. A quartile
b. A percentile
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15.

c. A coefficient of variation
d. Azscore

When a distribution is bell-shaped, approximately what
percentage of data values will fall within 1 standard
deviation of the mean?

a. 50%
b. 68%
c. 95%
d. 99.7%

Complete these statements with the best answer.

16.

17.

18.

19.

20.

21.

22,

24.

A measure obtained from sample data is called
a(n)

Generally, Greek letters are used to represent
, and Roman letters are used to represent

The positive square root of the variance is called
the

The symbol for the population standard deviation is

When the sum of the lowest data value and the highest
data value is divided by 2, the measure is called

If the mode is to the left of the median and the mean is
to the right of the median, then the distribution is
skewed.

An extremely high or extremely low data value is called

a(n)
23. Miles per Gallon The number of highway miles
per gallon of the 10 worst vehicles is shown.

12 15 13 14 15 16 17 16 17 18

Source: Pittsburgh Post Gazette.

Find each of these.

a. Mean

b. Median

c. Mode

d. Midrange

e. Range

f Variance

g. Standard deviation

Errors on a Typing Test The distribution of the number
of errors that 10 students made on a typing test is shown.
Errors Frequency
0-2 1
3-5 3
6-8 4
9-11 1
12-14 1



25.

26.

27.

28.

Find each of these.

¢. Variance
d. Standard deviation

a. Mean
b. Modal class

Inches of Rain Shown here is a frequency distribution
for the number of inches of rain received in 1 year in
25 selected cities in the United States.

Number of inches

5.5-20.5 2
20.5-35.5
35.5-50.5
50.5-65.5
65.5-80.5
80.5-95.5

Find each of these.

Frequency

W W o\ oW

a. Mean

b. Modal class

c. Variance

d. Standard deviation

Shipment Times A survey of 36 selected recording
companies showed these numbers of days that it took to
receive a shipment from the day it was ordered.

Days Frequency
1-3 6
4-6 8
7-9 10

10-12 7

13-15 0

16-18 5

Find each of these.
a. Mean

b. Modal class
c. Variance
d. Standard deviation

Best Friends of Students In a survey of third-grade
students, this distribution was obtained for the number
of “best friends” each had.

Number of students Number of best friends

8 1
6 2
5 3
3 0

Find the average number of best friends for the class.
Use the weighted mean.

Employee Years of Service In an advertisement, a
retail store stated that its employees averaged 9 years of
service. The distribution is shown here.

Number of employees Years of service

8 2
2 6
3 10

Using the weighted mean, calculate the correct average.
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29. Newspapers for Sale The average number of
newspapers for sale in an airport newsstand is 12, and
the standard deviation is 4. The average age of the pilots
is 37 years, with a standard deviation of 6 years. Which
data set is more variable?

30. Brands of Toothpaste Carried A survey of grocery
stores showed that the average number of brands of
toothpaste carried was 16, with a standard deviation of 5.
The same survey showed the average length of time each
store was in business was 7 years, with a standard
deviation of 1.6 years. Which is more variable, the number
of brands or the number of years?

31. Test Scores A student scored 76 on a general science
test where the class mean and standard deviation were
82 and 8, respectively; he also scored 53 on a
psychology test where the class mean and standard
deviation were 58 and 3, respectively. In which class
was his relative position higher?

32. Which score has the highest relative position?

a X=12 X=10 s =4
b X=170 X=120 s=32
c. X=180 X=60 s=8

33. Sizes of Malls The number of square feet (in
millions) of eight of the largest malls in southwestern
Pennsylvania is shown.

1 0.9 1.3 0.8
1.4 0.77 0.7 1.2

Source: International Council of Shopping Centers.

a. Find the percentile for each value.

b.  What value corresponds to the 40th percentile?

c. Construct a boxplot and comment on the nature of
the distribution.

34. Exam Scores On a philosophy comprehensive exam,
this distribution was obtained from 25 students.

Score Frequency
40.5-45.5 3
45.5-50.5 8
50.5-55.5 10
55.5-60.5 3
60.5-65.5 1

a. Construct a percentile graph.

b. Find the values that correspond to the 22nd, 78th,
and 99th percentiles.

c. Find the percentiles of the values 52, 43,
and 64.

35. Gas Prices for Rental Cars The first column of

these data represents the prebuy gas price of a rental
car, and the second column represents the price charged
if the car is returned without refilling the gas tank for a
selected car rental company. Draw two boxplots for the
data and compare the distributions. (Note: The data
were collected several years ago.)
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Prebuy cost No prebuy cost 36. SAT Scores The average national SAT score is 1019.
$1.55 $3.80 If we assume a bell-shaped distribution and a standard
1.54 3.99 deviation equal to 110, what percentage of scores will
1.62 3.99 you expect to fall above 1129? Above 7997
1.65 3.85 Source: New York Times Almanac, 2002.
1.72 3.99
1.63 3.95
1.65 3.94
1.72 4.19
1.45 3.84
1.52 3.94

Source: US4 TODAY.

Critical Thinking Challenges

1. Average Cost of Weddings Averages give us cost of a wedding. What type of average—mean,
information to help us to see where we stand and enable median, mode, or midrange—might have been used for
us to make comparisons. Here is a study on the average each category?

OTHER PEOPLE’S MONEY J

Question: What is the hottest wedding
month? Answer: It’s a tie. September now .
ranks as high as June in U.S. nuptials.
The average attendence is 186 guests.
And what kind of tabs are people running
up for these affairs? Well, the next time a
bride is throwing a bouquet, single women
might want to . . . duck!

Stats: Bride’s 2000 State of the Union Report

Reception . ... ............ $7246 @
Rings.................... 4042
Photos/videography. . . . . ... ... 1263 .
Bridalgown. ... ............. 790
Flowers . ... ............... 775

Music. . . ....... ... . ... .. 745 .
Invitations . . . .. ... ... ... 374 .
Mother of the bride’sdress . . . . . .. 198

Other (veil, limo, fees, etc.) . . . . .. 3441 .
Average cost

of a wedding $1 8’874 ﬂ

Source: Reprinted with permission from the September 2001 Reader’s
Digest. Copyright © 2001 by The Reader’s Digest Assn., Inc.

2. Average Cost of Smoking This article states that the cigarettes in your area, and compute the cost per day
average yearly cost of smoking a pack of cigarettes a for 1 year. Compare your answer with the one in the
day is $1190. Find the average cost of a pack of article.
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Burning Through the Cash

Everyone knows the health-related reasons to quit smoking,
so here’s an economic argument: A pack a day adds up to
$1190 a year on average; it’s more in states that have higher
taxes on tobacco. To calculate what you or a loved one
spends, visit ashline.org/ASH/quit/contemplation/index.html

1

and try out their smoker’s calculator.
You’ll be stunned.

Source: Reprinted with permission from the April 2002 Reader’s Digest. Copyright © 2002 by The

Reader’s Digest Assn., Inc.

3. Ages of U.S. Residents The table shows the median ages
of residents for the 10 oldest states and the 10 youngest

states of the United States including Washington, D.C.
Explain why the median is used instead of the mean.

10 Oldest 10 Youngest
Rank State Median age Rank State Median age
1 West Virginia 38.9 51 Utah 27.1
2 Florida 38.7 50 Texas 323
3 Maine 38.6 49 Alaska 324
4 Pennsylvania 38.0 48 Idaho 332
5 Vermont 37.7 47 California 333
6 Montana 37.5 46 Georgia 334
7 Connecticut 37.4 45 Mississippi 33.8
8 New Hampshire 37.1 44 Louisiana 34.0
9 New Jersey 36.7 43 Arizona 342
10 Rhode Island 36.7 42 Colorado 343

Source: U.S. Census Bureau.

@ Data Projects

Where appropriate, use MINITAB, the TI-83 Plus, the
TI-84 Plus, or a computer program of your choice to
complete the following exercises.

1. Business and Finance Use the data collected in data
project 1 of Chapter 2 regarding earnings per share.
Determine the mean, mode, median, and midrange for
the two data sets. Is one measure of center more
appropriate than the other for these data? Do the
measures of center appear similar? What does this say
about the symmetry of the distribution?

2. Sports and Leisure Use the data collected in data
project 2 of Chapter 2 regarding home runs. Determine
the mean, mode, median, and midrange for the two data
sets. Is one measure of center more appropriate than the

other for these data? Do the measures of center appear
similar? What does this say about the symmetry of the
distribution?

. Technology Use the data collected in data project 3 of

Chapter 2. Determine the mean for the frequency table
created in that project. Find the actual mean length of all
50 songs. How does the grouped mean compare to the
actual mean?

. Health and Wellness Use the data collected in data

project 6 of Chapter 2 regarding heart rates. Determine
the mean and standard deviation for each set of data. Do
the means seem very different from one another? Do the
standard deviations appear very different from one
another?
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5. Politics and Economics Use the data collected in data 6. Your Class Use your class as a sample. Determine the
project 5 of Chapter 2 regarding delegates. Use the mean, median, and standard deviation for the age of
formulas for population mean and standard deviation to students in your class. What z score would a 40-year-old
compute the parameters for all 50 states. What is the have? Would it be unusual to have an age of 40?

z score associated with California? Delaware? Ohio? Determine the skew of the data using the Pearson
Which states are more than 2 standard deviations from coefficient of skewness. (See Exercise 48, page 141.)
the mean?

Answers to Applying the Concepts

Section 3-1 Teacher Salaries Section 3-3 Determining Dosages
1. The sample mean is $22,921.67, the sample median is 1. The quartiles could be used to describe the data
$16,500, and the sample mode is $11,000. If you work results.

for the school board and do not want to raise salaries, you

could say that the average teacher salary is $22,921.67. 2. Since there are 10 mice in the upper quartile, this would

mean that 4 of them survived.
2. If you work for the teachers’ union and want a raise for

the teachers, either the sample median of $16,500 or the 3. The percentiles would give us the position of a single
sample mode of $11,000 would be a good measure of mouse with respect to all other mice.
center to report. 4. The quartiles divide the data into four groups of equal

3. The outlier is $107,000. With the outlier removed, the size.
sample mean is $15,278.18, the sample median is
$16,400, and the sample mode is still $11,000. The
mean is greatly affected by the outlier and allows the
school board to report an average teacher salary that is
not representative of a “typical” teacher salary.

5. Standard scores would give us the position of a single
mouse with respect to the mean time until the onset of
sepsis.

4. If the salaries represented every teacher in the school Section 3-4 The Noisy Workplace

district, the averages would be parameters, since we Boxplot of Noise Level Versus Area
have data from the entire population. 180

5. The mean can be misleading in the presence of outliers, 169
since it is greatly affected by these extreme values. 1404

6. Since the mean is greater than both the median and the e

mode, the distribution is skewed to the right (positively

Noise level
BLig =
¢ 3

skewed).
Section 3-2 Blood Pressure 04 é

1. Chebyshev’s theorem does not work for scores within e
1 standard deviation of the mean. e T T : 7 T T

2. At least 75% (900) of the normotensive men will fall in Area
the interval 105—141 mm Hg.

3. About 95% (1330) of the normotensive women have From this boxplot, we see that about 25% of the readings
diastolic blood pressures between 62 and 90 mm Hg. in area 5 are above the safe hearing level of 120 decibels.
About 95% (1235) of the hypertensive women have Those workers in area 5 should definitely have protective
diastolic blood pressures between 68 and 108 mm Hg. ear wear. One of the readings in area 6 is above the safe

4. About 95% (1140) of the normotensive men have hearing level. It might be a good idea to provide protective
systolic blood pressures between 105 and 141 mm Hg. ear wear to tl‘l‘ose \’Yorkers in area 6 as Well. Areas 1,_4
About 95% (1045) of the hypertensive men have appear to be “safe” with respect to hearing level, with

systolic blood pressures between 119 and 187 mm Hg. area 4 being the safest.

These two ranges do overlap.
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I obicctives

After completing this chapter, you should be able to

n Determine sample spaces and find the
probability of an event, using classical
probability or empirical probability.

Find the probability of compound events,
using the addition rules.

Find the probability of compound events,
using the multiplication rules.

Find the conditional probability of an event.

Find the total number of outcomes in a
sequence of events, using the fundamental
counting rule.

Find the number of ways that r objects can
be selected from n objects, using the
permutation rule.

B B B0 QO

selected from n objects without regard to
order, using the combination rule.

Find the probability of an event, using the
counting rules.

Find the number of ways that r objects can be

Probability and
Counting Rules

Introduction
4-1  Sample Spaces and Probability
4-2 The Addition Rules for Probability

4-3 The Multiplication Rules and Conditional
Probability

4—4 Counting Rules
45 Probability and Counting Rules

Summary
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Chapter 4 Probability and Counting Rules

Statistics
Today

Would You Bet Your Life?

Humans not only bet money when they gamble, but also bet their lives by engaging in
unhealthy activities such as smoking, drinking, using drugs, and exceeding the speed
limit when driving. Many people don’t care about the risks involved in these activities
since they do not understand the concepts of probability. On the other hand, people may
fear activities that involve little risk to health or life because these activities have been
sensationalized by the press and media.

In his book Probabilities in Everyday Life (Ivy Books, p. 191), John D. McGervey states

When people have been asked to estimate the frequency of death from various causes, the most
overestimated categories are those involving pregnancy, tornadoes, floods, fire, and homicide.
The most underestimated categories include deaths from diseases such as diabetes, strokes,
tuberculosis, asthma, and stomach cancer (although cancer in general is overestimated).

The question then is, Would you feel safer if you flew across the United States on a
commercial airline or if you drove? How much greater is the risk of one way to travel
over the other? See Statistics Today—Revisited at the end of the chapter for the answer.

In this chapter, you will learn about probability—its meaning, how it is computed,
and how to evaluate it in terms of the likelihood of an event actually happening.

Introduction
A cynical person once said, “The only two sure things are death and taxes.” This philos-
ophy no doubt arose because so much in people’s lives is affected by chance. From the time
you awake until you go to bed, you make decisions regarding the possible events that are
governed at least in part by chance. For example, should you carry an umbrella to work
today? Will your car battery last until spring? Should you accept that new job?
Probability as a general concept can be defined as the chance of an event occurring.
Many people are familiar with probability from observing or playing games of chance,
such as card games, slot machines, or lotteries. In addition to being used in games of
chance, probability theory is used in the fields of insurance, investments, and weather fore-
casting and in various other areas. Finally, as stated in Chapter 1, probability is the basis



Objective [E}
Determine sample
spaces and find the
probability of an
event, using classical
probability or
empirical probability.
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of inferential statistics. For example, predictions are based on probability, and hypotheses
are tested by using probability.

The basic concepts of probability are explained in this chapter. These concepts
include probability experiments, sample spaces, the addition and multiplication rules,
and the probabilities of complementary events. Also in this chapter, you will learn the rule
for counting, the differences between permutations and combinations, and how to figure
out how many different combinations for specific situations exist. Finally, Section 4-5
explains how the counting rules and the probability rules can be used together to solve a
wide variety of problems.

Sample Spaces and Probability

The theory of probability grew out of the study of various games of chance using coins,
dice, and cards. Since these devices lend themselves well to the application of concepts
of probability, they will be used in this chapter as examples. This section begins by
explaining some basic concepts of probability. Then the types of probability and proba-
bility rules are discussed.

Basic Concepts

Processes such as flipping a coin, rolling a die, or drawing a card from a deck are called
probability experiments.

A probability experiment is a chance process that leads to well-defined results called
outcomes.

An outcome is the result of a single trial of a probability experiment.

A trial means flipping a coin once, rolling one die once, or the like. When a coin is
tossed, there are two possible outcomes: head or tail. (Note: We exclude the possibility
of a coin landing on its edge.) In the roll of a single die, there are six possible outcomes:
1, 2, 3, 4, 5, or 6. In any experiment, the set of all possible outcomes is called the
sample space.

A sample space is the set of all possible outcomes of a probability experiment.

Some sample spaces for various probability experiments are shown here.

Experiment Sample space

Toss one coin Head, tail

Roll a die 1,2,3,4,5,6

Answer a true/false question True, false

Toss two coins Head-head, tail-tail, head-tail, tail-head

It is important to realize that when two coins are tossed, there are four possible out-
comes, as shown in the fourth experiment above. Both coins could fall heads up. Both
coins could fall tails up. Coin 1 could fall heads up and coin 2 tails up. Or coin 1 could
fall tails up and coin 2 heads up. Heads and tails will be abbreviated as H and T through-
out this chapter.

Example 4-1

Rolling Dice

Find the sample space for rolling two dice.
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Sample Space for
Rolling Two Dice
(Example 4-1)

Chapter 4 Probability and Counting Rules

Solution

Since each die can land in six different ways, and two dice are rolled, the sample space
can be presented by a rectangular array, as shown in Figure 4—1. The sample space is the
list of pairs of numbers in the chart.

Die 2
Die 1 1 2 3 4 5 6
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Example 4-2

-’> -’> ’> ‘>

Sample Space for
Drawing a Card
(Example 4-2)

Drawing Cards

Find the sample space for drawing one card from an ordinary deck of cards.

Solution

Since there are 4 suits (hearts, clubs, diamonds, and spades) and 13 cards for each suit
(ace through king), there are 52 outcomes in the sample space. See Figure 4-2.

_
o
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P - - €
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Example 4-3

Gender of Children

Find the sample space for the gender of the children if a family has three children. Use
B for boy and G for girl.

Solution

There are two genders, male and female, and each child could be either gender. Hence,
there are eight possibilities, as shown here.

BBB BBG BGB GBB GGG GGB GBG BGG

In Examples 4—1 through 4-3, the sample spaces were found by observation and rea-
soning; however, another way to find all possible outcomes of a probability experiment
is to use a tree diagram.
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A tree diagram is a device consisting of line segments emanating from a starting point
and also from the outcome point. It is used to determine all possible outcomes of a
probability experiment.

Example 4-4

Tree Diagram for
Example 4-4

The famous ltalian
astronomer Galileo
(1564-1642) found
that a sum of 10
occurs more often than
any other sum when
three dice are tossed.
Previously, it was
thought that a sum of 9
occurred more often
than any other sum.

A mathematician
named Jerome Cardan
(1501-1576) used his
talents in mathematics
and probability theory
to make his living as a
gambler. He is thought
to be the first person to
formulate the definition
of classical probability.

Gender of Children

Use a tree diagram to find the sample space for the gender of three children in a family,
as in Example 4-3.

Solution

Since there are two possibilities (boy or girl) for the first child, draw two branches from
a starting point and label one B and the other G. Then if the first child is a boy, there are
two possibilities for the second child (boy or girl), so draw two branches from B and
label one B and the other G. Do the same if the first child is a girl. Follow the same
procedure for the third child. The completed tree diagram is shown in Figure 4-3. To
find the outcomes for the sample space, trace through all the possible branches,
beginning at the starting point for each one.

Third
s d child Outcomes
econ
. B BBB
child
B /
First \
child G BBG
B
\ / B BGB
G \
G BGG
/ B GBB
B \
/ G GBG
G
\ / B GGB
G \
G GGG

An outcome was defined previously as the result of a single trial of a probability
experiment. In many problems, one must find the probability of two or more outcomes.
For this reason, it is necessary to distinguish between an outcome and an event.

An event consists of a set of outcomes of a probability experiment.

An event can be one outcome or more than one outcome. For example, if a die is
rolled and a 6 shows, this result is called an outcome, since it is a result of a single trial.
An event with one outcome is called a simple event. The event of getting an odd number
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During the mid-1600s,
a professional gambler
named Chevalier de
Méré made a consid-
erable amount of
money on a gambling
game. He would bet
unsuspecting patrons
that in four rolls of a
die, he could get at
least one 6. He was
so successful at the
game that some
people refused to
play. He decided that
a new game was
necessary to continue
his winnings. By
reasoning, he figured
he could roll at least
one double 6 in 24
rolls of two dice, but
his reasoning was
incorrect and he lost
systematically.
Unable to figure out
why, he contacted
a mathematician
named Blaise Pascal
(1623-1662) to find
out why.

Pascal became
interested and
began studying
probability theory.
He corresponded with
a French government
official, Pierre de
Fermat (1601-1665),
whose hobby was
mathematics. Together
the two formulated
the beginnings of
probability theory.

when a die is rolled is called a compound event, since it consists of three outcomes or
three simple events. In general, a compound event consists of two or more outcomes or
simple events.

There are three basic interpretations of probability:

1. Classical probability
2. Empirical or relative frequency probability
3. Subjective probability

Classical Probability

Classical probability uses sample spaces to determine the numerical probability that an
event will happen. You do not actually have to perform the experiment to determine that
probability. Classical probability is so named because it was the first type of probability
studied formally by mathematicians in the 17th and 18th centuries.

Classical probability assumes that all outcomes in the sample space are equally
likely to occur. For example, when a single die is rolled, each outcome has the same prob-
ability of occurring. Since there are six outcomes, each outcome has a probability of ¢.
When a card is selected from an ordinary deck of 52 cards, you assume that the deck
has bleen shuffled, and each card has the same probability of being selected. In this case,
it is 53.

Equally likely events are events that have the same probability of occurring.

Formula for Classical Probability

The probability of any event E is

Number of outcomes in £
Total number of outcomes in the sample space

This probability is denoted by

This probability is called classical probability, and it uses the sample space S.

Probabilities can be expressed as fractions, decimals, or—where appropriate—
percentages. If you ask, “What is the probability of getting a head when a coin is tossed?”
typical responses can be any of the following three.

“One-half.”
“Point five.”

“Fifty percent.

21

These answers are all equivalent. In most cases, the answers to examples and exercises
given in this chapter are expressed as fractions or decimals, but percentages are used
where appropriate.

IStrictly speaking, a percent is not a probability. However, in everyday language, probabilities are often expressed as percents
(i.e., there is a 60% chance of rain tomorrow). For this reason, some probabilities will be expressed as percents throughout this book.
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Rounding Rule for Probabilities Probabilities should be expressed as reduced
fractions or rounded to two or three decimal places. When the probability of an event is
an extremely small decimal, it is permissible to round the decimal to the first nonzero
digit after the point. For example, 0.0000587 would be 0.00006. When obtaining proba-
bilities from one of the tables in Appendix C, use the number of decimal places given in
the table. If decimals are converted to percentages to express probabilities, move the dec-
imal point two places to the right and add a percent sign.

Example 4-5 Drawing Cards

Find the probability of getting a red ace when a card is drawn at random from an
ordinary deck of cards.

Solution

Since there are 52 cards and there are 2 red aces, namely, the ace of hearts and the ace
of diamonds, P(red ace) = & = 5.

Example 4-6 Gender of Children

If a family has three children, find the probability that two of the three children are girls.

Solution

The sample space for the gender of the children for a family that has three children
has eight outcomes, that is, BBB, BBG, BGB, GBB, GGG, GGB, GBG, and BGG.
(See Examples 4-3 and 4—4.) Since there are three ways to have two girls, namely,
GGB, GBG, and BGG, P(two girls) = 3.

In probability theory, it is important to understand the meaning of the words and and

[{ istorical Nole or. For example, if you were asked to find the probability of getting a queen and a heart

Ancient Greeks and when you were drawing a single card from a deck, you would be looking for the queen
Romans made crude of hearts. Here the word and means “at the same time.” The word or has two meanings.
dice from animal For example, if you were asked to find the probability of selecting a queen or a heart
bones, various stones, when one card is selected from a deck, you would be looking for one of the 4 queens or
minerals, and ivory. one of the 13 hearts. In this case, the queen of hearts would be included in both cases and
When the dice were counted twice. So there would be 4 + 13 — 1 = 16 possibilities.

tested mathematically, On the other hand, if you were asked to find the probability of getting a queen or a
some were found to king, you would be looking for one of the 4 queens or one of the 4 kings. In this case,
be quite accurate. there would be 4 + 4 = 8 possibilities. In the first case, both events can occur at the same

time; we say that this is an example of the inclusive or. In the second case, both events
cannot occur at the same time, and we say that this is an example of the exclusive or.

Example 4-7 Drawing Cards
A card is drawn from an ordinary deck. Find these probabilities.
a. Of getting a jack
b. Of getting the 6 of clubs (i.e., a 6 and a club)
c. Of getting a 3 or a diamond
d. Of gettinga 3 ora 6
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Solution

a. Refer to the sample space in Figure 4-2. There are 4 jacks so there are 4
outcomes in event £ and 52 possible outcomes in the sample space. Hence,

P(jack) = 55 = 15
b. Since there is only one 6 of clubs in event £, the probability of getting a 6 of
clubs is
P(6 of clubs) = 35

c. There are four 3s and 13 diamonds, but the 3 of diamonds is counted twice in this
listing. Hence, there are 16 possibilities of drawing a 3 or a diamond, so

P(3 or diamond) = 1§ = &
This is an example of the inclusive or.
d. Since there are four 3s and four 6s,
PBor6)=3%=15

This is an example of the exclusive or.

There are four basic probability rules. These rules are helpful in solving probability
problems, in understanding the nature of probability, and in deciding if your answers to
the problems are correct.

ﬂistorical Note Probability Rule 1

Paintings in tombs

_ The probability of any event £ is a number (either a fraction or decimal) between and
excavated in Egypt including 0 and 1. This is denoted by 0 = P(E) =< 1.

show that the

Egyptians played
games of chance. One
game called Hound's
and Jackals played in

Rule 1 states that probabilities cannot be negative or greater than 1.

1800 B.C. is similar to Probability Rule 2
the present-day game

of Snakes and
Ladders.

If an event £ cannot occur (i.e., the event contains no members in the sample space), its
probability is 0.

Example 4-8 Rolling a Die

4-8

When a single die is rolled, find the probability of getting a 9.

Solution

Since the sample space is 1, 2, 3, 4, 5, and 6, it is impossible to get a 9. Hence, the
probability is P(9) = 2 = 0.

Probability Rule 3

If an event £ is certain, then the probability of £ is 1.
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In other words, if P(E) = 1, then the event E is certain to occur. This rule is illus-
trated in Example 4-9.

Example 4-9

Rolling a Die
When a single die is rolled, what is the probability of getting a number less than 7?

Solution
Since all outcomes—1, 2, 3, 4, 5, and 6—are less than 7, the probability is
P(number less than 7) = ¢ = 1

The event of getting a number less than 7 is certain.

In other words, probability values range from 0 to 1. When the probability of an
event is close to 0, its occurrence is highly unlikely. When the probability of an event is
near 0.5, there is about a 50-50 chance that the event will occur; and when the probabil-
ity of an event is close to 1, the event is highly likely to occur.

Probability Rule 4

The sum of the probabilities of all the outcomes in the sample space is 1.

For example, in the roll of a fair die, each outcome in the sample space has a prob-
ability of . Hence, the sum of the probabilities of the outcomes is as shown.

Outcome 1 2 3 4 5 6
Probability & : 1 L L 1
Sum ¢ + & + & + & + ¢ + t=%f=1

Complementary Events

Another important concept in probability theory is that of complementary events. When
a die is rolled, for instance, the sample space consists of the outcomes 1, 2, 3, 4, 5, and
6. The event E of getting odd numbers consists of the outcomes 1, 3, and 5. The event of
not getting an odd number is called the complement of event E, and it consists of the out-
comes 2, 4, and 6.

The complement of an event E is the set of outcomes in the sample space that are
not included in the outcomes of event E. The complement of E is denoted by E (read
“E bar").

Example 4-10 further illustrates the concept of complementary events.

Example 4-10

Finding Complements

Find the complement of each event.

a. Rolling a die and getting a 4
b. Selecting a letter of the alphabet and getting a vowel

4-9
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¢. Selecting a month and getting a month that begins with a J
d. Selecting a day of the week and getting a weekday

Solution
a. Gettinga 1,2,3,5,0r6
b. Getting a consonant (assume y is a consonant)

c¢. Getting February, March, April, May, August, September, October, November,
or December

d. Getting Saturday or Sunday

The outcomes of an event and the outcomes of the complement make up the entire
sample space. For example, if two coins are tossed, the sample space is HH, HT, TH, and
TT. The complement of “getting all heads” is not “getting all tails,” since the event “all
heads” is HH, and the complement of HH is HT, TH, and TT. Hence, the complement of
the event “all heads” is the event “getting at least one tail.”

Since the event and its complement make up the entire sample space, it follows
that the sum of the probability of the event and the probability of its complement
will equal 1. That is, P(E) + P(E) = 1. In Example 4-10, let E = all heads, or HH,
and let £ = at least one tail, or HT, TH, TT. Then P(E) = % and P(E) = %; hence,
PE)+ PE)=3+3=1.

The rule for complementary events can be stated algebraically in three ways.

Rule for Complementary Events

PEY=1—PE) or PE)=1—PE) o PE)+PE)=1

Stated in words, the rule is: If the probability of an event or the probability of its com-
plement is known, then the other can be found by subtracting the probability from 1. This
rule is important in probability theory because at times the best solution to a problem is
to find the probability of the complement of an event and then subtract from 1 to get the
probability of the event itself.

Example 4-11

4-10

Residence of People

If the probability that a person lives in an industrialized country of the world is , find
the probability that a person does not live in an industrialized country.

Source: Harper s Index.

Solution

P(not living in an industrialized country) = 1 — P(living in an industrialized country)

—1_1_4
=1-35=3

Probabilities can be represented pictorially by Venn diagrams. Figure 4—4(a) shows
the probability of a simple event E. The area inside the circle represents the probability
of event E, that is, P(E). The area inside the rectangle represents the probability of all the
events in the sample space P(S).
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Venn Diagram for the
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(a) Simple probability (b) P(E) =1 - P(E)

The Venn diagram that represents the probability of the complement of an event
P(E) is shown in Figure 4—4(b). In this case, P(E) = 1 — P(E), which is the area inside
the rectangle but outside the circle representing P(E). Recall that P(S) = 1 and P(E) =
1 — P(E). The reasoning is that P(E) is represented by the area of the circle and P(E) is
the probability of the events that are outside the circle.

Empirical Probability

The difference between classical and empirical probability is that classical probability
assumes that certain outcomes are equally likely (such as the outcomes when a die is
rolled), while empirical probability relies on actual experience to determine the likelihood
of outcomes. In empirical probability, one might actually roll a given die 6000 times,
observe the various frequencies, and use these frequencies to determine the probability of
an outcome.

Suppose, for example, that a researcher for the American Automobile Association
(AAA) asked 50 people who plan to travel over the Thanksgiving holiday how they will
get to their destination. The results can be categorized in a frequency distribution as
shown.

Method Frequency
Drive 41
Fly 6
Train or bus 3

50

Now probabilities can be computed for various categories. For example, the proba-
bility of selecting a person who is driving is %5, since 41 out of the 50 people said that
they were driving.

Formula for Empirical Probability

Given a frequency distribution, the probability of an event being in a given class is

PE) = frequency for the class _f

~ total frequencies in the distribution  n

This probability is called empirical probability and is based on observation.

4-11
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Example 4-12

Travel Survey

In the travel survey just described, find the probability that a person will travel by
airplane over the Thanksgiving holiday.

Solution

_S_6_3
PAE) n 50 25

Note: These figures are based on an AAA survey.

Example 4-13

4-12

Distribution of Blood Types

In a sample of 50 people, 21 had type O blood, 22 had type A blood, 5 had type B
blood, and 2 had type AB blood. Set up a frequency distribution and find the following
probabilities.

a. A person has type O blood.

b. A person has type A or type B blood.

c¢. A person has neither type A nor type O blood.

d. A person does not have type AB blood.

Source: The American Red Cross.

Solution
Type Frequency
A 22
B 5
AB 2
0 21
Total 50
_f_21
a. P(O) =50
22 5 27
b. P(AOI‘B)—%'F%—%
(Add the frequencies of the two classes.)
. 5 2 7
: ==+ ===
c. P(neither A nor O) = T 30" 30
(Neither A nor O means that a person has either type B or type AB blood.)
2 48 24
d. P(notAB) =1—-PAB)=1 —%—%—g

(Find the probability of not AB by subtracting the probability of type AB
from 1.)
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Example 4-14 Hospital Stays for Maternity Patients

Hospital records indicated that maternity patients stayed in the hospital for the number
of days shown in the distribution.

Number of
days stayed Frequency
3 15
4 32
5 56
6 19
7 s
127

Find these probabilities.

a. A patient stayed exactly 5 days. c. Apatient stayed at most 4 days.
b. A patient stayed less than 6 days.  d. A patient stayed at least 5 days.

Solution

56
a. P(5) = 127

15 32 56 103
b. P(fewer than 6 days) = 7 + o7 + 7= 127

(Fewer than 6 days means 3, 4, or 5 days.)
15,32 _ 47
127 127 127
(At most 4 days means 3 or 4 days.)

56 19 5 80
d. P(atleast 5 days) = o7 + 7 + 7" 17

(At least 5 days means 5, 6, or 7 days.)

c. Plat most 4 days) =

Empirical probabilities can also be found by using a relative frequency distribution,
as shown in Section 2-2. For example, the relative frequency distribution of the travel
survey shown previously is

Relative
Method Frequency frequency
Drive 41 0.82
Fly 6 0.12
Train or bus 3 0.06
50 1.00

These frequencies are the same as the relative frequencies explained in Chapter 2.

Law of Large Numbers

When a coin is tossed one time, it is common knowledge that the probability of getting
a head is 3. But what happens when the coin is tossed 50 times? Will it come up heads

4-13
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25 times? Not all the time. You should expect about 25 heads if the coin is fair. But due
to chance variation, 25 heads will not occur most of the time.

If the empirical probability of getting a head is computed by using a small number of
trials, it is usually not exactly 3. However, as the number of trials increases, the empirical
probability of getting a head will approach the theoretical probability of %, if in fact the
coin is fair (i.e., balanced). This phenomenon is an example of the law of large numbers.

You should be careful to not think that the number of heads and number of tails tend
to “even out.” As the number of trials increases, the proportion of heads to the total num-
ber of trials will approach 3. This law holds for any type of gambling game—tossing dice,
playing roulette, and so on.

It should be pointed out that the probabilities that the proportions steadily approach
may or may not agree with those theorized in the classical model. If not, it can have impor-
tant implications, such as “the die is not fair.” Pit bosses in Las Vegas watch for empiri-
cal trends that do not agree with classical theories, and they will sometimes take a set of
dice out of play if observed frequencies are too far out of line with classical expected
frequencies.

Subjective Probability

The third type of probability is called subjective probability. Subjective probability uses
a probability value based on an educated guess or estimate, employing opinions and inex-
act information.

In subjective probability, a person or group makes an educated guess at the chance
that an event will occur. This guess is based on the person’s experience and evaluation of
a solution. For example, a sportswriter may say that there is a 70% probability that the
Pirates will win the pennant next year. A physician might say that, on the basis of her
diagnosis, there is a 30% chance the patient will need an operation. A seismologist might
say there is an 80% probability that an earthquake will occur in a certain area. These are
only a few examples of how subjective probability is used in everyday life.

All three types of probability (classical, empirical, and subjective) are used to solve
a variety of problems in business, engineering, and other fields.

Probability and Risk Taking

An area in which people fail to understand probability is risk taking. Actually, people fear
situations or events that have a relatively small probability of happening rather than those
events that have a greater likelihood of occurring. For example, many people think that
the crime rate is increasing every year. However, in his book entitled How Risk Affects
Your Everyday Life, author James Walsh states: “Despite widespread concern about the
number of crimes committed in the United States, FBI and Justice Department statistics
show that the national crime rate has remained fairly level for 20 years. It even dropped
slightly in the early 1990s.”

He further states, “Today most media coverage of risk to health and well-being
focuses on shock and outrage.” Shock and outrage make good stories and can scare us
about the wrong dangers. For example, the author states that if a person is 20% over-
weight, the loss of life expectancy is 900 days (about 3 years), but loss of life expectancy
from exposure to radiation emitted by nuclear power plants is 0.02 day. As you can see,
being overweight is much more of a threat than being exposed to radioactive emission.

Many people gamble daily with their lives, for example, by using tobacco, drinking
and driving, and riding motorcycles. When people are asked to estimate the probabilities
or frequencies of death from various causes, they tend to overestimate causes such as
accidents, fires, and floods and to underestimate the probabilities of death from diseases
(other than cancer), strokes, etc. For example, most people think that their chances of
dying of a heart attack are 1 in 20, when in fact they are almost 1 in 3; the chances of
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dying by pesticide poisoning are 1 in 200,000 (True Odds by James Walsh). The reason
people think this way is that the news media sensationalize deaths resulting from cata-
strophic events and rarely mention deaths from disease.

When you are dealing with life-threatening catastrophes such as hurricanes, floods,
automobile accidents, or smoking, it is important to get the facts. That is, get the actual
numbers from accredited statistical agencies or reliable statistical studies, and then com-
pute the probabilities and make decisions based on your knowledge of probability and
statistics.

In summary, then, when you make a decision or plan a course of action based on
probability, make sure that you understand the true probability of the event occurring.
Also, find out how the information was obtained (i.e., from a reliable source). Weigh the
cost of the action and decide if it is worth it. Finally, look for other alternatives or courses
of action with less risk involved.

Applying the Concepts 4—1

Tossing a Coin

Assume you are at a carnival and decide to play one of the games. You spot a table where a
person is flipping a coin, and since you have an understanding of basic probability, you believe
that the odds of winning are in your favor. When you get to the table, you find out that all you
have to do is to guess which side of the coin will be facing up after it is tossed. You are assured
that the coin is fair, meaning that each of the two sides has an equally likely chance of
occurring. You think back about what you learned in your statistics class about probability
before you decide what to bet on. Answer the following questions about the coin-tossing game.

1. What is the sample space?

2. What are the possible outcomes?

3. What does the classical approach to probability say about computing probabilities for this
type of problem?

You decide to bet on heads, believing that it has a 50% chance of coming up. A friend of yours,
who had been playing the game for awhile before you got there, tells you that heads has come
up the last 9 times in a row. You remember the law of large numbers.

4. What is the law of large numbers, and does it change your thoughts about what will occur
on the next toss?

5. What does the empirical approach to probability say about this problem, and could you use
it to solve this problem?

6. Can subjective probabilities be used to help solve this problem? Explain.

7. Assume you could win $1 million if you could guess what the results of the next toss will
be. What would you bet on? Why?

See page 249 for the answers.

o -1

1. What is a probability experiment? 4. What are equally likely events?
2. Define sample space. 5. What is the range of the values of the probability of an
event?
3. What is the difference between an outcome and an
event? 6. When an event is certain to occur, what is its
probability?

4-15
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7. If an event cannot happen, what value is assigned to its
probability?

8. What is the sum of the probabilities of all the outcomes

in a sample space?

9. If the probability that it will rain tomorrow is 0.20, what

is the probability that it won’t rain tomorrow? Would
you recommend taking an umbrella?

10. A probability experiment is conducted. Which of these
cannot be considered a probability of an outcome?

a % d —0.59 g 1
b, —% e. 0 h. 33%
c. 0.80 f 145 i 112%

11. Classify each statement as an example of classical prob-

ability, empirical probability, or subjective probability.

a. The probability that a person will watch the 6 o’clock

evening news is 0.15.

b. The probability of winning at a Chuck-a-Luck

game is 3.

c. The probability that a bus will be in an accident on
a specific run is about 6%.

d. The probability of getting a royal flush when five
cards are selected at random is m.

e. The probability that a student will get a C or better
in a statistics course is about 70%.

/. The probability that a new fast-food restaurant will
be a success in Chicago is 35%.

g. The probability that interest rates will rise in the
next 6 months is 0.50.

12. (ans) Rolling a Die If a die is rolled one time, find
these probabilities.

Of getting a 4

Of getting an even number

Of getting a number greater than 4

Of getting a number less than 7

Of getting a number greater than 0

Of getting a number greater than 3 or an odd number

Q™S e AN =R

Of getting a number greater than 3 and an odd
number

13. Rolling Two Dice If two dice are rolled one time, find
the probability of getting these results.
a. Asumof6

Doubles

Asumof7or 11

A sum greater than 9

N

A sum less than or equal to 4

14. (ans) Drawing a Card If one card is drawn from a
deck, find the probability of getting these results.

4-16

15.

16.

17.

18.

An ace

A diamond

An ace of diamonds
Adorab

A4 oraclub

A 6 or a spade

A heart or a club

A red queen
Aredcardora?7

j. Ablack card and a 10

S0 TN A0 >R

~.

Shopping Mall Promotion A shopping mall has set up
a promotion as follows. With any mall purchase of $50
or more, the customer gets to spin the wheel shown
here. If a number 1 comes up, the customer wins $10. If
the number 2 comes up, the customer wins $5; and if
the number 3 or 4 comes up, the customer wins a
discount coupon. Find the following probabilities.

a. The customer wins $10.
b. The customer wins money.
c.  The customer wins a coupon.

\2
U

Selecting a State Choose one of the 50 states at
random.
a. What is the probability that it begins with M?

b. What is the probability that it doesn’t begin with a
vowel?

Human Blood Types Human blood is grouped into four
types. The percentages of Americans with each type are
listed below.

O 43% A 40% B 12% AB 5%

Choose one American at random. Find the probability
that this person

a. Has type O blood
b. Hastype AorB
¢. Does not have type O or A

Source: www.infoplease.com

Gender of College Students In 2004, 57.2% of all
enrolled college students were female. Choose one
enrolled student at random. What is the probability that
the student was male?

Source: www.nces.ed.gov
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19.

20.

21.

22.

23.

24.

Computers | 1-10

Prime Numbers A prime number is a number that is
evenly divisible only by 1 and itself. The prime
numbers less than 100 are listed below.

2 3 5 7 1r 13 17 19 23 29 31
37 41 43 47 53 59 61 67 71 73 719
8 89 97

Choose one of these numbers at random. Find the
probability that

a. The number is even

b. The sum of the number’s digits is even

c. The number is greater than 50

Rural Speed Limits Rural speed limits for all 50 states
are indicated below.

60 mph 65 mph 70 mph 75 mph

1 (HI) 18 18 13

Choose one state at random. Find the probability that its
speed limit is

a. 60 or 70 miles per hour

b. Greater than 65 miles per hour

c. 70 miles per hour or less

Source: World Almanac.

Gender of Children A couple has three children. Find
each probability.

a. All boys

b. All girls or all boys

¢. Exactly two boys or two girls

d. At least one child of each gender

Craps Game In the game of craps using two dice, a
person wins on the first roll if a 7 or an 11 is rolled. Find
the probability of winning on the first roll.

Craps Game In a game of craps, a player loses on the
roll ifa 2, 3, or 12 is tossed on the first roll. Find the
probability of losing on the first roll.

Computers in Elementary Schools Elementary and
secondary schools were classified by the number of
computers they had. Choose one of these schools at
random.

11-20  21-50 51-100 100+

Schools

|3170 4590 16,741 23,753 34,803

Choose one school at random. Find the probability that
it has

a. 50 or fewer computers
b. More than 100 computers
¢. No more than 20 computers

Source: World Almanac.

25.

26.

27.

28.

29.

30.
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Roulette A roulette wheel has 38 spaces numbered

1 through 36, 0, and 00. Find the probability of getting
these results.

a. An odd number (Do not count 0 or 00.)

A number greater than 27

A number that contains the digit 0

ST

Based on the answers to parts a, b, and ¢, which is
most likely to occur? Explain why.

Gasoline Mileage for Autos and Trucks Of the top
10 cars and trucks based on gas mileage, 4 are Hondas,
3 are Toyotas, and 3 are Volkswagens. Choose one at
random. Find the probability that it is

a. Japanese
b. Japanese or German
¢. Not foreign

Source: www.autobytel.com

Large Monetary Bills in Circulation There are
1,765,000 five thousand dollar bills in circulation and
3,460,000 ten thousand dollar bills in circulation. Choose
one bill at random (wouldn’t that be nice!). What is the
probability that it is a ten thousand dollar bill?

Source: World Almanac.

Sources of Energy Uses in the United States A
breakdown of the sources of energy used in the United
States is shown below. Choose one energy source at
random. Find the probability that it is

a. Not oil
b. Natural gas or oil

¢. Nuclear
0il 39% Natural gas 24% Coal 23%
Nuclear 8% Hydropower 3% Other 3%

Source: www.infoplease.com

Rolling Dice Roll two dice and multiply the numbers.

a. Write out the sample space.

b. What is the probability that the product is a multiple
of 67

c. What is the probability that the product is less
than 10?

Federal Government Revenue The source of federal
government revenue for a specific year is
50% from individual income taxes
32% from social insurance payroll taxes
10% from corporate income taxes
3% from excise taxes
5% other

4-17
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31.

32.

33.
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If a revenue source is selected at random, what is the
probability that it comes from individual or corporate
income taxes?

Source: New York Times Almanac.

Selecting a Bill A box contains a $1 bill, a $5 bill, a
$10 bill, and a $20 bill. A bill is selected at random, and
it is not replaced; then a second bill is selected at
random. Draw a tree diagram and determine the sample
space.

Tossing Coins Draw a tree diagram and determine the
sample space for tossing four coins.

Selecting Numbered Balls Four balls numbered 1
through 4 are placed in a box. A ball is selected at
random, and its number is noted; then it is replaced. A
second ball is selected at random, and its number is
noted. Draw a tree diagram and determine the sample
space.

Extending the Concepts

37.

38.

39.

Distribution of CEO Ages The distribution of ages of
CEOs is as follows:

Age Frequency
21-30 1
3140 8
41-50 27
51-60 29
61-70 24
71—up 11

Source: Information based on
USA TODAY Snapshot.

If a CEO is selected at random, find the probability that
his or her age is

a. Between 31 and 40

b. Under 31

c¢. Over 30 and under 51

d. Under 31 or over 60

Tossing a Coin A person flipped a coin 100 times and
obtained 73 heads. Can the person conclude that the
coin was unbalanced?

Medical Treatment A medical doctor stated that with
a certain treatment, a patient has a 50% chance of
recovering without surgery. That is, “Either he will

get well or he won’t get well.” Comment on this
statement.

4-18

34.

3S.

36.

40.

41.

42,

Family Dinner Combinations A family special at a
neighborhood restaurant offers dinner for four for
$19.99. There are 3 appetizers available, 4 entrees, and
3 desserts from which to choose. The special includes
one of each. Represent the possible dinner combinations
with a tree diagram.

Required First-Year College Courses First-year
students at a particular college must take one English
class, one class in mathematics, a first-year seminar, and
an elective. There are 2 English classes to choose from,
3 mathematics classes, 5 electives, and everyone takes
the same first-year seminar. Represent the possible
schedules using a tree diagram.

Tossing a Coin and Rolling a Die A coin is tossed; if
it falls heads up, it is tossed again. If it falls tails up, a
die is rolled. Draw a tree diagram and determine the
outcomes.

Wheel Spinner The wheel spinner shown here is spun
twice. Find the sample space, and then determine the
probability of the following events.

a. An odd number on the first spin and an even number
on the second spin (Note: 0 is considered even.)

b. A sum greater than 4

¢.  Even numbers on both spins

d. A sum that is odd

e. The same number on both spins

Tossing Coins Toss three coins 128 times and record

the number of heads (0, 1, 2, or 3); then record your
results with the theoretical probabilities. Compute the
empirical probabilities of each.

Tossing Coins Toss two coins 100 times and record the
number of heads (0, 1, 2). Compute the probabilities of
each outcome, and compare these probabilities with the
theoretical results.



43. Odds Odds are used in gambling games to make them
fair. For example, if you rolled a die and won every time
you rolled a 6, then you would win on average once
every 6 times. So that the game is fair, the odds of 5 to 1
are given. This means that if you bet $1 and won, you
could win $5. On average, you would win $5 once in
6 rolls and lose $1 on the other 5 rolls—hence the term
fair game.

In most gambling games, the odds given are not fair.
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In the die example,

1
=—orl:5

Odds in favor ofa 6 = 5

N[N E

=§or5:1

Odds againsta 6 = 1

=[N

Find the odds in favor of and against each event.

For example, if the odds of winning are really 20 to 1, a. Rolling a die and getting a 2
the house might offer 15 to 1 in order to make a profit. b. Rolling a die and getting an even number
Odds can be expressed as a fraction or as a ratio, ¢. Drawing a card from a deck and getting
such as ?, 5:1, or 5 to 1. Odds are computed in favor aspade
of the event or against the event. The formulas for d. Drawing a card and getting a red card
odds are e. Drawing a card and getting a queen
' P(E) /. Tossing two coins and getting two tails
Odds in favor = . . . .
1 — P(E) g. Tossing two coins and getting one tail
. P(E)
Odds against = = P@)

The Addition Rules for Probability

Objective B

Find the probability
of compound events,
using the addition
rules.

[ orical Nolte

The first book on
probability, The Book
of Chance and
Games, was written
by Jerome Cardan
(1601-1576). Cardan
was an astrologer,
philosopher, physician,
mathematician, and
gambler. This book
contained techniques
on how to cheat and
how to catch others at
cheating.

Many problems involve finding the probability of two or more events. For example, at a
large political gathering, you might wish to know, for a person selected at random, the
probability that the person is a female or is a Republican. In this case, there are three pos-
sibilities to consider:

1. The person is a female.
2. The person is a Republican.
3. The person is both a female and a Republican.

Consider another example. At the same gathering there are Republicans, Democrats,
and Independents. If a person is selected at random, what is the probability that the per-
son is a Democrat or an Independent? In this case, there are only two possibilities:

1. The person is a Democrat.
2. The person is an Independent.

The difference between the two examples is that in the first case, the person selected
can be a female and a Republican at the same time. In the second case, the person
selected cannot be both a Democrat and an Independent at the same time. In the second

case, the two events are said to be mutually exclusive, in the first case, they are not mutu-
ally exclusive.

Two events are mutually exclusive events if they cannot occur at the same time
(i.e., they have no outcomes in common).

In another situation, the events of getting a 4 and getting a 6 when a single card is
drawn from a deck are mutually exclusive events, since a single card cannot be both a 4
and a 6. On the other hand, the events of getting a 4 and getting a heart on a single draw
are not mutually exclusive, since you can select the 4 of hearts when drawing a single
card from an ordinary deck.

4-19
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Example 4-15

Rolling a Die
Determine which events are mutually exclusive and which are not, when a single die is
rolled.

a. Getting an odd number and getting an even number

b. Getting a 3 and getting an odd number

c¢. Getting an odd number and getting a number less than 4

d. Getting a number greater than 4 and getting a number less than 4

Solution
a. The events are mutually exclusive, since the first event can be 1, 3, or 5 and the
second event can be 2, 4, or 6.

b. The events are not mutually exclusive, since the first event is a 3 and the second
can be 1, 3, or 5. Hence, 3 is contained in both events.

c. The events are not mutually exclusive, since the first event can be 1, 3, or 5 and
the second can be 1, 2, or 3. Hence, 1 and 3 are contained in both events.

d. The events are mutually exclusive, since the first event can be 5 or 6 and the
second event can be 1, 2, or 3.

Example 4-16

Drawing a Card

Determine which events are mutually exclusive and which are not, when a single card is
drawn from a deck.

a. Getting a 7 and getting a jack

b. Getting a club and getting a king

c¢. Getting a face card and getting an ace
d. Getting a face card and getting a spade

Solution

Only the events in parts a and ¢ are mutually exclusive.

The probability of two or more events can be determined by the addition rules. The
first addition rule is used when the events are mutually exclusive.

Addition Rule 1

When two events 4 and B are mutually exclusive, the probability that 4 or B will occur is

P(4 or B) = P(4) + P(B)

Example 4-17

4-20

Selecting a Doughnut

A box contains 3 glazed doughnuts, 4 jelly doughnuts, and 5 chocolate doughnuts. If a
person selects a doughnut at random, find the probability that it is either a glazed
doughnut or a chocolate doughnut.
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Solution

Since the box contains 3 glazed doughnuts, 5 chocolate doughnuts, and a total of 12
doughnuts, P(glazed or chocolate) = P(glazed) + P(chocolate) = &5 + 5 = 5 = 2. The
events are mutually exclusive.

Example 4-18

Political Affiliation at a Rally

At a political rally, there are 20 Republicans, 13 Democrats, and 6 Independents. If a
person is selected at random, find the probability that he or she is either a Democrat or
an Independent.

Solution
P(Democrat or Independent) = P(Democrat) + P(Independent)

B, 6 _1
_39+39_39

Example 4-19

Selecting a Day of the Week
A day of the week is selected at random. Find the probability that it is a weekend day.

Solution

P(Saturday or Sunday) = P(Saturday) + P(Sunday) = % +1 =2

When two events are not mutually exclusive, we must subtract one of the two prob-
abilities of the outcomes that are common to both events, since they have been counted
twice. This technique is illustrated in Example 4-20.

Example 4-20

Drawing a Card

A single card is drawn at random from an ordinary deck of cards. Find the probability
that it is either an ace or a black card.

Solution

Since there are 4 aces and 26 black cards (13 spades and 13 clubs), 2 of the aces are
black cards, namely, the ace of spades and the ace of clubs. Hence the probabilities of
the two outcomes must be subtracted since they have been counted twice.

P(ace or black card) = P(ace) + P(black card) — P(black aces) = ;iz + ﬁ—g — 5% = g—; = %

When events are not mutually exclusive, addition rule 2 can be used to find the prob-
ability of the events.

Addition Rule 2

If A and B are not mutually exclusive, then
P(A4 or B) = P(4) + P(B) — P(4 and B)

4-21
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Note: This rule can also be used when the events are mutually exclusive, since
P(4 and B) will always equal 0. However, it is important to make a distinction between
the two situations.

Example 4-21

Selecting a Medical Staff Person

In a hospital unit there are 8 nurses and 5 physicians; 7 nurses and 3 physicians are females.
If a staff person is selected, find the probability that the subject is a nurse or a male.

Solution

The sample space is shown here.

Staff Females Males Total
Nurses 7 1 8
Physicians 3 2 )
Total 10 3 13
The probability is

P(nurse or male) = P(nurse) + P(male) — P(male nurse)

8 43 _1_10
_13+13 13713

Example 4-22

4-22

Driving While Intoxicated

On New Year’s Eve, the probability of a person driving while intoxicated is 0.32, the
probability of a person having a driving accident is 0.09, and the probability of a person
having a driving accident while intoxicated is 0.06. What is the probability of a person
driving while intoxicated or having a driving accident?

Solution

P(intoxicated or accident) = P(intoxicated) + P(accident)
— P(intoxicated and accident)
=0.32 + 0.09 — 0.06 = 0.35

In summary, then, when the two events are mutually exclusive, use addition rule 1.
When the events are not mutually exclusive, use addition rule 2.

The probability rules can be extended to three or more events. For three mutually
exclusive events 4, B, and C,

P(AorBorC)=P) + PB) + P(C)
For three events that are not mutually exclusive,

P(AorBorC)=P(A) + P(B) + P(C) — P(A and B) — P(4 and C)
— P(Band C) + P(4 and B and C)
See Exercises 23 and 24 in this section.

Figure 4-5(a) shows a Venn diagram that represents two mutually exclusive events 4
and B. In this case, P(4 or B) = P(4) + P(B), since these events are mutually exclusive



[ 1
Venn Diagrams for the
Addition Rules
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P(Aand B)

P(§)=1 P(S)=1
(a) Mutually exclusive events (b) Nonmutually exclusive events
P(Aor B) = P(A) + P(B) P(Aor B)=P(A) + P(B) - P(Aand B)

and do not overlap. In other words, the probability of occurrence of event 4 or event B
is the sum of the areas of the two circles.

Figure 4-5(b) represents the probability of two events that are not mutually exclu-
sive. In this case, P(4 or B) = P(4) + P(B) — P(4 and B). The area in the intersection
or overlapping part of both circles corresponds to P(4 and B); and when the area of cir-
cle 4 is added to the area of circle B, the overlapping part is counted twice. It must there-
fore be subtracted once to get the correct area or probability.

Note: Venn diagrams were developed by mathematician John Venn (1834—1923) and
are used in set theory and symbolic logic. They have been adapted to probability theory
also. In set theory, the symbol U represents the union of two sets, and 4 U B corresponds
to 4 or B. The symbol N represents the intersection of two sets, and 4 N B corresponds to
A and B. Venn diagrams show only a general picture of the probability rules and do not por-
tray all situations, such as P(4) = 0, accurately.

Applying the Concepts 4—2

Which Pain Reliever Is Best?

Assume that following an injury you received from playing your favorite sport, you obtain
and read information on new pain medications. In that information you read of a study

that was conducted to test the side effects of two new pain medications. Use the following
table to answer the questions and decide which, if any, of the two new pain medications you
will use.

Number of side effects in 12-week
clinical trial

Placebo Drug A Drug B
Side effect n =192 n =186 n =188
Upper respiratory congestion 10 32 19
Sinus headache 11 25 32
Stomach ache 2 46 12
Neurological headache 34 55 72
Cough 22 18 31
Lower respiratory congestion 2 5 1

4-23
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. How long was the study?

N N R W N =

. How many subjects were in the study?

. What were the variables under study?

. What type of variables are they, and what level of measurement are they on?

. Are the numbers in the table exact figures?

. What is the probability that a randomly selected person was receiving a placebo?

. What is the probability that a person was receiving a placebo or drug A? Are these

mutually exclusive events? What is the complement to this event?

8. What is the probability that a randomly selected person was receiving a placebo or
experienced a neurological headache?

9. What is the probability that a randomly selected person was not receiving a placebo or

experienced a sinus headache?

See page 249 for the answers.

1. Define mutually exclusive events, and give an example
of two events that are mutually exclusive and two
events that are not mutually exclusive.

2. Determine whether these events are mutually exclusive.
a. Roll a die: Get an even number, and get a number
less than 3.
b. Roll a die: Get a prime number (2, 3, 5), and get an
odd number.
c¢. Roll a die: Get a number greater than 3, and get a
number less than 3.

d. Select a student in your class: The student has blond

hair, and the student has blue eyes.

e. Select a student in your college: The student is a
sophomore, and the student is a business major.

f. Select any course: It is a calculus course, and it is an

English course.

g. Select a registered voter: The voter is a Republican,

and the voter is a Democrat.

3. College Degrees Awarded The table below represents
the college degrees awarded in a recent academic year
by gender.

Bachelor’s Master’s Doctorate
Men 573,079 211,381 24,341
Women 775,424 301,264 21,683

Choose a degree at random. Find the probability that it is

a. Abachelor’s degree

b. A doctorate or a degree awarded to a woman
¢. A doctorate awarded to a woman

d. Not a master’s degree

Source: www.nces.ed.gov
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. Selecting a Staff Person Ata community swimming

pool there are 2 managers, 8 lifeguards, 3 concession
stand clerks, and 2 maintenance people. If a person is
selected at random, find the probability that the person
is either a lifeguard or a manager.

. Selecting an Instructor At a convention there are

7 mathematics instructors, 5 computer science instructors,
3 statistics instructors, and 4 science instructors. If an
instructor is selected, find the probability of getting a
science instructor or a math instructor.

. Selecting a Movie A media rental store rented the

following number of movie titles in each of these
categories: 170 horror, 230 drama, 120 mystery,

310 romance, and 150 comedy. If a person selects a
movie to rent, find the probability that it is a romance or a
comedy. Is this event likely or unlikely to occur? Explain
your answer.

. Selecting a Nurse A recent study of 200 nurses found

that of 125 female nurses, 56 had bachelor’s degrees; and
of 75 male nurses, 34 had bachelor’s degrees. If a nurse is
selected at random, find the probability that the nurse is

a. A female nurse with a bachelor’s degree

b. A male nurse

¢. A male nurse with a bachelor’s degree

d

Based on your answers to parts a, b, and ¢, explain
which is most likely to occur. Explain why.

. Tourist Destinations The probability that a given

tourist goes to the amusement park is 0.47, and the
probability that she goes to the water park is 0.58. If the
probability that she goes to either the water park or the
amusement park is 0.95, what is the probability that she
visits both of the parks on vacation?


www.nces.ed.gov

10.

11.

12.

. Sports Participation At a particular school with 200

male students, 58 play football, 40 play basketball, and
8 play both. What is the probability that a randomly
selected male student plays neither sport?

Selecting a Card A single card is drawn from a deck.
Find the probability of selecting the following.

a. A4 oradiamond

b. Aclub or a diamond

c. Ajack or ablack card

Selecting a Student In a statistics class there are 18
juniors and 10 seniors; 6 of the seniors are females, and
12 of the juniors are males. If a student is selected at
random, find the probability of selecting the following.
a. A junior or a female

b. A senior or a female

¢.  Ajunior or a senior

Selecting a Book At a used-book sale, 100 books are
adult books and 160 are children’s books. Of the adult
books, 70 are nonfiction while 60 of the children’s
books are nonfiction. If a book is selected at random,
find the probability that it is

a. Fiction

b. Not a children’s nonfiction book

¢.  An adult book or a children’s nonfiction book

13. Young Adult Residences According to the Bureau of

the Census, the following statistics describe the number

(in thousands) of young adults living at home or in a

dormitory in the year 2004.

Ages 18-24 Ages 25-34

Male 7922 2534

Female 5779 995

Source: World Almanac.

Choose one student at random. Find the probability that

the student is

a. A female student aged 25-34

b. Male or aged 18-24

c.  Under 25 years of age and not male
14. Endangered Species The chart below shows the

numbers of endangered and threatened species both here

in the United States and abroad.

Endangered Threatened
United United
States Foreign States Foreign

Mammals 68 251 10 20
Birds 77 175 13 6
Reptiles 14 64 22 16
Amphibians 11 8 10 1

Source: www.infoplease.com

15.

16.

17.

18.
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Choose one species at random. Find the probability that
itis

a. Threatened and in the United States

b. An endangered foreign bird

c¢. A mammal or a threatened foreign species

Multiple Births The number of multiple births in the
United States for a recent year indicated that there were
128,665 sets of twins, 7110 sets of triplets, 468 sets of
quadruplets, and 85 sets of quintuplets. Choose one set
of siblings at random. Find the probability that it

a. Represented more than two babies
b. Represented quads or quints

c¢. Now choose one baby from these multiple births.
What is the probability that the baby was a triplet?

Licensed Drivers in the United States In a recent year
there were the following numbers (in thousands) of
licensed drivers in the United States.

Male Female
Age 19 and under 4746 4517
Age 20 1625 1553
Age 21 1679 1627

Source: World Almanac.

Choose one driver at random. Find the probability that
the driver is

a. Male and 19 or under

b. Age 20 or female

c. Atleast 20 years old

Cable Channel Programming Three cable channels

(6, 8, and 10) have quiz shows, comedies, and dramas.
The number of each is shown here.

Channel Channel Channel
Type of show 6 8 10
Quiz show 5 2 1
Comedy 3 2 8
Drama 4 4 2

If a show is selected at random, find these probabilities.
a. The show is a quiz show, or it is shown on

channel 8.
b. The show is a drama or a comedy.

The show is shown on channel 10, or it is

a drama.

Mail Delivery A local postal carrier distributes first-
class letters, advertisements, and magazines. For a
certain day, she distributed the following numbers of
each type of item.

First-class

Delivered to letters Ads Magazines
Home 325 406 203
Business 732 1021 97
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If an item of mail is selected at random, find these
probabilities.

a. The item went to a home.

b. The item was an ad, or it went to a business.

c. The item was a first-class letter, or it went to
a home.

Medical Tests on Emergency Patients The frequency
distribution shown here illustrates the number of
medical tests conducted on 30 randomly selected
emergency patients.

Number of tests Number of
performed patients
0 12
1 8
2 2
3 3
4 or more 5

If a patient is selected at random, find these probabilities.

a. The patient has had exactly 2 tests done.
The patient has had at least 2 tests done.
The patient has had at most 3 tests done.
The patient has had 3 or fewer tests done.
The patient has had 1 or 2 tests done.

LIS

A social organization of 32 members sold college
sweatshirts as a fundraiser. The results of their sale are
shown below.

No. of sweatshirts No. of students

0 2
1-5 13
6-10 8
11-15 4
16-20 4
20+ 1

Choose one student at random. Find the probability that
the student sold

a. More than 10 sweatshirts

b. At least one sweatshirt

¢. 1-5 or more than 15 sweatshirts

Door-to-Door Sales A sales representative who visits
customers at home finds she sells 0, 1, 2, 3, or 4 items
according to the following frequency distribution.

Items sold Frequency
0 8
1 10
2 3
3 2
4 1
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23.

24.
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Find the probability that she sells the following.

a. Exactly 1 item

b. More than 2 items

c. Atleast ] item

d. At most 3 items

Medical Patients A recent study of 300 patients

found that of 100 alcoholic patients, 87 had elevated
cholesterol levels, and of 200 nonalcoholic patients,
43 had elevated cholesterol levels. If a patient is
selected at random, find the probability that the patient
is the following.

a. An alcoholic with elevated cholesterol
level

b. A nonalcoholic

A nonalcoholic with nonelevated cholesterol
level

Selecting a Card If one card is drawn from an
ordinary deck of cards, find the probability of getting
the following.

A king or a queen or a jack
A club or a heart or a spade
A king or a queen or a diamond

An ace or a diamond or a heart

8 A D =R

A9 ora 10 ora spade or a club

Rolling a Die Two dice are rolled. Find the probability
of getting

a. Asumof5,6,or7

b. Doubles or a sum of 6 or 8

¢. A sum greater than 8 or less than 3

d

Based on the answers to parts a, b, and ¢, which is
least likely to occur? Explain why.

Corn Products U.S. growers harvested 11 billion
bushels of corn in 2005. About 1.9 billion bushels were
exported, and 1.6 billion bushels were used for ethanol.
Choose one bushel of corn at random. What is the
probability that it was used either for export or for
ethanol?

Source: www.census.gov

Rolling Dice Three dice are rolled. Find the probability
of getting

a. Triples b. Asumof5
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Extending the Concepts

27. Purchasing a Pizza The probability that a customer LAFF-A-DAY
selects a pizza with mushrooms or pepperoni is 0.43,
and the probability that the customer selects only
mushrooms is 0.32. If the probability that he or she
selects only pepperoni is 0.17, find the probability of the
customer selecting both items.

'v o
ROSS INSURANCE \

28. Building a New Home In building new homes, a
contractor finds that the probability of a home buyer
selecting a two-car garage is 0.70 and of selecting a
one-car garage is 0.20. Find the probability that the
buyer will select no garage. The builder does not build
houses with three-car or more garages.

29. In Exercise 28, find the probability that the buyer will

not want a two-car garage. SCHOCHET
30. Suppose that P(4) = 0.42, P(B) = 0.38, and “I know you haven’t had an accident in thirteen years.
P(4 U B) = 0.70. Are A and B mutually exclusive? We’re raising your rates because you’re about due one.”
Explaln. Source: © King Features Syndicate.
Step by Step
M I N ITAB Calculate Relative Frequency Probabilities
Step by Step The random variable X represents the number of days patients stayed in the hospital from

Example 4-14.

1. In C1 of a worksheet, type in the values of X. Name the column X.
2. In C2 enter the frequencies. Name the column f.
3. To calculate the relative frequencies and store them in a new column named Px:
a) Select Calc>Calculator.
b) Type Px in the box for Store result in variable:.
c¢) Click in the Expression box, then double-click C2 f.
d) Type or click the division operator.
e) Scroll down the function list to Sum, then click [Select].
f) Double-click C2 f to select it.
g) Click [OK].
The dialog box and completed worksheet are shown.

Calculator

Cl E Store result in variable: [Px
Expression:
s suNCED
Functions:
7|89 = | <»| |All functioos vl

-

W Worksheet 1 *** il 2

|
el
1|2]a ;! <=
X | € | P | o | 1] A

1 3 15 0118110 :[
2 4 32 025199 N
3 3 &5 0440845 ﬁl ﬂ[
4 & 19 0.149606
5 7 5 000970 ey
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Tabulated statistics: SMOKING STATUS, GENDER € ID-WEER | Categ riables:

oE i R For rows: [ 'SHOKING STATUS'
Rows: SMOK|NG STATUS Columns: GENDER c4 SHOKING STA| Forcolumns: [GENDER

lfz II'ETG‘H"T‘SE For layers: |

F M Al E; 5\'510;?.!01 Frequenciesarein: |  [optional)

0 25 22 47 o o | ’

rlil.]. GENDER v Display
1 1 8 1 9 37 12 MARITAL-ST 7 Caunta

I” Row percents
2 7 9 16 [~ Column percents
Al 50 50 100 RS chi-square... | other Stats...|
Select Options...
Cell Contents: Count Lo Lol
Help [ ok g | Cancel |

If the original data, rather than the table, are in a worksheet, use Stat>Tables>Tally to make
the tables with percents (Section 2—1).
MINITAB can also make a two-way classification table.

Construct a Contingency Table
1. Select File>Open Worksheet to open the Databank.mtw file.

2. Select Stat>Tables>Crosstabulation . ..
a) Double-click C4 SMOKING STATUS to select it For rows:.
b) Select C11 GENDER for the For Columns: Field.
¢) Click on option for Counts and then [OK].

The session window and completed dialog box are shown.

Cross Tabulation and Chi-Square

In this sample of 100 there are 25 females who do not smoke compared to 22 men. Sixteen
individuals smoke 1 pack or more per day.

TI-83 Plus or
TI-84 Plus

Step by Step

4-28

To construct a relative frequency table:
1. Enter the data values in L, and the frequencies in L,
2. Move the cursor to the top of the L, column so that L, is highlighted.
3. Type L, divided by the sample size, then press ENTER.

Use the data from Example 4-14.

Li Lz L] 3 Li Lz L3 3
] FC ] 1c :
i 32 i 32 25187
£ g £ g 4inay
B ig B ig 44951
7 £ 7 07
Lz=Lz-127N L=, 11281162362,
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Excel
Step hy Step

Constructing a Relative Frequency Distribution
Use the data from Example 4-14.

1. In a new worksheet, type the label DAYS in cell A1. Beginning in cell A2, type in the data
for the variable representing the number of days maternity patients stayed in the hospital.

2. In cell B1, type the label for the frequency, COUNT. Beginning in cell B2, type in the
frequencies.

3. In cell B7, compute the total frequency by selecting the sum icon Z from the toolbar and
press Enter.

4. Incell C1, type a label for the relative frequencies, Rf. In cell C2, type =(B2)/(B7) and Enter.
In cell C2, type =(B3)/(B7) and Enter. Repeat this for each of the remaining frequencies.

5. To find the total relative frequency, select the sum icon Z from the toolbar and Enter. This
sum should be 1.

R L Bkl - Microsoft Excel non-commereial use - X
Lo
) Home | Insert FageLayout  Formuias Data Review  View  Adddns W - x
oy L0 e P Gebl | o) || Sestnsen’s | E ;
Caliti S - |A AT ™ o (| SR | Genenal - ! 2 L é
Bt = Ko o5 I DA A
Paste B L0 @3 | | a8 - % o |/%8 M| condional Format cen . Soit & Find &
- ¥ EalE A [ W0 i Formatling + as Table + Shes - | (EIFOrmat= || 2~ Fitter~ Select
Chpbanrd & Font i augnment 0} Humber [ Shiés Cem tamng
i o7 -l fe | #
A B G B X F G H I 1 3 L M N o i
Days  Count RE
a 15 011811
4 32 0.251969
5 56 0440945
6 19 0.149606
7 5 003937
w ]

Constructing a Contingency Table
Example XL4-1

For this example, you will need to have the MegaStat Add-In installed on Excel (refer to
Chapter 1, Excel Step by Step instructions for instructions on installing MegaStat).

1. Open the Databank.xls file from the CD-ROM that came with your text. To do this:
Double-click My Computer on the Desktop.
Double-click the Bluman CD-ROM icon in the CD drive holding the disk.
Double-click the datasets folder. Then double-click the all_data-sets folder.

Double-click the bluman_es_data-sets_excel-windows folder. In this folder double-click
the Databank.xIs file. The Excel program will open automatically once you open this
file.
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. Highlight the column labeled SMOKING STATUS to copy these data onto a new Excel

worksheet.

. Click the Microsoft Office Button ) , select New Blank Workbook, then Create.

. With cell A1 selected, click the Paste icon on the toolbar to paste the data into the new

workbook.

. Return to the Databank.xls file. Highlight the column labeled Gender. Copy and

paste these data into column B of the worksheet containing the SMOKING STATUS
data.

. Type in the categories for SMOKING STATUS, 0, 1, and 2 into cells C2—C4. In cell D2,

type M for male and in cell D3, type F for female.
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7. On the toolbar, select Add-Ins. Then select MegaStat. Note: You may need to open

MegaStat from the file MegaStat.xls saved on your computer’s hard drive.

8. Select Chi-Square/Crosstab>Crosstabulation.
9. In the Row variable Data range box, type A1:A101. In the Row variable Specification

range box, type C2:C4. In the Column variable Data range box, type B1:B101. In the
Column variable Specification range box, type D2:D3. Remove any checks from the
Output Options. Then click [OK].

Crosstabulation
GENDER
M F Total
SMOKING STATUS (] il 25 46
1 1 [ 37
2 3 8 17
Tulal 49 51 100
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m The Multiplication Rules and Conditional Probability

Objective [E}]
Find the probability
of compound
events, using the
multiplication rules.

Section 4-2 showed that the addition rules are used to compute probabilities for mutually
exclusive and non-mutually exclusive events. This section introduces the multiplication
rules.

The Multiplication Rules

The multiplication rules can be used to find the probability of two or more events that
occur in sequence. For example, if you toss a coin and then roll a die, you can find the
probability of getting a head on the coin and a 4 on the die. These two events are said to
be independent since the outcome of the first event (tossing a coin) does not affect the
probability outcome of the second event (rolling a die).

Two events A and B are independent events if the fact that A occurs does not affect
the probability of B occurring.

Here are other examples of independent events:

Rolling a die and getting a 6, and then rolling a second die and getting a 3.

Drawing a card from a deck and getting a queen, replacing it, and drawing a second
card and getting a queen.

To find the probability of two independent events that occur in sequence, you must
find the probability of each event occurring separately and then multiply the answers. For
example, if a coin is tossed twice, the probability of getting two heads is 3 - 3 = 1. This

result can be verified by looking at the sample space HH, HT, TH, TT. Then P(HH) = 1.

Multiplication Rule 1

When two events are independent, the probability of both occurring is

P(4 and B) = P(4) - P(B)

Example 4-23

Tossing a Coin

A coin is flipped and a die is rolled. Find the probability of getting a head on the coin
and a 4 on the die.

Solution
P(head and 4) = P(head) - P(4) =5 ¢ = 15
Note that the sample space for the coin is H, T; and for the die itis 1, 2, 3, 4, 5, 6.

The problem in Example 4-23 can also be solved by using the sample space
Hl H2 H3 H4 HS H6 T1 T2 T3 T4 TS5 T6

The solution is 15, since there is only one way to get the head-4 outcome.
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Example 4-24

Drawing a Card
A card is drawn from a deck and replaced; then a second card is drawn. Find the
probability of getting a queen and then an ace.

Solution

The probability of getting a queen is 5, and since the card is replaced, the probability of
getting an ace is 55. Hence, the probability of getting a queen and an ace is
4 4 16 1

P(queen and ace) = P(queen) - P(ace) = 2 3522704 169

Example 4-25

Selecting a Colored Ball

An urn contains 3 red balls, 2 blue balls, and 5 white balls. A ball is selected and its
color noted. Then it is replaced. A second ball is selected and its color noted. Find the
probability of each of these.

a. Selecting 2 blue balls
b. Selecting 1 blue ball and then 1 white ball
c¢. Selecting 1 red ball and then 1 blue ball

Solution
a. P(blue and blue) = P(blue) - P(blue) = 15 - & = 105 = 2
b. P(blue and white) = P(blue) - P(white) = 35 * 5 = 196 = 16
c. P(red and blue) = P(red) - P(blue) = 3 - 5 = 155 = 35

Multiplication rule 1 can be extended to three or more independent events by
using the formula

P(Aand Band Cand...and K) = P(4) - P(B) - P(C) - - - P(K)

When a small sample is selected from a large population and the subjects are not
replaced, the probability of the event occurring changes so slightly that for the most part,
it is considered to remain the same. Examples 4-26 and 4-27 illustrate this concept.

Example 4-26

4-32

Survey on Stress

A Harris poll found that 46% of Americans say they suffer great stress at least once a
week. If three people are selected at random, find the probability that all three will say
that they suffer great stress at least once a week.

Source: 100% American.
Solution
Let S denote stress. Then
P(S and S and S) = P(S) - P(S) - P(S)
= (0.46)(0.46)(0.46) = 0.097
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Example 4-27 Male Color Blindness

Approximately 9% of men have a type of color blindness that prevents them from
distinguishing between red and green. If 3 men are selected at random, find the
probability that all of them will have this type of red-green color blindness.

Source: USA TODAY.
Solution
Let C denote red-green color blindness. Then
P(Cand Cand C) = P(C) - P(C) - P(C)
= (0.09)(0.09)(0.09)
= 0.000729

Hence, the rounded probability is 0.0007.

In Examples 4-23 through 4-27, the events were independent of one another, since
the occurrence of the first event in no way affected the outcome of the second event. On
the other hand, when the occurrence of the first event changes the probability of the occur-
rence of the second event, the two events are said to be dependent. For example, suppose
a card is drawn from a deck and not replaced, and then a second card is drawn. What is
the probability of selecting an ace on the first card and a king on the second card?

Before an answer to the question can be given, you must realize that the events are
dependent. The probability of selecting an ace on the first draw is 35. If that card is not
replaced, the probability of selecting a king on the second card is 3;, since there are 4 kings
and 51 cards remaining. The outcome of the first draw has affected the outcome of the
second draw.

Dependent events are formally defined now.

When the outcome or occurrence of the first event affects the outcome or occurrence of
the second event in such a way that the probability is changed, the events are said to be
dependent events.

Here are some examples of dependent events:

Drawing a card from a deck, not replacing it, and then drawing a second card.

Selecting a ball from an urn, not replacing it, and then selecting a second ball.

Being a lifeguard and getting a suntan.

Having high grades and getting a scholarship.

Parking in a no-parking zone and getting a parking ticket.

To find probabilities when events are dependent, use the multiplication rule with a
modification in notation. For the problem just discussed, the probability of getting an ace

on the first draw is ;‘7, and the probability of getting a king on the second draw is %. By
the multiplication rule, the probability of both events occurring is

4. 4_16 _ 4
52 51 2652 663
The event of getting a king on the second draw given that an ace was drawn the first
time is called a conditional probability.

The conditional probability of an event B in relationship to an event 4 is the prob-
ability that event B occurs after event 4 has already occurred. The notation for conditional

4-33



214 Chapter 4 Probability and Counting Rules

probability is P(B|A). This notation does not mean that B is divided by 4; rather, it means
the probability that event B occurs given that event 4 has already occurred. In the card
example, P(B|A) is the probability that the second card is a king given that the first card
is an ace, and it is equal to 3; since the first card was not replaced.

Multiplication Rule 2

When two events are dependent, the probability of both occurring is

P(4 and B) = P(4) - P(B|4)

Example 4-28

University Crime

At a university in western Pennsylvania, there were 5 burglaries reported in 2003, 16 in
2004, and 32 in 2005. If a researcher wishes to select at random two burglaries to
further investigate, find the probability that both will have occurred in 2004.

Source: IUP Police Department.
Solution

In this case, the events are dependent since the researcher wishes to investigate two
distinct cases. Hence the first case is selected and not replaced.

P(C, andCz)=P(C1)-P(C2|C1)=%~%=%

Example 4-29

Homeowner’s and Automobile Insurance

World Wide Insurance Company found that 53% of the residents of a city had
homeowner’s insurance (H) with the company. Of these clients, 27% also had
automobile insurance (A) with the company. If a resident is selected at random, find
the probability that the resident has both homeowner’s and automobile insurance with
World Wide Insurance Company.

Solution

P(Hand A) = P(H) - P(A|H) = (0.53)(0.27) = 0.1431

This multiplication rule can be extended to three or more events, as shown in
Example 4-30.

Example 4-30

4-34

Drawing Cards

Three cards are drawn from an ordinary deck and not replaced. Find the probability of
these events.

a. Getting 3 jacks

b. Getting an ace, a king, and a queen in order

c¢. Getting a club, a spade, and a heart in order

d. Getting 3 clubs

Solution

. 4 3 2 24 1
@ PG jacks) = 55 5150 = 132,600 _ 5525
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. 4 4 4 64 8
b. P(ace and king and queen) =35°31 30 132600 _ 16575

c¢. P(club and spade and heart) = B33 2197 _ 169

d. PG clubsy = 2. 12 1L _ 1716 11

Tree diagrams can be used as an aid to finding the solution to probability problems
when the events are sequential. Example 4-31 illustrates the use of tree diagrams.

Example 4-31

[ 1
[IWE S
Tree Diagram for
Example 4-31

Selecting Colored Balls

Box 1 contains 2 red balls and 1 blue ball. Box 2 contains 3 blue balls and 1 red ball. A
coin is tossed. If it falls heads up, box 1 is selected and a ball is drawn. If it falls tails up,
box 2 is selected and a ball is drawn. Find the probability of selecting a red ball.

Solution

The first two branches designate the selection of either box 1 or box 2. Then from box 1,
either a red ball or a blue ball can be selected. Likewise, a red ball or blue ball can be
selected from box 2. Hence a tree diagram of the example is shown in Figure 4-6.

Next determine the probabilities for each branch. Since a coin is being tossed for
the box selection, each branch has a probability of %, that is, heads for box 1 or tails for
box 2. The probabilities for the second branches are found by using the basic probability
rule. For example, if box 1 is selected and there are 2 red balls and 1 blue ball, the
probability of selecting a red ball is 3 and the probability of selecting a blue ball is 1.

If box 2 is selected and it contains 3 blue balls and 1 red ball, then the probability of
selecting a red ball is § and the probability of selecting a blue ball is 3.

Next multiply the probability for each outcome, using the rule P(4 and B) =
P(4) - P(B|A). For example, the probability of selecting box 1 and selecting a red ball is
3 -3 = % The probability of selecting box 1 and a blue ball is 5 - § = ¢. The probability
of selecting box 2 and selecting a red ball is 3 - § = 3. The probability of selecting box 2
and a blue ball is 5 - 3 = 3. (Note that the sum of these probabilities is 1.)

Finallly1 a red ball can be selected from either box 1 or box 2 so Plred) = + § =

8 , 3 _
2%t 2u=n
Ball
2 1,222
N Red 2°37 %
B\
Box
Box 1
1
3
a7
/49)
7 1121
Blue 2 °3 "%
101 _ 1
a«\% Red 7473
p®\
Box 2
3
o 3
{&/6’)
< Bl 1.38_3
ue 218
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Objective
Find the conditional
probability of an event.

Tree diagrams can be used when the events are independent or dependent, and they
can also be used for sequences of three or more events.

Conditional Probability

The conditional probability of an event B in relationship to an event 4 was defined as the
probability that event B occurs after event 4 has already occurred.

The conditional probability of an event can be found by dividing both sides of the
equation for multiplication rule 2 by P(4), as shown:

P(A and B) = P(A) - P(B|A)
P(4 and B) _ PiA) - P(B|A)
P(4) BA)

P4 and B) _
W = P(B|A)

Formula for Conditional Probability

The probability that the second event B occurs given that the first event 4 has occurred can be
found by dividing the probability that both events occurred by the probability that the first
event has occurred. The formula is

P(B|A) = P—(APTZ‘; B)

Examples 4-32, 4-33, and 4-34 illustrate the use of this rule.

Example 4-32 Selecting Colored Chips

4-36

A box contains black chips and white chips. A person selects two chips without
replacement. If the probability of selecting a black chip and a white chip is 2, and the
probability of selecting a black chip on the first draw is 2, find the probability of
selecting the white chip on the second draw, given that the first chip selected was a
black chip.

Solution
Let
B = selecting a black chip W = selecting a white chip
Then
_PBand W) _ 15/56
PVIB) = —=pg— = 3/8
5 1
L. 3_ 158 15 % 5
56 8 56 3 56 3 7
7 1

Hence, the probability of selecting a white chip on the second draw given that the first
chip selected was black is 3.
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Example 4-33

Parking Tickets
The probability that Sam parks in a no-parking zone and gets a parking ticket is 0.06,
and the probability that Sam cannot find a legal parking space and has to park in the no-
parking zone is 0.20. On Tuesday, Sam arrives at school and has to park in a no-parking
zone. Find the probability that he will get a parking ticket.
Solution
Let

N = parking in a no-parking zone T = getting a ticket
Then

PNand7) 0.06

PTIN) = PN) 020

0.30

Hence, Sam has a 0.30 probability of getting a parking ticket, given that he parked in a
no-parking zone.

The conditional probability of events occurring can also be computed when the data
are given in table form, as shown in Example 4-34.

Example 4-34

Survey on Women in the Military

A recent survey asked 100 people if they thought women in the armed forces should be
permitted to participate in combat. The results of the survey are shown.

Gender Yes No Total

Male 32 18 50
Female _8 KE ﬂ
Total 40 60 100

Find these probabilities.

a. The respondent answered yes, given that the respondent was a female.
b. The respondent was a male, given that the respondent answered no.

Solution

Let
M = respondent was a male Y = respondent answered yes

F = respondent was a female N = respondent answered no
a. The problem is to find P(Y|F). The rule states

P(Fand Y)

PUY|F) = PE)

The probability P(F and Y) is the number of females who responded yes, divided
by the total number of respondents:
8

P(FandY)=ﬁ
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Figure 4-7

Venn Diagram for
Conditional Probability

4-38

The probability P(F') is the probability of selecting a female:

_ 50
PF) = 100
Then
PYIF) = P(FandY)  8/100

PF)  50/100

4 1
_ 8 .50 8 180_ 4
100 ~ 100 1o6 560 25

12
b. The problem is to find P(M|N).

P(Nand M) _ 18/100

PN)  60/100
3 1
_18 60 & 1603
100 ~ 100 180 66 10
1 10

P(MIN) =

The Venn diagram for conditional probability is shown in Figure 4-7. In this case,

P(4 and B)
P(4)

which is represented by the area in the intersection or overlapping part of the circles
A and B, divided by the area of circle A. The reasoning here is that if you assume A
has occurred, then 4 becomes the sample space for the next calculation and is the
P(4 and B)
PA)
the probability of the part of B that is contained in 4. Hence, P(4 and B) becomes the
P(4 and B)

P(4)

PBlA) =

denominator of the probability fraction

. The numerator P(4 and B) represents

numerator of the probability fraction
sample space.

. Imposing a condition reduces the

Probabilities for “At Least”

The multiplication rules can be used with the complementary event rule (Section 4-1)
to simplify solving probability problems involving “at least.” Examples 4-35, 4-36, and
4-37 illustrate how this is done.

P(Aand B)

P($)

P(Aand B)

P(BIA) = =50
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Example 4-35

Drawing Cards

A game is played by drawing 4 cards from an ordinary deck and replacing each card
after it is drawn. Find the probability that at least 1 ace is drawn.

Solution

It is much easier to find the probability that no aces are drawn (i.e., losing) and then
subtract that value from 1 than to find the solution directly, because that would involve
finding the probability of getting 1 ace, 2 aces, 3 aces, and 4 aces and then adding the
results.

Let E = at least 1 ace is drawn and £ = no aces drawn. Then

_. 48 48 48 48
5252 52 52
12 12 12 12 20,736

13 13 13 13 28,561

Hence,

PE) =1— PE)
20,736 _ 7825
28,561 28,561

or a hand with at least 1 ace will win about 27% of the time.

Plwinning) = 1 — P(losing) = 1 =~ (.27

Example 4-36

Tossing Coins
A coin is tossed 5 times. Find the probability of getting at least 1 tail.

Solution

It is easier to find the probability of the complement of the event, which is “all heads,”
and then subtract the probability from 1 to get the probability of at least 1 tail.

P(E) =1 - PE)
Plat least 1 tail) = 1 — P(all heads)
Plall heads) = ()’ = 35
Hence,

Platleast 1 tail) = 1 — 35 = 3

Example 4-37

The Neckware Association of America reported that 3% of ties sold in the United States
are bow ties. If 4 customers who purchased a tie are randomly selected, find the
probability that at least 1 purchased a bow tie.
Solution
Let E = at least 1 bow tie is purchased and E = no bow ties are purchased. Then

P(E) = 0.03 and P(E)=1—10.03 =0.97

P(no bow ties are purchased) = (0.97)(0.97)(0.97)(0.97) = 0.885; hence,
P(at least one bow tie is purchased) = 1 — 0.885 = 0.115.

Similar methods can be used for problems involving “at most.”
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Applying the Concepts 4=3

Guilty or Innocent?

In July 1964, an elderly woman was mugged in Costa Mesa, California. In the vicinity of the
crime a tall, bearded man sat waiting in a yellow car. Shortly after the crime was committed, a
young, tall woman, wearing her blond hair in a ponytail, was seen running from the scene of
the crime and getting into the car, which sped off. The police broadcast a description of the
suspected muggers. Soon afterward, a couple fitting the description was arrested and convicted
of the crime. Although the evidence in the case was largely circumstantial, the two people
arrested were nonetheless convicted of the crime. The prosecutor based his entire case on basic
probability theory, showing the unlikeness of another couple being in that area while having
all the same characteristics that the elderly woman described. The following probabilities

were used.
Characteristic Assumed probability
Drives yellow car 1 outof 12
Man over 6 feet tall 1 outof 10
Man wearing tennis shoes loutof 4
Man with beard 1 outof 11
Woman with blond hair loutof 3
Woman with hair in a ponytail 1 outof 13
Woman over 6 feet tall 1 out of 100

N N B WN

8.

. Compute the probability of another couple being in that area with the same

characteristics.

. Would you use the addition or multiplication rule? Why?

. Are the characteristics independent or dependent?

. How are the computations affected by the assumption of independence or dependence?
. Should any court case be based solely on probabilities?

. Would you convict the couple who was arrested even if there were no eyewitnesses?

. Comment on why in today’s justice system no person can be convicted solely on the

results of probabilities.
In actuality, aren’t most court cases based on uncalculated probabilities?

See page 249 for the answers.

1. State which events are independent and which are g Smoking excessively and having lung
dependent. cancer
a. Tossing a coin and drawing a card from h. Eating an excessive amount of ice cream and smoking
a deck an excessive amount of cigarettes
b. Drawing a ball from an urn, not replacing it, and
then drawing a second ball 2. Exercise If37% of high school students said that they
c. Getting a raise in salary and purchasing a exercise regularly, find the probability that 5 randomly
new car selected high school students will say that they exercise
.. . . . regularly. Would you consider this event likely or
d. Driving on ice and having an accident . .
. . . unlikely to occur? Explain your answer.
e. Having a large shoe size and having a
high IQ . . .
. . 3. Video and Computer Games Sixty-nine percent of
/A father being left-handed and a daughter being

4-40
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U.S. heads of households play video or computer games.
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Choose 4 heads of households at random. Find the
probability that

a. None play video or computer games
b. All four do

Source: www.theesa.com

. Seat Belt Use The Gallup Poll reported that 52% of

Americans used a seat belt the last time they got into
a car. If 4 people are selected at random, find the
probability that they all used a seat belt the last time
they got into a car.

Source: 100% American.

. Medical Degrees If 28% of U.S. medical degrees are

conferred to women, find the probability that 3
randomly selected medical school graduates are men.
Would you consider this event likely or unlikely to
occur? Explain your answer.

. Prison Populations If 25% of U.S. federal prison

inmates are not U.S. citizens, find the probability that
2 randomly selected federal prison inmates will not be
U.S. citizens.

Source: Harper s Index.

. Computer Ownership At a local university 54.3% of

incoming first-year students have computers. If 3 students
are selected at random, find the following probabilities.

a. None have computers.

b. At least one has a computer.

c. All have computers.

. Cards If2 cards are selected from a standard deck of

52 cards without replacement, find these probabilities.
a. Both are spades.

b. Both are the same suit.

c. Both are kings.

. MLS Players Of the 216 players on major league

soccer rosters, 80.1% are U.S. citizens. If 3 players are
selected at random for an exhibition, what is the
probability that all are U.S. citizens?

Source: US4 TODAY.

Cable Television In 2006, 86% of U.S. households had
cable TV. Choose 3 households at random. Find the
probability that

a. None of the 3 households had cable TV

b. All 3 households had cable TV

c. Atleast 1 of the 3 households had cable TV

Source: www.infoplease.com

Working Women and Computer Use It is reported
that 72% of working women use computers at work.
Choose 5 working women at random. Find

12.

13.

14.

15.

16.

17.

18.

19.

20.

21.
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a. The probability that at least 1 doesn’t use a
computer at work

b. The probability that all 5 use a computer in their
jobs

Source: www.infoplease.com

Flashlight Batteries A flashlight has 6 batteries, 2 of
which are defective. If 2 are selected at random without
replacement, find the probability that both are defective.

Leisure Time Exercise Only 27% of U.S. adults get
enough leisure time exercise to achieve cardiovascular
fitness. Choose 3 adults at random. Find the probability
that

a. All 3 get enough daily exercise
b. Atleast 1 of the 3 gets enough exercise

Source: www.infoplease.com

Text Messages via Cell Phones Thirty-five percent of
people who own cell phones use their phones to send
and receive text messages. Choose 4 cell phone owners
at random. What is the probability that none use their
phones for texting?

Customer Purchases In a department store there are
120 customers, 90 of whom will buy at least 1 item. If
5 customers are selected at random, one by one, find the
probability that all will buy at least 1 item.

Drawing Cards Three cards are drawn from a deck
without replacement. Find these probabilities.

a. All are jacks.
b. All are clubs.
c. All are red cards.

Scientific Study In a scientific study there are 8 guinea
pigs, 5 of which are pregnant. If 3 are selected at
random without replacement, find the probability that
all are pregnant.

In Exercise 17, find the probability that none are
pregnant.

Membership in a Civic Organization In a civic
organization, there are 38 members; 15 are men and
23 are women. If 3 members are selected to plan the
July 4th parade, find the probability that all 3 are
women. Would you consider this event likely or
unlikely to occur? Explain your answer.

In Exercise 19, find the probability that all 3 members
are men.

Sales A manufacturer makes two models of an item:

model I, which accounts for 80% of unit sales, and
model II, which accounts for 20% of unit sales. Because
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of defects, the manufacturer has to replace (or
exchange) 10% of its model I and 18% of its model II.
If a model is selected at random, find the probability
that it will be defective.

Student Financial Aid In a recent year 8,073,000 male
students and 10,980,000 female students were enrolled
as undergraduates. Receiving aid were 60.6% of the
male students and 65.2% of the female students. Of
those receiving aid, 44.8% of the males got federal aid
and 50.4% of the females got federal aid. Choose 1
student at random. (Hint: Make a tree diagram.) Find
the probability that the student is

a. A male student without aid

b. A male student, given that the student has aid

c. A female student or a student who receives federal
aid

Source: www.nces .gov

Automobile Insurance An insurance company
classifies drivers as low-risk, medium-risk, and high-
risk. Of those insured, 60% are low-risk, 30% are
medium-risk, and 10% are high-risk. After a study, the
company finds that during a 1-year period, 1% of the
low-risk drivers had an accident, 5% of the medium-risk
drivers had an accident, and 9% of the high-risk drivers
had an accident. If a driver is selected at random, find
the probability that the driver will have had an accident
during the year.

Defective Items A production process produces an
item. On average, 15% of all items produced are
defective. Each item is inspected before being shipped,
and the inspector misclassifies an item 10% of the time.
What proportion of the items will be “classified as
good”? What is the probability that an item is defective
given that it was classified as good?

Selecting Colored Balls Urn 1 contains 5 red balls and
3 black balls. Urn 2 contains 3 red balls and 1 black
ball. Urn 3 contains 4 red balls and 2 black balls. If an
urn is selected at random and a ball is drawn, find the
probability it will be red.

Prison Populations For a recent year, 0.99 of the
incarcerated population is adults and 0.07 is female. If
an incarcerated person is selected at random, find the
probability that the person is a female given that the
person is an adult.

Source: Bureau of Justice.

Rolling Dice Roll two standard dice and add the
numbers. What is the probability of getting a number
larger than 9 for the first time on the third roll?

Model Railroad Circuit A circuit to run a model
railroad has 8 switches. Two are defective. If you select
2 switches at random and test them, find the probability
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that the second one is defective, given that the first one
is defective.

Country Club Activities At the Avonlea Country Club,
73% of the members play bridge and swim, and 82%
play bridge. If a member is selected at random, find the
probability that the member swims, given that the
member plays bridge.

College Courses At a large university, the probability
that a student takes calculus and is on the dean’s list is
0.042. The probability that a student is on the dean’s list
is 0.21. Find the probability that the student is taking
calculus, given that he or she is on the dean’s list.

House Types In Rolling Acres Housing Plan, 42% of
the houses have a deck and a garage; 60% have a deck.
Find the probability that a home has a garage, given that
it has a deck.

Pizza and Salads In a pizza restaurant, 95% of the
customers order pizza. If 65% of the customers order
pizza and a salad, find the probability that a customer
who orders pizza will also order a salad.

Gift Baskets The Gift Basket Store had the following
premade gift baskets containing the following
combinations in stock.

Cookies Mugs Candy
Coffee 20 13 10
Tea 12 10 12

Choose 1 basket at random. Find the probability that it
contains

a. Coffee or candy

b. Tea given that it contains mugs

c. Tea and cookies

Source: www.infoplease.com

Blood Types and Rh Factors In addition to being
grouped into four types, human blood is grouped by its
Rhesus (Rh) factor. Consider the figures below which
show the distributions of these groups for Americans.

(0] A B AB
Rh+ 37% 34% 10% 4%
Rh— 6% 6% 2% 1%

Choose 1 American at random. Find the probability that
the person

a. Isauniversal donor, i.e., has O negative blood
b. Has type O blood given that the person is Rh+
c¢. Has A+ or AB— blood

d. Has Rh— given that the person has type B

Source: www.infoplease.com
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35. Doctor Specialties Below are listed the numbers of
doctors in various specialties by gender.
Pathology Pediatrics Psychiatry
Male 12,575 33,020 27,803
Female 5,604 33,351 12,292

36.

37.

38.

39.

Choose 1 doctor at random.

a. Find P (Male|pediatrician).
b. Find P (Pathologist|female).

c. Are the characteristics “female” and “pathologist”
independent? Explain.

Source: World Almanac.
Olympic Medals The medal distribution from the 2004

Summer Olympic Games for the top 23 countries is
shown below.

Gold Silver Bronze
United States 35 39 29
Russia 27 27 38
China 32 17 14
Australia 17 16 16
Others 133 136 153

Choose 1 medal winner at random.

a. Find the probability that the winner won the gold
medal, given that the winner was from the United
States.

b. Find the probability that the winner was from the
United States, given that she or he won a gold
medal.

c. Are the events “medal winner is from United
States” and “gold medal won” independent?
Explain.

Source: New York Times Almanac.

Marital Status of Women According to the Statistical
Abstract of the United States, 70.3% of females ages 20
to 24 have never been married. Choose 5 young women
in this age category at random. Find the probability that
a. None have ever been married

b. Atleast | has been married

Source: New York Times Almanac.

Fatal Accidents The American Automobile
Association (AAA) reports that of the fatal car and truck
accidents, 54% are caused by car driver error. If 3
accidents are chosen at random, find the probability that
a. All are caused by car driver error

b. None are caused by car driver error

c. Atleast 1 is caused by car driver error

Source: AAA quoted on CNN.

On-Time Airplane Arrivals The greater Cincinnati
airport led major U.S. airports in on-time arrivals in the

40.
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last quarter of 2005 with an 84.3% on-time rate. Choose
5 arrivals at random and find the probability that at least
1 was not on time.

Source: Www.census.gov

Online Electronic Games Fifty-six percent of electronic

gamers play games online, and sixty-four percent of those

gamers are female. What is the probability that a randomly
selected gamer plays games online and is male?

Source: www.tech.msn.com

Reading to Children Fifty-eight percent of American
children (ages 3 to 5) are read to every day by someone
at home. Suppose 5 children are randomly selected.
What is the probability that at least 1 is read to every
day by someone at home?

Source: Federal Interagency Forum on Child and Family Statistics.

Doctoral Assistantships Of Ph.D. students, 60% have
paid assistantships. If 3 students are selected at random,
find the probabilities

a. All have assistantships

b. None have assistantships

c. Atleast I has an assistantship

Source: U.S. Department of Education/Chronicle of Higher Education.

Selecting Cards If 4 cards are drawn from a deck of
52 and not replaced, find the probability of getting at
least 1 club.

Full-Time College Enrollment The majority (69%) of
undergraduate students were enrolled in a 4-year college
in a recent year. Eighty-one percent of those enrolled
attended full-time. Choose 1 enrolled undergraduate
student at random. What is the probability that she or he
is a part-time student at a 4-year college?

Source: www.census.gov

Family and Children’s Computer Games It was
reported that 19.8% of computer games sold in 2005 were
classified as “family and children’s.” Choose 5 purchased
computer games at random. Find the probability that

a. None of the 5 were family and children’s
b. Atleast 1 of the 5 was family and children’s

Source: www.theesa.com

Medication Effectiveness A medication is 75%
effective against a bacterial infection. Find the
probability that if 12 people take the medication, at
least 1 person’s infection will not improve.

Tossing a Coin A coin is tossed 5 times; find the
probability of getting at least 1 tail. Would you consider
this event likely to happen? Explain your answer.

Selecting a Letter of the Alphabet If 3 letters of the
alphabet are selected at random, find the probability of
getting at least 1 letter x. Letters can be used more than
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once. Would you consider this event likely to happen?
Explain your answer.

Rolling a Die A die is rolled 7 times. Find the
probability of getting at least one 3. Would you consider
this event likely to occur? Explain your answer.

High School Grades of First-Year College Students
Forty-seven percent of first-year college students
enrolled in 2005 had an average grade of A in high
school compared to 20 percent of first-year college
students in 1970. Choose 6 first-year college students at
random enrolled in 2005. Find the probability that

51.

52.

a. All had an A average in high school
b. None had an A average in high school
c. Atleast 1 had an A average in high school

Source: WWW.Census.gov

Rolling a Die If a die is rolled 3 times, find the
probability of getting at least 1 even number.

Selecting a Flower In a large vase, there are 8 roses,

5 daisies, 12 lilies, and 9 orchids. If 4 flowers are selected
at random, find the probability that at least 1 of the
flowers is a rose. Would you consider this event likely to
occur? Explain your answer.

Extending the Concepts

53.

54.

5S.

Let 4 and B be two mutually exclusive events. Are 4
and B independent events? Explain your answer.

Types of Vehicles The Bargain Auto Mall has the
following cars in stock.

SUV Compact Mid-sized
Foreign 20 50 20
Domestic 65 100 45

Are the events “compact” and “domestic” independent?
Explain.

College Enrollment An admissions director knows
that the probability a student will enroll after a campus
visit is 0.55, or P(E) = 0.55. While students are on
campus visits, interviews with professors are arranged.

P(E|DW) = 0.95

56.

The admissions director computes these conditional
probabilities for students enrolling after visiting three
professors, DW, LP, and MH.

P(E|LP) = 0.55  P(E|MH) = 0.15

Is there something wrong with the numbers? Explain.

Commercials Event 4 is the event that a person
remembers a certain product commercial. Event B is the
event that a person buys the product. If P(B) = 0.35,
comment on each of these conditional probabilities if
you were vice president for sales.

a. P(B|4) = 0.20
b. P(B|4) =035
c. P(B|4)=0.55

Many times a person must know the number of all possible outcomes for a sequence of
events. To determine this number, three rules can be used: the fundamental counting rule,
the permutation rule, and the combination rule. These rules are explained here, and they

4-4 Counting Rules
will be used in Section 4-5 to find probabilities of events.
The first rule is called the fundamental counting rule.
The Fundamental Counting Rule
Objective [

Find the total number
of outcomes in a
sequence of events,
using the fundamental
counting rule.

kl.kz.k3...kn

Note: In this case and means to multiply.

Fundamental Counting Rule

In a sequence of n events in which the first one has k, possibilities and the second event has &,
and the third has k;, and so forth, the total number of possibilities of the sequence will be
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Examples 4-38 through 441 illustrate the fundamental counting rule.

Example 4-38

Figure 4-8

Complete Tree
Diagram for
Example 4-38

niere no r'd

Possible games of
chess: 25 X 10",

Tossing a Coin and Rolling a Die

A coin is tossed and a die is rolled. Find the number of outcomes for the sequence of
events.

Die
H,1
H, 2

H,3

H, 4
H,5
H, 6
TA
T2

T3

T4

T5

T.6

Solution

Since the coin can land either heads up or tails up and since the die can land with any
one of six numbers showing face up, there are 2 - 6 = 12 possibilities. A tree diagram
can also be drawn for the sequence of events. See Figure 4-8.

Example 4-39

Types of Paint
A paint manufacturer wishes to manufacture several different paints. The categories include

Color Red, blue, white, black, green, brown, yellow
Type Latex, oil

Texture Flat, semigloss, high gloss

Use Outdoor, indoor

How many different kinds of paint can be made if you can select one color, one type,
one texture, and one use?
Solution

You can choose one color and one type and one texture and one use. Since there are
7 color choices, 2 type choices, 3 texture choices, and 2 use choices, the total number
of possible different paints is

Color Type Texture Use

84

4-45
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There are four blood types, A, B, AB, and O. Blood can also be Rh+ and Rh—. Finally,
a blood donor can be classified as either male or female. How many different ways can
a donor have his or her blood labeled?

Example 4-40 Distribution of Blood Types

H M A, Rh+, M
Figure 4-9
Rh+
Complete Tree F A Rh+ F
Diagram for
Example 4-40 P M A, Rh— M
F A, Rh—, F
A M B, Rh+, M
Rh+
F B, Rh+, F
M B, Rh—, M
B Rh—
F B, Rh—, F
AB M AB, Rh+, M
Rh+
F AB, Rh+, F
0 M AB, Rh—, M
Rh—
F AB, Rh—, F
M 0, Rh+, M
Rh+
F 0,Rh+, F
M 0,Rh—, M
Rh—
F 0,Rh—, F

Solution

Since there are 4 possibilities for blood type, 2 possibilities for Rh factor, and 2
possibilities for the gender of the donor, there are 4 - 2 - 2, or 16, different classification
categories, as shown.

Blood type Rh Gender

S A =16

A tree diagram for the events is shown in Figure 4-9.

When determining the number of different possibilities of a sequence of events, you
must know whether repetitions are permissible.

Example 4-41 Identification Cards

The manager of a department store chain wishes to make four-digit identification cards
for her employees. How many different cards can be made if she uses the digits 1, 2, 3,
4, 5, and 6 and repetitions are permitted?
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Solution

Since there are 4 spaces to fill on each card and there are 6 choices for each space, the
total number of cards that can be madeis 6 - 6 - 6 - 6 = 1296.

Now, what if repetitions are not permitted? For Example 441, the first digit can be
chosen in 6 ways. But the second digit can be chosen in only 5 ways, since there are only
five digits left, etc. Thus, the solution is

6-5-4-3=360

The same situation occurs when one is drawing balls from an urn or cards from a
deck. If the ball or card is replaced before the next one is selected, then repetitions are
permitted, since the same one can be selected again. But if the selected ball or card is not
replaced, then repetitions are not permitted, since the same ball or card cannot be selected
the second time.

These examples illustrate the fundamental counting rule. In summary: If repetitions
are permitted, then the numbers stay the same going from left to right. If repetitions are
not permitted, then the numbers decrease by 1 for each place left to right.

Two other rules that can be used to determine the total number of possibilities of a
sequence of events are the permutation rule and the combination rule.

Factorial Notation

These rules use factorial notation. The factorial notation uses the exclamation point.
51=5-4-3-2-1
9=9-8-7-6-5-4-3-2-1

To use the formulas in the permutation and combination rules, a special definition of 0!
is needed. 0! = 1.

Factorial Formulas

For any counting »
nl=nn—1)n-2)---1
0l =1

Permutations

A permutation is an arrangement of n objects in a specific order.

Examples 442 and 4-43 illustrate permutations.

Example 4-42

Business Location

Suppose a business owner has a choice of 5 locations in which to establish her business.
She decides to rank each location according to certain criteria, such as price of the store
and parking facilities. How many different ways can she rank the 5 locations?
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Solution

There are
5!'=5-4-3-2-1=120

different possible rankings. The reason is that she has 5 choices for the first location,
4 choices for the second location, 3 choices for the third location, etc.

In Example 4-42 all objects were used up. But what happens when not all objects
are used up? The answer to this question is given in Example 4—43.

Example 4-43

Objective [

Find the number of
ways that r objects
can be selected from
n objects, using the
permutation rule.

4-48

Business Location

Suppose the business owner in Example 442 wishes to rank only the top 3 of the
5 locations. How many different ways can she rank them?

Solution

Using the fundamental counting rule, she can select any one of the 5 for first choice,
then any one of the remaining 4 locations for her second choice, and finally, any one of
the remaining locations for her third choice, as shown.

First choice Second choice Third choice

' '

60

The solutions in Examples 4-42 and 443 are permutations.

Permutation Rule

The arrangement of z objects in a specific order using  objects at a time is called a
permutation of n objects taking r objects at a time. It is written as P, and the formula is

nor

The notation ,P, is used for permutations.

6! 60 6-5-4:3-2-F
6—4 % 2" 2 = 360

«P4 means

Although Examples 4-42 and 4-43 were solved by the multiplication rule, they can
now be solved by the permutation rule.
In Example 4-42, 5 locations were taken and then arranged in order; hence,

51 51 5-4-3-2-1

B s T 1 =120

(Recall that 0! = 1.)
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In Example 4-43, 3 locations were selected from 5 locations, so n = 5 and
r = 3; hence

St 5! 5-4-3-2-%_
(5-3)1 2 2-X
Examples 444 and 445 illustrate the permutation rule.

sPy = 60

Example 4-44

Television News Stories

A television news director wishes to use 3 news stories on an evening show. One story
will be the lead story, one will be the second story, and the last will be a closing story.

If the director has a total of 8 stories to choose from, how many possible ways can the
program be set up?

Solution

Since order is important, the solution is

8! 8!

P: =
378 =31 5!

Hence, there would be 336 ways to set up the program.

Example 4-45

Objective

Find the number of
ways that r objects
can be selected from
n objects without
regard to order, using
the combination rule.

School Musical Plays

A school musical director can select 2 musical plays to present next year. One will be
presented in the fall, and one will be presented in the spring. If she has 9 to pick from,
how many different possibilities are there?

Solution

Order is important since one play can be presented in the fall and the other play in the
spring.

9ot 9t _9-8-T71 _
@-=2r 7 7!

N= 72

There are 72 different possibilities.

Combinations

Suppose a dress designer wishes to select two colors of material to design a new dress,
and she has on hand four colors. How many different possibilities can there be in this
situation?

This type of problem differs from previous ones in that the order of selection is not
important. That is, if the designer selects yellow and red, this selection is the same as the
selection red and yellow. This type of selection is called a combination. The difference
between a permutation and a combination is that in a combination, the order or arrange-
ment of the objects is not important; by contrast, order is important in a permutation.
Example 4-46 illustrates this difference.

A selection of distinct objects without regard to order is called a combination.
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Example 4-46

nilere no r'd

The total number of
hours spent mowing
lawns in the United
States each year:
2,220,000,000.

4-50

Letters

Given the letters A, B, C, and D, list the permutations and combinations for selecting
two letters.

Solution

The permutations are

AB BA CA DA
AC BC CB DB
AD BD CD DC

In permutations, AB is different from BA. But in combinations, AB is the same as BA
since the order of the objects does not matter in combinations. Therefore, if duplicates are
removed from a list of permutations, what is left is a list of combinations, as shown.

AB BA CK DX
AC BC cB DB
AD BD CD DE

Hence the combinations of A, B, C, and D are AB, AC, AD, BC, BD, and CD.
(Alternatively, BA could be listed and AB crossed out, etc.) The combinations have
been listed alphabetically for convenience, but this is not a requirement.

Combinations are used when the order or arrangement is not important, as in the
selecting process. Suppose a committee of 5 students is to be selected from 25 students.
The five selected students represent a combination, since it does not matter who is
selected first, second, etc.

Combination Rule

The number of combinations of 7 objects selected from n objects is denoted by ,C, and is
given by the formula
n!

nCr = (n —7r)r!
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Example 4-47

Combinations

How many combinations of 4 objects are there, taken 2 at a time?

Solution

Since this is a combination problem, the answer is

2
! | . .
PSR | S S L L’ S
4 —2)121 2120 2-1-4

This is the same result shown in Example 4-46.

Notice that the expression for ,C, is

n!
(n—rr!

which is the formula for permutations with 7! in the denominator. In other words,
P

nr
n-r

7!

This 7! divides out the duplicates from the number of permutations, as shown in
Example 4—46. For each two letters, there are two permutations but only one combina-
tion. Hence, dividing the number of permutations by 7! eliminates the duplicates. This
result can be verified for other values of n and » Note: ,C, = 1.

Example 4-48

Book Reviews

A newspaper editor has received 8 books to review. He decides that he can use 3 reviews
in his newspaper. How many different ways can these 3 reviews be selected?

Solution

8! _ 8 _8-7-6
(8 =331 5131 3-2-1

Cy = = 56

There are 56 possibilities.

Example 4-49

Committee Selection

In a club there are 7 women and 5 men. A committee of 3 women and 2 men is to be
chosen. How many different possibilities are there?

Solution

Here, you must select 3 women from 7 women, which can be done in ,C;, or 35,

ways. Next, 2 men must be selected from 5 men, which can be done in ;C,, or 10,

ways. Finally, by the fundamental counting rule, the total number of different ways is

35 - 10 = 350, since you are choosing both men and women. Using the formula gives
7! 5!

7= G- >0

1C-5C =

4-51
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Table 41 summarizes the counting rules.

4-1  Summary of Counting Rules

Rule Definition Formula
Fundamental The number of ways a sequence of n events ko ky kg -k,
counting rule can occur if the first event can occur in

k, ways, the second event can occur in

k, ways, etc.
Permutation rule The number of permutations of n objects p - n!

taking 7 objects at a time (order is important) T (n— )
Combination rule The number of combinations of 7 objects C = n!

n~r

taken from 7 objects (order is not important) (n— r)r!

Applying the Concepts 4—4

Garage Door Openers

Garage door openers originally had a series of four on/off switches so that homeowners could
personalize the frequencies that opened their garage doors. If all garage door openers were set
at the same frequency, anyone with a garage door opener could open anyone else’s garage
door.

1. Use a tree diagram to show how many different positions 4 consecutive on/off switches
could be in.

After garage door openers became more popular, another set of 4 on/off switches was added to
the systems.

2. Find a pattern of how many different positions are possible with the addition of each on/off
switch.
3. How many different positions are possible with 8 consecutive on/off switches?

4. Is it reasonable to assume, if you owned a garage door opener with 8 switches, that
someone could use his or her garage door opener to open your garage door by trying all
the different possible positions?

In 1989 it was reported that the ignition keys for 1988 Dodge Caravans were made from a
single blank that had five cuts on it. Each cut was made at one out of five possible levels. In
1988, assume there were 420,000 Dodge Caravans sold in the United States.

5. How many different possible keys can be made from the same key blank?
6. How many different 1988 Dodge Caravans could any one key start?
Look at the ignition key for your car and count the number of cuts on it. Assume that the cuts

are made at one of any of five possible levels. Most car companies use one key blank for all
their makes and models of cars.

7. Conjecture how many cars your car company sold over recent years, and then figure out
how many other cars your car key could start. What would you do to decrease the odds of
someone being able to open another vehicle with his or her key?

See page 250 for the answers.
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10.

11.

12.

13.

. Zip Codes How many 5-digit zip codes are possible if

digits can be repeated? If there cannot be repetitions?

. Batting Order How many ways can a baseball

manager arrange a batting order of 9 players?

. Video Games How many different ways can 7 different

video game cartridges be arranged on a shelf?

. Seating Arrangements In how many ways can

5 speakers be seated in a row on a stage?

. Shampoo Display A store manager wishes to display

8 different brands of shampoo in a row. How many
ways can this be done?

. Show Programs Three bands and two comics are

performing for a student talent show. How many
different programs (in terms of order) can be arranged?
How many if the comics must perform between bands?

. Campus Tours Student volunteers take visitors on a

tour of 7 campus buildings. How many different tours
are possible? (Assume order is important.)

. Radio Station Call Letters The call letters of a radio

station must have 4 letters. The first letter must be a K
or a W. How many different station call letters can be
made if repetitions are not allowed? If repetitions are
allowed?

. Identification Tags How many different 3-digit

identification tags can be made if the digits can be used
more than once? If the first digit must be a 5 and
repetitions are not permitted?

Book Arrangements A reference encyclopedia has 12
volumes. Disregarding alphabetical or numerical order,
in how many ways can the books be arranged on a
shelf?

Selection of Officers Six students are running for the
positions of president and vice-president, and five
students are running for secretary and treasurer. If

the two highest vote getters in each of the two contests
are elected, how many winning combinations can there
be?

Automobile Trips There are 2 major roads from city
X to city Y and 4 major roads from city Y to city Z.
How many different trips can be made from city X to
city Z passing through city Y?

Evaluate each of these.

a. 8! e. 4Ps i. $Ps
b. 10! VAT J. P>
c. 0 g 5P
d 1! h. (P

=Y
o

14.

15.

16.

17.

18.

19.

20.

21.

22.

23.

24.

25.

26.
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County Assessments The County Assessment Bureau
decides to reassess homes in 8 different areas. How
many different ways can this be accomplished?

Sports Car Stripes How many different 4-color code
stripes can be made on a sports car if each code consists
of the colors green, red, blue, and white? All colors are
used only once.

Manufacturing Tests An inspector must select 3 tests
to perform in a certain order on a manufactured part. He
has a choice of 7 tests. How many ways can he perform
3 different tests?

Threatened Species of Reptiles There are 22
threatened species of reptiles in the United States. In
how many ways can you choose 4 to write about?
(Order is not important.)

Source: www.infoplease.com

Inspecting Restaurants How many different ways can
a city health department inspector visit 5 restaurants in a
city with 10 restaurants?

How many different 4-letter permutations can be
formed from the letters in the word decagon?

Cell Phone Models A particular cell phone company
offers 4 models of phones, each in 6 different colors and
each available with any one of 5 calling plans. How
many combinations are possible?

ID Cards How many different ID cards can be made if
there are 6 digits on a card and no digit can be used
more than once?

Free-Sample Requests An online coupon service has
13 offers for free samples. How may different requests
are possible if a customer must request exactly 3 free
samples? How many are possible if the customer may
request up to 3 free samples?

Ticket Selection How many different ways can
4 tickets be selected from 50 tickets if each ticket
wins a different prize?

Movie Selections The Foreign Language Club is
showing a four-movie marathon of subtitled movies.
How many ways can they choose 4 from the 11
available?

Task Assignments How many ways can an adviser
choose 4 students from a class of 12 if they are all
assigned the same task? How many ways can the
students be chosen if they are each given a different
task?

Agency Cases An investigative agency has 7 cases and
5 agents. How many different ways can the cases be
assigned if only 1 case is assigned to each agent?
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28.

29.

30.

31.

32.

33.

34.
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37.
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(ans) Evaluate each expression.

a. G d. G g ;G Jo 4Gy
b. C, e. C4 h. oC,

c. 4G 153G LG

Selecting Cards How many ways can 3 cards be

selected from a standard deck of 52 cards, disregarding
the order of selection?

Selecting Bracelets How many ways are there to select
3 bracelets from a box of 10 bracelets, disregarding the
order of selection?

Selecting Players How many ways can 4 baseball
players and 3 basketball players be selected from
12 baseball players and 9 basketball players?

Selecting a Committee How many ways can a
committee of 4 people be selected from a group of 10
people?

Selecting Christmas Presents If a person can select
3 presents from 10 presents under a Christmas tree, how
many different combinations are there?

Questions for a Test How many different tests can be
made from a test bank of 20 questions if the test
consists of 5 questions?

Promotional Program The general manager of a
fast-food restaurant chain must select 6 restaurants from
11 for a promotional program. How many different
possible ways can this selection be done?

Music Program Selections A jazz band has prepared
18 selections for a concert tour. At each stop they will
perform 10. How many different programs are possible?
How many programs are possible if they always begin
with the same song and end with the same song?

Freight Train Cars In a train yard there are 4 tank cars,
12 boxcars, and 7 flatcars. How many ways can a train
be made up consisting of 2 tank cars, 5 boxcars, and

3 flatcars? (In this case, order is not important.)

Selecting a Committee There are 7 women and 5 men
in a department. How many ways can a committee of

4 people be selected? How many ways can this
committee be selected if there must be 2 men and

2 women on the committee? How many ways can this
committee be selected if there must be at least 2 women
on the committee?

Selecting Cereal Boxes Wake Up cereal comes in

2 types, crispy and crunchy. If a researcher has 10 boxes
of each, how many ways can she select 3 boxes of each
for a quality control test?

Hawaiian Words The Hawaiian alphabet consists of
7 consonants and 5 vowels. How many three-letter
“words” are possible if there are never two consonants
together and if a word must always end in a vowel?
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40.

41.

42,

43.

44.

45.

46.

47.

48.

Selecting a Jury How many ways can a jury of
6 women and 6 men be selected from 10 women and
12 men?

Selecting a Golf Foursome How many ways can a
foursome of 2 men and 2 women be selected from
10 men and 12 women in a golf club?

Investigative Team The state narcotics bureau must
form a 5-member investigative team. If it has 25 agents
from which to choose, how many different possible
teams can be formed?

Dominoes A domino is a flat rectangular block the face
of which is divided into two square parts, each part
showing from zero to six pips (or dots). Playing a game
consists of playing dominoes with a matching number
of pips. Explain why there are 28 dominoes in a
complete set.

Charity Event Participants There are 16 seniors and
15 juniors in a particular social organization. In how
many ways can 4 seniors and 2 juniors be chosen to
participate in a charity event?

Selecting Commercials How many ways can a person
select 7 television commercials from 11 television
commercials?

DVD Selection How many ways can a person select
8 DVDs from a display of 13 DVDs?

Candy Bar Selection How many ways can a person
select 6 candy bars from a list of 10 and 6 salty snacks
from a list of 12 to put in a vending machine?

Selecting a Location An advertising manager decides
to have an ad campaign in which 8 special calculators
will be hidden at various locations in a shopping

mall. If he has 17 locations from which to pick,

how many different possible combinations can he
choose?

Permutations and Combinations

49.

50.

51.

52.

Selecting Posters A buyer decides to stock 8 different
posters. How many ways can she select these 8 if there
are 20 from which to choose?

Test Marketing Products Anderson Research
Company decides to test-market a product in 6 areas.
How many different ways can 3 areas be selected in a
certain order for the first test?

Selecting Rats How many different ways can a
researcher select 5 rats from 20 rats and assign each to a
different test?

Selecting Musicals How many different ways can a
theatrical group select 2 musicals and 3 dramas from
11 musicals and 8 dramas to be presented during the
year?



53.

54.

5S.

56.

Textbook Selections How many different ways can an
instructor select 2 textbooks from a possible 17?

Tape Selections How many ways can a person select 8
videotapes from 10 videotapes?

Public Service Announcements How many different
ways can 5 public service announcements be run during
1 hour?

Signal Flags How many different signals can be made
by using at least 3 different flags if there are 5 different
flags from which to select?

57.

58.

59.

Section 4-4 Counting Rules 235

Dinner Selections How many ways can a dinner patron
select 3 appetizers and 2 vegetables if there are 6
appetizers and 5 vegetables on the menu?

Air Pollution The Environmental Protection Agency
must investigate 9 mills for complaints of air pollution.
How many different ways can a representative select 5
of these to investigate this week?

Selecting Officers In a board of directors composed of
8 people, how many ways can one chief executive
officer, one director, and one treasurer be selected?

Extending the Concepts

60.

61.

62.

Selecting Coins How many different ways can you
select one or more coins if you have 2 nickels, 1 dime,
and 1 half-dollar?

People Seated in a Circle In how many ways can

3 people be seated in a circle? 4? n? (Hint: Think of
them standing in a line before they sit down and/or draw
diagrams.)

Seating in a Movie Theater How many different ways
can 5 people—A, B, C, D, and E—sit in a row at a movie

Step by Step
TI-83 Plus or
3 ]
Tl_ 8 4 Plu S Factorials n!
Step hy Step 1. Type the value of n.
3. Press ENTER.
Permutations P,
1. Type the value of n.
3. Type the value of .
4. Press ENTER.
Combinations ,C,
5 1. Type the value of n.
128
2 nPr 3 138
12 nCr 5 g 3. Type the value of .
4. Press ENTER.

63.

theater if (@) A and B must sit together; (b) C must sit to the
right of, but not necessarily next to, B; (¢) D and E will not
sit next to each other?

Poker Hands Using combinations, calculate the
number of each poker hand in a deck of cards. (A poker
hand consists of 5 cards dealt in any order.)

a. Royal flush
b. Straight flush

c. Four of akind
d. Full house

Factorials, Permutations, and Combinations

2. Press MATH and move the cursor to PRB, then press 4 for !.

2. Press MATH and move the cursor to PRB, then press 2 for ,P,.

2. Press MATH and move the cursor to PRB, then press 3 for ,C..

Calculate 5!, (P;, and |,C5 (Examples 4-42, 4-44, and 448 from the text).
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Excel Permutations, Combinations, and Factorials
Step by Step To find a value of a permutation, for example, ;P;:

1. In an open cell in an Excel worksheet, select the Formulas tab on the toolbar. Then click

PERMUT (asmbier mmleer_e lussen)
Haturns the number of permutations For 3 given numbsr of cbjects that can be
selected from the total objects.

Halp on this function I ok i Cancel

3. Type 5 in the Number box.
4. Type 3 in the Number_chosen box and click [OK].

The selected cell will display the answer: 60.
To find a value of a combination, for example, ;C;:

1. In an open cell, select the Formulas tab on the toolbar. Click the Insert function icon.
2. Select the All function category, then the COMBIN function, and click [OK].

search For a function:

[Type a briet description of what you wank to do and then dick
In ——

Or select & ateqorys | [»]
Select a function:

TSRO TR
COMPLEX 523
| CONCATENATE q
CONFILENCE Q
| COMVERT

|DORREL

|COS

COMBTN nber, moler_chosen)
Haturne the number of combinations for 3 aven number of kems.

Help on this hunction Looe ][ comn

3. Type 5 in the Number box.
4. Type 3 in the Number_chosen box and click [OK].

The selected cell will display the answer: 10.
To find a factorial of a number, for example, 7!:

1. In an open cell, select the Formulas tab on the toolbar. Click the Insert function icon.
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Objective [
Find the probability of

an event, using the
counting rules.
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2. Select the Math & Trig function category, then the FACT function, and click [OK].

Jeanch For & tunction:
Type a briet desaiption of what vou wanit bo do and then click Ga
I T

L sedect 3 cabogory: Math & Ing '-']
Select a function:

FACTDOUDLD

FLOOR

LD

INT

LM 3

IN |

TACT{number)
Retuns the Factorial of a number, equal to 1*2*3*. . Number.

oo s

3. Type 7 in the Number box and click [OK].
The selected cell will display the answer: 5040.

Probability and Counting Rules

237

The counting rules can be combined with the probability rules in this chapter to solve
many types of probability problems. By using the fundamental counting rule, the per-
mutation rules, and the combination rule, you can compute the probability of outcomes
of many experiments, such as getting a full house when 5 cards are dealt or selecting a
committee of 3 women and 2 men from a club consisting of 10 women and 10 men.

Example 4-50 Four Aces

Find the probability of getting 4 aces when 5 cards are drawn from an ordinary deck of

cards.
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Solution

There are 5,C; ways to draw 5 cards from a deck. There is only 1 way to get 4 aces
(i.e., ,C,), but there are 48 possibilities to get the fifth card. Therefore, there are 48 ways
to get 4 aces and 1 other card. Hence,

_4C,-48  1-48 48 __ 1
P(4 aces) = »Cs 2,598,960 2,598,960 54,145

Example 4-51 Defective Transistors

A box contains 24 transistors, 4 of which are defective. If 4 are sold at random, find the
following probabilities.

a. Exactly 2 are defective. c. All are defective.
b. None is defective. d. Atleast 1 is defective.
Solution

There are ,,C, ways to sell 4 transistors, so the denominator in each case will be 10,626.

a. Two defective transistors can be selected as ,C, and two nondefective ones as
,0C,. Hence,

_ 4C2 * 20C2 _ 1140 _ 190

Plexactly 2 defectives) e 10,626 ~ 1771

b. The number of ways to choose no defectives is ,,C,. Hence,

_ Gy _ 4845 1615
.Cy 10,626 3542

P(no defectives)

¢. The number of ways to choose 4 defectives from 4 is ,C,, or 1. Hence,

|
4Cs 10,626

P(all defective) =

d. To find the probability of at least 1 defective transistor, find the probability that
there are no defective transistors, and then subtract that probability from 1.

Plat least 1 defective) = 1 — P(no defectives)

Gy _ 16151927

=1 22 272l
e 3542 3542

Example 4-52 Magazines

A store has 6 TV Graphic magazines and 8 Newstime magazines on the counter. If two
customers purchased a magazine, find the probability that one of each magazine was
purchased.

Solution

C, -gC;, 6-8 48
, | O N O _ %
P(1 TV Graphic and 1 Newstime) G ol o
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Combination Lock

A combination lock consists of the 26 letters of the alphabet. If a 3-letter combination is
needed, find the probability that the combination will consist of the letters ABC in that
order. The same letter can be used more than once. (Nofe: A combination lock is really a
permutation lock.)

Solution

Since repetitions are permitted, there are 26 - 26 - 26 = 17,576 different possible
combinations. And since there is only one ABC combination, the probability is
P(ABC) = 1/26° = 1/17,576.

Example 4-54

Tennis Tournament

There are 8 married couples in a tennis club. If 1 man and 1 woman are selected at random
to plan the summer tournament, find the probability that they are married to each other.
Solution

Since there are 8 ways to select the man and 8 ways to select the woman, there are 8 - 8,
or 64, ways to select 1 man and 1 woman. Since there are 8 married couples, the
solution is & = .

As indicated at the beginning of this section, the counting rules and the probability
rules can be used to solve a large variety of probability problems found in business, gam-
bling, economics, biology, and other fields.

Applying the Concepts 4=5

Counting Rules and Probability

One of the biggest problems for students when doing probability problems is to decide which
formula or formulas to use. Another problem is to decide whether two events are independent
or dependent. Use the following problem to help develop a better understanding of these
concepts.

Assume you are given a 5-question multiple-choice quiz. Each question has 5 possible
answers: A, B, C, D, and E.
1. How many events are there?
2. Are the events independent or dependent?
3. If you guess at each question, what is the probability that you get all of them correct?
4. What is the probability that a person would guess answer A for each question?
Assume that you are given a test in which you are to match the correct answers in the right
column with the questions in the left column. You can use each answer only once.
5. How many events are there?
6. Are the events independent or dependent?
7. What is the probability of getting them all correct if you are guessing?
8. What is the difference between the two problems?

See page 250 for the answers.
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Speaking of

Statistics

The Mathematics of Gambling

Gambling is big business. There are state lotteries, casinos, sports betting, and church bingos. It seems that today
everybody is either watching or playing Texas Hold
’Em Poker.

Using permutations, combinations, and the
probability rules, mathematicians can find the
probabilities of various gambling games. Here are
the probabilities of the various 5-card poker hands.

Number

Hand of ways Probability
Straight flush 40 0.000015
Four of a kind 624 0.000240
Full house 3,744 0.001441
Flush 5,108 0.001965
Straight 10,200 0.003925
Three of a kind 54,912 0.021129
Two pairs 123,552 0.047539
One pair 1,098,240 0.422569
Less than one pair 1,302,540 0.501177

Total 2,598,960 1.000000

The chance of winning at gambling games can be compared by using what is called the house advantage, house edge,
or house percentage. For example, the house advantage for roulette is about 5.26%, which means in the long run, the
house wins 5.26 cents on every $1 bet; or you will lose, on average, 5.26 cents on every $1 you bet. The lower the house
advantage, the more favorable the game is to you.

For the game of craps, the house advantage is anywhere between 1.4 and 15%, depending on what you bet on. For the
game called keno, the house advantage is 29.5%. The house of advantage for Chuck-a-Luck is 7.87%, and for baccarat, it
is either 1.36 or 1.17% depending on your bet.

Slot machines have a house advantage anywhere from about 4 to 10% depending on the geographic location, such as
Atlantic City, Las Vegas, and Mississippi, and the amount put in the machine, such as 5¢, 25¢, and $1.

Actually, gamblers found winning strategies for the game blackjack or 21 such as card counting. However, the
casinos retaliated by using multiple decks and by banning card counters.

Exercises 4-5

1. Selecting Cards Find the probability of getting 2 face c. All parents
cards (king, queen, or jack) when 2 cards are drawn d. 1 teacher and 3 parents
from a deck without replacement.

3. Management Seminar In a company there are 7
executives: 4 women and 3 men. Three are selected to
attend a management seminar. Find these probabilities.

2. Selecting a Committee A parent-teacher committee
consisting of 4 people is to be formed from 20 parents
and 5 teachers. Find the probability that the committee
will consist of these people. (Assume that the selection
will be random.)

All 3 selected will be women.
All 3 selected will be men.

a. All teachers 2 men and 1 woman will be selected.

U0 SR

b. 2 teachers and 2 parents 1 man and 2 women will be selected.
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4. Senate Partisanship The composition of the Senate of

10.

the 107th Congress is

49 Republicans 1 Independent 50 Democrats

A new committee is being formed to study ways to
benefit the arts in education. If 3 Senators are selected at
random to head the committee, what is the probability
that they will all be Republicans? What is the
probability that they will all be Democrats? What is the
probability that there will be 1 from each party,
including the Independent?

Source: New York Times Almanac.

. Congressional Committee Memberships The

composition of the 108th Congress is 51 Republicans,
48 Democrats, and 1 Independent. A committee on aid
to higher education is to be formed with 3 Senators to
be chosen at random to head the committee. Find the
probability that the group of 3 consists of

a. All Republicans
b. All Democrats

¢.  One Democrat, one Republican, and one
Independent

. Defective Resistors A package contains 12 resistors,

3 of which are defective. If 4 are selected, find the
probability of getting

a. 0 defective resistors

b. 1 defective resistor

c. 3 defective resistors

. Winning Tickets If 50 tickets are sold and 2 prizes are

to be awarded, find the probability that one person will
win 2 prizes if that person buys 2 tickets.

. Getting a Full House Find the probability of getting

a full house (3 cards of one denomination and 2 of
another) when 5 cards are dealt from an ordinary
deck.

. Flight School Graduation At a recent graduation at

a naval flight school, 18 Marines, 10 members of the
Navy, and 3 members of the Coast Guard got their
wings. Choose three pilots at random to feature on

a training brochure. Find the probability that there
will be

a. 1 ofeach

b. 0 members of the Navy
¢. 3 Marines

Selecting Cards The red face cards and the black cards
numbered 2—-9 are put into a bag. Four cards are drawn
at random without replacement. Find the following
probabilities:

11.

12.

13.

14.

15.

16.

17.
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All 4 cards are red.

2 cards are red and 2 cards are black.
At least 1 of the cards is red.

All 4 cards are black.

U TR

Socks in a Drawer A drawer contains 11 identical red
socks and 8 identical black socks. Suppose that you
choose 2 socks at random in the dark.

a. What is the probability that you get a pair of red

socks?

b.  What is the probability that you get a pair of black
socks?

c. What is the probability that you get 2 unmatched
socks?

d. Where did the other red sock go?

Selecting Books Find the probability of selecting
3 science books and 4 math books from 8 science
books and 9 math books. The books are selected at
random.

Rolling Three Dice When 3 dice are rolled, find the
probability of getting a sum of 7.

Football Team Selection A football team consists of
20 each freshmen and sophomores, 15 juniors, and 10
seniors. Four players are selected at random to serve as
captains. Find the probability that

a. All 4 are seniors

b. There is 1 each: freshman, sophomore, junior,
and senior

¢. There are 2 sophomores and 2 freshmen

d. Atleast | of the students is a senior

Arrangement of Washers Find the probability that if 5
different-sized washers are arranged in a row, they will
be arranged in order of size.

Using the information in Exercise 63 in Section 44, find
the probability of each poker hand.

a. Royal flush
b. Straight flush
c. Four of a kind

Plant Selection All holly plants are dioecious—a male
plant must be planted within 30 to 40 feet of the female
plants in order to yield berries. A home improvement
store has 12 unmarked holly plants for sale, 8 of

which are female. If a homeowner buys 3 plants at
random, what is the probability that berries will be
produced?
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Summary

In this chapter, the basic concepts and rules of probability are explained. The three types
of probability are classical, empirical, and subjective. Classical probability uses sample
spaces. Empirical probability uses frequency distributions and is based on observation.
In subjective probability, the researcher makes an educated guess about the chance of an
event occurring.

A probability event consists of one or more outcomes of a probability experiment.
Two events are said to be mutually exclusive if they cannot occur at the same time.
Events can also be classified as independent or dependent. If events are independent,
whether or not the first event occurs does not affect the probability of the next event
occurring. If the probability of the second event occurring is changed by the occurrence
of the first event, then the events are dependent. The complement of an event is the set
of outcomes in the sample space that are not included in the outcomes of the event itself.
Complementary events are mutually exclusive.

Probability problems can be solved by using the addition rules, the multiplication
rules, and the complementary event rules.

Finally, the fundamental counting rule, the permutation rule, and the combination
rule can be used to determine the number of outcomes of events; then these numbers can
be used to determine the probabilities of events.

important Terms

classical probability 186
combination 229

complement of an
event 189

compound event 186
conditional probability 213
dependent events 213

empirical probability 191 mutually exclusive simple event 185

equally likely events 186 events 199 subjective probability 194
event 185 outcome 183 tree diagram 185
permutation 227

fundamental counting Venn diagrams 190

rule 224 probability 182
independent events 211 probability experiment 183
law of large numbers 194 sample space 183

Important Formulas

Formula for classical probability: Addition rule 2, for events that are not mutually exclusive:
number of
outcomes P(A or B) = P(4) + P(B) — P(A and B)
P =—nf B Multiplication rule 1, for independ :
= total number of _ n S) ultiplication rule 1, for independent events:
outcomes in
P(A and B) = P(A) - P(B
sample space (d and B) ) - P(B)
Formula for empirical probability: Multiplication rule 2, for dependent events:
P(E) = frequency for c}ass _ f P(4 and B) = P(4) - P(B|A)
total frequencies n
in distribution Formula for conditional probability:
Addition rule 1, for two mutually exclusive events:
P(B|A) = P(A and B)
P(A or B) = P(A) + P(B) P(A)
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Formula for complementary events:

PE)=1-PE) or PE)=1-PE)
or  PE)+PE)=1

Fundamental counting rule: In a sequence of #n events in
which the first one has k, possibilities, the second event has
k, possibilities, the third has k; possibilities, etc., the total
number possibilities of the sequence will be

ky-ky-ky- -k,

Review EXxercises

1. When a standard die is rolled, find the probability of
getting
a. A5
b. A number larger than 2
¢. An odd number

2. Selecting a Card When a card is selected from a deck,
find the probability of getting

A club

A face card or a heart
A 6 and a spade
Aking

A red card

3. Software Selection The top-10 selling computer
software titles last year consisted of 3 for doing taxes,
5 antivirus or security programs, and 2 “other.” Choose
one title at random.

S A0 =8

a. What is the probability that it is not used for doing
taxes?

b. What is the probability that it is used for taxes or is
one of the “other” programs?

Source: www.infoplease.com

4. A six-sided die is printed with the numbers 1, 2, 3, 5, 8,
and 13. Roll the die once—what is the probability of
getting an even number? Roll the die twice and add the
numbers. What is the probability of getting an odd sum
on the dice?

5. Cordless Phone Survey A recent survey indicated
that in a town of 1500 households, 850 had cordless
telephones. If a household is randomly selected, find the
probability that it has a cordless telephone.

6. Purchasing Sweaters During a sale at a men’s store,
16 white sweaters, 3 red sweaters, 9 blue sweaters, and
7 yellow sweaters were purchased. If a customer is
selected at random, find the probability that he bought

a. A blue sweater

b. A yellow or a white sweater

c. Ared, ablue, or a yellow sweater
d. A sweater that was not white

Review Exercises 243

Permutation rule: The number of permutations of # objects
taking 7 objects at a time when order is important is

n!
p=—""_
(=)

Combination rule: The number of combinations of » objects
selected from » objects when order is not important is

n!
C,=—
T (m =)

7. Budget Rental Cars Cheap Rentals has nothing but
budget cars for rental. The probability that a car has air
conditioning is 0.5, and the probability that a car has a
CD player is 0.37. The probability that a car has both air
conditioning and a CD player is 0.06. What is the
probability that a randomly selected car has neither air
conditioning nor a CD player?

8. Rolling Two Dice When two dice are rolled, find the
probability of getting

Asumof5Sor6

A sum greater than 9

A sum less than 4 or greater than 9
A sum that is divisible by 4

A sum of 14

A sum less than 13

e RN =R

9. Car and Boat Ownership The probability that a
person owns a car is 0.80, that a person owns a boat is
0.30, and that a person owns both a car and a boat is
0.12. Find the probability that a person owns either a
boat or a car.

10. Car Purchases There is a 0.39 probability that John
will purchase a new car, a 0.73 probability that Mary will
purchase a new car, and a 0.36 probability that both
will purchase a new car. Find the probability that neither
will purchase a new car.

11. Online Course Selection Roughly 1 in 6 students
enrolled in higher education took at least one online
course last fall. Choose 5 enrolled students at random.
Find the probability that

a. All 5 took online courses
b. None of the 5 took a course online
c. Atleast 1 took an online course

Source: www.encarta.msn.com
12. Borrowing Books Of Americans using library services,
67% borrow books. If 5 patrons are chosen at random,

what is the probability that all borrowed books? That
none borrowed books?

Source: American Library Association.
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13. Drawing Cards Three cards are drawn from an
ordinary deck without replacement. Find the probability
of getting
a. All black cards
b. All spades
c. All queens

14. Coin Toss and Card Drawn A coin is tossed and a card
is drawn from a deck. Find the probability of getting

a. Aheadanda 6
b. A tail and a red card
c. Ahead and a club

15. Movie Releases The top five countries for movie
releases so far this year are the United States with 471
releases, United Kingdom with 386, Japan with 79,
Germany with 316, and France with 132. Choose one
new release at random. Find the probability that it is

a. European

b. From the United States

c. German or French

d. German given that it is European

Source: www.showbizdata.com

16. Factory Output A manufacturing company has three
factories: X, Y, and Z. The daily output of each is shown

here.
Product Factory X Factory Y Factory Z
TVs 18 32 15
Stereos 6 20 13

If one item is selected at random, find these probabilities.

a. It was manufactured at factory X or is a stereo.
b. It was manufactured at factory Y or factory Z.
c. Itisa TV or was manufactured at factory Z.

17. Effectiveness of Vaccine A vaccine has a 90%
probability of being effective in preventing a certain
disease. The probability of getting the disease if a
person is not vaccinated is 50%. In a certain geographic
region, 25% of the people get vaccinated. If a person is
selected at random, find the probability that he or she
will contract the disease.

18. Television Models A manufacturer makes three models
of a television set, models A, B, and C. A store sells
40% of model A sets, 40% of model B sets, and 20% of
model C sets. Of model A sets, 3% have stereo sound;
of model B sets, 7% have stereo sound; and of model C
sets, 9% have stereo sound. If a set is sold at random,
find the probability that it has stereo sound.

19. Car Purchase The probability that Sue will live on
campus and buy a new car is 0.37. If the probability
that she will live on campus is 0.73, find the
probability that she will buy a new car, given that
she lives on campus.

20. Applying Shipping Labels Four unmarked packages
have lost their shipping labels, and you must reapply

4-64

21.

22.

23.

them. What is the probability that you apply the labels
and get all four of them correct? Exactly three correct?
Exactly two? At least one correct?

Health Club Membership Of the members of the Blue
River Health Club, 43% have a lifetime membership
and exercise regularly (three or more times a week). If
75% of the club members exercise regularly, find the
probability that a randomly selected member is a life
member, given that he or she exercises regularly.

Bad Weather The probability that it snows and the bus
arrives late is 0.023. José hears the weather forecast,
and there is a 40% chance of snow tomorrow. Find

the probability that the bus will be late, given that it
SNOWS.

Education Level and Smoking At a large factory, the
employees were surveyed and classified according to
their level of education and whether they smoked. The
data are shown in the table.

Educational level

Not high High
school school College
Smoking habit graduate graduate graduate
Smoke 6 14 19
Do not smoke 18 7 25

24.

25.

26.

27.

If an employee is selected at random, find these
probabilities.

a. The employee smokes, given that he or she
graduated from college.

b. Given that the employee did not graduate from high
school, he or she is a smoker.

War Veterans Approximately 11% of the civilian
population are veterans. Choose 5 civilians at random.
What is the probability that none are veterans? What is
the probability that at least 1 is a veteran?

Source: www.factfinder.census.gov

DVD Players Eighty-one percent of U.S. households
have DVD players. Choose 6 households at random.
What is the probability that at least one does not have a
DVD player?

Source: www.infoplease.com

Chronic Sinusitis The U.S. Department of Health and
Human Services reports that 15% of Americans have
chronic sinusitis. If 5 people are selected at random, find
the probability that at least 1 has chronic sinusitis.

Source: 100% American.

Automobile License Plate An automobile license plate
consists of 3 letters followed by 4 digits. How many
different plates can be made if repetitions are allowed? If
repetitions are not allowed? If repetitions are allowed in
the letters but not in the digits?


www.showbizdata.com
www.factfinder.census.gov
www.infoplease.com

28.

29.

30.

31.

32.

33.

34.

3s.

36.

37.

Types of Copy Paper White copy paper is offered
in 5 different strengths and 11 different degrees of
brightness, recycled or not, and acid-free or not. How
many different types of paper are available for order?

Baseball Players How many ways can 3 outfielders
and 4 infielders be chosen from 5 outfielders and
7 infielders?

Computer Operators How many different ways can
8 computer operators be seated in a row?

Student Representatives How many ways can a
student select 2 electives from a possible choice of
10 electives?

Committee Representation There are 6 Republican,
5 Democrat, and 4 Independent candidates. How many
different ways can a committee of 3 Republicans,

2 Democrats, and 1 Independent be selected?

Song Selections A promotional MP3 player is available
with the capacity to store 100 songs which can be
reordered at the push of a button. How many different
arrangements of these songs are possible?

(Note: Factorials get very big, very fast! How large

a factorial will your calculator calculate?)

Employee Health Care Plans A new employee has a
choice of 5 health care plans, 3 retirement plans, and

2 different expense accounts. If a person selects one of
each option, how many different options does he or she
have?

Course Enrollment There are 12 students who wish
to enroll in a particular course. There are only 4 seats
left in the classroom. How many different ways can
4 students be selected to attend the class?

Candy Selection A candy store allows customers to
select 3 different candies to be packaged and mailed. If
there are 13 varieties available, how many possible
selections can be made?

Book Selection If a student can select 5 novels from a
reading list of 20 for a course in literature, how many
different possible ways can this selection be done?

Statistics
Today

38.

39.

40.

41.

42,

43.
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Review Exercises

Course Selection If a student can select one of 3
language courses, one of 5 mathematics courses, and
one of 4 history courses, how many different schedules
can be made?

License Plates License plates are to be issued with
3 letters followed by 4 single digits. How many
such license plates are possible? If the plates are
issued at random, what is the probability that the
license plate says USA followed by a number that is
divisible by 5?

Leisure Activities A newspaper advertises 5 different
movies, 3 plays, and 2 baseball games for the weekend.
If a couple selects 3 activities, find the probability that
they attend 2 plays and 1 movie.

Territorial Selection Several territories and colonies
today are still under the jurisdiction of another country.
France holds the most with 16 territories, the United
Kingdom has 15, the United States has 14, and several
other countries have territories as well. Choose 3
territories at random from those held by France, the
United Kingdom, and the United States. What is the
probability that all 3 belong to the same country?

Source: www.infoplease.com

Yahtzee Yahtzee is a game played with 5 dice. Players
attempt to score points by rolling various combinations.
When all 5 dice show the same number, it is called

a Yahtzee and scores 50 points for the first one and

100 points for each subsequent Yahtzee in the same
game. What is the probability that a person throws a
Yahtzee on the very first roll? What is the probability
that a person throws two Yahtzees on two successive
turns?

Personnel Classification For a survey, a subject can be
classified as follows:

Gender: male or female
Martial status: single, married, widowed, divorced
Occupation: administration, faculty, staff

Draw a tree diagram for the different ways a person can
be classified.

Would You Bet Your Life?—Revisited

In his book Probabilities in Everyday Life, John D. McGervey states that the chance of being

killed on any given commercial airline flight is almost 1 in 1 million and that the chance of
being killed during a transcontinental auto trip is about 1 in 8000. The corresponding
probabilities are 1/1,000,000 = 0.000001 as compared to 1/8000 = 0.000125. Since the
second number is 125 times greater than the first number, you have a much higher risk driving

than flying across the United States.
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Chapter Quiz

Determine whether each statement is true or false. If the
statement is false, explain why.

1.

Subjective probability has little use in the real
world.

. Classical probability uses a frequency distribution to

compute probabilities.

. In classical probability, all outcomes in the sample

space are equally likely.

. When two events are not mutually exclusive,

P(4 or B) = P(4) + P(B).

. If two events are dependent, they must have the same

probability of occurring.

. An event and its complement can occur at the same

time.

. The arrangement ABC is the same as BAC for

combinations.

. When objects are arranged in a specific order, the

arrangement is called a combination.

Select the best answer.

9.

10.

11.

12.

13.

14.

The probability that an event happens is 0.42. What is
the probability that the event won’t happen?

a. —0.42 c. 0

b. 0.58 d 1

When a meteorologist says that there is a 30% chance of
showers, what type of probability is the person using?

c. Relative
d. Subjective

a. Classical
b. Empirical

The sample space for tossing 3 coins consists of how
many outcomes?

a. 2 c. 6

b. 4 d 8

The complement of guessing 5 correct answers on a
5-question true/false exam is

a. Guessing 5 incorrect answers

b. Guessing at least 1 incorrect answer
c.  Guessing at least 1 correct answer
d. Guessing no incorrect answers

When two dice are rolled, the sample space consists of
how many events?

a. 6 c. 36

b. 12 d 54

What is ,P,?

a 0 c.n

b. 1 d. It cannot be determined.
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15.

16.

17.

What is the number of permutations of 6 different
objects taken all together?

a. 0 c. 36

b. 1 d. 720

What is 0!?

a 0 ¢. Undefined

b 1 d 10

What is ,C,?

a. 0 c. n

b 1 d. Tt cannot be determined.

Complete the following statements with the best answer.

18.

19.

20.
21.

22.

23.

24.

25.

26.

The set of all possible outcomes of a probability
experiment is called the

The probability of an event can be any number between
and including and

If an event cannot occur, its probability is

The sum of the probabilities of the events in the sample
space is

When two events cannot occur at the same time, they
are said to be

When a card is drawn, find the probability of getting
a. Ajack
b. A4

¢.  Acard less than 6 (an ace is considered above 6)
Selecting a Card When a card is drawn from a deck,
find the probability of getting

b. A5 oraheart
d. Aking

a. A diamond
c. A5 andaheart
e. Aredcard

Selecting a Sweater At a men’s clothing store, 12 men
purchased blue golf sweaters, 8 purchased green
sweaters, 4 purchased gray sweaters, and 7 bought black
sweaters. If a customer is selected at random, find the
probability that he purchased

a. A blue sweater

b. A green or gray sweater

c. A green or black or blue sweater
d. A sweater that was not black

Rolling Dice When 2 dice are rolled, find the
probability of getting

A sum of 6 or 7

A sum greater than 8

A sum less than 3 or greater than 8

A sum that is divisible by 3

Asum of 16

A sum less than 11

R RN =R



27. Appliance Ownership The probability that a person
owns a microwave oven is 0.75, that a person owns a
compact disk player is 0.25, and that a person owns
both a microwave and a CD player is 0.16. Find the
probability that a person owns either a microwave or a
CD player, but not both.

28. Starting Salaries Of the physics graduates of a
university, 30% received a starting salary of $30,000 or
more. If 5 of the graduates are selected at random, find
the probability that all had a starting salary of $30,000
or more.

29. Selecting Cards Five cards are drawn from an ordinary
deck without replacement. Find the probability of getting

a. All red cards
b. All diamonds
c. All aces

30. Scholarships The probability that Samantha will be
accepted by the college of her choice and obtain a
scholarship is 0.35. If the probability that she is
accepted by the college is 0.65, find the probability that
she will obtain a scholarship given that she is accepted
by the college.

31. New Car Warranty The probability that a customer
will buy a car and an extended warranty is 0.16. If the
probability that a customer will purchase a car is 0.30,
find the probability that the customer will also purchase
the extended warranty.

32. Bowling and Club Membership Of the members of
the Spring Lake Bowling Lanes, 57% have a lifetime
membership and bowl regularly (three or more times
a week). If 70% of the club members bowl regularly,
find the probability that a randomly selected member
is a lifetime member, given that he or she bowls
regularly.

33. Work and Weather The probability that Mike has to
work overtime and it rains is 0.028. Mike hears the
weather forecast, and there is a 50% chance of rain.
Find the probability that he will have to work overtime,
given that it rains.

34. Education of Factory Employees At a large factory,
the employees were surveyed and classified according
to their level of education and whether they attend a
sports event at least once a month. The data are shown
in the table.

Educational level

High Two-year  Four-year
school college college
Sports event graduate degree degree
Attend 16 20 24
Do not attend 12 19 25

If an employee is selected at random, find the
probability that

35.

37.

38.

39.

40.

41.

42.

43.

44,

45.

46.

47.

48.
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a. The employee attends sports events regularly,
given that he or she graduated from college
(2- or 4-year degree)

b. Given that the employee is a high school graduate, he
or she does not attend sports events regularly

Heart Attacks In a certain high-risk group, the chances
of a person having suffered a heart attack are 55%. If

6 people are chosen, find the probability that at least 1
will have had a heart attack.

. Rolling a Die A single die is rolled 4 times. Find the

probability of getting at least one 5.

Eye Color If 85% of all people have brown eyes and
6 people are selected at random, find the probability that
at least 1 of them has brown eyes.

Singer Selection How many ways can 5 sopranos and
4 altos be selected from 7 sopranos and 9 altos?

Speaker Selection How many different ways can
8 speakers be seated on a stage?

Stocking Machines A soda machine servicer must
restock and collect money from 15 machines, each one
at a different location. How many ways can she select
4 machines to service in 1 day?

ID Cards One company’s ID cards consist of 5 letters
followed by 2 digits. How many cards can be made

if repetitions are allowed? If repetitions are not
allowed?

How many different arrangements of the letters in the
word number can be made?

Physics Test A physics test consists of 25 true/false
questions. How many different possible answer keys
can be made?

Cellular Telephones How many different ways can 5
cellular telephones be selected from 8 cellular phones?

Fruit Selection On a lunch counter, there are 3
oranges, 5 apples, and 2 bananas. If 3 pieces of fruit are
selected, find the probability that 1 orange, 1 apple, and
1 banana are selected.

Cruise Ship Activities A cruise director schedules 4

different movies, 2 bridge games, and 3 tennis games

for a 2-day period. If a couple selects 3 activities, find
the probability that they attend 2 movies and 1 tennis

game.

Committee Selection At a sorority meeting, there are 6
seniors, 4 juniors, and 2 sophomores. If a committee of

3 is to be formed, find the probability that 1 of each will
be selected.

Banquet Meal Choices For a banquet, a committee
can select beef, pork, chicken, or veal; baked potatoes
or mashed potatoes; and peas or green beans for a
vegetable. Draw a tree diagram for all possible choices
of a meat, a potato, and a vegetable.
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Critical Thinking Challenges

1. Con Man Game Consider this problem: A con man has For example, suppose there were 3 people in the

3 coins. One coin has been specially made and has a head
on each side. A second coin has been specially made, and
on each side it has a tail. Finally, a third coin has a head
and a tail on it. All coins are of the same denomination.
The con man places the 3 coins in his pocket, selects one,
and shows you one side. It is heads. He is willing to bet
you even money that it is the two-headed coin. His
reasoning is that it can’t be the two-tailed coin since a
head is showing; therefore, there is a 50-50 chance of it
being the two-headed coin. Would you take the bet?
(Hint: See Exercise 1 in Data Projects.)

. de Méré Dice Game Chevalier de Méré won money
when he bet unsuspecting patrons that in 4 rolls of 1 die,
he could get at least one 6, but he lost money when he
bet that in 24 rolls of 2 dice, he could get at least a
double 6. Using the probability rules, find the
probability of each event and explain why he won the
majority of the time on the first game but lost the
majority of the time when playing the second game.
(Hint: Find the probabilities of losing each game and
subtract from 1.)

. Classical Birthday Problem How many people do you
think need to be in a room so that 2 people will have the
same birthday (month and day)? You might think it is 366.
This would, of course, guarantee it (excluding leap year),
but how many people would need to be in a room so that
there would be a 90% probability that 2 people would be
born on the same day? What about a 50% probability?

Actually, the number is much smaller than you
may think. For example, if you have 50 people in a room,
the probability that 2 people will have the same birthday
is 97%. If you have 23 people in a room, there is a 50%
probability that 2 people were born on the same day!

The problem can be solved by using the probability
rules. It must be assumed that all birthdays are equally
likely, but this assumption will have little effect on the
answers. The way to find the answer is by using the
complementary event rule as P(2 people having the same
birthday) = 1 — P(all have different birthdays).

@ Data Projects

1. Business and Finance Select a pizza restaurant and a

sandwich shop. For the pizza restaurant look at the
menu to determine how many sizes, crust types, and
toppings are available. How many different pizza types
are possible? For the sandwich shop determine how
many breads, meats, veggies, cheeses, sauces, and
condiments are available. How many different sandwich
choices are possible?
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room. The probability that each had a different birthday
would be

— oo = 0.992
Hence, the probability that at least 2 of the 3 people will
have the same birthday will be

1 —0.992 = 0.008
Hence, for & people, the formula is

P(at least 2 people have the same birthday)

365k
365%

Using your calculator, complete the table and verify
that for at least a 50% chance of 2 people having the
same birthday, 23 or more people will be needed.

Probability
that at least
Number of 2 have the
people same birthday
1 0.000
2 0.003
5 0.027
10
15
20
21
22
23

. We know that if the probability of an event happening is

100%, then the event is a certainty. Can it be concluded
that if there is a 50% chance of contracting a
communicable disease through contact with an infected
person, there would be a 100% chance of contracting the
disease if 2 contacts were made with the infected person?
Explain your answer.

. Sports and Leisure When poker games are shown

on television, there are often percentages displayed
that show how likely it is that a certain hand will win.
Investigate how these percentages are determined.
Show an example with two competing hands in a
Texas Hold ’em game. Include the percentages that
each hand will win after the deal, the flop, the turn,
and the river.



3.

Technology A music player or music organization
program can keep track of how many different artists
are in a library. First note how many different artists are
in your music library. Then find the probability that if
25 songs are selected at random, none will have the
same artist.

. Health and Wellness Assume that the gender

distribution of babies is such that one-half the time
females are born and one-half the time males are born.
In a family of 3 children, what is the probability that all
are girls? In a family of 4? Is it unusual that in a family
with 4 children all would be girls? In a family of 5?

5.

Answers to Applying the Concepts 249

Politics and Economics Consider the U.S. Senate.
Find out about the composition of any three of the
Senate’s standing committees. How many different
committees of Senators are possible, knowing the party
composition of the Senate and the number of committee
members from each party for each committee?

. Your Class Research the famous Monty Hall

probability problem. Conduct a simulation of the Monty
Hall problem online using a simulation program or in
class using live “contestants.” After 50 simulations
compare your results to those stated in the research you
did. Did your simulation support the conclusions?

Answers to Applying the Concepts

Section 4-1 Tossing a Coin

1.

The sample space is the listing of all possible outcomes
of the coin toss.

2. The possible outcomes are heads or tails.

3. Classical probability says that a fair coin has a 50-50

chance of coming up heads or tails.

. The law of large numbers says that as you increase the

number of trials, the overall results will approach the
theoretical probability. However, since the coin has no
“memory,” it still has a 50-50 chance of coming up
heads or tails on the next toss. Knowing what has
already happened should not change your opinion on
what will happen on the next toss.

. The empirical approach to probability is based on

running an experiment and looking at the results. You
cannot do that at this time.

. Subjective probabilities could be used if you believe the

coin is biased.

. Answers will vary; however, they should address that a

fair coin has a 50-50 chance of coming up heads or tails
on the next flip.

Section 4-2 Which Pain Reliever Is Best?
1. There were 192 + 186 + 188 = 566 subjects in the study.
2. The study lasted for 12 weeks.

3. The variables are the type of pain reliever and the side

effects.

4. Both variables are qualitative and nominal.

5. The numbers in the table are exact figures.

6. The probability that a randomly selected person was

receiving a placebo is 192/566 = 0.3392 (about 34%).

. The probability that a randomly selected person was

receiving a placebo or drug 4 is (192 + 186)/566 =
378/566 = 0.6678 (about 67%). These are mutually

exclusive events. The complement is that a randomly
selected person was receiving drug B.

. The probability that a randomly selected person was

receiving a placebo or experienced a neurological
headache is (192 + 55 + 72)/566 = 319/566 =
0.5636 (about 56%).

. The probability that a randomly selected person was

not receiving a placebo or experienced a sinus headache
is (186 + 188)/566 + 11/566 = 385/566 = 0.6802
(about 68%).

Section 4-3 Guilty or Innocent?

1.

The probability of another couple with the same
characteristics being in that area is

1 1 1 1 1 1 1 _ 1 :
907410313 100 — 20,595,000, Assuming the
characteristics are independent of one another.

. You would use the multiplication rule, since we are

looking for the probability of multiple events happening
together.

. We do not know if the characteristics are dependent or

independent, but we assumed independence for the
calculation in question 1.

. The probabilities would change if there were

dependence among two or more events.

. Answers will vary. One possible answer is that

probabilities can be used to explain how unlikely it is
to have a set of events occur at the same time (in this
case, how unlikely it is to have another couple with
the same characteristics in that area).

. Answers will vary. One possible answer is that if the

only eyewitness was the woman who was mugged and
the probabilities are accurate, it seems very unlikely
that a couple matching these characteristics would be

in that area at that time. This might cause you to convict
the couple.
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7. Answers will vary. One possible answer is that our
probabilities are theoretical and serve a purpose when
appropriate, but that court cases are based on much
more than impersonal chance.

8. Answers will vary. One possible answer is that juries

. With 5 on/off switches, there are 2° = 32 different

settings. With 6 on/off switches, there are 2° = 64
different settings. In general, if there are k on/off
switches, there are 2% different settings.

. With 8 consecutive on/off switches, there are 2% = 256

decide whether to convict a defendant if they find

evidence “beyond a reasonable doubt” that the person is 4
guilty. In probability terms, this means that if the

defendant was actually innocent, then the chance of

seeing the events that occurred is so unlikely as to have
occurred by chance. Therefore, the jury concludes that

the defendant is guilty.

different settings.

. Tt is less likely for someone to be able to open your
garage door if you have 8 on/off settings (probability
about 0.4%) than if you have 4 on/off switches
(probability about 6.0%). Having 8 on/off switches in
the opener seems pretty safe.

5. Each key blank could be made into 5° = 3125 possible

Section 4-4 Garage Door Openers keys.

6. If there were 420,000 Dodge Caravans sold in the
United States, then any one key could start about
420,000/3125 = 134.4, or about 134, different

1. Four on/off switches lead to 16 different settings.

+=0n +
_ = Off + Caravans.
N - 7. Answers will vary.
+
- Section 4-5 Counting Rules and Probability
. - 1. There are five different events: each multiple-choice

question is an event.

+
+

2. These events are independent.

3. If you guess on 1 question, the probability of getting it
correct is 0.20. Thus, if you guess on all 5 questions,
the probability of getting all of them correct is (0.20)° =
0.00032.

. The probability that a person would guess answer A
for a question is 0.20, so the probability that a person
would guess answer A for each question is (0.20)° =
0.00032.

. There are five different events: each matching question
is an event.

+

+
+

+
W

6. These are dependent events.

+

7. The probability of getting them all correct if you are

: 101 1 1 1 1
guessingiss 3337 = 125 — 0.0083.

+

ANANANAN

8. The difference between the two problems is that we are
sampling without replacement in the second problem, so
the denominator changes in the event probabilities.

+

ANVANAWA
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I obicctives

After completing this chapter, you should be able to

H

Construct a probability distribution for a
random variable.

Find the mean, variance, standard deviation,
and expected value for a discrete random
variable.

Find the exact probability for X successes in
n trials of a binomial experiment.

Find the mean, variance, and standard
deviation for the variable of a binomial
distribution.

Find probabilities for outcomes of variables,
using the Poisson, hypergeometric, and
multinomial distributions.

Discrete Probability
Distributions

5-3

5-4

Introduction
Probability Distributions

Mean, Variance, Standard Deviation,
and Expectation

The Binomial Distribution
Other Types of Distributions (Optional)

Summary
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Chapter 5 Discrete Probability Distributions

Statistics
Today

T

Is Pooling Worthwhile?

Blood samples are used to screen people for certain diseases. When the disease is rare,
health care workers sometimes combine or pool the blood samples of a group of
individuals into one batch and then test it. If the test result of the batch is negative, no
further testing is needed since none of the individuals in the group has the disease.
However, if the test result of the batch is positive, each individual in the group must be
tested.

Consider this hypothetical example: Suppose the probability of a person having the
disease is 0.05, and a pooled sample of 15 individuals is tested. What is the probability
that no further testing will be needed for the individuals in the sample? The answer to
this question can be found by using what is called the binomial distribution. See
Statistics Today—Revisited at the end of the chapter.

This chapter explains probability distributions in general and a specific, often used
distribution called the binomial distribution. The Poisson, hypergeometric, and multino-
mial distributions are also explained.

Introduction

Many decisions in business, insurance, and other real-life situations are made by assign-
ing probabilities to all possible outcomes pertaining to the situation and then evaluating
the results. For example, a saleswoman can compute the probability that she will make
0, 1, 2, or 3 or more sales in a single day. An insurance company might be able to assign
probabilities to the number of vehicles a family owns. A self-employed speaker might be
able to compute the probabilities for giving 0, 1, 2, 3, or 4 or more speeches each week.
Once these probabilities are assigned, statistics such as the mean, variance, and standard
deviation can be computed for these events. With these statistics, various decisions can
be made. The saleswoman will be able to compute the average number of sales she makes
per week, and if she is working on commission, she will be able to approximate her
weekly income over a period of time, say, monthly. The public speaker will be able to



Objective [E}
Construct a

probability distribution
for a random variable.
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plan ahead and approximate his average income and expenses. The insurance company
can use its information to design special computer forms and programs to accommodate
its customers’ future needs.

This chapter explains the concepts and applications of what is called a probability
distribution. In addition, special probability distributions, such as the binomial,
multinomial, Poisson, and hypergeometric distributions, are explained.

Probability Distributions

Before probability distribution is defined formally, the definition of a variable is
reviewed. In Chapter 1, a variable was defined as a characteristic or attribute that can
assume different values. Various letters of the alphabet, such as X, Y, or Z, are used to
represent variables. Since the variables in this chapter are associated with probability,
they are called random variables.

For example, if a die is rolled, a letter such as X can be used to represent the
outcomes. Then the value that X can assume is 1, 2, 3, 4, 5, or 6, corresponding to the
outcomes of rolling a single die. If two coins are tossed, a letter, say ¥, can be used to
represent the number of heads, in this case 0, 1, or 2. As another example, if the temper-
ature at 8:00 A.M. is 43° and at noon it is 53°, then the values 7T that the temperature
assumes are said to be random, since they are due to various atmospheric conditions at
the time the temperature was taken.

A random variable is a variable whose values are determined by chance.

Also recall from Chapter 1 that you can classify variables as discrete or continuous
by observing the values the variable can assume. If a variable can assume only a specific
number of values, such as the outcomes for the roll of a die or the outcomes for the toss
of a coin, then the variable is called a discrete variable.

Discrete variables have a finite number of possible values or an infinite number of
values that can be counted. The word counted means that they can be enumerated using
the numbers 1, 2, 3, etc. For example, the number of joggers in Riverview Park each day
and the number of phone calls received after a TV commercial airs are examples of dis-
crete variables, since they can be counted.

Variables that can assume all values in the interval between any two given values
are called continuous variables. For example, if the temperature goes from 62 to 78° in
a 24-hour period, it has passed through every possible number from 62 to 78. Continuous
random variables are obtained from data that can be measured rather than counted.
Continuous random variables can assume an infinite number of values and can be deci-
mal and fractional values. On a continuous scale, a person’s weight might be exactly
183.426 pounds if a scale could measure weight to the thousandths place; however, on a
digital scale that measures only to tenths of pounds, the weight would be 183.4 pounds.
Examples of continuous variables are heights, weights, temperatures, and time. In this
chapter only discrete random variables are used; Chapter 6 explains continuous random
variables.

The procedure shown here for constructing a probability distribution for a discrete
random variable uses the probability experiment of tossing three coins. Recall that when
three coins are tossed, the sample space is represented as TTT, TTH, THT, HTT, HHT,
HTH, THH, HHH; and if X is the random variable for the number of heads, then X
assumes the value 0, 1, 2, or 3.
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Probabilities for the values of X can be determined as follows:

No heads One head Two heads Three heads
TTT TTH THT HTT HHT HTH THH HHH
1
! P Poob !
' (. ~~ J (. ~~ J '
1 3 3 1
8 8 8 8

Hence, the probability of getting no heads is §, one head is 3, two heads is 3, and three
heads is 3. From these values, a probability distribution can be constructed by listing the
outcomes and assigning the probability of each outcome, as shown here.

Number of heads X | 2 3
Probability P(X) |

(=)

oo|—
01w | —
oolw
oof—

A discrete probability distribution consists of the values a random variable can
assume and the corresponding probabilities of the values. The probabilities are
determined theoretically or by observation.

Discrete probability distributions can be shown by using a graph or a table. Probability
distributions can also be represented by a formula. See Exercises 31-36 at the end of this
section for examples.

Construct a probability distribution for rolling a single die.

Solution

Since the sample space is 1, 2, 3, 4, 5, 6 and each outcome has a probability of §, the
distribution is as shown.

Outcome X |
Probability P(X) |

4

(9]
(@)}

A= | —
\S]
(O8]

=
=
=
=
N=

Probability distributions can be shown graphically by representing the values of X on
the x axis and the probabilities P(X) on the y axis.

Represent graphically the probability distribution for the sample space for tossing three

coins.
Number of heads X | 0 1 2 3
Probability P(X) R
Solution

The values that X assumes are located on the x axis, and the values for P(X) are located
on the y axis. The graph is shown in Figure 5-1.

Note that for visual appearances, it is not necessary to start with 0 at the origin.

Examples 5—-1 and 5-2 are illustrations of theoretical probability distributions. You
did not need to actually perform the experiments to compute the probabilities. In contrast,
to construct actual probability distributions, you must observe the variable over a period
of time. They are empirical, as shown in Example 5-3.

5-4
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Probability Distribution
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Probability

oo|n
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!

oo|—

0 1 2 3
Number of heads

o 1
Probability Distribution
for Example 5-3

Baseball World Series

The baseball World Series is played by the winner of the National League and the
American League. The first team to win four games wins the World Series. In other
words, the series will consist of four to seven games, depending on the individual
victories. The data shown consist of the number of games played in the World Series
from 1965 through 2005. (There was no World Series in 1994.) The number of games
played is represented by the variable X. Find the probability P(X) for each X, construct
a probability distribution, and draw a graph for the data.

X Number of games played
4 8
5 7
6 9
7 16
40

Solution

The probability P(X) can be computed for each X by dividing the number of games X
by the total.

For 4 games, % = 0.200 For 6 games, & = 0.225
For 5 games, 5 = 0.175 For 7 games, 5 = 0.400
The probability distribution is
Number of games X | 4 5 6 7
Probability P(X) | 0.200  0.175  0.225  0.400
The graph is shown in Figure 5-2.
P(X)
040 -}
z 030+
£ o020+
0104
X
0
4 5 6 7
Number of games
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Speaking of

Statistics

Coins, Births, and Other Random (?)
Events

Examples of random events such as
tossing coins are used in almost all books
on probability. But is flipping a coin really
a random event?

Tossing coins dates back to ancient
Roman times when the coins usually
consisted of the Emperor’s head on one
side (i.e., heads) and another icon such as
a ship on the other side (i.e., ships).
Tossing coins was used in both fortune
telling and ancient Roman games.

A Chinese form of divination called
the /-Ching (pronounced E-Ching) is
thought to be at least 4000 years old. It consists of 64 hexagrams made up of six horizontal lines. Each line is either
broken or unbroken, representing the yin and the yang. These 64 hexagrams are supposed to represent all possible
situations in life. To consult the I-Ching, a question is asked and then three coins are tossed six times. The way the coins
fall, either heads up or heads down, determines whether the line is broken (yin) or unbroken (yang). Once the hexagon is
determined, its meaning is consulted and interpreted to get the answer to the question. (Nofe. Another method used to
determine the hexagon employs yarrow sticks.)

In the 16th century, a mathematician named Abraham DeMoivre used the outcomes of tossing coins to study what
later became known as the normal distribution; however, his work at that time was not widely known.

Mathematicians usually consider the outcomes of a coin toss a random event. That is, each probability of getting a
head is 1, and the probability of getting a tail is 3. Also, it is not possible to predict with 100% certainty which outcome
will occur. But new studies question this theory. During World War II a South African mathematician named John
Kerrich tossed a coin 10,000 times while he was interned in a German prison camp. Unfortunately, the results of his
experiment were never recorded, so we don’t know the number of heads that occurred.

Several studies have shown that when a coin-tossing device is used, the probability that a coin will land on the same
side on which it is placed on the coin-tossing device is about 51%. It would take about 10,000 tosses to become aware
of this bias. Furthermore, researchers showed that when a coin is spun on its edge, the coin falls tails up about 80% of the
time since there is more metal on the heads side of a coin. This makes the coin slightly heavier on the heads side than on
the tails side.

Another assumption commonly made in probability theory is that the number of male births is equal to the number
of female births and that the probability of a boy being born is 5 and the probability of a girl being born is 3. We know
this is not exactly true.

In the later 1700s, a French mathematician named Pierre Simon Laplace attempted to prove that more males than
females are born. He used records from 1745 to 1770 in Paris and showed that the percentage of females born was
about 49%. Although these percentages vary somewhat from location to location, further surveys show they are generally
true worldwide. Even though there are discrepancies, we generally consider the outcomes to be 50-50 since these
discrepancies are relatively small.

Based on this article, would you consider the coin toss at the beginning of a football game fair?
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Two Requirements for a Probability Distribution

1. The sum of the probabilities of all the events in the sample space must equal 1; that is,
2PX) = 1.

2. The probability of each event in the sample space must be between or equal to 0 and 1.
Thatis, 0 = P(X) = 1.

The first requirement states that the sum of the probabilities of all the events must be
equal to 1. This sum cannot be less than 1 or greater than 1 since the sample space includes
all possible outcomes of the probability experiment. The second requirement states that
the probability of any individual event must be a value from 0 to 1. The reason (as stated
in Chapter 4) is that the range of the probability of any individual value can be 0, 1, or any
value between 0 and 1. A probability cannot be a negative number or greater than 1.

Example 5—-4

Probability Distributions

Determine whether each distribution is a probability distribution.

a X | 0 5 10 15 20 <X 1 2 3 4
T R
b X |0 2 4 6 d X | 2 37
PX) | -10 15 03 02 PX) | 05 03 04
Solution

a. Yes, it is a probability distribution.

b. No, it is not a probability distribution, since P(X) cannot be 1.5 or —1.0.
c. Yes, it is a probability distribution.

d. No, it is not, since 2P(X) = 1.2.

Many variables in business, education, engineering, and other areas can be analyzed
by using probability distributions. Section 5-2 shows methods for finding the mean and
standard deviation for a probability distribution.

Applying the Concepts 5=-1

Dropping College Courses
Use the following table to answer the questions.

Reason for Dropping a College Course Frequency Percentage
Too difficult 45
Illness 40
Change in work schedule 20
Change of major 14
Family-related problems 9
Money 7
Miscellaneous 6
No meaningful reason 3
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. What is the variable under study? Is it a random variable?
. How many people were in the study?
. Complete the table.

. From the information given, what is the probability that a student will drop a class because
of illness? Money? Change of major?

A WO =

. Would you consider the information in the table to be a probability distribution?
. Are the categories mutually exclusive?

. Are the categories independent?

[N e Y]

. Are the categories exhaustive?
9. Are the two requirements for a discrete probability distribution met?

See page 297 for the answers.

1. Define and give three examples of a random 15. The weight of a Siberian tiger

variable. L
16. The time it takes to complete a marathon

2. Expl.aln the difference l?etween a discrete and a 17. The number of mathematics majors in your school
continuous random variable.
18. The blood pressures of all patients admitted to a

3. Give three examples of a discrete random variable. - )
hospital on a specific day

4. Give three examples of a continuous random variable.
For Exercises 19 through 26, construct a probability
distribution for the data and draw a graph for the
For Exercises 6 through 11, determine whether the distribution.

distribution represents a probability distribution. If it
does not, state why.

5. What is a probability distribution? Give an example.

19. Medical Tests The probabilities that a patient will
have 0, 1, 2, or 3 medical tests performed on entering
6. X 2 5 6 8 10 a hospital are &, 3, i, and 15, respectively.
P | oo

1

|~
S

20. Student Volunteers The probabilities that a student
volunteer hosts 1, 2, 3, or 4 prospective first-year
7. X 3 6 8 12 students are 0.4, 0.3, 0.2, and 0.1, respectively.
P(X) 03 05 07 -038

21. Birthday Cake Sales The probabilities that a bakery

8. X 3 6 8 has a demand for 2, 3, 5, or 7 birthday cakes on any
P(X) 03 06 07 given day are 0.35, 0.41, 0.15, and 0.09, respectively.
9. X 1 b 3 4 5 22. DVD Rentals The probabilities that a customer will
3 ; ; > 3 rent 0, 1, 2, 3, or 4 DVDs on a single visit to the rental
P(X) 10 10 10 10 10 store are 0.15, 0.25, 0.3, 0.25, and 0.05, respectively.
10. X 20 30 40 50 23. Loaded Die A die is loaded in such a way that the
P(X) 0.05 035 04 0.2 probabilities of getting 1, 2, 3,4, 5, and 6 are 1, +, 5, &5,
1 1 :
1, and 13, respectively.
1. X 5 10 15 12> 4Nz TSP Y
24. Item Selection The probabilities that a customer
PX) 12 0.3 05 selects 1, 2, 3, 4, and 5 items at a convenience store are
For Exercises 12 through 18, state whether the variable 0.32,0.12, 0.23, 0.18, and 0.15, respectively.
is discrete or continuous. L .
o 25. Student Classes The probabilities that a student is
12. The speed of a jet airplane registered for 2, 3, 4, or 5 classes are 0.01, 0.34, 0.62,
13. The number of cheeseburgers a fast-food restaurant and 0.03, respectively.
serves each day 26. Garage Space The probabilities that a randomly
14. The number of people who play the state lottery each selected home has garage space for 0, 1, 2, or 3 cars are
day 0.22, 0.33, 0.37, and 0.08, respectively.

5-8



27. Selecting a Monetary Bill A box contains three
$1 bills, two $5 bills, five $10 bills, and one $20 bill.
Construct a probability distribution for the data if x
represents the value of a single bill drawn at random

and then replaced.

28. Family with Children Construct a probability
distribution for a family of three children. Let X

Section 5-2 Mean, Variance, Standard Deviation, and Expectation 259

29. Drawing a Card Construct a probability distribution
for drawing a card from a deck of 40 cards consisting of
10 cards numbered 1, 10 cards numbered 2, 15 cards
numbered 3, and 5 cards numbered 4.

30. Rolling Two Dice Using the sample space for tossing
two dice, construct a probability distribution for the
sums 2 through 12.

represent the number of boys.

Extending the Concepts

A probability distribution can be written in formula notation
such as P(X) = 1/X, where X = 2, 3, 6. The distribution is

shown as follows:

X |

[\
W

For Exercises 31 through 36, write the distribution for
the formula and determine whether it is a probability
distribution.

[e)}

31. P(X) = X/6for X =1,2,3

D=

PX) |

Objective B
Find the mean,
variance, standard
deviation, and
expected value for
a discrete random
variable.

A professor, Augustin
Louis Cauchy
(1789-1857), wrote a
book on probability.
While he was teaching
at the Military School
of Paris, one of his
students was
Napoleon Bonaparte.

wl—

32. P(X) = XforX = 0.2,0.3,0.5

33. P(X) = X/6 for X = 3,4,7

34. P(X) = X + 0.1 for X = 0.1, 0.02, 0.04
35. P(X) = X/7for X = 1,2,4

36. P(X) = X/(X + 2) for X =0, 1,2

SN

Mean, Variance, Standard Deviation, and Expectation

The mean, variance, and standard deviation for a probability distribution are computed
differently from the mean, variance, and standard deviation for samples. This section
explains how these measures—as well as a new measure called the expectation—are
calculated for probability distributions.

Mean

In Chapter 3, the mean for a sample or population was computed by adding the values
and dividing by the total number of values, as shown in these formulas:
- 22X X

X n Y
But how would you compute the mean of the number of spots that show on top when a
die is rolled? You could try rolling the die, say, 10 times, recording the number of spots,
and finding the mean; however, this answer would only approximate the true mean. What
about 50 rolls or 100 rolls? Actually, the more times the die is rolled, the better the approx-
imation. You might ask, then, How many times must the die be rolled to get the exact
answer? It must be rolled an infinite number of times. Since this task is impossible, the
previous formulas cannot be used because the denominators would be infinity. Hence, a
new method of computing the mean is necessary. This method gives the exact theoretical
value of the mean as if it were possible to roll the die an infinite number of times.

Before the formula is stated, an example will be used to explain the concept. Suppose
two coins are tossed repeatedly, and the number of heads that occurred is recorded. What
will be the mean of the number of heads? The sample space is

HH, HT, TH, TT

5-9
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and each outcome has a probability of ;. Now, in the long run, you would expect two
heads (HH) to occur approximately ; of the time, one head to occur approximately § of
the time (HT or TH), and no heads (TT) to occur approximately ; of the time. Hence, on
average, you would expect the number of heads to be

T24t1+4t.0=1

That is, if it were possible to toss the coins many times or an infinite number of times,
the average of the number of heads would be 1.

Hence, to find the mean for a probability distribution, you must multiply each possi-
ble outcome by its corresponding probability and find the sum of the products.

Formula for the Mean of a Probability Distribution

The mean of a random variable with a discrete probability distribution is
p=X PX) + X PXG) + X PAXG) + -+ X PX)
= 3X - P(X)

where X}, X,, X;, . . ., X, are the outcomes and P(X,), P(X,), P(X;), . . ., P(X,) are the
corresponding probabilities.

Note: 2X - P(X) means to sum the products.

Rounding Rule for the Mean, Variance, and Standard Deviation for a
Probability Distribution The rounding rule for the mean, variance, and standard
deviation for variables of a probability distribution is this: The mean, variance, and stan-
dard deviation should be rounded to one more decimal place than the outcome X. When
fractions are used, they should be reduced to lowest terms.

Examples 5-5 through 5-8 illustrate the use of the formula.

Rolling a Die

Find the mean of the number of spots that appear when a die is tossed.

Solution

In the toss of a die, the mean can be computed thus.

Outcome X | 1 2 3 4 5 6
Probability P(X) | L L L L 1 1L

R=3X-PX)=1-¢+2-c+3-¢+4-¢+5-¢+6¢

=%=3%0r3.5

That is, when a die is tossed many times, the theoretical mean will be 3.5. Note that
even though the die cannot show a 3.5, the theoretical average is 3.5.

The reason why this formula gives the theoretical mean is that in the long run, each
outcome would occur approximately # of the time. Hence, multiplying the outcome by
its corresponding probability and finding the sum would yield the theoretical mean. In
other words, outcome 1 would occur approximately : of the time, outcome 2 would
occur approximately é of the time, etc.
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Example 5-6

Children in a Family

In a family with two children, find the mean of the number of children who will be girls.
Solution
The probability distribution is as follows:

Number of girls X |
Probability P(X) |

(=)
Rl— | —
[\o]

A=
=

Hence, the mean is

p=3X-PX)=0-3+1-3+2-

EST
Il
—_

Tossing Coins

If three coins are tossed, find the mean of the number of heads that occur. (See the table
preceding Example 5-1.)

Solution

The probability distribution is

Number of heads X | 0 1 2 3
Probability P(X) T
The mean is

w=3X-PX)=0-4+1-3+2-3+3-1=2=1lor15

The value 1.5 cannot occur as an outcome. Nevertheless, it is the long-run or theoretical
average.

Example 5-8

Number of Trips of Five Nights or More

The probability distribution shown represents the number of trips of five nights or more
that American adults take per year. (That is, 6% do not take any trips lasting five nights
or more, 70% take one trip lasting five nights or more per year, etc.) Find the mean.

Number of trips X | 0 1 2 3 4
Probability P(X) | 0.06 0.70 0.20 0.03 0.01
Solution
= 2X - PX)

= (0)(0.06) + (1)(0.70) + (2)(0.20) + (3)(0.03) + (4)(0.01)
=0+ 0.70 + 0.40 + 0.09 + 0.04
—123~12

Hence, the mean of the number of trips lasting five nights or more per year taken by
American adults is 1.2.

5-11
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[—] orical INolte

Fey Manufacturing
Co., located in San
Francisco, invented
the first three-reel,
automatic payout slot
machine in 1895.

Variance and Standard Deviation

For a probability distribution, the mean of the random variable describes the measure of
the so-called long-run or theoretical average, but it does not tell anything about the spread
of the distribution. Recall from Chapter 3 that in order to measure this spread or variabil-
ity, statisticians use the variance and standard deviation. These formulas were used:

SWopP 4 [E

N N

o=

These formulas cannot be used for a random variable of a probability distribution since
N is infinite, so the variance and standard deviation must be computed differently.

To find the variance for the random variable of a probability distribution, subtract the
theoretical mean of the random variable from each outcome and square the difference.
Then multiply each difference by its corresponding probability and add the products. The
formula is

o? = Z[(X — p)* - PY)]

Finding the variance by using this formula is somewhat tedious. So for simplified
computations, a shortcut formula can be used. This formula is algebraically equivalent to
the longer one and is used in the examples that follow.

Formula for the Variance of a Probability Distribution

Find the variance of a probability distribution by multiplying the square of each outcome by
its corresponding probability, summing those products, and subtracting the square of the
mean. The formula for the variance of a probability distribution is

o? = S0 POO] — @

The standard deviation of a probability distribution is

c=Vo> o VIX-PXW] -

Remember that the variance and standard deviation cannot be negative.

Example 5-9 Rolling a Die

5-12

Compute the variance and standard deviation for the probability distribution in
Example 5-5.
Solution

Recall that the mean is w = 3.5, as computed in Example 5-5. Square each outcome
and multiply by the corresponding probability, sum those products, and then subtract the
square of the mean.

=2 b+22 432l 252 462 — (352 =29
To get the standard deviation, find the square root of the variance.

o=V29=17
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Example 5-10 Selecting Numbered Balls

A box contains 5 balls. Two are numbered 3, one is numbered 4, and two are numbered 5.
The balls are mixed and one is selected at random. After a ball is selected, its number is
recorded. Then it is replaced. If the experiment is repeated many times, find the variance
and standard deviation of the numbers on the balls.

Solution

Let X be the number on each ball. The probability distribution is

Number on ball X | 3 4 5
Probability P(X) | 2 L 2
The mean is

w=3X-PX)=3-2+4-1+5-2=4
The variance is
o =3X* PX)] - u’
=32 34+4 -1 +5-2=4
=163 — 16

4

-5

The standard deviation is
o= \/g =10.8 = 0.894

The mean, variance, and standard deviation can also be found by using vertical
columns, as shown.

X  PX) X PX) X* - P(X)

3 04 1.2 3.6
4 02 0.8 32
5 04 2.0 10

SX - P(X) = 4.0 16.8

Find the mean by summing the 2X - P(X) column, and find the variance by
summing the X? - P(X) column and subtracting the square of the mean.
0?=168—-4*=168—16=0.8
and

o=V0.8=0.89%

w On Hold for Talk Radio

A talk radio station has four telephone lines. If the host is unable to talk (i.e., during a
commercial) or is talking to a person, the other callers are placed on hold. When all
lines are in use, others who are trying to call in get a busy signal. The probability that 0,
1, 2, 3, or 4 people will get through is shown in the distribution. Find the variance and
standard deviation for the distribution.

X | 0 1 2 3 4

P(X) | 0.18 0.34 0.23 0.21 0.04

Should the station have considered getting more phone lines installed?

5-13
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Solution
The mean is
p=2X - PX)
=0-(0.18) +1-(0.34) +2-(0.23) + 3 -(0.21) + 4 - (0.04)
=1.6

The variance is
02 = S POY)] — 42
=[0%-(0.18) + 17 - (0.34) + 2% - (0.23) + 3% - (0.21) + 4% - (0.04)] — 1.6?
=[0+ 0.34 +0.92 + 1.89 + 0.64] — 2.56
=379 —-256=1.23
= 1.2 (rounded)
The standard deviation is o = \/;, oroc=V12=1.1.
No. The mean number of people calling at any one time is 1.6. Since the standard
deviation is 1.1, most callers would be accommodated by having four phone lines
because u + 20 would be 1.6 + 2(1.1) = 1.6 + 2.2 = 3.8. Very few callers would get a

busy signal since at least 75% of the callers would either get through or be put on hold.
(See Chebyshev’s theorem in Section 3-2.)

Expectation

Another concept related to the mean for a probability distribution is that of expected
value or expectation. Expected value is used in various types of games of chance, in
insurance, and in other areas, such as decision theory.

The expected value of a discrete random variable of a probability distribution is the
theoretical average of the variable. The formula is

u = EX) =3X: P(X)
The symbol E(X) is used for the expected value.

The formula for the expected value is the same as the formula for the theoretical
mean. The expected value, then, is the theoretical mean of the probability distribution.
That is, E(X) = p.

When expected value problems involve money, it is customary to round the answer
to the nearest cent.

Winning Tickets

One thousand tickets are sold at $1 each for a color television valued at $350. What is
the expected value of the gain if you purchase one ticket?

Solution

The problem can be set up as follows:

Win Lose

Gain X $349 —$1
1

Probability P(X) m %
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Two things should be noted. First, for a win, the net gain is $349, since you do not
get the cost of the ticket ($1) back. Second, for a loss, the gain is represented by a
negative number, in this case —$1. The solution, then, is
999

_ L ey 99
E(X) = $349 - —oo5 + (=S1) - 7505 = —$0.65

Expected value problems of this type can also be solved by finding the overall gain
(i.e., the value of the prize won or the amount of money won, not considering the cost
of the ticket for the prize or the cost to play the game) and subtracting the cost of the
tickets or the cost to play the game, as shown:

1
E(X) = $350 1000 $1 $0.65
Here, the overall gain ($350) must be used.

Note that the expectation is —$0.65. This does not mean that you lose $0.65, since
you can only win a television set valued at $350 or lose $1 on the ticket. What this expec-
tation means is that the average of the losses is $0.65 for each of the 1000 ticket holders.
Here is another way of looking at this situation: If you purchased one ticket each week
over a long time, the average loss would be $0.65 per ticket, since theoretically, on
average, you would win the set once for each 1000 tickets purchased.

Winning Tickets

One thousand tickets are sold at $1 each for four prizes of $100, $50, $25, and $10.
After each prize drawing, the winning ticket is then returned to the pool of tickets.
What is the expected value if you purchase two tickets?

Gain X | $98  $48  $23 $8 —-$2
. 2 2 2 2 992
Probability P(X) 1000 1000 1000 1000 1000
Solution
2 2 2 2 992
E@) =398 7500 T 38 1000 T 2% " To00 T %8 " T000 T % " 1000
= —$1.63

An alternate solution is

2 2 2 2
= =+ 850 —— 4+ $25 - —— + $10 - —— —
B(X) = $100 - 7o0s + 850 - 700 + 825 - o0 4 810 - oos — 82

= —§1.63

Example 5-14

Bond Investment

A financial adviser suggests that his client select one of two types of bonds in which to
invest $5000. Bond X pays a return of 4% and has a default rate of 2%. Bond Y has a
21% return and a default rate of 1%. Find the expected rate of return and decide which
bond would be a better investment. When the bond defaults, the investor loses all the
investment.

5-15
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Solution

The return on bond X is $5000 - 4% = $200. The expected return then is
E(X) = $200(0.98) — $5000(0.02) = $96

The return on bond Y is $5000 - 2% = $125. The expected return then is
E(X) = $125(0.99) — $5000(0.01) = $73.75

Hence, bond X would be a better investment since the expected return is higher.

In gambling games, if the expected value of the game is zero, the game is said to be
fair. If the expected value of a game is positive, then the game is in favor of the player.
That is, the player has a better than even chance of winning. If the expected value of the
game is negative, then the game is said to be in favor of the house. That is, in the long run,
the players will lose money.

In his book Probabilities in Everyday Life (Ivy Books, 1986), author John D.
McGervy gives the expectations for various casino games. For keno, the house wins
$0.27 on every $1.00 bet. For Chuck-a-Luck, the house wins about $0.52 on every $1.00
bet. For roulette, the house wins about $0.90 on every $1.00 bet. For craps, the house
wins about $0.88 on every $1.00 bet. The bottom line here is that if you gamble long
enough, sooner or later you will end up losing money.

Applying the Concepts 5=2

Expected Value

On March 28, 1979, the nuclear generating facility at Three Mile Island, Pennsylvania, began
discharging radiation into the atmosphere. People exposed to even low levels of radiation can
experience health problems ranging from very mild to severe, even causing death. A local
newspaper reported that 11 babies were born with kidney problems in the three-county area
surrounding the Three Mile Island nuclear power plant. The expected value for that problem in
infants in that area was 3. Answer the following questions.

1. What does expected value mean?
2. Would you expect the exact value of 3 all the time?

3. If a news reporter stated that the number of cases of kidney problems in newborns was
nearly four times as much as was usually expected, do you think pregnant mothers living
in that area would be overly concerned?

4. Is it unlikely that 11 occurred by chance?

5. Are there any other statistics that could better inform the public?

6. Assume that 3 out of 2500 babies were born with kidney problems in that three-county
area the year before the accident. Also assume that 11 out of 2500 babies were born with
kidney problems in that three-county area the year after the accident. What is the real
percent of increase in that abnormality?

7. Do you think that pregnant mothers living in that area should be overly concerned after
looking at the results in terms of rates?

See page 298 for the answers.




1. Defective Transistors From past experience, a

company has found that in cartons of transistors, 92%
contain no defective transistors, 3% contain one
defective transistor, 3% contain two defective
transistors, and 2% contain three defective transistors.
Find the mean, variance, and standard deviation for the
defective transistors.

About how many extra transistors per day would
the company need to replace the defective ones if it
used 10 cartons per day?

. Suit Sales The number of suits sold per day at a retail
store is shown in the table, with the corresponding
probabilities. Find the mean, variance, and standard
deviation of the distribution.

Number of suits

sold X ‘ 19 20 21 22 23

Probability P(X) | 02 02 03 02 0.1

If the manager of the retail store wants to be sure that he
has enough suits for the next 5 days, how many should
the manager purchase?

. Number of Credit Cards A bank vice president feels
that each savings account customer has, on average,
three credit cards. The following distribution represents
the number of credit cards people own. Find the mean,
variance, and standard deviation. Is the vice president
correct?

Number of

cards X ‘ 0 1 2 3 4

Probability P(X) | 0.18 044 027 0.08 0.03

. Trivia Quiz The probabilities that a player will get 5
to 10 questions right on a trivia quiz are shown below.
Find the mean, variance, and standard deviation for the
distribution.

X | 5
P(X) | 0.05
. Cellular Phone Sales The probability that a cellular
phone company kiosk sells X number of new phone
contracts per day is shown below. Find the mean,

variance, and standard deviation for this probability
distribution.

X |
P |

What is the probability that they will sell 6 or more
contracts three days in a row?

6
0.2

7 8
04 0.1

9
0.15

10
0.1

4 5
04 03

6 8
0.1 0.15

10
0.05

. Animal Shelter Adoptions The local animal shelter
adopts out cats and dogs each week with the following
probabilities.
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X | 3 4 5 6 1 8
Py | 015 03 025 018 01 002

Find the mean, variance, and standard deviation for the
number of animals adopted each week. What is the
probability that they find homes for more than 5 animals
in a given week?

. Commercials During Children’s TV Programs A

concerned parents group determined the number of
commercials shown in each of five children’s
programs over a period of time. Find the mean,
variance, and standard deviation for the distribution
shown.

Number of

commercials X ‘ 5 6 7 8 9

Probability P(X) | 02 025 038 0.10 0.07

. Number of Televisions per Household A study

conducted by a TV station showed the number of
televisions per household and the corresponding
probabilities for each. Find the mean, variance, and
standard deviation.

Number of
televisions X 1 2 3 4
Probability P(X) | 0.32 0.51 0.12 0.05

If you were taking a survey on the programs that were
watched on television, how many program diaries
would you send to each household in the survey?

. Students Using the Math Lab The number of students

using the Math Lab per day is found in the distribution
below. Find the mean, variance, and standard deviation
for this probability distribution.

X | 6 8 10 12 14
P(X) | 0.15 03 035 0.1 0.1

What is the probability that fewer than 8 or more than
12 use the lab in a given day?

Pizza Deliveries A pizza shop owner determines the
number of pizzas that are delivered each day. Find
the mean, variance, and standard deviation for the
distribution shown. If the manager stated that 45
pizzas were delivered on one day, do you think that
this is a believable claim?

Number of deliveries X | 35 36 37 38 39
Probability P(X) | 0.1 02 03 03 0.1

Insurance An insurance company insures a

person’s antique coin collection worth $20,000 for

an annual premium of $300. If the company figures

that the probability of the collection being stolen is 0.002,
what will be the company’s expected profit?
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Job Bids A landscape contractor bids on jobs where he
can make $3000 profit. The probabilities of getting 1, 2,
3, or 4 jobs per month are shown.

Number of jobs 1 2 3 4

Probability 0.2 0.3 0.4 0.1

Find the contractor’s expected profit per month.

Rolling Dice If a person rolls doubles when she tosses
two dice, she wins $5. For the game to be fair, how
much should she pay to play the game?

Dice Game A person pays $2 to play a certain game by
rolling a single die once. If a 1 or a 2 comes up, the
person wins nothing. If, however, the player rolls a 3, 4,
5, or 6, he or she wins the difference between the
number rolled and $2. Find the expectation for this
game. Is the game fair?

Lottery Prizes A lottery offers one $1000 prize, one
$500 prize, and five $100 prizes. One thousand tickets
are sold at $3 each. Find the expectation if a person buys
one ticket.

Extending the Concepts

20.

21.

22.

23.

24.

Rolling Dice Construct a probability distribution for
the sum shown on the faces when two dice are rolled.
Find the mean, variance, and standard deviation of the
distribution.

Rolling a Die When one die is rolled, the expected
value of the number of spots is 3.5. In Exercise 20, the
mean number of spots was found for rolling two dice.
What is the mean number of spots if three dice are
rolled?

The formula for finding the variance for a probability
distribution is

o’ = Z[(X — p)’ - PX)]

Verify algebraically that this formula gives the same
result as the shortcut formula shown in this section.

Rolling a Die Roll a die 100 times. Compute the mean
and standard deviation. How does the result compare with
the theoretical results of Example 5-5?

Rolling Two Dice Roll two dice 100 times and find

the mean, variance, and standard deviation of the sum of
the spots. Compare the result with the theoretical results
obtained in Exercise 20.

5-18

16.

17.

18.

19.

25.

26.

In Exercise 15, find the expectation if a person buys two
tickets. Assume that the player’s ticket is replaced after
each draw and that the same ticket can win more than
one prize.

Winning the Lottery For a daily lottery, a person
selects a three-digit number. If the person plays for $1,
she can win $500. Find the expectation. In the same
daily lottery, if a person boxes a number, she will win
$80. Find the expectation if the number 123 is played
for $1 and boxed. (When a number is “boxed,” it can
win when the digits occur in any order.)

Life Insurance A 35-year-old woman purchases a
$100,000 term life insurance policy for an annual
payment of $360. Based on a period life table for the
U.S. government, the probability that she will survive
the year is 0.999057. Find the expected value of the
policy for the insurance company.

Raffle Ticket Sales A civic group sells 1000 raffle
tickets to raise $2500 for its namesake charity. First
prize is $1000, second prize is $300, and third prize is
$200. How much should the group charge for each
ticket?

Extracurricular Activities Conduct a survey of the
number of extracurricular activities your classmates
are enrolled in. Construct a probability distribution
and find the mean, variance, and standard

deviation.

Promotional Campaign In a recent promotional
campaign, a company offered these prizes and the
corresponding probabilities. Find the expected value
of winning. The tickets are free.

Number of prizes Amount Probability
1
1 $100,000 W
1
2 10,000 50’—000
1
5 1,000 m
10 100 L
1000

If the winner has to mail in the winning ticket to claim the
prize, what will be the expectation if the cost of the stamp
is considered? Use the current cost of a stamp for a first-
class letter.



Speaking of

Statistics

This study shows that a part

of the brain reacts to the impact
of losing, and it might explain
why people tend to increase
their bets after losing when
gambling. Explain how this
type of split decision making
may influence fighter pilots,
firefighters, or police officers,
as the article states.

Technology Step by Step

TI-83 Plus or

TI-84 Plus 1.
Step by Step

@R 9 N N A WN
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THE GAMBLER’S FALLACY

WHY WE EXPECT TO STRIKE IT RICH AFTER A LOSING STREAK

A GAMBLER USUALLY WAGERS
more after taking a loss, in the misguided
belief that a run of bad luck increases the
probability of a win. We tend to cling to
the misconception that past events can
skew future odds. “On some level, you’re
thinking, ‘If I just lost, it’s going to even
out.” The extent to which you’re disturbed
by a loss seems to go along with risky
behavior,” says University of Michigan
psychologist William Gehring, Ph.D., co-
author of a new study linking dicey
decision-making to neurological activity
originating in the medial frontal cortex,
long thought to be an area of the brain
used in error detection.

Because people are so driven to up the
ante after a loss, Gehring believes that the
medial frontal cortex unconsciously
influences future decisions based on the
impact of the loss, in addition to
registering the loss itself.

Gehring drew this conclusion by asking
12 subjects fitted with electrode caps to
choose either the number 5 or 25, with the
larger number representing the riskier bet.

On any given round, both numbers could
amount to a loss, both could amount to a
gain or the results could split, one number
signifying a loss, the other a gain.

The medial frontal cortex responded to
the outcome of a gamble within a quarter
of a second, registering sharp electrical
impulses only after a loss. Gehring points
out that if the medial frontal cortex
simply detected errors it would have
reacted after participants chose the lesser
of two possible gains. In other words,
choosing “5” during a round in which
both numbers paid off and betting on
“25” would have yielded a larger profit.

After the study appeared in Science,
Gehring received several e-mails from
stock traders likening the “gambler's
fallacy” to impulsive trading decisions
made directly after off-loading a losing
security. Researchers speculate that such
risky, split-second decision-making could
extend to fighter pilots, firemen and
policemen—professions in which rapid-
fire decisions are crucial and frequent.

—Dan Schulman

. Type 2nd QUIT to return to the home screen.
. Type 2nd LIST, move the cursor to MATH, type 5 for sum, then type L, then press ENTER.
. Type 2nd ENTER, move the cursor to L, type L,, then press ENTER.

Source: Psychology Today, August 2002, p. 22. Used with permission.

To calculate the mean and variance for a discrete random variable by using the formulas:
Enter the x values into L, and the probabilities into L,.

. Move the cursor to the top of the L, column so that L, is highlighted.

. Type L, multiplied by L,, then press ENTER.

. Move the cursor to the top of the L, column so that L, is highlighted.

. Type L, followed by the x* key multiplied by L,, then press ENTER.
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Using the data from Example 5-10 gives the following:

Li Lz L) E Li Lz Lz E;
] - [ i} 3z o |
4 L z £ |
Y iz y iz |
& Z f Z 1.z
g iz | iz {6
Lz = 1#Lz L=
Lz Lr Ll y Lz Lz Ly 4 surtlz 2 4
H 0 | ____ Z 0 o
z Y £ K] I sumilyl
F L 24
: iz z Eir EX | 2d—dz
____________ =]
[ |
=12+l z Luii=H

To calculate the mean and standard deviation for a discrete random variable without using the
formulas, modify the procedure to calculate the mean and standard deviation from grouped
data (Chapter 3) by entering the x values into L, and the probabilities into L,.

1-\ar Stats Li-L 1-Var Stats
z H=d
2x=d
ExE=2d4
Sm=
gx=2. B2E427 125
Lh=1

m The Binomial Distribution

Many types of probability problems have only two outcomes or can be reduced to two
outcomes. For example, when a coin is tossed, it can land heads or tails. When a baby is
born, it will be either male or female. In a basketball game, a team either wins or loses.
A true/false item can be answered in only two ways, true or false. Other situations can be
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Objective [E}]
Find the exact
probability for X
successes in n trials
of a binomial
experiment.

In 1653, Blaise Pascal
created a triangle of
numbers called
Pascal’s triangle that
can be used in the
binomial distribution.
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reduced to two outcomes. For example, a medical treatment can be classified as effective
or ineffective, depending on the results. A person can be classified as having normal or
abnormal blood pressure, depending on the measure of the blood pressure gauge. A
multiple-choice question, even though there are four or five answer choices, can be clas-
sified as correct or incorrect. Situations like these are called binomial experiments.

A binomial experiment is a probability experiment that satisfies the following four
requirements:

1. There must be a fixed number of trials.

2. Each trial can have only two outcomes or outcomes that can be reduced to two
outcomes. These outcomes can be considered as either success or failure.

3. The outcomes of each trial must be independent of one another.

4. The probability of a success must remain the same for each trial.

A binomial experiment and its results give rise to a special probability distribution
called the binomial distribution.

The outcomes of a binomial experiment and the corresponding probabilities of these
outcomes are called a binomial distribution.

In binomial experiments, the outcomes are usually classified as successes or failures.
For example, the correct answer to a multiple-choice item can be classified as a success,
but any of the other choices would be incorrect and hence classified as a failure. The
notation that is commonly used for binomial experiments and the binomial distribution
is defined now.

Notation for the Binomial Distribution

P(S) The symbol for the probability of success

P(F) The symbol for the probability of failure

P The numerical probability of a success

q The numerical probability of a failure
PS)=p and PF)=1—-p=gq

n The number of trials

X The number of successes in 7 trials

Notethat 0 = X =nand X=0,1,2,3,...,n

The probability of a success in a binomial experiment can be computed with this
formula.

Binomial Probability Formula

In a binomial experiment, the probability of exactly X successes in # trials is

!
PO =t _n)'m LA

An explanation of why the formula works is given following Example 5-15.
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A coin is tossed 3 times. Find the probability of getting exactly two heads.

Solution

This problem can be solved by looking at the sample space. There are three ways to get
two heads.

HHH, HHT, HTH, THH, TTH, THT, HTT, TTT

The answer is 3, or 0.375.

Looking at the problem in Example 5-15 from the standpoint of a binomial experi-
ment, one can show that it meets the four requirements.

1. There are a fixed number of trials (three).
2. There are only two outcomes for each trial, heads or tails.

3. The outcomes are independent of one another (the outcome of one toss in no way
affects the outcome of another toss).

4. The probability of a success (heads) is 3 in each case.
Inthiscase,n =3, X=2,p = %, andg = %
3! 1\2(1\ 3
P2 heads) = ————- (— —) ==
(@heads) =51 12) 2] ~%

which is the same answer obtained by using the sample space.

The same example can be used to explain the formula. First, note that there are three
ways to get exactly two heads and one tail from a possible eight ways. They are HHT,
HTH, and THH. In this case, then, the number of ways of obtaining two heads from three
coin tosses is ;C,, or 3, as shown in Chapter 4. In general, the number of ways to get X
successes from # trials without regard to order is

Hence, substituting in the formula gives

2

= 0.375

n!

(n—X)'X1

This is the first part of the binomial formula. (Some calculators can be used for this.)

Next, each success has a probability of  and can occur twice. Likewise, each failure
has a probability of  and can occur once, giving the (3)%(3)" part of the formula. To gen-
eralize, then, each success has a probability of p and can occur X times, and each failure
has a probability of ¢ and can occur n — X times. Putting it all together yields the bino-
mial probability formula.

nCX =

Example 5-16

5-22

Survey on Doctor Visits

A survey found that one out of five Americans say he or she has visited a doctor in any
given month. If 10 people are selected at random, find the probability that exactly 3 will
have visited a doctor last month.

Source: Reader s Digest.

Solution

In this case,n = 10, X =3,p = %, and g = %. Hence,

PO = i)

7

= 0.201
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Example 5=-17

Survey on Employment

A survey from Teenage Research Unlimited (Northbrook, Illinois) found that 30% of
teenage consumers receive their spending money from part-time jobs. If 5 teenagers
are selected at random, find the probability that at least 3 of them will have part-time jobs.

Solution

To find the probability that at least 3 have part-time jobs, it is necessary to find the
individual probabilities for 3, or 4, or 5, and then add them to get the total probability.

8! _
P(3) = Go3m (0.3)%(0.7)? = 0.132
_ S _

P(4) = G- (0.3)%0.7)" = 0.028
| _

P(5) = 5551 (0.3)%(0.7)° = 0.002

Hence,

P(at least three teenagers have part-time jobs)
=0.132 + 0.028 + 0.002 = 0.162

Computing probabilities by using the binomial probability formula can be quite
tedious at times, so tables have been developed for selected values of # and p. Table B in
Appendix C gives the probabilities for individual events. Example 5-18 shows how to
use Table B to compute probabilities for binomial experiments.

Example 5-18

Using Table B for
Example 5-18

Tossing Coins
Solve the problem in Example 5-15 by using Table B.

Solution

Since n = 3, X = 2, and p = 0.5, the value 0.375 is found as shown in Figure 5-3.

p p=05
n X 0.05 0.1 0.2 0.3 0.4 0.5 “ 0.6 0.7 0.8 0.9 0.95
2 0
|
2
3 0 0.125
@ 1 0.375
3 0.125
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Example 5-19 Survey on Fear of Being Home Alone at Night

Public Opinion reported that 5% of Americans are afraid of being alone in a house at
night. If a random sample of 20 Americans is selected, find these probabilities by using
the binomial table.

a. There are exactly 5 people in the sample who are afraid of being alone at night.
b. There are at most 3 people in the sample who are afraid of being alone at night.
c. There are at least 3 people in the sample who are afraid of being alone at night.

Source: 100% American by Daniel Evan Weiss.

Solution

a. n =20,p = 0.05, and X = 5. From the table, we get 0.002.
b. n =20 and p = 0.05. “At most 3 people” means 0, or 1, or 2, or 3.
Hence, the solution is

P(0) + P(1) + P(2) + P(3) = 0.358 + 0.377 + 0.189 + 0.060
=(.984
c. n=20and p = 0.05. “At least 3 people” means 3, 4, 5, . . ., 20. This problem
can best be solved by finding P(0) + P(1) + P(2) and subtracting from 1.
P(0) + P(1) + P(2) = 0.358 + 0.377 + 0.189 = 0.924
1 —0.924 = 0.076

Example 5-20 Driving While Intoxicated

A report from the Secretary of Health and Human Services stated that 70% of single-
vehicle traffic fatalities that occur at night on weekends involve an intoxicated driver.
If a sample of 15 single-vehicle traffic fatalities that occur at night on a weekend is
selected, find the probability that exactly 12 involve a driver who is intoxicated.

Source: 100% American by Daniel Evan Weiss.

Solution

Now, n = 15, p = 0.70, and X = 12. From Table B, P(12) = 0.170. Hence, the
probability is 0.17.

Remember that in the use of the binomial distribution, the outcomes must be inde-
pendent. For example, in the selection of components from a batch to be tested, each
component must be replaced before the next one is selected. Otherwise, the outcomes are
not independent. However, a dilemma arises because there is a chance that the same
component could be selected again. This situation can be avoided by not replacing
the component and using a distribution called the hypergeometric distribution to calculate
the probabilities. The hypergeometric distribution is presented later in this chapter. Note
that when the population is large and the sample is small, the binomial probabilities can
be shown to be nearly the same as the corresponding hypergeometric probabilities.

Objective Mean, Variance, and Standard Deviation for the Binomial Distribution

Find the mean,
variance, and

standard deviation
for the variable of a Mean: u =n-p Variance: 0> =n-p - q Standard deviation: 0 = Vn-p-g¢q

The mean, variance, and standard deviation of a variable that has the binomial distribution can
be found by using the following formulas.

binomial distribution.
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These formulas are algebraically equivalent to the formulas for the mean, vari-
ance, and standard deviation of the variables for probability distributions, but because
they are for variables of the binomial distribution, they have been simplified by using
algebra. The algebraic derivation is omitted here, but their equivalence is shown in
Example 5-21.

Tossing a Coin

A coin is tossed 4 times. Find the mean, variance, and standard deviation of the number
of heads that will be obtained.

Solution

With the formulas for the binomial distribution and n = 4, p = 3, and ¢ = 3, the results are

From Example 5-21, when four coins are tossed many, many times, the average of
the number of heads that appear is 2, and the standard deviation of the number of heads
is 1. Note that these are theoretical values.

As stated previously, this problem can be solved by using the formulas for expected
value. The distribution is shown.

No. of heads X | 0 1 2
Probability P(X) | L &+ & & L

L=EX)=32X-PX)=0-1g+1 -{s+2-5+3-5+4-g=1%=2
o’ =3X* P(X) — u?
=07t 1P+ 22+ A 2= - 4=1

a'=\/1=1

Hence, the simplified binomial formulas give the same results.

Rolling a Die

A die is rolled 360 times. Find the mean, variance, and standard deviation of the number
of 4s that will be rolled.

Solution

This is a binomial experiment since getting a 4 is a success and not getting a 4 is
considered a failure. Hence n = 360, p = ¢, and ¢ = 2.

w=n-p=360-1=60
o =n-p-q=360-(5)) =50

oco=Vn-p- =\/%=7.07

On average, sixty 4s will be rolled. The standard deviation is 7.07.
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m Likelihood of Twins

The Statistical Bulletin published by Metropolitan Life Insurance Co. reported that 2%
of all American births result in twins. If a random sample of 8000 births is taken, find the
mean, variance, and standard deviation of the number of births that would result in twins.

Source: 100% American by Daniel Evan Weiss.

Solution

This is a binomial situation, since a birth can result in either twins or not twins (i.e., two
outcomes).

w=rn-p=(8000)0.02) = 160
o =n-p-q=(8000)(0.02)(0.98) = 156.8
c=Vn-p-qg=\V1568 =125

For the sample, the average number of births that would result in twins is 160, the
variance is 156.8, or 157, and the standard deviation is 12.5, or 13 if rounded.

Applying the Concepts 5=3

Unsanitary Restaurants

Health officials routinely check sanitary conditions of restaurants. Assume you visit a popular
tourist spot and read in the newspaper that in 3 out of every 7 restaurants checked, there were
unsatisfactory health conditions found. Assuming you are planning to eat out 10 times while
you are there on vacation, answer the following questions.

. How likely is it that you will eat at three restaurants with unsanitary conditions?
. How likely is it that you will eat at four or five restaurants with unsanitary conditions?

. Explain how you would compute the probability of eating in at least one restaurant with
unsanitary conditions. Could you use the complement to solve this problem?

. What is the most likely number to occur in this experiment?
. How variable will the data be around the most likely number?
. Is this a binomial distribution?

. If it is a binomial distribution, does that mean that the likelihood of a success is always
50% since there are only two possible outcomes?

S N S R

~N O U A

Check your answers by using the following computer-generated table.

Mean = 4.3 Std. dev. = 1.56557
X P(X) Cum. Prob.
0 0.00362 0.00362

1 0.02731 0.03093

2 0.09272 0.12365

3 0.18651 0.31016
4 0.24623 0.55639

5 0.22291 0.77930

6 0.14013 0.91943

7 0.06041 0.97983

8 0.01709 0.99692

9 0.00286 0.99979
10 0.00022 1.00000

See page 298 for the answers.
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1. Which of the following are binomial experiments or can
be reduced to binomial experiments?

a. Surveying 100 people to determine if they like
Sudsy Soap

b. Tossing a coin 100 times to see how many heads
occur

c¢. Drawing a card with replacement from a deck and
getting a heart
d. Asking 1000 people which brand of cigarettes they
smoke
e. Testing four different brands of aspirin to see which
brands are effective
/. Testing one brand of aspirin by using 10 people to
determine whether it is effective
g. Asking 100 people if they smoke
h. Checking 1000 applicants to see whether they were
admitted to White Oak College
i.  Surveying 300 prisoners to see how many different
crimes they were convicted of
J. Surveying 300 prisoners to see whether this is their
first offense
. (ans) Compute the probability of X successes, using
Table B in Appendix C.
n=2,p=030,X=1
n=4,p=0.60,X=3
n=5p=0.10,X=0
n=10,p=040,X=4
n=12,p=090,X=2
n=15p=0.80,X=12
n=17,p=0.05X=0
n=20,p=0.50,X=10
i. n=16,p=020,X=3
. Compute the probability of X successes, using the
binomial formula.
a. n=6,X=3,p=0.03
b. n=4,X=2,p=0.18
c. n=5X=3,p=0.63
d n=9,X=0,p=042
ee. n=10,X=5,p=037

=0 TN D RS =R

10.
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. True/False Exam A student takes a 20-question,

true/false exam and guesses on each question. Find the
probability of passing if the lowest passing grade is 15
correct out of 20. Would you consider this event likely
to occur? Explain your answer.

. Multiple-Choice Exam A student takes a 20-question,

multiple-choice exam with five choices for each question
and guesses on each question. Find the probability of
guessing at least 15 out of 20 correctly. Would you
consider this event likely or unlikely to occur? Explain
your answer.

. Driving to Work Alone It is reported that 77% of

workers aged 16 and over drive to work alone. Choose
8 workers at random. Find the probability that

a. All drive to work alone

b.  More than one-half drive to work alone

c. Exactly 3 drive to work alone

Source: www.factfinder.census.gov

. High School Dropouts Approximately 10.3% of

American high school students drop out of school before
graduation. Choose 10 students entering high school at
random. Find the probability that

a. No more than two drop out

b. At least 6 graduate

c.  All 10 stay in school and graduate

Source: www.infoplease.com

. Survey on Concern for Criminals In a survey, 3 of

4 students said the courts show “too much concern” for

criminals. Find the probability that at most 3 out of 7

randomly selected students will agree with this statement.

Source: Harper's Index.

Labor Force Couples The percentage of couples

where both parties are in the labor force is 52.1. Choose

5 couples at random. Find the probability that

a. None of the couples have both persons working

b. More than 3 of the couples have both persons in the
labor force

c.  Fewer than 2 of the couples have both parties
working

Source: www.bls.gov

For Exercises 4 through 13, assume all variables are 1
binomial. (Note: If values are not found in Table B of
Appendix C, use the binomial formula.)

. College Education and Business World Success
R. H. Bruskin Associates Market Research found that

40% of Americans do not think that having a college
4. Burglar Alarms A burglar alarm system has six fail-safe

components. The probability of each failing is 0.05. Find

these probabilities.

a. Exactly three will fail.

b. Fewer than two will fail.

¢. None will fail.

d. Compare the answers for parts a, b, and ¢, and
explain why the results are reasonable.

education is important to succeed in the business world.
If a random sample of five Americans is selected, find
these probabilities.

a. Exactly 2 people will agree with that statement.

b. Atmost 3 people will agree with that statement.

c. Atleast 2 people will agree with that statement.

d. Fewer than 3 people will agree with that statement.

Source: 100% American by Daniel Evans Weiss.
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12. Destination Weddings Twenty-six percent of couples
who plan to marry this year are planning destination
weddings. In a random sample of 12 couples who plan
to marry, find the probability that
a. Exactly 6 couples will have a destination wedding
b. At least 6 couples will have a destination wedding
c. Fewer than 5 couples will have a destination

wedding

Source: Time magazine.

13. People Who Have Some College Education Fifty-
three percent of all persons in the U.S. population have
at least some college education. Choose 10 persons at
random. Find the probability that

a. Exactly one-half have some college education
b. Atleast 5 do not have any college education
c¢.  Fewer than 5 have some college education

Source: New York Times Almanac.

14. (ans) Find the mean, variance, and standard deviation

for each of the values of » and p when the conditions for

the binomial distribution are met.
a. n=100,p =0.75

b. n=1300,p=03

c. n=20,p=05

d n=10,p=0.8

e. n=1000,p=0.1

f n=500,p =025
g n=50,p=%
h. n=36,p=1

15. Social Security Recipients A study found that 1%

of Social Security recipients are too young to vote. If 800
Social Security recipients are randomly selected, find the
mean, variance, and standard deviation of the number of

recipients who are too young to vote.

Source: Harper's Index.

16. Find the mean, variance, and standard deviation for the
number of heads when 20 coins are tossed.

17. Defective Calculators If 3% of calculators are defective,

find the mean, variance, and standard deviation of a lot
of 300 calculators.

18. Federal Government Employee E-mail Use It has

been reported that 83% of federal government employees

use e-mail. If a sample of 200 federal government
employees is selected, find the mean, variance, and
standard deviation of the number who use e-mail.
Source: US4 TODAY.

19. Watching Fireworks A survey found that 21% of
Americans watch fireworks on television on July 4.
Find the mean, variance, and standard deviation of the
number of individuals who watch fireworks on
television on July 4 if a random sample of 1000
Americans is selected.

Source: USA Snapshot, USA TODAY.
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20.

21.

22.

23.

24.

25.

26.

27.

28.

Alternate Sources of Fuel Eighty-five percent of
Americans favor spending government money to
develop alternative sources of fuel for automobiles. For
a random sample of 120 Americans, find the mean,
variance, and standard deviation for the number who
favor government spending for alternative fuels.

Source: www.pollingreport.com

Survey on Bathing Pets A survey found that 25% of
pet owners had their pets bathed professionally rather
than do it themselves. If 18 pet owners are randomly
selected, find the probability that exactly 5 people have
their pets bathed professionally.

Source: USA Snapshot, USA TODAY.

Survey on Answering Machine Ownership In asurvey,
63% of Americans said they own an answering machine. If
14 Americans are selected at random, find the probability
that exactly 9 own an answering machine.

Source: USA Snapshot, USA TODAY.

Poverty and the Federal Government One out of
every three Americans believes that the U.S. government
should take “primary responsibility” for eliminating
poverty in the United States. If 10 Americans are
selected, find the probability that at most 3 will believe
that the U.S. government should take primary
responsibility for eliminating poverty.

Source: Harper s Index.

Internet Purchases Thirty-two percent of adult Internet
users have purchased products or services online. For a
random sample of 200 adult Internet users, find the mean,
variance, and standard deviation for the number who
have purchased goods or services online.

Source: www.infoplease.com

Survey on Internet Awareness In a survey, 58% of
American adults said they had never heard of the
Internet. If 20 American adults are selected at random,
find the probability that exactly 12 will say they have
never heard of the Internet.

Source: Harper s Index.

Job Elimination In the past year, 13% of businesses
have eliminated jobs. If 5 businesses are selected at
random, find the probability that at least 3 have
eliminated jobs during the last year.

Source: US4 TODAY.

Survey of High School Seniors Of graduating high
school seniors, 14% said that their generation will be
remembered for their social concerns. If 7 graduating
seniors are selected at random, find the probability that
either 2 or 3 will agree with that statement.

Source: USA TODAY.

Is this a binomial distribution? Explain.
X | 0 1 2 3
P(X) | 0.064 0.288 0432 0.216


www.pollingreport.com
www.infoplease.com

Extending the Concepts

29. Children in a Family The graph shown here represents

the probability distribution for the number of girls in a
family of three children. From this graph, construct a

probability distribution.

0.375 1

0.250 1

Probability

0125 T

P(X)

Step by Step —

MINITAB
Step hy Step

1 2 3
Number of girls

The Binomial Distribution
Calculate a Binomial Probability
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30. Construct a binomial distribution graph for the number

of defective computer chips in a lot of 4 if p = 0.3.

From Example 5-19, it is known that 5% of the population is afraid of being alone at night. If a
random sample of 20 Americans is selected, what is the probability that exactly 5 of them are

afraid?

n=20 p=0.05(%)

and

No data need to be entered in the worksheet.

1. Select Calc>Probability
Distributions>Binomial.

2. Click the option for
Probability.

3. Click in the text box for Number
of trials:.

4. Type in 20, then Tab to Probability
of success, then type .05.

5. Click the option for Input constant,
then type in 5. Leave the text box
for Optional storage empty. If the
name of a constant such as K1 is
entered here, the results are stored
but not displayed in the session
window.

6. Click [OK]. The results are visible in the session window.

Probability Density Function

Binomial with n =20 and p = 0.05

X f(x)
5 0.0022446

Binomial Distribution

X =5 (5 out of 20)

& Probability

" Cumulative probability
" Inwerse cumulative probability

Number of trials:

Probability of success: .05

" Input column:

& Input

Select
Help

———
Opfional storage: [
5
Opfional ctorage: [
B
[ ok ]  cancel |

|20
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Simpla Set of Mumbers

Construct a Binomial Distribution

These instructions will use n = 20 and p = 0.05.
1. Select Calc>Make Patterned Data>Simple Set of Numbers.
2. You must enter three items:

a) Enter X in the box for Store patterned data in:. MINITAB will use the first empty
column of the active worksheet and name it X.

b) Press Tab. Enter the value of 0 for the first value. Press Tab.

c) Enter 20 for the last value. This value should be n. In steps of:, the value should be 1.
3. Click [OK].
4. Select Calc>Probability Distributions>Binomial.
5. In the dialog box you must enter five items.

a) Click the button for Probability.

b) In the box for Number of trials enter 20.

c) Enter .05 in the Probability of success.

Binomial Distribution

Help

Store patterned data in:  [X c1 X & Probability
" Cumulative probability

From first value: [0 " Inverse cumulative probability
Tolastvalue: 20
s Number of trials: |20
meveeor L Probability of success: [0
List each value 1 times

; & Input column: Ix
List the whole sequence |1 times

[k Optional storage: e

 Input tant: [
i
= BEEG Optional storage:

Help Iﬂ Cancel |

d) Check the button for Input columns, then type the column name, X, in the text box.
e) Click in the box for Optional storage, then type Px.

6. Click [OK]. The first available column will be named Px, and the calculated probabilities
will be stored in it.

7. To view the completed table, click the worksheet icon on the toolbar. '@ & E'%

Graph a Binomial Distribution
The table must be available in the worksheet.
1. Select Graph>Scatterplot, then Simple.
a) Double-click on C2 Px for the Y variable and C1 X for the X variable.

b) Click [Data view], then Project lines, then [OK]. Deselect any other type of display
that may be selected in this list.

¢) Click on [Labels], then Title/Footnotes.

d) Type an appropriate title, such as Binomial Distribution n = 20, p = .05.

e) Press Tab to the Subtitle 1, then type in Your Name.

f) Optional: Click [Scales] then [Gridlines] then check the box for Y major ticks.
g) Click [OK] twice.



Scatterplot - Labels

Tiles/Footnotes | Dala Labels |
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& Scatterplot of Px vs X

Binomial Distribution Table n = 20 and p = .05

Ttk Your Name
|Binomisl Distrbasion n=20 p= 16 o
Subbie 1: k
[rous Hame
Sublile 2 [ e
[
3 0.2 oo
&
T ek e 4 5 i

P04 —

"1"['T"I"T"["["I"1"["]’"!"1"["I'"I"]'"
0 5 10 15 20
3

The graph will be displayed in a window. Right-click the control box to save, print, or close the
graph.

TI-83 Plus or

Tl-84 Plus
Step by Step

Binomial Random Variables

To find the probability for a binomial variable:

Press 2nd [DISTR] then 0 for binomial pdf( (Note: On the TI-84 Plus Use A)
The form is binompdf(n,p,X).

Example: n = 20, X = 5, p = .05. (Example 5-19a from the text) binompdf(20,.05,5)
Example: n = 20, X =0, 1, 2, 3, p = .05. (Example 5-19b from the text)
binompdf(20,.05,{0,1,2,3})

The calculator will display the probabilities in a list. Use the arrow keys to view entire display.

To find the cumulative probability for a binomial random variable:

Press 2nd [DISTR] then A (ALPHA MATH) for binomcdf( (Note: On the TI-84 Plus Use B)
The form is binomcdf(n,p,X). This will calculate the cumulative probability for values from
0to X.

Example: n = 20, X =0, 1, 2, 3, p = .05 (Example 5-19b from the text)
binomcdf(20,.05,3)

i norEd (28, 85,

% romcdf (28, A5,
HE2 244545

. 3240924 74

bi
3

To construct a binomial probability table:
1. Enter the X values 0 through » into L.
2. Move the cursor to the top of the L, column so that L, is highlighted.
3. Type the command binompdf(n,p,L,), then press ENTER.
Example: n = 20, p = .05 (Example 5-19 from the text)

._
Lol
r
-

[ AL N ARty

[ L WUT AT SE=

Mlonswrnes | =+

-

Lz =binomFdf C2E8. .. L2 8511 20 Leiii=, 3224859204
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Excel Creating a Binomial Distribution and Graph
Step by Step These instructions will demonstrate how Excel can be used to construct a binomial distribution
table for n = 20 and p = 0.35.

1. Type X for the binomial variable label in cell A1 of an Excel worksheet.

2. Type P(X) for the corresponding probabilities in cell B1.

3. Enter the integers from 0 to 20 in column A starting at cell A2. Select the Data tab from
the toolbar. Then select Data Analysis. Under Analysis Tools, select Random Number
Generation and click [OK].

4. In the Random Number Generation dialog box, enter the following:
a) Number of Variables: 1
b) Distribution: Patterned

¢) Parameters: From 0 to 20 in steps of 1, repeating each number: 1 times and repeating
each sequence 1 times

d) Output range: A2:A21
5. Then click [OK].

Hamdom Nomber Gu

Random Number xd
Generation Dialog Box Number of yarizbles: 1 e

Nusnler of Rardon Nmyers: Canxel

Distribution: Pedbemrml v | Lisk

Parameters

Erom o to @ In steps of 1
repeating ach numbsr 1 times.
repeating the sequence 1 I&a

Randomn Seed:

Output options

(&) Ouput Range: az-pzy E]
() e Wewckshnat Bly:

) N Wiorklonk

6. To determine the probability corresponding to the first value of the binomial random
variable, select cell B2 and type: =BINOMDIST(0,20,.35,FALSE). This will give the
probability of obtaining 0 successes in 20 trials of a binomial experiment for which the
probability of success is 0.35.

7. Repeat step 6, changing the first parameter, for each of the values of the random variable
from column A.

Note: If you wish to obtain the cumulative probabilities for each of the values in column A,
you can type: =BINOMDIST(0,20,.35,TRUE) and repeat for each of the values in column A.

To create the graph:

1. Select the Insert tab from the toolbar and the Column Chart.
2. Select the Clustered Column (the first column chart under the 2-D Column selections).
3. You will need to edit the data for the chart.

a) Right-click the mouse on any location of the chart. Click the Select Data option. The
Select Data Source dialog box will appear.

b) Click X in the Legend Entries box and click Remove.

c¢) Click the Edit button under Horizontal Axis Labels to insert a range for the variable X.

d) When the Axis Labels box appears, highlight cells A2 to A21 on the worksheet, then
click [OK].

4. To change the title of the chart:
a) Left-click once on the current title.
b) Type a new title for the chart, for example, Binomial Distribution (20, .35, .65).
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A B
% P(X)
0 0.00M81245
1 0.001951874
2 0.009923587
3 0.032257897

0.073320356
0.127199166
0.171229673
0.184401186
0.161351038
0.115841771
0.0686139/2
0.033587759
0.013561085
0.u0444608
0.001210087
0.000260634
4.38567C-05

5.5565E-06
4,98661E 07
2.R26470-08
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Objective [

Find probabilities for
outcomes of variables,
using the Poisson,
hypergeometric, and
multinomial
distributions.

...
o
BohURGEERSEwmuoauw a

7.60958E-10

Other Types of Distributions (Optional)

In addition to the binomial distribution, other types of distributions are used in statistics.
Three of the most commonly used distributions are the multinomial distribution, the
Poisson distribution, and the hypergeometric distribution. They are described next.

The Multinomial Distribution

Recall that in order for an experiment to be binomial, two outcomes are required for each
trial. But if each trial in an experiment has more than two outcomes, a distribution called
the multinomial distribution must be used. For example, a survey might require the
responses of “approve,” “disapprove,” or “no opinion.” In another situation, a person
may have a choice of one of five activities for Friday night, such as a movie, dinner, base-
ball game, play, or party. Since these situations have more than two possible outcomes
for each trial, the binomial distribution cannot be used to compute probabilities.

The multinomial distribution can be used for such situations if the probabilities for
each trial remain constant and the outcomes are independent for a fixed number of trials.
The events must also be mutually exclusive.

Formula for the Multinomial Distribution

If X consists of events E|, E,, E;, . . ., E;, which have corresponding probabilities p,, p,, ps, . . .,
p; of occurring, and X is the number of times £, will occur, X, is the number of times E, will
occur, Xj is the number of times £; will occur, etc., then the probability that X will occur is

n'

P(X) :Xl! .X2! 'X3! '.'Xk! -p‘i(lnp;l---p‘]/},k

where X| + X, + X; +---+ X, =nandp, +p, +p; +---+p, =1

Example 5-24

Leisure Activities

In a large city, 50% of the people choose a movie, 30% choose dinner and a play, and
20% choose shopping as a leisure activity. If a sample of 5 people is randomly
selected, find the probability that 3 are planning to go to a movie, 1 to a play, and 1
to a shopping mall.
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Example 5-26

[—] orical Note

Simeon D. Poisson
(1781-1840)
formulated the
distribution that bears
his name. It appears
only once in his
writings and is only
one page long.
Mathematicians paid
little attention to it
until 1907, when a
statistician named
W. S. Gosset found

real applications for it.
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Solution

We know thatn = 5, X, =3, X, =1,X; =1, p, = 0.50, p, = 0.30, and p, = 0.20.
Substituting in the formula gives

!
PX) = ﬁ - (0.50)°(0.30)!(0.20)" = 0.15

Again, note that the multinomial distribution can be used even though replacement
is not done, provided that the sample is small in comparison with the population.

CD Purchases

In a music store, a manager found that the probabilities that a person buys 0, 1, or 2 or
more CDs are 0.3, 0.6, and 0.1, respectively. If 6 customers enter the store, find the
probability that 1 won’t buy any CDs, 3 will buy 1 CD, and 2 will buy 2 or more CDs.

Solution
Itisgiventhatn = 6, X, = 1,X, =3,X; =2,p, = 0.3, p, = 0.6, and p; = 0.1. Then
__6 1 3 2
PX) = TETY (0.3)'(0.6)°(0.1)
=60 - (0.3)(0.216)(0.01) = 0.03888

Selecting Colored Balls

A box contains 4 white balls, 3 red balls, and 3 blue balls. A ball is selected at
random, and its color is written down. It is replaced each time. Find the probability
that if 5 balls are selected, 2 are white, 2 are red, and 1 is blue.

Solution

We know thatn = 5, X, =2, X, =2, X;=1;p, = %,pz = 1%, and p; = 1%; hence,

_ 5l 4 2(3)2(3)1_81
P(X)_z!zu! (10) 10/ \10/ 625

Thus, the multinomial distribution is similar to the binomial distribution but has
the advantage of allowing you to compute probabilities when there are more than two
outcomes for each trial in the experiment. That is, the multinomial distribution is a
general distribution, and the binomial distribution is a special case of the multinomial
distribution.

The Poisson Distribution

A discrete probability distribution that is useful when 7 is large and p is small and when
the independent variables occur over a period of time is called the Poisson distribution.
In addition to being used for the stated conditions (i.e., n is large, p is small, and the vari-
ables occur over a period of time), the Poisson distribution can be used when a density
of items is distributed over a given area or volume, such as the number of plants grow-
ing per acre or the number of defects in a given length of videotape.
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Formula for the Poisson Distribution

The probability of X occurrences in an interval of time, volume, area, etc., for a variable where
A (Greek letter lambda) is the mean number of occurrences per unit (time, volume, area, etc.) is

—A\X
OGN =S

where X=0,1,2,...

The letter e is a constant approximately equal to 2.7183.

Round the answers to four decimal places.

Example 5-27

Using Table C

Example 5-28

Typographical Errors
If there are 200 typographical errors randomly distributed in a 500-page manuscript,
find the probability that a given page contains exactly 3 errors.

Solution

First, find the mean number A of errors. Since there are 200 errors distributed over 500
pages, each page has an average of
200 2
“500 5 4
or 0.4 error per page. Since X = 3, substituting into the formula yields
e Y (2.7183)7940.4)°

PX; \) = S 3 = 0.0072

Thus, there is less than a 1% chance that any given page will contain exactly 3 errors.

Since the mathematics involved in computing Poisson probabilities is somewhat
complicated, tables have been compiled for these probabilities. Table C in Appendix C
gives P for various values for A and X.

In Example 5-27, where X is 3 and A is 0.4, the table gives the value 0.0072 for the
probability. See Figure 5—4.

)

X 0.1 0.2 0.3 0.4 0.5 0.6 0.7 0.8 0.9 1.0

0

1

2

3 ( 0.0072
X=3)y

Toll-Free Telephone Calls

A sales firm receives, on average, 3 calls per hour on its toll-free number. For any given
hour, find the probability that it will receive the following.

a. At most 3 calls b. At least 3 calls c. 5 or more calls

5-35
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Solution
a. “At most 3 calls” means 0, 1, 2, or 3 calls. Hence,

P(0; 3) + P(1;3) + P(2; 3) + P(3; 3)
= 0.0498 + 0.1494 + 0.2240 + 0.2240
= 0.6472
b. “At least 3 calls” means 3 or more calls. It is easier to find the probability of 0, 1,

and 2 calls and then subtract this answer from 1 to get the probability of at least
3 calls.

P(0;3) + P(1;3) + P(2; 3) = 0.0498 + 0.1494 + 0.2240 = 0.4232
and
1 —0.4232 = 0.5768

c. For the probability of 5 or more calls, it is easier to find the probability of getting
0, 1, 2, 3, or 4 calls and subtract this answer from 1. Hence,

P(0;3) + P(1;3) + P(2;3) + P(3; 3) + P(4; 3)
= 0.0498 + 0.1494 + 0.2240 + 0.2240 + 0.1680
=0.8152
and
1 —0.8152 =0.1848

Thus, for the events described, the part @ event is most likely to occur and the
part c event is least likely to occur.

The Poisson distribution can also be used to approximate the binomial distribution
when the expected value A = n - p is less than 5, as shown in Example 5-29. (The same
is true whenn - ¢ < 5.)

Example 5-29

5-36

Left-Handed People

If approximately 2% of the people in a room of 200 people are left-handed, find the
probability that exactly 5 people there are left-handed.

Solution

Since A = n - p, then A = (200)(0.02) = 4. Hence,

—4(4)3
PX; A) = w = 0.1563

which is verified by the formula ,,,C5(0.02)°(0.98)"*> = 0.1579. The difference between

the two answers is based on the fact that the Poisson distribution is an approximation

and rounding has been used.

The Hypergeometric Distribution
When sampling is done without replacement, the binomial distribution does not give
exact probabilities, since the trials are not independent. The smaller the size of the pop-
ulation, the less accurate the binomial probabilities will be.

For example, suppose a committee of 4 people is to be selected from 7 women and
5 men. What is the probability that the committee will consist of 3 women and 1 man?
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To solve this problem, you must find the number of ways a committee of 3 women
and 1 man can be selected from 7 women and 5 men. This answer can be found by using
combinations; it is

CyC, =35-5=175

Next, find the total number of ways a committee of 4 people can be selected from 12
people. Again, by the use of combinations, the answer is

1,C, = 495

Finally, the probability of getting a committee of 3 women and 1 man from 7 women and
5 men is

175 _35

P =755 = 99

The results of the problem can be generalized by using a special probability dis-
tribution called the hypergeometric distribution. The hypergeometric distribution is
a distribution of a variable that has two outcomes when sampling is done without
replacement.

The probabilities for the hypergeometric distribution can be calculated by using the
formula given next.

Formula for the Hypergeometric Distribution

Given a population with only two types of objects (females and males, defective and
nondefective, successes and failures, etc.), such that there are a items of one kind and b items
of another kind and a + b equals the total population, the probability P(X) of selecting
without replacement a sample of size n with X items of type a and n — X items of type b is

The basis of the formula is that there are ,C, ways of selecting the first type of items,
»C,_y ways of selecting the second type of items, and ,,,C, ways of selecting n items

from the entire population.

Example 5-30

Assistant Manager Applicants

Ten people apply for a job as assistant manager of a restaurant. Five have completed
college and five have not. If the manager selects 3 applicants at random, find the
probability that all 3 are college graduates.

Solution

Assigning the values to the variables gives

a = 5 college graduates n=3
b = 5 nongraduates X=3

and n — X = 0. Substituting in the formula gives

C-sC, 10 1
_s5t3 st MU 1
PX) WG 120 12
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5-38

A recent study found that 2 out of every 10 houses in a neighborhood have no
insurance. If 5 houses are selected from 10 houses, find the probability that exactly
1 will be uninsured.

Solution
In this example,a = 2,b=8,n=5,X=1,andn — X = 4.
2C1'8C4 2'70_@_

P = = = =
X 10Cs 252 252

>
9

In many situations where objects are manufactured and shipped to a company,
the company selects a few items and tests them to see whether they are satisfactory or
defective. If a certain percentage is defective, the company then can refuse the whole
shipment. This procedure saves the time and cost of testing every single item. To make
the judgment about whether to accept or reject the whole shipment based on a small
sample of tests, the company must know the probability of getting a specific number of
defective items. To calculate the probability, the company uses the hypergeometric
distribution.

Defective Compressor Tanks

A lot of 12 compressor tanks is checked to see whether there are any defective tanks.
Three tanks are checked for leaks. If 1 or more of the 3 is defective, the lot is rejected.
Find the probability that the lot will be rejected if there are actually 3 defective tanks in
the lot.

Solution

Since the lot is rejected if at least 1 tank is found to be defective, it is necessary to find
the probability that none are defective and subtract this probability from 1.
Here,a =3,b=9,n=3,and X = 0; so

Co-oC; 1-84
_3b0 903 _ _
G, 220 0.38

PX)
Hence,
P(at least 1 defective) = 1 — P(no defectives) = 1 — 0.38 = 0.62

There is a 0.62, or 62%, probability that the lot will be rejected when 3 of the 12 tanks
are defective.

A summary of the discrete distributions used in this chapter is shown in
Table 5-1.
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5-1  Summary of Discrete Distributions

1. Binomial distribution

n! e
P =—(n—X)!X!.pX.q X

m=n-p o=Vn-p-q

Used when there are only two outcomes for a fixed number of independent trials and
the probability for each success remains the same for each trial.
2. Multinomial distribution

n!

PO = Xy P

where

X+t X+X5+-+X,=n and prtp,tps o+ p =1

Used when the distribution has more than two outcomes, the probabilities for each
trial remain constant, outcomes are independent, and there are a fixed number of trials.
3. Poisson distribution

e \X

PX; A) = X

where X=10,1,2, ...

Used when # is large and p is small, the independent variable occurs over a period of
time, or a density of items is distributed over a given area or volume.
4. Hypergeometric distribution

— aCX . anfX
a+an

PX)

Used when there are two outcomes and sampling is done without replacement.

Applying the Concepts 5—4

Rockets and Targets

During the latter days of World War II, the Germans developed flying rocket bombs. These
bombs were used to attack London. Allied military intelligence didn’t know whether these
bombs were fired at random or had a sophisticated aiming device. To determine the answer,
they used the Poisson distribution.

To assess the accuracy of these bombs, London was divided into 576 square regions. Each
region was § square kilometer in area. They then compared the number of actual hits with the
theoretical number of hits by using the Poisson distribution. If the values in both distributions
were close, then they would conclude that the rockets were fired at random. The actual
distribution is as follows:

Hits | 0 1 2 3 4 5
Regions | 229 211 93 35 7 1

1. Using the Poisson distribution, find the theoretical values for each number of hits. In this
case, the number of bombs was 535, and the number of regions was 576. So

535

=222 - 0.9
B =576~ 0929
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For 3 hits,

_pet
PX) = X1

(0.929)3(2.7183) 0%

3!

=0.0528

Hence the number of hits is (0.0528)(576) = 30.4128.
Complete the table for the other number of hits.

Hits | 0 1

2

3 4 5

Regions |

304

2. Write a brief statement comparing the two distributions.

3. Based on your answer to question 2, can you conclude that the rockets were fired at random?

See page 298 for the answer.

1. Use the multinomial formula and find the probabilities

for each.

a n=6X=3,X=2,X=1,p, =05,p, =03,
p; =02

b. n=5X=1,X=2,X,=2,p,=03,p,=0.6,
p;=0.1

c n=4X=1,X=1,X,=2,p,=08,p,=0.1,
p;=0.1

d n=3X=1,X=1,X,=1,p, =0.5,p,=03,
p; =02

e n=5X=1,X=3X=1p, =07,p,=02,
p;=0.1

2. Firearm Sales When people were asked if they felt that
the laws covering the sale of firearms should be more
strict, less strict, or kept as they are now, 54% responded
more strict, 11% responded less, 34% said keep them as
they are now, and 1% had no opinion. If 10 randomly
selected people are asked the same question, what is the
probability that 4 will respond more strict, 3 less, 2 keep
them the same, and 1 have no opinion?

Source: www.pollingreport.com

3. M&M Color Distribution According to the
manufacturer, M&M’s are produced and distributed in
the following proportions: 13% brown, 13% red, 14%
yellow, 16% green, 20% orange, and 24% blue. In a
random sample of 12 M&M’s what is the probability of
having 2 of each color?

4. Number of Prescriptions When a customer enters a
pharmacy, the probabilities that he or she will have 0, 1,
2, or 3 prescriptions filled are 0.60, 0.25, 0.10, and 0.05,
respectively. For a sample of 6 people who enter the
pharmacy, find the probability that 2 will have
0 prescriptions, 2 will have 1 prescription, 1 will have
2 prescriptions, and 1 will have 3 prescriptions.
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. Rolling a Die A die is rolled 4 times. Find the

probability of two 1s, one 2, and one 3.

. Mendel’s Theory According to Mendel’s theory, if tall

and colorful plants are crossed with short and colorless
plants, the corresponding probabilities are 1%, =, i,

and 11? for tall and colorful, tall and colorless, short and
colorful, and short and colorless, respectively. If 8 plants
are selected, find the probability that 1 will be tall and
colorful, 3 will be tall and colorless, 3 will be short and
colorful, and 1 will be short and colorless.

. Find each probability P(X; A), using Table C in

Appendix C.
a. P(5;4)
b. P(2;4)
c. P(6;3)
d. P(10;7)
e. P(9;8)

. Copy Machine Output A copy machine randomly puts

out 10 blank sheets per 500 copies processed. Find the
probability that in a run of 300 copies, 5 sheets of paper
will be blank.

. Study of Robberies A recent study of robberies for

a certain geographic region showed an average of

1 robbery per 20,000 people. In a city of 80,000 people,
find the probability of the following.

a. 0 robberies

b. 1 robbery

c. 2 robberies

d. 3 or more robberies

Misprints on Manuscript Pages In a 400-page
manuscript, there are 200 randomly distributed
misprints. If a page is selected, find the probability that
it has 1 misprint.


www.pollingreport.com

Section 5-4 Other Types of Distributions (Optional) 291

11. Telephone Soliciting A telephone soliciting company 17. School Newspaper Staff A school newspaper staff is
obtains an average of 5 orders per 1000 solicitations. If comprised of 5 seniors, 4 juniors, 5 sophomores, and
the company reaches 250 potential customers, find the 7 freshmen. If four staff members are chosen at random
probability of obtaining at least 2 orders. for a publicity photo, what is the probability that there

. . . . will be 1 student from each class?

12. Mail Ordering A mail-order company receives an
average of 5 orders per 500 solicitations. If it sends out 18. Missing Pages from Books A bookstore owner
100 advertisements, find the probability of receiving at examines 5 books from each lot of 25 to check for
least 2 orders. missing pages. If he finds at least 2 books with missing

» pages, the entire lot is returned. If, indeed, there are

13. Company Mailing Of a company’s mailings 1.5% are 5 books with missing pages, find the probability that the

returned because of incorrect or incomplete addresses. lot will be returned.

In a mailing of 200 pieces, find the probability that none

will be returned. 19. Types of CDs A CD case contains 10 jazz albums,
4 classical albums, and 2 soundtracks. Choose 3 at

14. Emission Inspection Failures If 3% of all cars fail random to put ina CD Changer. What is the probabi]ity
the emissions inspection, find the probability that in of selecting 2 jazz albums and 1 classical album?

2 samp.Ie of90 cars, 3 will fail. Use the Poisson 20. Defective Computer Keyboards A shipment of 24
approximation. . . .
computer keyboards is rejected if 4 are checked for

15. Phone Inquiries The average number of phone defects and at least 1 is found to be defective. Find the
inquiries per day at the poison control center is 4. Find probability that the shipment will be returned if there
the probability it will receive 5 calls on a given day. Use are actually 6 defective keyboards.
the Poisson approximation. 21. Defective Electronics A shipment of 24 electric

16. Defective Calculators In a batch of 2000 calculators, typewriters is rejected if 3 are checked for defects and at
there are, on average, 8 defective ones. If a random least 1 is found to be defective. Find the probability that
sample of 150 is selected, find the probability of 5 the shipment will be returned if there are actually 6
defective ones. typewriters that are defective.

——
Technology Step by Step .

TI-83 Plus or

TI-84 Plus
Step by Step

Poisson Random Variables
To find the probability for a Poisson random variable:

Press 2nd [DISTR] then B (ALPHA APPS) for poissonpdf(
The form is poissonpdf(A,X).

Example: A = 0.4, X = 3 (Example 5-27 from the text)
poissonpdf(.4,3)

Example: A =3, X =0, 1, 2, 3 (Example 5-28a from the text)

poissonpdf(3,{0,1,2,3})

The calculator will display the probabilities in a list. Use the arrow keys to view the entire
display.

(Note: On the TI-84 Plus Use C)

To find the cumulative probability for a Poisson random variable:
Press 2nd [DISTR] then C (ALPHA PRGM) for poissoncdf(  (Note: On the TI-84 Plus Use D)
The form is poissoncdf(A,X). This will calculate the cumulative probability for values from 0 to X.

Example: A =3, X =0, 1, 2, 3 (Example 5-28a from the text)
poissoncdf(3,3)

FoissonFPdf (. 4.3 PDiSSDEE%Eé%ég%S
Y e s | = -

FOilssonFdf {3, {d

1.2. 332

;:. B49787EEE4 1.
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To construct a Poisson probability table:
1. Enter the X values 0 through a large possible value of X into L.
2. Move the cursor to the top of the L, column so that L, is highlighted.
3. Enter the command poissonpdf(A,L,) then press ENTER.

Example: A =3,X=0,1,2,3,...,10 (Example 5-28 from the text)

L1 L Lz z 2] = Lz z T Lz Lz z
R N v || —____ T o |
i i i 14836
z E z Zzho4
E E E 22404
q i g 16803
g 5 c 100EE
i B [ DS OML

Lz =FoilssonFdfy L =_.onFdf i3 L2 Leti=, @49 7EFOSE3..

Summary

Many variables have special probability distributions. This chapter presented several
of the most common probability distributions, including the binomial distribution, the
multinomial distribution, the Poisson distribution, and the hypergeometric distribution.

The binomial distribution is used when there are only two outcomes for an experi-
ment, there are a fixed number of trials, the probability is the same for each trial, and the
outcomes are independent of one another. The multinomial distribution is an extension
of the binomial distribution and is used when there are three or more outcomes for an
experiment. The hypergeometric distribution is used when sampling is done without
replacement. Finally, the Poisson distribution is used in special cases when independent
events occur over a period of time, area, or volume.

A probability distribution can be graphed, and the mean, variance, and standard devi-
ation can be found. The mathematical expectation can also be calculated for a probabil-
ity distribution. Expectation is used in insurance and games of chance.

important Terms

binomial
distribution 271

binomial
experiment 271

discrete probability hypergeometric Poisson distribution 284

distribution 254 distribution 287 random variable 253

expected value 264 multinomial
distribution 283

Important Formulas

Formula for the mean of a probability distribution: Binomial probability formula:

p=3X" PXX)

Formulas for the variance and standard deviation of a
probability distribution:

o’ = SIX* - PX)| =
o= \VIX? PX)| — p

Formula for expected value:

E(X) = 2X - P(X)
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n!

P(X) =m'PX'¢I"_X

Formula for the mean of the binomial distribution:

p=n-p

Formulas for the variance and standard deviation of the
binomial distribution:

o’=n-p-q o=Vnpyq



Formula for the multinomial distribution:

n!
TXX X - -X,,z"’f"”é(z' o

Formula for the Poisson distribution:

P(X)

e*)\ X

P(X; A) = where X =0,1,2,...

Review Exercises

For Exercises 1 through 3, determine whether the
distribution represents a probability distribution. If it
does not, state why.

1. X 12 3 4 5
PO | % @ w0 T 1
2. X 10 20 30
Px) | 01 04 03
3. X § 12 16 20
PX) | § & h b

4. Emergency Calls The number of emergency calls a
local police department receives per 24-hour period is
distributed as shown here. Construct a graph for the data.

Number 0fcallsX| 10 11 12 13 14

Probability P(X) | 0.02 0.12 040 031 0.15

5. Credit Cards A large retail company encourages its
employees to get customers to apply for the store credit
card. Below is the distribution for the number of credit
card applications received per employee for an 8-hour
shift.

X | 0 1 2 3 4 5

P(X) | 027 028 020 0.15 0.08 0.02

a. What is the probability that an employee will get 2
or 3 applications during any given shift?

b. Find the mean, variance, and standard deviation for
this probability distribution.

6. Coins in a Box A box contains 5 pennies, 3 dimes,
1 quarter, and 1 half-dollar. Construct a probability
distribution and draw a graph for the data.

7. Tie Purchases At Tyler’s Tie Shop, Tyler found the
probabilities that a customer will buy 0, 1, 2, 3, or 4
ties, as shown. Construct a graph for the distribution.

Number of ties X | 0 1 2 3 4

Probability P(X) | 030 0.50 0.10 0.08 0.02

8. Customers in a Bank A bank has a drive-through
service. The number of customers arriving during a
15-minute period is distributed as shown. Find the

Review Exercises 293

Formula for the hypergeometric distribution:

10.

11.

12.

13.

aCX : an—X

a+an

PX) =

mean, variance, and standard deviation for the
distribution.

Number of
customers X 0 1 2 3 4

Probability P(X) | 0.12 020 031 025 0.12

. Museum Visitors At a small community museum, the

number of visitors per hour during the day has the
distribution shown here. Find the mean, variance, and
standard deviation for the data.

Number of
visitors X 13 14 15 16 17

Probability PX) | 0.12 0.15 029 025 0.19

Cans of Paint Purchased During a recent paint sale at
Corner Hardware, the number of cans of paint purchased
was distributed as shown. Find the mean, variance, and
standard deviation of the distribution.

Number of
cans X 1 2 3 4 5

ProbabilityP(X)l 042 027 0.15 0.10 0.06

Inquiries Received The number of inquiries received
per day for a college catalog is distributed as shown.
Find the mean, variance, and standard deviation for the
data.

Number of
inquiries X | 22 23 24 25 26 27
Probability‘
P(X) 0.08 0.9 036 025 007 0.05

Outdoor Regatta A producer plans an outdoor regatta
for May 3. The cost of the regatta is $8000. This includes
advertising, security, printing tickets, entertainment, etc.
The producer plans to make $15,000 profit if all goes
well. However, if it rains, the regatta will have to be
canceled. According to the weather report, the probability
of rain is 0.3. Find the producer’s expected profit.

Card Game A game is set up as follows: All the
diamonds are removed from a deck of cards, and these
13 cards are placed in a bag. The cards are mixed up, and
then one card is chosen at random (and then replaced).
The player wins according to the following rules.
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If the ace is drawn, the player loses $20.
If a face card is drawn, the player wins $10.
If any other card (2-10) is drawn, the player wins $2.

How much should be charged to play this game in order
for it to be fair?

Using Exercise 13, how much should be charged if
instead of winning $2 for drawing a 2—10, the player
wins the amount shown on the card in dollars?

Let x be a binomial random variable with n» = 12 and
p = 0.3. Find the following:

a. P(X=2738)

b. P(X<5)

c. P(X=10)

d P4<X=9)

Internet Access via Cell Phone Fourteen percent of cell
phone users use their cell phones to access the Internet. In
a random sample of 10 cell phone users, what is the
probability that exactly 2 have used their phones to
access the Internet? More than 2?

Source: www.infoplease.com

Drug Calculation Test If 75% of nursing students are
able to pass a drug calculation test, find the mean,
variance, and standard deviation of the number of
students who pass the test in a sample of 180 nursing
students.

Flu Shots It has been reported that 63% of adults aged
65 and over got their flu shots last year. In a random
sample of 300 adults aged 65 and over, find the mean,
variance, and standard deviation for the number who got
their flu shots.

Source: U.S. Center for Disease Control and Prevention.

U.S. Police Chiefs and the Death Penalty The chance
that a U.S. police chief believes the death penalty
“significantly reduces the number of homicides” is

1 in 4. If a random sample of 8 police chiefs is selected,
find the probability that at most 3 believe that the

death penalty significantly reduces the number of
homicides.

Source: Harper's Index.

Household Wood Burning American Energy Review
reported that 27% of American households burn wood. If
arandom sample of 500 American households is selected,
find the mean, variance, and standard deviation of the
number of households that burn wood.

Source: 100% American by Daniel Evan Weiss.

Pizza for Breakfast Three out of four American adults
under age 35 have eaten pizza for breakfast. If a random
sample of 20 adults under age 35 is selected, find the
probability that exactly 16 have eaten pizza for breakfast.

Source: Harper's Index.
Unmarried Women According to survey records,

75.4% of women aged 20-24 have never been married.
In a random sample of 250 young women aged 2024,
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23.

24,

25.

26.

27.

28.

29.

30.

31.

find the mean, variance, and standard deviation for the
number who are or who have been married.

Source: www.infoplease.com

(Opt.) Accuracy Count of Votes After a recent
national election, voters were asked how confident they
were that votes in their state would be counted
accurately. The results are shown below.

46% Very Confident 41% Somewhat Confident
9% Not Very Confident 3% Not at All Confident

If 10 voters are selected at random, find the probability
that 5 would be very confident, 3 somewhat confident,
1 not very confident, and 1 not at all confident.

Source: New York Times.

(Opt.) Before a VCR leaves the factory, it is given a
quality control check. The probabilities that a VCR
contains 0, 1, or 2 defects are 0.90, 0.06, and 0.04,
respectively. In a sample of 12 recorders, find the
probability that 8 have 0 defects, 3 have 1 defect,
and 1 has 2 defects.

(Opt.) In a Christmas display, the probability that all
lights are the same color is 0.50; that 2 colors are used
is 0.40; and that 3 or more colors are used is 0.10. If a
sample of 10 displays is selected, find the probability
that 5 have only 1 color of light, 3 have 2 colors, and
2 have 3 or more colors.

(Opt.) Lost Luggage in Airlines Transportation
officials reported that 8.25 out of every 1000 airline
passengers lost luggage during their travels last year. If
we randomly select 400 airline passengers, what is the
probability that 5 lost some luggage?

Source: U.S. Department of Transportation.

(Opt.) Computer Help Hot Line receives, on average,
6 calls per hour asking for assistance. The distribution
is Poisson. For any randomly selected hour, find the
probability that the company will receive

a. Atleast 6 calls
b. 4 or more calls
c. Atmost 5 calls

(Opt.) The number of boating accidents on Lake Emilie
follows a Poisson distribution. The probability of an
accident is 0.003. If there are 1000 boats on the lake
during a summer month, find the probability that there
will be 6 accidents.

(Opt.) If 5 cards are drawn from a deck, find the
probability that 2 will be hearts.

(Opt.) Of the 50 automobiles in a used-car lot, 10 are
white. If 5 automobiles are selected to be sold at an
auction, find the probability that exactly 2 will be white.

(Opt.) Items Donated to a Food Bank At a food bank
a case of donated items contains 10 cans of soup, 8 cans
of vegetables, and 8 cans of fruit. If 3 cans are selected
at random to distribute, find the probability of getting

1 vegetable and 2 cans of fruit.


www.infoplease.com
www.infoplease.com
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Is Pooling Worthwhile?—Revisited
In the case of the pooled sample, the probability that only one test will be needed can be

determined by using the binomial distribution. The question being asked is, In a sample of 15
individuals, what is the probability that no individual will have the disease? Hence, n = 15,

p = 0.05, and X = 0. From Table B in Appendix C, the probability is 0.463, or 46% of the time,
only one test will be needed. For screening purposes, then, pooling samples in this case would
save considerable time, money, and effort as opposed to testing every individual in the population.

Chapter Quiz

Determine whether each statement is true or false. If the
statement is false, explain why.

1.

4.

The expected value of a random variable can be thought
of as a long-run average.

. The number of courses a student is taking this semester

is an example of a continuous random variable.

. When the binomial distribution is used, the outcomes

must be dependent.

A binomial experiment has a fixed number of trials.

Complete these statements with the best answer.

5.
6.

7.

Random variable values are determined by

The mean for a binomial variable can be found by using
the formula

One requirement for a probability distribution is that
the sum of all the events in the sample space must
equal

Select the best answer.

8.

10.

What is the sum of the probabilities of all outcomes in a
probability distribution?

a 0 c. 1

b. % d. Tt cannot be determined.
. How many outcomes are there in a binomial

experiment?

a. 0 c. 2

b. 1 d. Tt varies.

The number of trials for a binomial experiment

a. Can be infinite
b. Isunchanged
c. Isunlimited

d. Must be fixed

For questions 11 through 14, determine if the
distribution represents a probability distribution.
If not, state why.

11.

x| +r 2z 3 4 5
I

12.

13.

14.

15.

16.

17.

18.

X 3 6 9 12 15
P(X) 0.3 0.5 0.1 0.08 0.02
X 50 75 100

PX)l 05 0.2 0.3

X 4 8 12 16

P g iz 2 2

Calls for a Fire Company The number of fire calls
the Conestoga Valley Fire Company receives per day is
distributed as follows:

Number X | 5 6 7 8 9
Probability P(X) | 028 032 009 021 0.10
Construct a graph for the data.

Telephones per Household A study was conducted to
determine the number of telephones each household
has. The data are shown here.

Number of
telephones 0 1 2 3 4

Frequency | 2 30 48 13 7

Construct a probability distribution and draw a graph
for the data.

CD Purchases During a recent CD sale at Matt’s
Music Store, the number of CDs customers purchased
was distributed as follows:

Number X | 0 1 2 3 4
ProbabilityP(X)| 0.10 0.23 0.31 027 0.09

Find the mean, variance, and standard deviation of the
distribution.

Calls for a Crisis Hot Line The number of calls received
per day at a crisis hot line is distributed as follows:

Number X | 30 31 32 33 34

Probability P(X)| 0.05 021 038 025 0.11

Find the mean, variance, and standard deviation of the
distribution.
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Selecting a Card There are 6 playing cards placed face
down in a box. They are the 4 of diamonds, the 5

of hearts, the 2 of clubs, the 10 of spades, the 3 of
diamonds, and the 7 of hearts. A person selects a card.
Find the expected value of the draw.

Selecting a Card A person selects a card from an
ordinary deck of cards. If it is a black card, she wins $2.
If it is a red card between or including 3 and 7, she wins
$10. If it is a red face card, she wins $25; and if it is a
black jack, she wins an extra $100. Find the expectation
of the game.

Carpooling If 40% of all commuters ride to work in
carpools, find the probability that if 8 workers are
selected, 5 will ride in carpools.

Employed Women If 60% of all women are employed
outside the home, find the probability that in a sample
of 20 women,

a. Exactly 15 are employed
b. Atleast 10 are employed
¢.  Atmost 5 are not employed outside the home

Driver’s Exam If 80% of the applicants are able to
pass a driver’s proficiency road test, find the mean,
variance, and standard deviation of the number of
people who pass the test in a sample of 300
applicants.

Meeting Attendance A history class has 75 members.
If there is a 12% absentee rate per class meeting, find
the mean, variance, and standard deviation of the
number of students who will be absent from each class.

Income Tax Errors The probability that a person will
make 0, 1, 2, or 3 errors on his or her income tax return
is 0.50, 0.30, 0.15, and 0.05, respectively. If 30 claims
are selected, find the probability that 15 will contain 0
errors, 8 will contain 1 error, 5 will contain 2 errors, and
2 will contain 3 errors.

Critical Thinking Challenges

1.

Lottery Numbers Pennsylvania has a lottery entitled
“Big 4.” To win, a player must correctly match four
digits from a daily lottery in which four digits are
selected. Find the probability of winning.

. Lottery Numbers In the Big 4 lottery, for a bet of $100,

the payoff is $5000. What is the expected value of
winning? Is it worth it?

. Lottery Numbers If you played the same four-digit

number every day (or any four-digit number for that
matter) in the Big 4, how often (in years) would you
win, assuming you have average luck?
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Quality Control Check Before a television set leaves
the factory, it is given a quality control check. The
probability that a television contains 0, 1, or 2 defects is
0.88, 0.08, and 0.04, respectively. In a sample of 16
televisions, find the probability that 9 will have 0 defects,
4 will have 1 defect, and 3 will have 2 defects.

Bowling Team Uniforms Among the teams in a
bowling league, the probability that the uniforms are all
1 color is 0.45, that 2 colors are used is 0.35, and that

3 or more colors are used is 0.20. If a sample of 12
uniforms is selected, find the probability that 5 contain
only 1 color, 4 contain 2 colors, and 3 contain 3 or
more colors.

Elm Trees If 8% of the population of trees are elm trees,
find the probability that in a sample of 100 trees, there
are exactly 6 elm trees. Assume the distribution is
approximately Poisson.

Sports Score Hot Line Calls Sports Scores Hot Line
receives, on the average, 8§ calls per hour requesting the
latest sports scores. The distribution is Poisson in
nature. For any randomly selected hour, find the
probability that the company will receive

a. Atleast 8 calls
b. 3 or more calls
c. Atmost 7 calls

Color of Raincoats There are 48 raincoats for sale at
a local men’s clothing store. Twelve are black. If 6
raincoats are selected to be marked down, find the
probability that exactly 3 will be black.

Youth Group Officers A youth group has 8 boys and
6 girls. If a slate of 4 officers is selected, find the
probability that exactly

a. 3 are girls
b. 2 are girls
c. 4 are boys

. Chuck-a-Luck In the game Chuck-a-Luck, three dice

are rolled. A player bets a certain amount (say $1.00) on
a number from 1 to 6. If the number appears on 1 die,
the person wins $1.00. If it appears on 2 dice, the person
wins $2.00, and if it appears on all 3 dice, the person
wins $3.00. What are the chances of winning $1.00?
$2.00? $3.00?

. Chuck-a-Luck What is the expected value of the game

of Chuck-a-Luck if a player bets $1.00 on one number?



@ Data Projects

1. Business and Finance Assume that a life insurance

company would like to make a profit of $250 on a
$100,000 policy sold to a person whose probability of
surviving the year is 0.9985. What premium should the
company charge the customer? If the company would
like to make a $250 profit on a $100,000 policy at a
premium of $500, what is the lowest life expectancy it
should accept for a customer?

. Sports and Leisure Baseball, hockey, and basketball
all use a seven-game series to determine their
championship. Find the probability that with two evenly
matched teams a champion will be found in 4 games.
Repeat for 5, 6, and 7 games. Look at the historical
results for the three sports. How do the actual results
compare to the theoretical?

. Technology Use your most recent itemized phone bill
for the data in this problem. Assume that incoming and
outgoing calls are equal in the population (why is this a
reasonable assumption?). This means assume p = 0.5.
For the number of calls you made last month, what
would be the mean number of outgoing calls in a
random selection of calls? Also, compute the standard
deviation. Was the number of outgoing calls you made
an unusual amount given the above? In a selection of
12 calls, what is the probability that less than 3 were
outgoing?

4.
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Health and Wellness Use Red Cross data to

determine the percentage of the population with an Rh
factor that is positive (A+, B+, AB+, or O+ blood
types). Use that value for p. How many students in your
class have a positive Rh factor? Is this an unusual
amount?

. Politics and Economics Find out what percentage of

citizens in your state is registered to vote. Assuming that
this is a binomial variable, what would be the mean
number of registered voters in a random group of
citizens with a sample size equal to the number of
students in your class? Also determine the standard
deviation. How many students in your class are
registered to vote? Is this an unusual number, given the
above?

. Your Class Have each student in class toss 4 coins on

her or his desk, and note how many heads are showing.
Create a frequency table displaying the results.
Compare the frequency table to the theoretical
probability distribution for the outcome when 4 coins
are tossed. Find the mean for the frequency table. How
does it compare with the mean for the probability
distribution?

Answers to Applying the Concepts

Section 5-1 Dropping College Courses 4. The probability that a student will drop a class because
1. The random variable under study is the reason for of illness is about 28%. The probability that a student
dropping a college course. will drop a class because of money is about 5%. The
. probability that a student will drop a class because of a
2. There were a total O.f 144 people in the study. change of major is about 10%.
3. The complete table is as follows: 5. The information is not itself a probability distribution,

Reason for dropping but it can be used as one.

11 F P t. . . .
A coflege course requency ereemtage 6. The categories are not necessarily mutually exclusive,
Too difficult 45 31.25 but we treated them as such in computing the
Illness 40 27.78 probabilities.
Change in work schedule 20 13.89 . .
Change of major 14 972 7. The categories are not independent.
Family-related problems 9 6.25 8. The categories are exhaustive.
Money 7 4.86 9. Since all the probabilities are between 0 and 1, inclusive,
Miscellaneous 6 4.17 and the probabilities sum to 1, the requirements for a
No meaningful reason 3 2.08

discrete probability distribution are met.

5-47
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Section 5-2 Expected Value

1.

The expected value is the mean in a discrete probability
distribution.

. We would expect variation from the expected

value of 3.

. Answers will vary. One possible answer is that pregnant

mothers in that area might be overly concerned upon
hearing that the number of cases of kidney problems
in newborns was nearly 4 times what was usually
expected. Other mothers (particularly those who had
taken a statistics course!) might ask for more
information about the claim.

. Answers will vary. One possible answer is that it does

seem unlikely to have 11 newborns with kidney
problems when we expect only 3 newborns to have
kidney problems.

. The public might better be informed by percentages or

rates (e.g., rate per 1000 newborns).

. The increase of 8 babies born with kidney problems

represents a 0.32% increase (less than 3%).

. Answers will vary. One possible answer is that the

percentage increase does not seem to be something to
be overly concerned about.

Section 5-3 Unsanitary Restaurants

1.

The probability of eating at 3 restaurants with
unsanitary conditions out of the 10 restaurants is
0.18651.

. The probability of eating at 4 or 5 restaurants with

unsanitary conditions out of the 10 restaurants is
0.24623 + 0.22291 = 0.46914.

5-48

. To find this probability, you could add the probabilities

for eating at 1, 2, . . ., 10 unsanitary restaurants. An
easier way to compute the probability is to subtract the
probability of eating at no unsanitary restaurants from 1
(using the complement rule).

4. The highest probability for this distribution is 4, but the

expected number of unsanitary restaurants that you
would eat atis 10 - 2 = 4.3.

. The standard deviation for this distribution is

V(10)3)3) = 1.56.

. This is a binomial distribution. We have two possible

outcomes: “success” is eating in an unsanitary restaurant;
“failure” is eating in a sanitary restaurant. The probability
that one restaurant is unsanitary is independent of the
probability that any other restaurant is unsanitary.

The probability that a restaurant is unsanitary remains
constant at 3. And we are looking at the number of
unsanitary restaurants that we eat at out of 10 “trials.”

. The likelihood of success will vary from situation to

situation. Just because we have two possible outcomes,
this does not mean that each outcome occurs with
probability 0.50.

Section 5-4 Rockets and Targets

1. The theoretical values for the number of hits are as

follows:
Hits | 0 1 2 3 4 5
Regions | 2275 2113 982 304 7.1 13

2. The actual values are very close to the theoretical values.

3. Since the actual values are close to the theoretical values,

it does appear that the rockets were fired at random.
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Chapter 6 The Normal Distribution

Statistics
Today

What Is Normal?

Medical researchers have determined so-called normal intervals for a person’s blood
pressure, cholesterol, triglycerides, and the like. For example, the normal range of sys-
tolic blood pressure is 110 to 140. The normal interval for a person’s triglycerides is from
30 to 200 milligrams per deciliter (mg/dl). By measuring these variables, a physician can
determine if a patient’s vital statistics are within the normal interval or if some type of
treatment is needed to correct a condition and avoid future illnesses. The question then is,
How does one determine the so-called normal intervals? See Statistics Today—Revisited
at the end of the chapter.

In this chapter, you will learn how researchers determine normal intervals for specific
medical tests by using a normal distribution. You will see how the same methods are used
to determine the lifetimes of batteries, the strength of ropes, and many other traits.

Introduction

Random variables can be either discrete or continuous. Discrete variables and their dis-
tributions were explained in Chapter 5. Recall that a discrete variable cannot assume all
values between any two given values of the variables. On the other hand, a continuous
variable can assume all values between any two given values of the variables. Examples
of continuous variables are the heights of adult men, body temperatures of rats, and cho-
lesterol levels of adults. Many continuous variables, such as the examples just mentioned,
have distributions that are bell-shaped, and these are called approximately normally dis-
tributed variables. For example, if a researcher selects a random sample of 100 adult
women, measures their heights, and constructs a histogram, the researcher gets a graph
similar to the one shown in Figure 6—1(a). Now, if the researcher increases the sample size
and decreases the width of the classes, the histograms will look like the ones shown in
Figure 6-1(b) and (c). Finally, if it were possible to measure exactly the heights of all
adult females in the United States and plot them, the histogram would approach what is
called a normal distribution, shown in Figure 6—1(d). This distribution is also known as
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(a) Random sample of 100 women (b) Sample size increased and class width decreased

(c) Sample size increased and class width (d) Normal distribution for the population
decreased further

Mean
e Median
/ Mode
(a) Normal
Mean Median Mode Mode Median Mean
(b) Negatively skewed (c) Positively skewed

Objective [E}}

Identify distributions
as symmetric or
skewed.

a bell curve or a Gaussian distribution, named for the German mathematician Carl
Friedrich Gauss (1777-1855), who derived its equation.

No variable fits a normal distribution perfectly, since a normal distribution is a
theoretical distribution. However, a normal distribution can be used to describe many
variables, because the deviations from a normal distribution are very small. This concept
will be explained further in Section 6—1.

When the data values are evenly distributed about the mean, a distribution is said to
be a symmetric distribution. (A normal distribution is symmetric.) Figure 6-2(a) shows
a symmetric distribution. When the majority of the data values fall to the left or right of
the mean, the distribution is said to be skewed. When the majority of the data values fall
to the right of the mean, the distribution is said to be a negatively or left-skewed distri-
bution. The mean is to the left of the median, and the mean and the median are to the left
of the mode. See Figure 6-2(b). When the majority of the data values fall to the left of
the mean, a distribution is said to be a positively or right-skewed distribution. The
mean falls to the right of the median, and both the mean and the median fall to the right
of the mode. See Figure 6-2(c).
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Objective [E)

Identify the properties
of a normal
distribution.

Graph of a Circle and
an Application

Circle

>

Yy
N

X24y2=r2

Wheel

?
B

The “tail” of the curve indicates the direction of skewness (right is positive, left is
negative). These distributions can be compared with the ones shown in Figure 3—1 in
Chapter 3. Both types follow the same principles.

This chapter will present the properties of a normal distribution and discuss its
applications. Then a very important fact about a normal distribution called the central
limit theorem will be explained. Finally, the chapter will explain how a normal
distribution curve can be used as an approximation to other distributions, such as the
binomial distribution. Since a binomial distribution is a discrete distribution, a cor-
rection for continuity may be employed when a normal distribution is used for its
approximation.

Normal Distributions

In mathematics, curves can be represented by equations. For example, the equation of the
circle shown in Figure 6-3 is x> + y* = 72, where r is the radius. A circle can be used to
represent many physical objects, such as a wheel or a gear. Even though it is not possi-
ble to manufacture a wheel that is perfectly round, the equation and the properties of a
circle can be used to study many aspects of the wheel, such as area, velocity, and accel-
eration. In a similar manner, the theoretical curve, called a normal distribution curve,
can be used to study many variables that are not perfectly normally distributed but are
nevertheless approximately normal.
The mathematical equation for a normal distribution is

e~ W—pP/20?)

Y= o\/2mT

where

e =~ 2.718 (= means “is approximately equal to”)
T =~3.14
M = population mean

o = population standard deviation

This equation may look formidable, but in applied statistics, tables or technology is used
for specific problems instead of the equation.

Another important consideration in applied statistics is that the area under a normal
distribution curve is used more often than the values on the y axis. Therefore, when a
normal distribution is pictured, the y axis is sometimes omitted.

Circles can be different sizes, depending on their diameters (or radii), and can be
used to represent wheels of different sizes. Likewise, normal curves have different shapes
and can be used to represent different variables.

The shape and position of a normal distribution curve depend on two parameters, the
mean and the standard deviation. Each normally distributed variable has its own normal
distribution curve, which depends on the values of the variable’s mean and standard
deviation. Figure 6—4(a) shows two normal distributions with the same mean values but
different standard deviations. The larger the standard deviation, the more dispersed, or
spread out, the distribution is. Figure 6—4(b) shows two normal distributions with the
same standard deviation but with different means. These curves have the same shapes but
are located at different positions on the x axis. Figure 6—4(c) shows two normal distribu-
tions with different means and different standard deviations.
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Section 6-1 Normal Distributions
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(a) Same means but different standard deviations

/—Curve 2

o1 =0y

01> 0y

Curve 1 \ /—Curve 2

1
M

(b) Different means but same standard deviations

The discovery of the
equation for a normal
distribution can be
traced to three
mathematicians. In
1733, the French
mathematician
Abraham DeMoivre
derived an equation for
a normal distribution
based on the random
variation of the number
of heads appearing
when a large number
of coins were tossed.
Not realizing any
connection with the
naturally occurring
variables, he showed
this formula to only

a few friends. About
100 years later, two
mathematicians, Pierre
Laplace in France and
Carl Gauss in
Germany, derived the
equation of the normal
curve independently
and without any
knowledge of
DeMoivre's work. In
1924, Karl Pearson
found that DeMoivre
had discovered the
formula before Laplace
or Gauss.

|
Mo

T T
e Ha

(c) Different means and different standard deviations

A normal distribution is a continuous, symmetric, bell-shaped distribution of a
variable.

The properties of a normal distribution, including those mentioned in the definition,

are explained next.

Summary of the Properties of the Theoretical Normal Distribution

L.
2.
3.
4.

. The total area under a normal distribution curve is equal to 1.00, or 100%. This fact

. The area under the part of a normal curve that lies within 1 standard deviation of the

A normal distribution curve is bell-shaped.

The mean, median, and mode are equal and are located at the center of the distribution.
A normal distribution curve is unimodal (i.e., it has only one mode).

The curve is symmetric about the mean, which is equivalent to saying that its shape is the
same on both sides of a vertical line passing through the center.

The curve is continuous; that is, there are no gaps or holes. For each value of X, there is a
corresponding value of Y.

The curve never touches the x axis. Theoretically, no matter how far in either direction
the curve extends, it never meets the x axis—but it gets increasingly closer.

may seem unusual, since the curve never touches the x axis, but one can prove it
mathematically by using calculus. (The proof is beyond the scope of this textbook.)

mean is approximately 0.68, or 68%; within 2 standard deviations, about 0.95, or 95%);
and within 3 standard deviations, about 0.997, or 99.7%. See Figure 65, which also
shows the area in each region.

The values given in item 8 of the summary follow the empirical rule for data given

in Section 3-2.

that

You must know these properties in order to solve problems involving distributions
are approximately normal.
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Areas Under a Normal
Distribution Curve

34.13% | 34.13%

13.59%

| | | | | |
n=30 n-20 n-1o m pntlo u+20 n+ 30
\ \
\—— About68% —

~—— About95% ———
\ About 99.7% 4

The Standard Normal Distribution

Since each normally distributed variable has its own mean and standard deviation, as
stated earlier, the shape and location of these curves will vary. In practical applications,
then, you would have to have a table of areas under the curve for each variable. To sim-
plify this situation, statisticians use what is called the standard normal distribution.

Objective B The standard normal distribution is a normal distribution with a mean of 0 and a
Find the area under standard deviation of 1.

the standard normal
distribution, given
various z values.

The standard normal distribution is shown in Figure 6-6.

The values under the curve indicate the proportion of area in each section. For exam-
ple, the area between the mean and 1 standard deviation above or below the mean is
about 0.3413, or 34.13%.

The formula for the standard normal distribution is

e—zz/Z

Y= \ 2

All normally distributed variables can be transformed into the standard normally dis-
tributed variable by using the formula for the standard score:

value — mean X—pun
z= — or =
standard deviation o

This is the same formula used in Section 3—3. The use of this formula will be explained
in Section 6-3.

As stated earlier, the area under a normal distribution curve is used to solve practi-
cal application problems, such as finding the percentage of adult women whose height is
between 5 feet 4 inches and 5 feet 7 inches, or finding the probability that a new battery
will last longer than 4 years. Hence, the major emphasis of this section will be to show
the procedure for finding the area under the standard normal distribution curve for any
z value. The applications will be shown in Section 6—2. Once the X values are trans-
formed by using the preceding formula, they are called z values. The z value is actually
the number of standard deviations that a particular X value is away from the mean.
Table E in Appendix C gives the area (to four decimal places) under the standard normal
curve for any z value from —3.49 to 3.49.
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[y 1
Standard Normal
Distribution

34.13% | 34.13%

13.59%

Finding Areas Under the Standard Normal Distribution Curve

For the solution of problems using the standard normal distribution, a four-step proce-

Bell-shaped dure is recommended with the use of the Procedure Table shown.
distributions occurred

quite often in early

coin-tossing and Step 2 Find the appropriate figure in the Procedure Table and follow the directions
die-rolling experiments. given.

nlere no 1'd

Step 1 Draw the normal distribution curve and shade the area.

There are three basic types of problems, and all three are summarized in the
Procedure Table. Note that this table is presented as an aid in understanding how to use
the standard normal distribution table and in visualizing the problems. After learning
the procedures, you should not find it necessary to refer to the Procedure Table for every
problem.

Procedure Table e

Finding the Area Under the Standard Normal Distribution Curve

1. To the left of any z value: 2. To the right of any z value:
Look up the z value in the table and use the area given. Look up the z value and subtract the area from 1.

] T or i i T ] gl i T
0 +Z -z 0 -z 0 0 +Z

3. Between any two z values:
Look up both z values and subtract the
corresponding areas.

1 T ar T s
-z 0 +Z 0 z2

LI
—Z1—=2y 0
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Table E Area Value for
z=1.39

z 000 .. 0.09

0.0

@@

Table E in Appendix C gives the area under the normal distribution curve to the left
of any z value given in two decimal places. For example, the area to the left of a z value
of 1.39 is found by looking up 1.3 in the left column and 0.09 in the top row. Where the
two lines meet gives an area of 0.9177. See Figure 6-7.

Example 6-1

Figure 6—-8
Area Under the
Standard Normal
Distribution Curve for
Example 6-1

Find the area to the left of z = 1.99.

Solution

Step 1 Draw the figure. The desired area is shown in Figure 6-8.

|
0 1.99

Step 2 We are looking for the area under the standard normal distribution curve to
the left of z = 1.99. Since this is an example of the first case, look up the area
in the table. It is 0.9767. Hence 97.67% of the area is less than z = 1.99.

Example 6-2

Figure 6-9
Area Under the
Standard Normal
Distribution Curve for
Example 6-2

Find the area to the right of z = —1.16.

Solution

Step 1 Draw the figure. The desired area is shown in Figure 6-9.

-1.16 0
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Step 2 We are looking for the area to the right of z = —1.16. This is an example
of the second case. Look up the area for z = —1.16. It is 0.3770. Subtract it
from 1.000. 1.000 — 0.1230 = 0.8770. Hence 87.70% of the area under the
standard normal distribution curve is to the left of z = —1.16.

Figure 6-10

Area Under the
Standard Normal
Distribution Curve
for Example 6-3

Example 6-3

Find the area betweenz = +1.68 and z = —1.37.

Solution

Step 1 Draw the figure as shown. The desired area is shown in Figure 6-10.

-1.37 0 1.68

Step 2 Since the area desired is between two given z values, look up the areas
corresponding to the two z values and subtract the smaller area from the
larger area. (Do not subtract the z values.) The area for z = +1.68 is 0.9535,
and the area for z = —1.37 is 0.0853. The area between the two z values is
0.9535 — 0.0853 = 0.8682 or 86.82%.

A Normal Distribution Curve as a Probability Distribution Curve

A normal distribution curve can be used as a probability distribution curve for normally
distributed variables. Recall that a normal distribution is a continuous distribution, as
opposed to a discrete probability distribution, as explained in Chapter 5. The fact that it
is continuous means that there are no gaps in the curve. In other words, for every z value
on the x axis, there is a corresponding height, or frequency, value.

The area under the standard normal distribution curve can also be thought of as a
probability. That is, if it were possible to select any z value at random, the probability of
choosing one, say, between 0 and 2.00 would be the same as the area under the curve
between 0 and 2.00. In this case, the area is 0.4772. Therefore, the probability of
randomly selecting any z value between 0 and 2.00 is 0.4772. The problems involving
probability are solved in the same manner as the previous examples involving areas
in this section. For example, if the problem is to find the probability of selecting a
z value between 2.25 and 2.94, solve it by using the method shown in case 3 of the
Procedure Table.

For probabilities, a special notation is used. For example, if the problem is to
find the probability of any z value between 0 and 2.32, this probability is written as
P(0 < z<232).
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Note: In a continuous distribution, the probability of any exact z value is 0 since the
area would be represented by a vertical line above the value. But vertical lines in theory
havenoarea. So Pla =<z=<=b) = Pla<z<bh),

Example 6—-4 Find the probability for each.

a. P(0 <z <2232)
b. P(z < 1.65)
c. Pz>191)

Solution

a. P(0 <z < 2.32) means to find the area under the standard normal distribution
curve between 0 and 2.32. First look up the area corresponding to 2.32. It is
0.9898. Then look up the area corresponding to z = 0. It is 0.500. Subtract the
two areas: 0.9898 — 0.5000 = 0.4898. Hence the probability is 0.4898, or
48.98%. This is shown in Figure 6-11.

[
Area Under the
Standard Normal
Distribution Curve for
Part a of Example 6-4

0 2.32

b. P(z < 1.65) is represented in Figure 6—12. Look up the area corresponding
toz = 1.65 in Table E. It is 0.9505. Hence, P(z < 1.65) = 0.9505,
or 95.05%.

Area Under the
Standard Normal
Distribution Curve
for Part b of
Example 6-4

¢. P(z>1.91) is shown in Figure 6—13. Look up the area that corresponds to
z = 1.91. It is 0.9719. Then subtract this area from 1.0000. P(z < 1.91) =
1.0000 — 0.9719 = 0.0281, or 2.81%.

6-10
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Area Under the
Standard Normal
Distribution Curve
for Part c of
Example 6-4

o
.
©
=

Sometimes, one must find a specific z value for a given area under the standard
normal distribution curve. The procedure is to work backward, using Table E.

Since Table E is cumulative, it is necessary to locate the cumulative area up to a
given z value. Example 65 shows this.

Example 6-5 Find the z value such that the area under the standard normal distribution curve between
0 and the z value is 0.2123.

Solution

Draw the figure. The area is shown in Figure 6—14.

Figure 6-14 X—O.2123

Area Under the
Standard Normal
Distribution Curve for
Example 6-5

0 z

In this case it is necessary to add 0.5000 to the given area of 0.2123 to get the
cumulative area of 0.7123. Look up the area in Table E. The value in the left column is
0.5, and the top value is 0.06, so the positive z value for the area z = 0.56.

Next, find the area in Table E, as shown in Figure 6-15. Then read the correct z value
in the left column as 0.5 and in the top row as 0.06, and add these two values to get 0.56.

Finding the z Value
from Table E for 0.0
Example 6-5 01

0.2
0.3
0.4

0.5 {0.7123 )\

0.6 Start here
0.7

6-11



310 Chapter 6 The Normal Distribution

[
The Relationship

Between Area and
Probability

6-12

~ 3 units

(b) Rectangle

If the exact area cannot be found, use the closest value. For example, if you wanted
to find the z value for an area 0.9241, the closest area is 0.9236, which gives a z value of
1.43. See Table E in Appendix C.

The rationale for using an area under a continuous curve to determine a probability
can be understood by considering the example of a watch that is powered by a battery.
When the battery goes dead, what is the probability that the minute hand will stop some-
where between the numbers 2 and 5 on the face of the watch? In this case, the values of
the variable constitute a continuous variable since the hour hand can stop anywhere on
the dial’s face between 0 and 12 (one revolution of the minute hand). Hence, the sample
space can be considered to be 12 units long, and the distance between the numbers 2 and
51is 5 — 2, or 3 units. Hence, the probability that the minute hand stops on a number
between 2 and 5 is 75 = 3. See Figure 6-16(a).

The problem could also be solved by using a graph of a continuous variable. Let us
assume that since the watch can stop anytime at random, the values where the minute
hand would land are spread evenly over the range of 0 through 12. The graph would then
consist of a continuous uniform distribution with a range of 12 units. Now if we require
the area under the curve to be 1 (like the area under the standard normal distribution), the
height of the rectangle formed by the curve and the x axis would need to be 5. The reason
is that the area of a rectangle is equal to the base times the height. If the base is 12 units
long, then the height has to be {5 since 12 - {5 = 1.

The area of the rectangle with a base from 2 through 5 would be 3 - &5, or 5. See
Figure 6-16(b). Notice that the area of the small rectangle is the same as the probability
found previously. Hence the area of this rectangle corresponds to the probability of this
event. The same reasoning can be applied to the standard normal distribution curve
shown in Example 6-5.

Finding the area under the standard normal distribution curve is the first step in solving
a wide variety of practical applications in which the variables are normally distributed.
Some of these applications will be presented in Section 6-2.
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Applying the Concepts 6=-1

Assessing Normality

Many times in statistics it is necessary to see if a set of data values is approximately normally
distributed. There are special techniques that can be used. One technique is to draw a
histogram for the data and see if it is approximately bell-shaped. (Note: It does not have to
be exactly symmetric to be bell-shaped.)

The numbers of branches of the 50 top libraries are shown.

67 84 80 77 97 59 62 37 33 42
36 54 18 12 19 33 49 24 25 22
24 29 9 21 21 24 31 17 15 21
13 19 19 22 22 30 41 22 18 20
26 33 14 14 16 22 26 10 16 24

Source: The World Almanac and Book of Facts.
. Construct a frequency distribution for the data.
. Construct a histogram for the data.
. Describe the shape of the histogram.

AW N =

. Based on your answer to question 3, do you feel that the distribution is approximately normal?

In addition to the histogram, distributions that are approximately normal have about 68%
of the values fall within 1 standard deviation of the mean, about 95% of the data values fall
within 2 standard deviations of the mean, and almost 100% of the data values fall within
3 standard deviations of the mean. (See Figure 6-5.)

. Find the mean and standard deviation for the data.
. What percent of the data values fall within 1 standard deviation of the mean?

What percent of the data values fall within 2 standard deviations of the mean?
. What percent of the data values fall within 3 standard deviations of the mean?

© 0 o W

. How do your answers to questions 6, 7, and 8 compare to 68, 95, and 100%, respectively?
10. Does your answer help support the conclusion you reached in question 4? Explain.

(More techniques for assessing normality are explained in Section 6-2.)
See pages 353 and 354 for the answers.

e o1 IS

1. What are the characteristics of a normal distribution?

2. Why is the standard normal distribution important in
statistical analysis?

3. What is the total area under the standard normal
distribution curve?

4. What percentage of the area falls below the mean?
Above the mean?

5. About what percentage of the area under the normal
distribution curve falls within 1 standard deviation
above and below the mean? 2 standard deviations?
3 standard deviations?

For Exercises 6 through 25, find the area under the
standard normal distribution curve.

6. Betweenz = 0 andz = 1.89
7. Betweenz = 0 andz = 0.75
8. Betweenz = 0 andz = —0.46
9. Betweenz = 0 andz = —2.07

10. To the right of z = 2.11

11. To the right of z = 0.23

12. To the left of z = —0.75

13. To the left of z = —1.43

6-13
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14

15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.

Chapter 6 The Normal Distribution

Betweenz = 1.23 and z = 1.90

Betweenz = 1.05and z = 1.78

Betweenz = —0.96 and z = —0.36

Betweenz = —1.56 andz = —1.83

Betweenz = 0.24 andz = —1.12

Betweenz = —1.53 andz = —2.08

To the left of z = 1.31

To the left of z = 2.11

To the right of z = —1.92

To the right of z = —0.25

To the left of z = —2.15 and to the right of z = 1.62
To the right of z = 1.92 and to the left of z = —0.44

In Exercises 26 through 39, find the probabilities for
each, using the standard normal distribution.

26
27

28.
29.
30.
31.
32.
33.
34.
35.
36.
37.
38.
39.

P(0 <z < 1.96)
PO <z<0.67)
P(—123<z<0)
P(—1.57<z<0)
Pz > 0.82)
P(z > 2.83)
Pz < —1.77)
Pz < —121)
P(—0.20 < z < 1.56)
P(—2.46 <z < 1.74)
P(1.12 < z < 1.43)
P(1.46 < z < 2.97)
Pz > —1.43)
Pz < 1.42)

For Exercises 40 through 45, find the 7 value that
corresponds to the given area.

40.

0.4066

6-14

41.

42.

45.

0.4175

N

0.0239

\\\\\$<:—
|

0 z

0.0188\
| |
z 0

44,

0.9671
| |
0 z

0.8962
| |
z 0

46. Find the z value to the right of the mean so that

a.

S

o

54.78% of the area under the distribution curve lies
to the left of it.
69.85% of the area under the distribution curve lies
to the left of it.
88.10% of the area under the distribution curve lies
to the left of it.

47. Find the z value to the left of the mean so that

]

S

o

98.87% of the area under the distribution curve lies
to the right of it.
82.12% of the area under the distribution curve lies
to the right of'it.
60.64% of the area under the distribution curve lies
to the right of it.



48.

49.

Find two z values so that 48% of the middle area is
bounded by them.

Find two z values, one positive and one negative, that
are equidistant from the mean so that the areas in the
two tails total the following values.
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a. 5%
b. 10%
c. 1%

Extending the Concepts

50.

51.

S2.
53.
54.
55.

In the standard normal distribution, find the values of z for
the 75th, 80th, and 92nd percentiles.

FindP(—1<z<1),P(—2<z<2),and P(—3 <z <3).
How do these values compare with the empirical rule?
Find z; such that P(z > z;) = 0.1234.

Find z; such that P(—1.2 <z <z)) = 0.8671.

Find z; such that P(z, < z < 2.5) = 0.7672.

Find z,, such that the area between z; and z = —0.5 is
0.2345 (two answers).

56.
57.

S8.

Find z; such that P(—z, <z < z;) = 0.76.

Find the equation for the standard normal distribution
by substituting 0 for u and 1 for o in the equation

e*(X*p,)z/(Zo'z)
o\ 2w

Graph by hand the standard normal distribution by
using the formula derived in Exercise 57. Let w = 3.14
and e = 2.718. Use X values of —2, —1.5, —1, —0.5, 0,
0.5, 1, 1.5, and 2. (Use a calculator to compute the y
values.)

y:

Step by Step —

MINITAB
Step hy Step

Appendix C.

the storage box empty.
4. Click [OK].

Mormal Distribution

Help

The Standard Normal Distribution

It is possible to determine the height of the density curve given a value of z, the cumulative
area given a value of z, or a z value given a cumulative area. Examples are from Table E in

Find the Area to the Left of z= 1.39
1. Select Calc>Probability Distributions>Normal. There are three options.

2. Click the button for Cumulative probability. In the center section, the mean and standard
deviation for the standard normal distribution are the defaults. The mean should be 0, and
the standard deviation should be 1.

3. Click the button for Input Constant, then click inside the text box and type in 1.39. Leave

" Probability density
& Cumulative probability
" Inverse cumulative probability

Mean: [0.0
Standard deviation: 1.0
" Input column: !

Optional storage: I
& Input constant: 1.39

Optional storage: == |
" Graph

0K Cancel I
A2
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Cumulative Distribution Function

0.4+

U3+

DensityCurve

0.2+

0.1+

0.0+

Normal with mean = 0 and standard deviation = 1
x P(X<=x)
1.39  0.917736
The graph is not shown in the output.

6-16

The session window displays the result, 0.917736. If you choose the optional storage, type

in a variable name such as K1. The result will be stored in the constant and will not be in the
session window.

Find the Area to the Right of —2.06
1.
2.
3.

Select Calc>Probability Distributions>Normal.
Click the button for Cumulative probability.

Click the button for Input Constant, then enter —2.06 in the text box. Do not forget the
minus sign.

4. Click in the text box for Optional storage and type K1.
5. Click [OK]. The area to the left of —2.06 is stored in K1 but not displayed in the session

window.

To determine the area to the right of the z value, subtract this constant from 1, then display
the result.

. Select Calc>Calculator.

a) Type K2 in the text box for Store result in:.
b) Type in the expression 1 — K1, then click [OK].

. Select Data>Display Data. Drag the mouse over K1 and K2, then click [Select]

and [OK].

The results will be in the session window and stored in the constants.
Data Display B coeE

K1 0.0196993

K2 0.980301

. To see the constants and other information about the worksheet, click the Project Manager

icon. In the left pane click on the green worksheet icon, and then click the constants folder.
You should see all constants and their values in the right pane of the Project Manager.

. For the third example calculate the two probabilities and store them in K1 and K2.
. Use the calculator to subtract K1 from K2 and store in K3.

The calculator and project manager windows are shown.

18 Project Manager

5; Store result in variable: fﬁ? (1 RopertPad

Expression:
k2-kl = () Workshest 1
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Calculate a z Value Given the Cumulative Probability
Find the z value for a cumulative probability of 0.025.
1. Select Calc>Probability Distributions>Normal.
2. Click the option for Inverse cumulative probability, then the option for Input constant.
3. In the text box type .025, the cumulative area, then click [OK].
4. In the dialog box, the z value will be returned, —1.960.

Inverse Cumulative Distribution Function
Normal with mean = 0 and standard deviation = 1

P(X<=x) X
0.025 —1.95996

In the session window z is —1.95996.

TI-83 Plus or

TI-84 Plus
Step by Step

ngmalch(i.ii:E

. 1334995565
TDPmalc-df“{ “ETY, -

Standard Normal Random Variables

To find the probability for a standard normal random variable:

Press 2nd [DISTR], then 2 for normalcdf(

The form is normalcdf(lower z score, upper z score).

Use E99 for « (infinity) and —E99 for — (negative infinity). Press 2nd [EE] to get E.

Example: Area to the right of z = 1.11
normalcdf(1.11,E99)

- B265355433 Example: Area to the left of z = —1.93
normalcdf(—E99,—1.93)
Example: Area between z = 2.00 and z = 2.47
nornaledf€2-2.47 11 hormaledf(2.00,2.47)
. LB1559344012
m"’“””:'éég % %giﬁi To find the percentile for a standard normal random variable:
Press 2nd [DISTR], then 3 for the invNorm(
The form is invNorm(area to the left of z score)
Example: Find the z score such that the area under the standard normal curve to the left of it is
0.7123
invNorm(.7123)
Excel The Standard Normal Distribution
Step by Step Finding areas under the standard normal distribution curve

Example XL6-1

Find the area to the left of z = 1.99.
In a blank cell type: =NORMSDIST(1.99)
Answer: 0.976705

Example XL6-2

Find the area to the right of z = —2.04.
In a blank cell type: = I-NORMSDIST(—2.04)
Answer: 0.979325
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Example XL6-3

Find the area betweenz = —2.04 and z = 1.99.
In a blank cell type: =NORMSDIST(1.99) — NORMSDIST(—2.04)
Answer: 0.956029

Finding a z value given an area under the standard normal distribution curve

Example XL6-4

Find a z score given the cumulative area (area to the left of z) is 0.0250.
In a blank cell type: =NORMSINV(.025)
Answer: —1.95996

m Applications of the Normal Distribution

The standard normal distribution curve can be used to solve a wide variety of practical

Objective problems. The only requirement is that the variable be normally or approximately nor-

mally distributed. There are several mathematical tests to determine whether a variable
Find probabilities is normally distributed. See the Critical Thinking Challenges on page 352. For all the
for a normally problems presented in this chapter, you can assume that the variable is normally or
distributed variable approximately normally distributed.
by transforming it To solve problems by using the standard normal distribution, transform the original
into a standard variable to a standard normal distribution variable by using the formula
normal variable.

_ value — mean X
7 standard deviation or A

This is the same formula presented in Section 3—3. This formula transforms the values of
the variable into standard units or z values. Once the variable is transformed, then the
Procedure Table and Table E in Appendix C can be used to solve problems.

For example, suppose that the scores for a standardized test are normally distributed,
have a mean of 100, and have a standard deviation of 15. When the scores are trans-
formed to z values, the two distributions coincide, as shown in Figure 6—17. (Recall that
the z distribution has a mean of 0 and a standard deviation of 1.)

[ ]
Test Scores and Their
Corresponding z
Values

55 70 85 100 115 130 145

To solve the application problems in this section, transform the values of the variable
to z values and then find the areas under the standard normal distribution, as shown in
Section 6—1.
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Example 6-6

Figure 6-18

Area Under a
Normal Curve for
Example 6-6

Figure 6-19

Area and z Values for
Example 6-6

Holiday Spending

A survey by the National Retail Federation found that women spend on average $146.21
for the Christmas holidays. Assume the standard deviation is $29.44. Find the percentage
of women who spend less than $160.00. Assume the variable is normally distributed.

Solution

Step 1 Draw the figure and represent the area as shown in Figure 6—18.

~

$146.21 $160

Step 2 Find the z value corresponding to $160.00.

_ X—p _ $160.00 — §146.21 _
T $29.44

Hence $160.00 is 0.47 of a standard deviation above the mean of $146.21, as
shown in the z distribution in Figure 6—19.

~

0.47

0 0.47

Step 3 Find the area, using Table E. The area under the curve to the left of z = 0.47
is 0.6808.

Therefore 0.6808, or 68.08%, of the women spend less than $160.00 at Christmas time.

Example 6-7

Monthly Newspaper Recycling

Each month, an American household generates an average of 28 pounds of newspaper
for garbage or recycling. Assume the standard deviation is 2 pounds. If a household is
selected at random, find the probability of its generating

a. Between 27 and 31 pounds per month

b. More than 30.2 pounds per month
Assume the variable is approximately normally distributed.

Source: Michael D. Shook and Robert L. Shook, The Book of Odds.
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Solution a

Step 1 Draw the figure and represent the area. See Figure 6-20.

oy 1

Area Under a Normal
Curve for Part a of
Example 6-7

Astronomers in the
late 1700s and the
1800s used the

principles underlying X—uw  27-28

1
the normal distribution “ P 2 2

to correct X — w 31 — 28 3
measurement errors Z; = = ==—=1.5
. o 2 2
that occurred in
charting the positions Step 3 Find the appropriate area, using Table E. The area to the left of z, is 0.9332,
of the planets. and the area to the left of z, is 0.3085. Hence the area between z, and z, is
0.9332 — 0.3085 = 0.6247. See Figure 6-21.

Figwe6-21 | -~

Area and z Values for
Part a of Example 6-7

27 28 31

Step 2 Find the two z values.

=—0.5

|
27 28 31

-05 0 1.5

Hence, the probability that a randomly selected household generates between 27 and
31 pounds of newspapers per month is 62.47%.

Solution b

Step 1 Draw the figure and represent the area, as shown in Figure 6-22.

Area Under a Normal
Curve for Part b of
Example 6-7

28 30.2

Step 2 Find the z value for 30.2.

X—un 302-28 22
= = = —-—= 1.1
o 2

z
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Step 3 Find the appropriate area. The area to the left of z = 1.1 is 0.8643. Hence the
area to the right of z = 1.1 is 1.0000 — 0.8643 = 0.1357.

Hence, the probability that a randomly selected household will
accumulate more than 30.2 pounds of newspapers is 0.1357, or 13.57%.

A normal distribution can also be used to answer questions of “How many?” This
application is shown in Example 6-8.

Example 6-8

Area Under a
Normal Curve for
Example 6-8

Emergency Call Response Time

The American Automobile Association reports that the average time it takes to respond
to an emergency call is 25 minutes. Assume the variable is approximately normally
distributed and the standard deviation is 4.5 minutes. If 80 calls are randomly selected,
approximately how many will be responded to in less than 15 minutes?

Source: Michael D. Shook and Robert L. Shook, The Book of Odds.
Solution
To solve the problem, find the area under a normal distribution curve to the left of 15.

Step 1 Draw a figure and represent the area as shown in Figure 6-23.

15 25

Step 2 Find the z value for 15.

X—p 15-25
= = =-222
T 45

Step 3 Find the area to the left of z = —2.22. It is 0.0132.

Step 4 To find how many calls will be made in less than 15 minutes, multiply the
sample size 80 by 0.0132 to get 1.056. Hence, 1.056, or approximately 1, call
will be responded to in under 15 minutes.

Note: For problems using percentages, be sure to change the percentage to a decimal
before multiplying. Also, round the answer to the nearest whole number, since it is not
possible to have 1.056 calls.

Finding Data Values Given Specific Probabilities

A normal distribution can also be used to find specific data values for given percentages.
This application is shown in Example 6-9.
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Example 6-9 Police Academy Qualifications

To qualify for a police academy, candidates must score in the top 10% on a general

Objective B abilities test. The test has a mean of 200 and a standard deviation of 20. Find the lowest
Find specific data possible score to qualify. Assume the test scores are normally distributed.

values for given . Solution

percentages, using —_

the standard normal Since the test scores are normally distributed, the test value X that cuts off the upper 10%
distribution. of the area under a normal distribution curve is desired. This area is shown in Figure 6-24.

[
Area Under a

Normal Curve for
Example 6-9

10%, or 0.1000

200 X
Work backward to solve this problem.

Step 1 Subtract 0.1000 from 1.000 to get the area under the normal distribution to the
left of x: 1.0000 — 0.10000 = 0.9000.

Step 2 Find the z value that corresponds to an area of 0.9000 by looking up 0.9000 in
the area portion of Table E. If the specific value cannot be found, use the closest
value—in this case 0.8997, as shown in Figure 6-25. The corresponding z
value is 1.28. (If the area falls exactly halfway between two z values, use the
larger of the two z values. For example, the area 0.9500 falls halfway between
0.9495 and 0.9505. In this case use 1.65 rather than 1.64 for the z value.)

oo 1
Finding the z Value

from Table E 0.0
(Example 6-9) 01

Specific
value

0.2
1.1 (0.9000
1.2 {_0.8997 )'0.9015
1.3
1.4

Closest
value

mm Step 3 Substitute in the formula z = (X — w)/o and solve for X.

Americans are the 1.28 = X—200
largest consumers of 20
chocolate. We spend (1.28)(20) + 200 = X
$16.6 billion annually. 25.60 + 200 = X
225.60 = X
226 =X

A score of 226 should be used as a cutoff. Anybody scoring 226 or higher qualifies.
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Instead of using the formula shown in step 3, you can use the formula X =z - o + .
This is obtained by solving

for X as shown.
z-o=X—pu Multiply both sides by o.
z-ot+tu=X Add w to both sides.
X=z-0o+pu Exchange both sides of the equation.

Formula for Finding X

When you must find the value of X, you can use the following formula:

X=z-0g+pu

Example 6-10

Figure 6—-26

Area Under a
Normal Curve for
Example 6-10

Systolic Blood Pressure

For a medical study, a researcher wishes to select people in the middle 60% of the
population based on blood pressure. If the mean systolic blood pressure is 120 and the
standard deviation is 8, find the upper and lower readings that would qualify people to
participate in the study.

Solution

Assume that blood pressure readings are normally distributed; then cutoff points are as

shown in Figure 6-26.

20%

X 120 X

Figure 6-26 shows that two values are needed, one above the mean and one below
the mean. To get the area to the left of the positive z value, add 0.5000 + 0.3000 =
0.8000 (30% = 0.3000). The z value closest to 0.8000 is 0.84. Substituting in the
formula X = zo + u gives

X, =zo + p = (0.84)(8) + 120 = 126.72

The area to the left of the negative z value is 20%, or 2.000. The area closest to 0.2000
is —0.84.

X, = (—0.84)(8) + 120 = 113.28
Therefore, the middle 60% will have blood pressure readings of 113.28 < X' < 126.72.

As shown in this section, a normal distribution is a useful tool in answering many
questions about variables that are normally or approximately normally distributed.
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Determining Normality
A normally shaped or bell-shaped distribution is only one of many shapes that a distribu-
tion can assume; however, it is very important since many statistical methods require that
the distribution of values (shown in subsequent chapters) be normally or approximately
normally shaped.

There are several ways statisticians check for normality. The easiest way is to draw
a histogram for the data and check its shape. If the histogram is not approximately bell-
shaped, then the data are not normally distributed.

Skewness can be checked by using Pearson’s index PI of skewness. The formula is

3(X — median)
s

PI =

If the index is greater than or equal to +1 or less than or equal to —1, it can be concluded
that the data are significantly skewed.

In addition, the data should be checked for outliers by using the method shown in
Chapter 3. Even one or two outliers can have a big effect on normality.

Examples 6—11 and 6—12 show how to check for normality.

Example 6-11 Technology Inventories

A survey of 18 high-technology firms showed the number of days’ inventory they
had on hand. Determine if the data are approximately normally distributed.

5 29 34 44 45 63 68 74 74
81 88 91 97 98 113 118 151 158

Source: US4 TODAY.

Solution

Step 1 Construct a frequency distribution and draw a histogram for the data, as
shown in Figure 6-27.

Class Frequency
5-29 2
30-54 3
55-79 4
80-104 5
105-129 2
130-154 1
155-179 1

Figure 6-27

Histogram for
Example 6-11

Frequency
w

45 295 545 795 104.5 129.5 1545 179.5
Days
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Since the histogram is approximately bell-shaped, we can say that the distribution is
approximately normal.

Step 2

Step 3

Check for skewness. For these data, X = 79.5, median = 77.5, and s = 40.5.
Using Pearson’s index of skewness gives

3(79.5 — 717.5)
40.5

= 0.148

PI =

In this case, the PI is not greater than +1 or less than —1, so it can be
concluded that the distribution is not significantly skewed.

Check for outliers. Recall that an outlier is a data value that lies more than
1.5 (IQR) units below Q, or 1.5 (IQR) units above Q;. In this case, O, = 45
and O, = 98; hence, IQR = O; — O, = 98 — 45 = 53. An outlier would be
a data value less than 45 — 1.5(53) = —34.5 or a data value larger than

98 + 1.5(53) = 177.5. In this case, there are no outliers.

Since the histogram is approximately bell-shaped, the data are not significantly
skewed, and there are no outliers, it can be concluded that the distribution is
approximately normally distributed.

Example 6-12

oy 1
Histogram for
Example 6-12

Number of Baseball Games Played

The data shown consist of the number of games played each year in the career of
Baseball Hall of Famer Bill Mazeroski. Determine if the data are approximately
normally distributed.

81 148 152 135 151 152
159 142 34 162 130 162
163 143 67 112 70

Source: Greensburg Tribune Review.

Solution

Step 1

5t
.l
61
5 |
Al
.l
al

Frequency

Construct a frequency distribution and draw a histogram for the data. See
Figure 6-28.

Class Frequency

34-58

59-83

84-108
109-133
134-158
159-183

EEEN B \S B en VS IR

335 585 835 108.5 133.5 158.5 183.5
Games
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The histogram shows that the frequency distribution is somewhat negatively
skewed.

W Step 2 Check for skewness; X = 127.24, median = 143, and s = 39.87.

The average amount
of money stolen by a
pickpocket each time
is $128.

6-26

_ 3(X — median)

- S
3(127.24 — 143)

B 39.87

= —1.19

PI

Since the PI is less than —1, it can be concluded that the distribution is
significantly skewed to the left.

Step 3 Check for outliers. In this case, O, = 96.5 and O; = 155.5. IQR = O, —
0, = 155.5 — 96.5 = 59. Any value less than 96.5 — 1.5(59) = 8 or above
155.5 + 1.5(59) = 244 is considered an outlier. There are no outliers.

In summary, the distribution is somewhat negatively skewed.

Another method that is used to check normality is to draw a normal quantile plot.
Quantiles, sometimes called fractiles, are values that separate the data set into approxi-
mately equal groups. Recall that quartiles separate the data set into four approximately
equal groups, and deciles separate the data set into 10 approximately equal groups. A nor-
mal quantile plot consists of a graph of points using the data values for the x coordinates
and the z values of the quantiles corresponding to the x values for the y coordinates.
(Note: The calculations of the z values are somewhat complicated, and technology is usu-
ally used to draw the graph. The Technology Step by Step section shows how to draw a
normal quantile plot.) If the points of the quantile plot do not lie in an approximately
straight line, then normality can be rejected.

There are several other methods used to check for normality. A method using normal
probability graph paper is shown in the Critical Thinking Challenge section at the end of
this chapter, and the chi-square goodness-of-fit test is shown in Chapter 11. Two other
tests sometimes used to check normality are the Kolmogorov-Smikirov test and the
Lilliefors test. An explanation of these tests can be found in advanced textbooks.

Applying the Concepts 6—2

Smart People

Assume you are thinking about starting a Mensa chapter in your hometown of Visiala,
California, which has a population of about 10,000 people. You need to know how many
people would qualify for Mensa, which requires an 1Q of at least 130. You realize that IQ is
normally distributed with a mean of 100 and a standard deviation of 15. Complete the
following.

1. Find the approximate number of people in Visiala who are eligible for Mensa.
2. Is it reasonable to continue your quest for a Mensa chapter in Visiala?

3. How could you proceed to find out how many of the eligible people would actually join
the new chapter? Be specific about your methods of gathering data.

4. What would be the minimum IQ score needed if you wanted to start an Ultra-Mensa club
that included only the top 1% of I1Q scores?

See page 354 for the answers.




1.

Admission Charge for Movies The average admission
charge for a movie is $5.81. If the distribution of movie
admission charges is approximately normal with a
standard deviation of $0.81, what is the probability that a
randomly selected admission charge is less than $3.50?

Source: New York Times Almanac.

. Teachers’ Salaries The average annual salary for all

U.S. teachers is $47,750. Assume that the distribution is

normal and the standard deviation is $5680. Find the

probability that a randomly selected teacher earns

a. Between $35,000 and $45,000 a year

b. More than $40,000 a year

c¢. Ifyou were applying for a teaching position and
were offered $31,000 a year, how would you feel
(based on this information)?

Source: New York Times Almanac.

. Population in U.S. Jails The average daily jail

population in the United States is 706,242. If the
distribution is normal and the standard deviation is
52,145, find the probability that on a randomly selected
day, the jail population is

a. Greater than 750,000

b. Between 600,000 and 700,000

Source: New York Times Almanac.

. SAT Scores The national average SAT score (for

Verbal and Math) is 1028. If we assume a normal
distribution with o = 92, what is the 90th percentile
score? What is the probability that a randomly selected
score exceeds 1200?

Source: New York Times Almanac.

. Chocolate Bar Calories The average number of

calories in a 1.5-ounce chocolate bar is 225. Suppose
that the distribution of calories is approximately normal
with o = 10. Find the probability that a randomly
selected chocolate bar will have

a. Between 200 and 220 calories
b. Less than 200 calories

Source: The Doctor’s Pocket Calorie, Fat, and Carbohydrate Counter.

. Monthly Mortgage Payments The average monthly

mortgage payment including principal and interest is
$982 in the United States. If the standard deviation is
approximately $180 and the mortgage payments are
approximately normally distributed, find the probability
that a randomly selected monthly payment is

a. More than $1000

b. More than $1475

c. Between $800 and $1150

Source: World Almanac.

. Professors’ Salaries The average salary for a Queens

College full professor is $85,900. If the average salaries

10.

11.

12.

13.
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are normally distributed with a standard deviation of
$11,000, find these probabilities.

a. The professor makes more than $90,000.

b. The professor makes more than $75,000.

Source: AAUP, Chronicle of Higher Education.

. Doctoral Student Salaries Full-time Ph.D. students

receive an average of $12,837 per year. If the average
salaries are normally distributed with a standard
deviation of $1500, find these probabilities.
a. The student makes more than $15,000.
b. The student makes between $13,000 and

$14,000.

Source: U.S. Education Dept., Chronicle of Higher Education.

. Miles Driven Annually The mean number of miles

driven per vehicle annually in the United States is
12,494 miles. Choose a randomly selected vehicle, and
assume the annual mileage is normally distributed with
a standard deviation of 1290 miles. What is the
probability that the vehicle was driven more than 15,000
miles? Less than 8000 miles? Would you buy a vehicle
if you had been told that it had been driven less than
6000 miles in the past year?

Source: World Almanac.

Commute Time to Work The average commute to work
(one way) is 25 minutes according to the 2005 American
Community Survey. If we assume that commuting times
are normally distributed and that the standard deviation is
6.1 minutes, what is the probability that a randomly
selected commuter spends more than 30 minutes
commuting one way? Less than 18 minutes?

Source: www.census.gov

Credit Card Debt The average credit card debt for
college seniors is $3262. If the debt is normally
distributed with a standard deviation of $1100, find
these probabilities.

a. That the senior owes at least $1000

b. That the senior owes more than $4000

c. That the senior owes between $3000 and $4000
Source: USA TODAY.

Price of Gasoline The average retail price of gasoline
(all types) for the first half of 2005 was 212.2 cents. What
would the standard deviation have to be in order for a
15% probability that a gallon of gas costs less than $1.80?

Source: World Almanac.

Time for Mail Carriers The average time for a mail
carrier to cover a route is 380 minutes, and the standard
deviation is 16 minutes. If one of these trips is selected
at random, find the probability that the carrier will have
the following route time. Assume the variable is
normally distributed.
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a. Atleast 350 minutes

At most 395 minutes

c. How might a mail carrier estimate a range for the
time he or she will spend en route?

S

Newborn Elephant Weights Newborn elephant calves
usually weigh between 200 and 250 pounds—until
October 2006, that is. An Asian elephant at the Houston
(Texas) Zoo gave birth to a male calf weighing in at a
whopping 384 pounds! Mack (like the truck) is believed
to be the heaviest elephant calf ever born at a facility
accredited by the Association of Zoos and Aquariums.
If, indeed, the mean weight for newborn elephant calves
is 225 pounds with a standard deviation of 45 pounds,
what is the probability of a newborn weighing at least
384 pounds? Assume that the weights of newborn
elephants are normally distributed.

Source: www.houstonzoo.org

Waiting to Be Seated The average waiting time to be
seated for dinner at a popular restaurant is 23.5 minutes,
with a standard deviation of 3.6 minutes. Assume the
variable is normally distributed. When a patron arrives
at the restaurant for dinner, find the probability that the
patron will have to wait the following time.

a. Between 15 and 22 minutes

b. Less than 18 minutes or more than 25 minutes
c. Isitlikely that a person will be seated in less than
15 minutes?

Salary of Full-Time Male Professors The average
salary of a male full professor at a public four-year
institution offering classes at the doctoral level is
$99,685. For a female full professor at the same kind of
institution, the salary is $90,330. If the standard
deviation for the salaries of both genders is
approximately $5200 and the salaries are normally
distributed, find the 80th percentile salary for male
professors and for female professors.

Source: World Almanac.

Used Boat Prices A marine sales dealer finds that the
average price of a previously owned boat is $6492. He
decides to sell boats that will appeal to the middle 66%
of the market in terms of price. Find the maximum and
minimum prices of the boats the dealer will sell. The
standard deviation is $1025, and the variable is normally
distributed. Would a boat priced at $5550 be sold in

this store?

Itemized Charitable Contributions The average
charitable contribution itemized per income tax
return in Pennsylvania is $792. Suppose that the
distribution of contributions is normal with a standard
deviation of $103. Find the limits for the middle 50%
of contributions.

Source: IRS, Statistics of Income Bulletin.

New Home Sizes A contractor decided to build

homes that will include the middle 80% of the market.
If the average size of homes built is 1810 square feet,
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21.

23.

24.

25.

26.

find the maximum and minimum sizes of the homes the
contractor should build. Assume that the standard
deviation is 92 square feet and the variable is normally
distributed.

Source: Michael D. Shook and Robert L. Shook, The Book of Odds.

New Home Prices If'the average price of a new one-
family home is $246,300 with a standard deviation of
$15,000, find the minimum and maximum prices of the
houses that a contractor will build to satisfy the middle
80% of the market. Assume that the variable is normally
distributed.

Source: New York Times Almanac.

Cost of Personal Computers The average price of a
personal computer (PC) is $949. If the computer prices
are approximately normally distributed and o = $100,
what is the probability that a randomly selected PC costs
more than $1200? The least expensive 10% of personal
computers cost less than what amount?

Source: New York Times Almanac.

. Reading Improvement Program To help students

improve their reading, a school district decides to
implement a reading program. It is to be administered to
the bottom 5% of the students in the district, based on
the scores on a reading achievement exam. If the
average score for the students in the district is 122.6,
find the cutoff score that will make a student eligible for
the program. The standard deviation is 18. Assume the
variable is normally distributed.

Used Car Prices An automobile dealer finds that the
average price of a previously owned vehicle is $8256.
He decides to sell cars that will appeal to the middle
60% of the market in terms of price. Find the maximum
and minimum prices of the cars the dealer will sell. The
standard deviation is $1150, and the variable is normally
distributed.

Ages of Amtrak Passenger Cars The average age of
Amtrak passenger train cars is 19.4 years. If the
distribution of ages is normal and 20% of the cars are
older than 22.8 years, find the standard deviation.

Source: New York Times Almanac.

Lengths of Hospital Stays The average length of

a hospital stay for all diagnoses is 4.8 days. If we
assume that the lengths of hospital stays are normally
distributed with a variance of 2.1, then 10% of hospital
stays are longer than how many days? Thirty percent
of stays are less than how many days?

Source: www.cdc.gov

High School Competency Test A mandatory
competency test for high school sophomores has a
normal distribution with a mean of 400 and a standard
deviation of 100.

a. The top 3% of students receive $500. What is the
minimum score you would need to receive this
award?


www.houstonzoo.org
www.cdc.gov

27.

28.

29.

30.

31.

o

b. The bottom 1.5% of students must go to summer
school. What is the minimum score you would need
to stay out of this group?

Product Marketing An advertising company plans to
market a product to low-income families. A study states
that for a particular area, the average income per family
is $24,596 and the standard deviation is $6256. If the
company plans to target the bottom 18% of the families
based on income, find the cutoff income. Assume the
variable is normally distributed.

Bottled Drinking Water Americans drank an average
of 23.2 gallons of bottled water per capita in 2004. If the
standard deviation is 2.7 gallons and the variable is
normally distributed, find the probability that a randomly
selected American drank more than 25 gallons of bottled
water. What is the probability that the selected person
drank between 18 and 26 gallons?

Source: www.census.gov

Wristwatch Lifetimes The mean lifetime of a
wristwatch is 25 months, with a standard deviation of

5 months. If the distribution is normal, for how many
months should a guarantee be made if the manufacturer
does not want to exchange more than 10% of the watches?
Assume the variable is normally distributed.

Security Officer Stress Tolerance To qualify for
security officers’ training, recruits are tested for stress
tolerance. The scores are normally distributed, with a
mean of 62 and a standard deviation of 8. If only the
top 15% of recruits are selected, find the cutoff
score.

In the distributions shown, state the mean and

standard deviation for each. Hint: See Figures 6-5

and 6-6. Also the vertical lines are 1 standard deviation
apart.

| | | |
80 100

60 120 140 160 180
b.

| | | | | |
75 10 12.5 15 17.5 20 22.5
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| | | | | |
15 20 25 30 35 40 45

32. SAT Scores Suppose that the mathematics SAT scores
for high school seniors for a specific year have a mean
of 456 and a standard deviation of 100 and are
approximately normally distributed. If a subgroup of
these high school seniors, those who are in the National
Honor Society, is selected, would you expect the
distribution of scores to have the same mean and
standard deviation? Explain your answer.

33. Given a data set, how could you decide if the
distribution of the data was approximately normal?

34, If a distribution of raw scores were plotted and then the
scores were transformed to z scores, would the shape of
the distribution change? Explain your answer.

35. In a normal distribution, find o when u = 110 and
2.87% of the area lies to the right of 112.

36. In a normal distribution, find p when o is 6 and 3.75%
of the area lies to the left of 85.

37. In a certain normal distribution, 1.25% of the area lies
to the left of 42, and 1.25% of the area lies to the right
of 48. Find p and o

38. Exam Scores An instructor gives a 100-point
examination in which the grades are normally
distributed. The mean is 60 and the standard deviation
is 10. If there are 5% A’s and 5% F’s, 15% B’s and
15% D’s, and 60% C’s, find the scores that divide the
distribution into those categories.

39. Drive-in Movies The data shown represent the
number of outdoor drive-in movies in the United States
for a 14-year period. Check for normality.

2084 1497 1014 910 899 870
848 826 815 750 637 737

Source: National Association of Theater Owners.

837 859

40. Cigarette Taxes The data shown represent the
cigarette tax (in cents) for 30 randomly selected states.
Check for normality.

3 58 5 65 17 48 52 75 21 76 58 36
100 111 34 41 23 44 33 50 13 18 7 12
20 24 66 28 28 31

Source: Commerce Clearing House.
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41. Box Office Revenues The data shown represent

the box office total revenue (in millions of dollars) for
a randomly selected sample of the top-grossing films in
2001. Check for normality.

294 241 130 144 113 70 97
71 67 67 56 180 199 165 114 60
Source: US4 TODAY.

94 91 202 74 79
56 53 51

Step by Step

MINITAB

Determining Normality

42. Number of Runs Made The data shown
represent the number of runs made each year during
Bill Mazeroski’s career. Check for normality.

30 59 69 50 58 71 55 43 66 52 56 62
36 13 29 17 3

Source: Greensburg Tribune Review.

There are several ways in which statisticians test a data set for normality. Four are shown here.

Step by Step
Construct a Histogram
Inspect the histogram for
Data shape.
5 444 4 1. Enter the data in the first
5 29 3 5 column of a new
63 68 74 74 8l worksheet. Name the
88 91 97 98 113 column Inventory.
118 151 158

2. Use Stat>Basic
Statistics>Graphical
Summary presented in
Section 3-3 to create
the histogram. Is it
symmetric? Is there a
single peak?

Summary for Inventory
| Parling ity Tact
Men 75
Qe 4045 A-Squared 017
B-ialus 082
Maan 7950
siev WA
Wariance 1636.50
; [ Re—— 03
¥4 Kurtosiz ~0.0%
L N 12.00
B . Mirierrn £00
T T T T T 13t Quartile I5
0 0 o0 120 160 : P
ard Quartile 10175
Maxirnum 158.00
T T
a @ 100 15 35% Confiderme Inberval fur b
(525 w62
95% Confidence Intervals 5% Confidence Interval for Siama
Hean I I’ 30,3559 £0.65
| | 9590 Confidence Interval for Median
| . : : Z | : fA0% W48
= &0 70 a0 0 100

Check for Outliers

skewed distribution either.

calculator and the formula.

_ 3(X — median)
s

PI

e 0 I3 &

6-30

Inspect the boxplot for outliers. There are no outliers in this graph. Furthermore, the box is in
the middle of the range, and the median is in the middle of the box. Most likely this is not a

Calculate Pearson’s Index of Skewness

The measure of skewness in the graphical summary is not the same as Pearson’s index. Use the

3. Select Calc>Calculator, then type PI in the text box for Store result in:.

4. Enter the expression: 3*(MEAN(C1)—MEDI(C1))/(STDEV(C1)). Make sure you get all
the parentheses in the right place!

5. Click [OK]. The result, 0.148318, will be stored in the first row of C2 named PI. Since it is
smaller than +1, the distribution is not skewed.

Construct a Normal Probability Plot

. Select Graph>Probability Plot, then Single and click [OK].

. Double-click C1 Inventory to select the data to be graphed.

. Click [Distribution] and make sure that Normal is selected. Click [OK].

. Click [Labels] and enter the title for the graph: Quantile Plot for Inventory. You may
also put Your Name in the subtitle.

10. Click [OK] twice. Inspect the graph to see if the graph of the points is linear.



Quantile Plot for Inventory
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These data are nearly normal.

Normal - 95% CI What do you look for in the plot?
Wem 7B a) An “S curve” indicates a distribution that
3”"’ "“-: is too thick in the tails, a uniform
A0 01697 distribution, for example.
P-Value 0920

b) Concave plots indicate a skewed
distribution.

c) If one end has a point that is extremely
high or low, there may be outliers.

This data set appears to be nearly normal by
every one of the four criteria!

TI-83 Plus or

TI-84 Plus
Step by Step

rormal cdf (27 31,

T 6246552391
inwHorms . 9. Zea, 2

223.6310313

Normal Random Variables

To find the probability for a normal random variable:

Press 2nd [DISTR], then 2 for normalcdf(

The form is normalcdf(lower x value, upper x value, u, o)

Use E99 for < (infinity) and —E99 for —o0 (negative infinity). Press 2nd [EE] to get E.

Example: Find the probability that x is between 27 and 31 when u = 28 and o = 2
(Example 6—7a from the text).
normalcdf(27,31,28,2)

To find the percentile for a normal random variable:
Press 2nd [DISTR], then 3 for invNorm(
The form is invNorm(area to the left of x value, u, o)

Example: Find the 90th percentile when w = 200 and o = 20 (Example 6-9 from text).
invNorm(.9,200,20)

To construct a normal quantile plot:
1. Enter the data values into L.
. Press 2nd [STAT PLOT] to get the STAT PLOT menu.
. Press 1 for Plot 1.
. Turn on the plot by pressing ENTER while the cursor is flashing over ON.
. Move the cursor to the normal quantile plot (6th graph).
. Make sure L, is entered for the Data List and X is highlighted for the Data Axis.

. Press WINDOW for the Window menu. Adjust Xmin and Xmax according to the data
values. Adjust Ymin and Ymax as well, Ymin = —3 and Ymax = 3 usually work fine.

8. Press GRAPH.

N N N A WN

Using the data from the previous example gives

Flokz  Flokz 1T HOa

Off Emin=@ i
gpel ke k= dn Hmax=150 e "

Hh- HIH Hec1=28 g%
Data Listili Wmin=-32 g
Oata Axis:f v nmax=3 o
Hark: B + - Yaol=1
Ares=1

Since the points in the normal quantile plot lie close to a straight line, the distribution is
approximately normal.
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Excel
Step by Step

6-32

Normal Quantile Plot

Excel can be used to construct a normal quantile plot in order to examine if a set of data is
approximately normally distributed.

1. Enter the data from the MINITAB example into column A of a new worksheet. The data
should be sorted in ascending order. If the data are not already sorted in ascending order,
highlight the data to be sorted and select the Sort & Filter icon from the toolbar. Then
select Sort Smallest to Largest.

2. After all the data are entered and sorted in column A, select cell B1. Type:
=NORMSINV(1/(2*18)). Since the sample size is 18, each score represents 7, or
approximately 5.6%, of the sample. Each data value is assumed to subdivide the data into
equal intervals. Each data value corresponds to the midpoint of a particular subinterval.
Thus, this procedure will standardize the data by assuming each data value represents the
midpoint of a subinterval of width .

3. Repeat the procedure from step 2 for each data value in column A. However, for each
subsequent value in column A, enter the next odd multiple of 3¢ in the argument for the
NORMSINV function. For example, in cell B2, type: =NORMSINV(3/(2*18)). In cell
B3, type: =NORMSINV(5/(2*18)), and so on until all the data values have corresponding
Z scores.

4. Highlight the data from columns A and B, and select Insert, then Scatter chart. Select the
Scatter with only markers (the first Scatter chart).

5. To insert a title to the chart: Left-click on any region of the chart. Select Chart Tools and
Layout from the toolbar. Then select Chart Title.

6. To insert a label for the variable on the horizontal axis: Left-click on any region of the chart.
Select Chart Tools and Layout form the toolbar. Then select Axis Titles>Primary Horizontal
Axis Title.

eyl B Bkl - Microsoft Excel nan-cammercial use — *

) Home | lnsert Fage Layout  Formuias Data Review  View  Add-dng W - x

% i - - A AT A| Qns - { Ee g | aelnset- | E - :
& Calibni ”u : AN ™ o[ ZF General }g £ B 2% beiete - | (3]~ é? 'ﬁ

e 5 (LG [ W | () o S 51, e | o 2t IR

Chpbanrd & Font i augnment i Humber & Shiés Cem tamng

[ w - fe | j
A B c D E F (] H I Pl K k M N_| o i

1 5 -1.81451

2 29 -1.38299

3 31 108532

4 42 .0.86163

5 45 -0.67449

& 63 -0.50849

7 68 -0.35549

5 7¢ 021043 Normal Quantile Plot

bl 74 -0.06968 T g

10 Bl 0.065685 3 ' - :I

1 88 0210428 15 =

12 91 0.25549 % - q

13 97 0.508488 ak I

1 o 0.67448 & o7

15 113 0851634 05 o in ." 109 130 200 *Seriesl

16 18 10685325 a .

17 151 1.3829%4 a5 4 *

i3 158 1.914506 -3 i

18 as |

0 Number of Days’ Inventary

The points on the chart appear to lie close to a straight line. Thus, we deduce that the data are
approximately normally distributed.
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“ The Central Limit Theorem

Objective [
Use the central limit
theorem to solve
problems involving
sample means for
large samples.

In addition to knowing how individual data values vary about the mean for a population,
statisticians are interested in knowing how the means of samples of the same size taken
from the same population vary about the population mean.

Distribution of Sample Means

Suppose a researcher selects a sample of 30 adult males and finds the mean of the
measure of the triglyceride levels for the sample subjects to be 187 milligrams/deciliter.
Then suppose a second sample is selected, and the mean of that sample is found to be
192 milligrams/deciliter. Continue the process for 100 samples. What happens then is that
the mean becomes a random variable, and the sample means 187, 192, 184, ..., 196 con-
stitute a sampling distribution of sample means.

A sampling distribution of sample means is a distribution using the means
computed from all possible random samples of a specific size taken from a population.

If the samples are randomly selected with replacement, the sample means, for the
most part, will be somewhat different from the population mean w. These differences are
caused by sampling error.

Sampling error is the difference between the sample measure and the corresponding
population measure due to the fact that the sample is not a perfect representation of the
population.

When all possible samples of a specific size are selected with replacement from a
population, the distribution of the sample means for a variable has two important prop-
erties, which are explained next.

Properties of the Distribution of Sample Means

1. The mean of the sample means will be the same as the population mean.

2. The standard deviation of the sample means will be smaller than the standard deviation of
the population, and it will be equal to the population standard deviation divided by the
square root of the sample size.

The following example illustrates these two properties. Suppose a professor gave an
8-point quiz to a small class of four students. The results of the quiz were 2, 6, 4, and 8.
For the sake of discussion, assume that the four students constitute the population. The
mean of the population is

_2+6+4+8_5
® 4
The standard deviation of the population is

_\/(2—5)2+(6—5)2+(4—5)2+(8—5)2
7 4

= 2.236

The graph of the original distribution is shown in Figure 6-29. This is called a uniform
distribution.

6-33



332 Chapter 6 The Normal Distribution
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Two mathematicians
who contributed to

the development Now, if all samples of size 2 are taken with replacement and the mean of each sam-

of the central limit ple is found, the distribution is as shown.
theorem were

Abraham DeMoivre Sample Mean Sample Mean
(1667-1754) and 5 4
Pierre Simon Laplace
(1749-1827).
DeMoivre was once
jailed for his religious
beliefs. After his
release, DeMoivre
made a living by

consulting on the e .
mathematics of A frequency distribution of sample means is as follows.

f

AP
0 N BN BN
AN AWK~ W

0N PR DN PRDN

0 00 00 0 N NN O

o BEN Be NV RN e V)|

gambling and
insurance. He wrote
two books, Annuities
Upon Lives and The
Doctrine of Chance.
Laplace held a
government position
under Napoleon and
later under Louis XVIII.

He once CQWPUted For the data from the example just discussed, Figure 630 shows the graph of the
the probability of the sample means. The histogram appears to be approximately normal.

sun rising to be The mean of the sample means, denoted by u, is
18,226,214/

18,226,215. 24+34+...4+8 80
e T T

0NN B W N
— N WA W —

5

Figure 6-30

Distribution of Sample 51
Means

Frequency
w

Sample mean
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Each year a person
living in the United
States consumes on
average 1400 pounds
of food.
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which is the same as the population mean. Hence,
Mg = M
The standard deviation of sample means, denoted by o, is

\/(2—5)2+(3—5)2+---+(8—5)2
oy =

T = 1.581
which is the same as the population standard deviation, divided by \/2:
2.2
oy = % = 1.581

(Note: Rounding rules were not used here in order to show that the answers coincide.)
In summary, if all possible samples of size n are taken with replacement from the
same population, the mean of the sample means, denoted by x, equals the population
mean u; and the standard deviation of the sample means, denoted by o, equals al\/n.
The standard deviation of the sample means is called the standard error of the mean.

Hence,

A third property of the sampling distribution of sample means pertains to the shape
of the distribution and is explained by the central limit theorem.

The Central Limit Theorem

As the sample size n increases without limit, the shape of the distribution of the sample means
taken with replacement from a population with mean w and standard deviation o will
approach a normal distribution. As previously shown, this distribution will have a mean u and
a standard deviation o/\/n.

If the sample size is sufficiently large, the central limit theorem can be used to
answer questions about sample means in the same manner that a normal distribution can
be used to answer questions about individual values. The only difference is that a new
formula must be used for the z values. It is

_X-p
NG

Notice that X is the sample mean, and the denominator must be adjusted since means
are being used instead of individual data values. The denominator is the standard devia-
tion of the sample means.

If a large number of samples of a given size are selected from a normally distributed
population, or if a large number of samples of a given size that is greater than or equal to
30 are selected from a population that is not normally distributed, and the sample means
are computed, then the distribution of sample means will look like the one shown in
Figure 6-31. Their percentages indicate the areas of the regions.

It’s important to remember two things when you use the central limit theorem:

z

1. When the original variable is normally distributed, the distribution of the sample
means will be normally distributed, for any sample size .

2. When the distribution of the original variable might not be normal, a sample size of
30 or more is needed to use a normal distribution to approximate the distribution of
the sample means. The larger the sample, the better the approximation will be.
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e
Distribution of Sample
Means for a Large
Number of Samples

34.13% | 34.13%

13.59%

| | | | | |
pn=3cx p-20y p-loy ” w+loy wp+20y p+3oy

Examples 6—13 through 6—15 show how the standard normal distribution can be used
to answer questions about sample means.

Example 6-13 Hours That Children Watch Television

A. C. Neilsen reported that children between the ages of 2 and 5 watch an average of
25 hours of television per week. Assume the variable is normally distributed and the
standard deviation is 3 hours. If 20 children between the ages of 2 and 5 are randomly
selected, find the probability that the mean of the number of hours they watch television
will be greater than 26.3 hours.

Source: Michael D. Shook and Robert L. Shook, The Book of Odds.

Solution

Since the variable is approximately normally distributed, the distribution of sample
means will be approximately normal, with a mean of 25. The standard deviation of the
sample means is

o 3
037:75:_70= 0.671
The distribution of the means is shown in Figure 632, with the appropriate area

shaded.

Distribution of
the Means for
Example 6-13

25 26.3

The z value is

_X-—p_263-25_ 13
oNn 320 0671
The area to the right of 1.94 is 1.000 — 0.9738 = 0.0262, or 2.62%.

One can conclude that the probability of obtaining a sample mean larger than
26.3 hours is 2.62% [i.e., P(X > 26.3) = 2.62%].

=1.94

z
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Example 6-14

Area Under a
Normal Curve for
Example 6-14

The average age of a vehicle registered in the United States is 8 years, or 96 months.
Assume the standard deviation is 16 months. If a random sample of 36 vehicles is
selected, find the probability that the mean of their age is between 90 and 100 months.

Source: Harper s Index.
Solution

Since the sample is 30 or larger, the normality assumption is not necessary. The desired
area is shown in Figure 6-33.

90 96 100
The two z values are
90 — 96
z, = 16N/36 —2.25
100 — 96
zZ, = 1636 1.50

To find the area between the two z values of —2.25 and 1.50, look up the corresponding
area in Table E and subtract one from the other. The area for z = —2.25 15 0.0122,
and the area for z = 1.50 is 0.9332. Hence the area between the two values is
0.9332 — 0.0122 = 0.9210, or 92.1%.

Hence, the probability of obtaining a sample mean between 90 and 100 months is
92.1%; that is, P(90 < X < 100) = 92.1%.

Students sometimes have difficulty deciding whether to use

_X—n _X—p
=" N or 2=
The formula
_X—wu
z o/Nn

should be used to gain information about a sample mean, as shown in this section. The
formula

X—p
g

z =

is used to gain information about an individual data value obtained from the population.
Notice that the first formula contains X, the symbol for the sample mean, while the sec-
ond formula contains X, the symbol for an individual data value. Example 615 illus-
trates the uses of the two formulas.
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Example 6-15

[
Area Under a Normal
Curve for Part a of
Example 6-15

Area Under a Normal
Curve for Part b of
Example 6-15

6-38

Meat Consumption

The average number of pounds of meat that a person consumes per year is 218.4 pounds.
Assume that the standard deviation is 25 pounds and the distribution is approximately
normal.

Source: Michael D. Shook and Robert L. Shook, The Book of Odds.

a. Find the probability that a person selected at random consumes less than
224 pounds per year.

b. If a sample of 40 individuals is selected, find the probability that the mean of
the sample will be less than 224 pounds per year.

Solution

a. Since the question asks about an individual person, the formulaz = (X — w)/o is
used. The distribution is shown in Figure 6-34.

N\

218.4 224
Distribution of individual data values for the population

The z value is

X—p 2242184
o 25
The area to the left of z = 0.22 is 0.5871. Hence, the probability of selecting an
individual who consumes less than 224 pounds of meat per year is 0.5871, or
58.71% [i.e., P(X < 224) = 0.5871].
b. Since the question concerns the mean of a sample with a size of 40, the formula
z = (X — w)/(a/\/n) is used. The area is shown in Figure 6-35.

=0.22

z

]
218.4 224
Distribution of means for all samples of size 40 taken from the population

The z value is

_X—p 2242184 L4
o/Nn 25/A/40 '

The area to the left of z = 1.42 is 0.9222.

z
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Hence, the probability that the mean of a sample of 40 individuals is less than
224 pounds per year is 0.9222, or 92.22%. That is, P(X < 224) = 0.9222.

Comparing the two probabilities, you can see that the probability of selecting
an individual who consumes less than 224 pounds of meat per year is 58.71%,
but the probability of selecting a sample of 40 people with a mean consumption
of meat that is less than 224 pounds per year is 92.22%. This rather large
difference is due to the fact that the distribution of sample means is much less
variable than the distribution of individual data values. (Note: An individual
person is the equivalent of saying n = 1.)

Finite Population Correction Factor (Optional)

The formula for the standard error of the mean o/\/n is accurate when the samples are
drawn with replacement or are drawn without replacement from a very large or infinite pop-
ulation. Since sampling with replacement is for the most part unrealistic, a correction factor
is necessary for computing the standard error of the mean for samples drawn without
replacement from a finite population. Compute the correction factor by using the expression

N-—n
N-—1

where N is the population size and #» is the sample size.

This correction factor is necessary if relatively large samples are taken from a small
population, because the sample mean will then more accurately estimate the population
mean and there will be less error in the estimation. Therefore, the standard error of the
mean must be multiplied by the correction factor to adjust for large samples taken from
a small population. That is,

_ 0 \NZn
%TNn VN1
Finally, the formula for the z value becomes
X—u
= K
g N—n
vn VN-1

When the population is large and the sample is small, the correction factor is gener-
ally not used, since it will be very close to 1.00.
The formulas and their uses are summarized in Table 6—1.

6-1  Summary of Formulas and Their Uses

Formula Use
1. 7= X— Used to gain information about an individual data value when the variable
o= is normally distributed.
9 ;= X—pn Used to gain information when applying the central limit theorem about a
= N/n sample mean when the variable is normally distributed or when the

sample size is 30 or more.
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Applying the Concepts 6=3

Central Limit Theorem

Twenty students from a statistics class each collected a random sample of times on how long it
took students to get to class from their homes. All the sample sizes were 30. The resulting

means are listed.

Student Mean Std. Dev. Student Mean Std. Dev.
1 22 3.7 11 27 1.4
2 31 4.6 12 24 2.2
3 18 2.4 13 14 3.1
4 27 1.9 14 29 2.4
5 20 3.0 15 37 2.8
6 17 2.8 16 23 2.7
7 26 1.9 17 26 1.8
8 34 42 18 21 2.0
9 23 2.6 19 30 22

10 29 2.1 20 29 2.8

1. The students noticed that everyone had different answers. If you randomly sample over and
over from any population, with the same sample size, will the results ever be the same?

2. The students wondered whose results were right. How can they find out what the
population mean and standard deviation are?

3. Input the means into the computer and check to see if the distribution is normal.

4. Check the mean and standard deviation of the means. How do these values compare to the

students’ individual scores?

5. Is the distribution of the means a sampling distribution?

6. Check the sampling error for students 3, 7, and 14.

7. Compare the standard deviation of the sample of the 20 means. Is that equal to the standard
deviation from student 3 divided by the square of the sample size? How about for student

7, or 14?
See page 354 for the answers.

s s I

1.

If samples of a specific size are selected from a
population and the means are computed, what is this
distribution of means called?

. Why do most of the sample means differ somewhat

from the population mean? What is this difference
called?

. What is the mean of the sample means?

. What is the standard deviation of the sample means

called? What is the formula for this standard deviation?

. What does the central limit theorem say about the shape

of the distribution of sample means?

. What formula is used to gain information about an

individual data value when the variable is normally
distributed?
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7. What formula is used to gain information about a

sample mean when the variable is normally distributed
or when the sample size is 30 or more?

For Exercises 8 through 25, assume that the sample is
taken from a large population and the correction factor
can be ignored.

8. Glass Garbage Generation A survey found that the

American family generates an average of 17.2 pounds of
glass garbage each year. Assume the standard deviation of
the distribution is 2.5 pounds. Find the probability that the
mean of a sample of 55 families will be between 17 and
18 pounds.

Source: Michael D. Shook and Robert L. Shook, The Book of Odds.

. College Costs The mean undergraduate cost for tuition,

fees, room, and board for four-year institutions was
$26,489 for the 20042005 academic year. Suppose



10.

11.

12.

13.

14.

15.

that o = $3204 and that 36 four-year institutions are
randomly selected. Find the probability that the sample
mean cost for these 36 schools is

a. Less than $25,000
b. Greater than $26,000
c. Between $24,000 and $26,000

Source: www.nces.ed.gov

Teachers’ Salaries in Connecticut The average
teacher’s salary in Connecticut (ranked first among
states) is $57,337. Suppose that the distribution of
salaries is normal with a standard deviation of $7500.

a. What is the probability that a randomly selected
teacher makes less than $52,000 per year?

b. If we sample 100 teachers’ salaries, what is the
probability that the sample mean is less than
$56,000?

Source: New York Times Almanac.

Weights of 15-Year-Old Males The mean weight of
15-year-old males is 142 pounds, and the standard
deviation is 12.3 pounds. If a sample of thirty-six 15-year-
old males is selected, find the probability that the mean of
the sample will be greater than 144.5 pounds. Assume the
variable is normally distributed. Based on your answer,
would you consider the group overweight?

Teachers’ Salaries in North Dakota The average
teacher’s salary in North Dakota is $35,441. Assume a
normal distribution with o = $5100.

a. What is the probability that a randomly selected
teacher’s salary is greater than $45,000?

b. For a sample of 75 teachers, what is the probability
that the sample mean is greater than $38,000?

Source: New York Times Almanac.

Fuel Efficiency for U.S. Light Vehicles The average
fuel efficiency of U.S. light vehicles (cars, SUVs,
minivans, vans, and light trucks) for 2005 was 21 mpg.
If the standard deviation of the population was 2.9 and
the gas ratings were normally distributed, what is the
probability that the mean mpg for a random sample of
25 light vehicles is under 20? Between 20 and 25?

Source: World Almanac.

SAT Scores The national average SAT score (for
Verbal and Math) is 1028. Suppose that nothing is
known about the shape of the distribution and that the
standard deviation is 100. If a random sample of 200
scores were selected and the sample mean were
calculated to be 1050, would you be surprised? Explain.

Source: New York Times Almanac.

Sodium in Frozen Food The average number of
milligrams (mg) of sodium in a certain brand of low-salt
microwave frozen dinners is 660 mg, and the standard
deviation is 35 mg. Assume the variable is normally
distributed.

16.

17.

18.

19.

20.

21.
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a. Ifasingle dinner is selected, find the probability that the
sodium content will be more than 670 mg.

b. If a sample of 10 dinners is selected, find the
probability that the mean of the sample will be
larger than 670 mg.

¢.  Why is the probability for part a greater than that
for part »?

Worker Ages The average age of chemical engineers
is 37 years with a standard deviation of 4 years. If an
engineering firm employs 25 chemical engineers, find
the probability that the average age of the group is
greater than 38.2 years old. If this is the case, would it
be safe to assume that the engineers in this group are
generally much older than average?

Water Use The Old Farmer s Almanac reports that the
average person uses 123 gallons of water daily. If the
standard deviation is 21 gallons, find the probability that
the mean of a randomly selected sample of 15 people
will be between 120 and 126 gallons. Assume the
variable is normally distributed.

Medicare Hospital Insurance The average yearly
Medicare Hospital Insurance benefit per person was
$4064 in a recent year. If the benefits are normally
distributed with a standard deviation of $460, find the
probability that the mean benefit for a random sample
of 20 patients is

a. Less than $3800
b. More than $4100

Source: New York Times Almanac.

Amount of Laundry Washed Each Year Procter &
Gamble reported that an American family of four
washes an average of 1 ton (2000 pounds) of clothes
each year. If the standard deviation of the distribution is
187.5 pounds, find the probability that the mean of a
randomly selected sample of 50 families of four will be
between 1980 and 1990 pounds.

Source: The Harper's Index Book.

Per Capita Income of Delaware Residents In a recent
year, Delaware had the highest per capita annual income
with $51,803. If o = $4850, what is the probability that
a random sample of 34 state residents had a mean
income greater than $50,000? Less than $48,000?

Source: New York Times Almanac.

Time to Complete an Exam The average time it takes
a group of adults to complete a certain achievement test
is 46.2 minutes. The standard deviation is 8 minutes.
Assume the variable is normally distributed.

a. Find the probability that a randomly selected adult
will complete the test in less than 43 minutes.

b. Find the probability that if 50 randomly selected
adults take the test, the mean time it takes the
group to complete the test will be less than
43 minutes.
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c. Does it seem reasonable that an adult would finish
the test in less than 43 minutes? Explain.

d. Does it seem reasonable that the mean of the 50
adults could be less than 43 minutes?

Systolic Blood Pressure Assume that the mean systolic
blood pressure of normal adults is 120 millimeters of
mercury (mm Hg) and the standard deviation is 5.6.
Assume the variable is normally distributed.

a. Ifan individual is selected, find the probability that
the individual’s pressure will be between 120 and
121.8 mm Hg.

b. 1If a sample of 30 adults is randomly selected, find
the probability that the sample mean will be
between 120 and 121.8 mm Hg.

c¢.  Why is the answer to part a so much smaller than
the answer to part b?

Cholesterol Content The average cholesterol content
of a certain brand of eggs is 215 milligrams, and the
standard deviation is 15 milligrams. Assume the
variable is normally distributed.

a. Ifasingle egg is selected, find the probability
that the cholesterol content will be greater than
220 milligrams.

Extending the Concepts

For Exercises 26 and 27, check to see whether the
correction factor should be used. If so, be sure to include
it in the calculations.

26.

27.

Life Expectancies In a study of the life expectancy of
500 people in a certain geographic region, the mean age
at death was 72.0 years, and the standard deviation was
5.3 years. If a sample of 50 people from this region is
selected, find the probability that the mean life
expectancy will be less than 70 years.

Home Values A study of 800 homeowners in a certain
area showed that the average value of the homes was
$82,000, and the standard deviation was $5000. If 50
homes are for sale, find the probability that the mean of
the values of these homes is greater than $83,500.

24.

25.

28.

29.

30.

b. If a sample of 25 eggs is selected, find the
probability that the mean of the sample will be
larger than 220 milligrams.

Source: Living Fit.

Ages of Proofreaders At a large publishing company,
the mean age of proofreaders is 36.2 years, and the
standard deviation is 3.7 years. Assume the variable is
normally distributed.

a. Ifaproofreader from the company is randomly
selected, find the probability that his or her age will
be between 36 and 37.5 years.

b. If a random sample of 15 proofreaders is selected,
find the probability that the mean age of the
proofreaders in the sample will be between 36 and
37.5 years.

Weekly Income of Private Industry Information
Workers The average weekly income of information
workers in private industry is $777. If the standard
deviation is $77, what is the probability that a random
sample of 50 information workers will earn, on average,
more than $800 per week? Do we need to assume a
normal distribution? Explain.

Source: World Almanac.

Breaking Strength of Steel Cable The average
breaking strength of a certain brand of steel cable is
2000 pounds, with a standard deviation of 100 pounds.
A sample of 20 cables is selected and tested. Find the
sample mean that will cut off the upper 95% of all
samples of size 20 taken from the population. Assume
the variable is normally distributed.

The standard deviation of a variable is 15. If a sample of
100 individuals is selected, compute the standard error
of the mean. What size sample is necessary to double
the standard error of the mean?

In Exercise 29, what size sample is needed to cut the
standard error of the mean in half?

m The Normal Approximation to the Binomial

Distribution

A normal distribution is often used to solve problems that involve the binomial distribu-
tion since when 7 is large (say, 100), the calculations are too difficult to do by hand using
the binomial distribution. Recall from Chapter 5 that a binomial distribution has the fol-

lowing characteristics:

1. There must be a fixed number of trials.

2. The outcome of each trial must be independent.

6-42



Section 6-4 The Normal Approximation to the Binomial Distribution 341

3. Each experiment can have only two outcomes or outcomes that can be reduced to
two outcomes.

4. The probability of a success must remain the same for each trial.

Also, recall that a binomial distribution is determined by » (the number of trials) and
p (the probability of a success). When p is approximately 0.5, and as n increases, the
shape of the binomial distribution becomes similar to that of a normal distribution. The
larger n is and the closer p is to 0.5, the more similar the shape of the binomial distribu-
tion is to that of a normal distribution.
Objective But when p is close to 0 or 1 and # is relatively small, a normal approximation is
inaccurate. As a rule of thumb, statisticians generally agree that a normal approxima-
tion should be used only when n - p and n - ¢ are both greater than or equal to 5. (Note:
g = 1 — p.) For example, if p is 0.3 and # is 10, then np = (10)(0.3) = 3, and a normal
distribution should not be used as an approximation. On the other hand, if p = 0.5 and
n = 10, then np = (10)(0.5) = 5 and ng = (10)(0.5) = 5, and a normal distribution can
be used as an approximation. See Figure 6-36.

Use the normal
approximation to
compute probabilities
for a binomial variable.

Figure 6-36 P(X) Binomial probabilities for n=10, p=0.3

Comparison of the [n-p=10(03)=3;n-¢=10(0.7) = 7]
Binomial Distribution 03 1
and a Normal
Distribution
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In addition to the previous condition of np = 5 and ng = 5, a correction for conti-
nuity may be used in the normal approximation.

A correction for continuity is a correction employed when a continuous distribution is
used to approximate a discrete distribution.

The continuity correction means that for any specific value of X, say 8, the bound-
aries of X in the binomial distribution (in this case, 7.5 to 8.5) must be used. (See Sec-
tion 1-2.) Hence, when you employ a normal distribution to approximate the binomial,
you must use the boundaries of any specific value X as they are shown in the binomial
distribution. For example, for P(X = 8), the correction is P(7.5 < X < 8.5). For P(X = 7),
the correction is P(X < 7.5). For P(X = 3), the correction is P(X > 2.5).

Students sometimes have difficulty deciding whether to add 0.5 or subtract 0.5 from
the data value for the correction factor. Table 62 summarizes the different situations.

6-2  Summary of the Normal Approximation to the Binomial Distribution

Binomial Normal

When finding: Use:

1. P(X = a) Pla—05<X<a+0.5)
2. PX=a) P(X>a—0.5)

3. P(X>a) PX>a+0.5)

4. P(X=a) PX<a+0.5)

5. P(X<a) PX<a-—0.5)

Forallcases,u =n-p,c=\/n-p-qn-p=5andn-qg=5.

The formulas for the mean and standard deviation for the binomial distribution are
necessary for calculations. They are

mL=n-p and oc=\n"p-q

The steps for using the normal distribution to approximate the binomial distribution
are shown in this Procedure Table.

Procedure Table

Procedure for the Normal Approximation to the Binomial Distribution
Step1  Check to see whether the normal approximation can be used.
Step2 Find the mean p and the standard deviation o

Step 3  Write the problem in probability notation, using X.

Step4  Rewrite the problem by using the continuity correction factor, and show the
corresponding area under the normal distribution.

Step 5 Find the corresponding z values.

Step 6 Find the solution.
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Example 6-16

Area Under a Normal
Curve and X Values for
Example 6-16

Reading While Driving

A magazine reported that 6% of American drivers read the newspaper while driving. If
300 drivers are selected at random, find the probability that exactly 25 say they read the
newspaper while driving.

Source: USA Snapshot, USA TODAY.
Solution

Here, p = 0.06, ¢ = 0.94, and n = 300.
Step 1 Check to see whether a normal approximation can be used.
np = (300)(0.06) = 18 ng = (300)(0.94) = 282
Since np = 5 and ng = 5, the normal distribution can be used.
Step 2 Find the mean and standard deviation.
= np = (300)(0.06) = 18
o = Vnpq = V(300)0.06)(0.94) = \V/16.92 = 4.11
Step 3 Write the problem in probability notation: P(X = 25).

Step 4 Rewrite the problem by using the continuity correction factor. See
approximation number 1 in Table 6-2: P(25 — 0.5 < X <25 + 0.5) =
P(24.5 < X < 25.5). Show the corresponding area under the normal
distribution curve. See Figure 6-37.

/-25

1]
24.5 25.5

18

Step 5 Find the corresponding z values. Since 25 represents any value between 24.5
and 25.5, find both z values.

255 — 18 245 — 18
A=y M aT AT T

Step 6 The area to the left of z = 1.82 is 0.9656, and the area to the left of z = 1.58 is
0.9429. The area between the two z values is 0.9656 — 0.9429 = 0.0227, or
2.27%. Hence, the probability that exactly 25 people read the newspaper
while driving is 2.27%.

1.58

Example 6-17

Widowed Bowlers

Of the members of a bowling league, 10% are widowed. If 200 bowling league
members are selected at random, find the probability that 10 or more will be widowed.

Solution

Here, p = 0.10, ¢ = 0.90, and n = 200.

Step 1 Since np = (200)(0.10) = 20 and ng = (200)(0.90) = 180, the normal
approximation can be used.
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Figure 6-38

Area Under a Normal
Curve and X Value for
Example 6-17

Step2 = np = (200)(0.10) = 20
o = \Vnpg = V(200)0.10)0.90) = \/18 = 4.24

Step3 PX=10)

Step 4 See approximation number 2 in Table 6-2: P(X > 10 — 0.5) = P(X > 9.5).
The desired area is shown in Figure 6-38.

L
9.5 10 20

Step 5 Since the problem is to find the probability of 10 or more positive responses,
a normal distribution graph is as shown in Figure 6-38. Hence, the area
between 9.5 and 20 must be added to 0.5000 to get the correct approximation.

The z value is

9.5 —120
Step 6 The area to the left of z = —2.48 is 0.0066. Hence the area to the right of
z = —2.481s 1.0000 — 0.0066 = 0.9934, or 99.34%.

It can be concluded, then, that the probability of 10 or more widowed people in a
random sample of 200 bowling league members is 99.34%.

Example 6-18

6-46

Batting Averages
If a baseball player’s batting average is 0.320 (32%), find the probability that the player

will get at most 26 hits in 100 times at bat.
Solution
Here, p = 0.32, ¢ = 0.68, and n = 100.

Step 1 Since np = (100)(0.320) = 32 and nq = (100)(0.680) = 68, the normal
distribution can be used to approximate the binomial distribution.

Step2 u = np = (100)(0.320) = 32
o = Vnpq = V(100)0.32)(0.68) = \V/21.76 = 4.66
Step3 P(X =26)

Step 4 See approximation number 4 in Table 6-2: P(X <26 + 0.5) = P(X < 26.5).
The desired area is shown in Figure 6-39.

Step 5 The z value is

_265—32
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Step 6 The area to the left of z = —1.18 15 0.1190. Hence the probability is 0.1190,

or 11.9%.

The closeness of the normal approximation is shown in Example 6-19.

Example 6-19

Figure 6-40

Area Under a
Normal Curve for
Example 6-19

When n = 10 and p = 0.5, use the binomial distribution table (Table B in Appendix C)

to find the probability that X = 6. Then use the normal approximation to find the
probability that X = 6.

Solution

From Table B, for n = 10, p = 0.5, and X = 6, the probability is 0.205.
For a normal approximation,

w=np=(10)0.5) =5
o =Vnpq = V(10)0.5)0.5) = 1.58

Now, X = 6 is represented by the boundaries 5.5 and 6.5. So the z values are

65—75 55-5
158 0P 2T g

=0.32

zZ) =

The corresponding area for 0.95 is 0.8289, and the corresponding area for 0.32 is
0.6255. The area between the two z values of 0.95 and 0.32 is 0.8289 — 0.6255 =
0.2034, which is very close to the binomial table value of 0.205. See Figure 6—40.

~ 6
\/—

5 (;.5 (;Is

The normal approximation also can be used to approximate other distributions, such

as the Poisson distribution (see Table C in Appendix C).
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Applying the Concepts 6—4

How Safe Are You?

Assume one of your favorite activities is mountain climbing. When you go mountain climbing,
you have several safety devices to keep you from falling. You notice that attached to one of
your safety hooks is a reliability rating of 97%. You estimate that throughout the next year you
will be using this device about 100 times. Answer the following questions.

1. Does a reliability rating of 97% mean that there is a 97% chance that the device will not

fail any of the 100 times?

~N N L bW

Explain why or why not.

8. Is correction for continuity needed?

. What is the probability of at least one failure?

. What is the complement of this event?

. Can this be considered a binomial experiment?

. Can you use the binomial probability formula? Why or why not?
. Find the probability of at least two failures.

. Can you use a normal distribution to accurately approximate the binomial distribution?

9. How much safer would it be to use a second safety hook independently of the first?

See page 354 for the answers.

e o1

1. Explain why a normal distribution can be used as an
approximation to a binomial distribution. What
conditions must be met to use the normal distribution
to approximate the binomial distribution? Why is a
correction for continuity necessary?

2. (ans) Use the normal approximation to the binomial to
find the probabilities for the specific value(s) of X.

n=30,p=05X=18

n=50,p=08,X=44

n=100,p=0.1,X=12

n=10,p=05X=7

n=20,p=07,X=12

f n=50,p=0.6,X=40

& a0 =8

3. Check each binomial distribution to see whether it can
be approximated by a normal distribution (i.e., are
np = 5 and ng = 57).
a. n=20,p=0.5 d n=50,p=02
b. n=10,p = 0.6 e. n=30,p=0.8
c. n=40,p=09 f n=20,p=0.85

4. School Enrollment Of all 3- to 5-year-old children,
56% are enrolled in school. If a sample of 500 such
children is randomly selected, find the probability that
at least 250 will be enrolled in school.

Source: Statistical Abstract of the United States.

6-48

. Youth Smoking Two out of five adult smokers

acquired the habit by age 14. If 400 smokers are
randomly selected, find the probability that 170 or
more acquired the habit by age 14.

Source: Harper's Index.

. Theater No-shows A theater owner has found that 5%

of patrons do not show up for the performance that they
purchased tickets for. If the theater has 100 seats, find the
probability that 6 or more patrons will not show up for
the sold-out performance.

. Percentage of Americans Who Have Some College

Education The percentage of Americans 25 years or
older who have at least some college education is
53.1%. In a random sample of 300 Americans 25 years
old or older, what is the probability that more than 175
have at least some college education?

Source: New York Times Almanac.

. Household Computers According to recent surveys,

60% of households have personal computers. If a
random sample of 180 households is selected, what is
the probability that more than 60 but fewer than 100
have a personal computer?

Source: New York Times Almanac.

. Female Americans Who Have Completed 4 Years of

College The percentage of female Americans 25 years
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old and older who have completed 4 years of college
or more is 26.1. In a random sample of 200 American
women who are at least 25, what is the probability
that at least 50 have completed 4 years of college or
more?

Source: New York Times Almanac.

10. Population of College Cities College students often
make up a substantial portion of the population of
college cities and towns. State College, Pennsylvania,
ranks first with 71.1% of its population made up of
college students. What is the probability that in a
random sample of 150 people from State College, more
than 50 are not college students?

12.

13.
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Telephone Answering Devices Seventy-eight percent
of U.S. homes have a telephone answering device. In a
random sample of 250 homes, what is the probability
that fewer than 50 do not have a telephone answering
device?

Source: New York Times Almanac.

Parking Lot Construction The mayor of a small town
estimates that 35% of the residents in the town favor
the construction of a municipal parking lot. If there are
350 people at a town meeting, find the probability that
at least 100 favor construction of the parking lot. Based
on your answetr, is it likely that 100 or more people
would favor the parking lot?

Source: www.infoplease.com 14

. Residences of U.S. Citizens According to the U.S.
Census, 67.5% of the U.S. population were born in
their state of residence. In a random sample of 200
Americans, what is the probability that fewer than 125
were born in their state of residence?

11. Elementary School Teachers Women comprise 80.3%
of all elementary school teachers. In a random sample of
300 elementary teachers, what is the probability that
more than three-fourths are women?

Source: New York Times Almanac. Source: www.census.gov

Extending the Concepts

15. Recall that for use of a normal distribution as an a. p=0.1 d p=038
approximation to the binomial distribution, the b. p=03 e. p=09
conditions np = 5 and ng = 5 must be met. For each e p=05

given probability, compute the minimum sample size
needed for use of the normal approximation.

Summary

A normal distribution can be used to describe a variety of variables, such as heights,
weights, and temperatures. A normal distribution is bell-shaped, unimodal, symmetric,
and continuous; its mean, median, and mode are equal. Since each variable has its own
distribution with mean p and standard deviation o, mathematicians use the standard
normal distribution, which has a mean of 0 and a standard deviation of 1. Other approx-
imately normally distributed variables can be transformed to the standard normal distri-
bution with the formulaz = (X — u)/o.

A normal distribution can also be used to describe a sampling distribution of sample
means. These samples must be of the same size and randomly selected with replacement
from the population. The means of the samples will differ somewhat from the population
mean, since samples are generally not perfect representations of the population from which
they came. The mean of the sample means will be equal to the population mean; and the
standard deviation of the sample means will be equal to the population standard deviation,
divided by the square root of the sample size. The central limit theorem states that as the
size of the samples increases, the distribution of sample means will be approximately
normal.

A normal distribution can be used to approximate other distributions, such as a
binomial distribution. For a normal distribution to be used as an approximation, the con-
ditions np = 5 and ng = 5 must be met. Also, a correction for continuity may be used for
more accurate results.
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important Terms

central limit theorem 333 normal distribution 303

correction for
continuity 342

positively or right-skewed
distribution 301

negatively or left-skewed
distribution 301

sampling distribution of
sample means 331

important Formulas

Formula for the z value (or standard score):

X_
=Xom
o

Formula for finding a specific data value:
X=zr0+p
Formula for the mean of the sample means:

Mg =M

Review Exercises

1. Find the area under the standard normal distribution
curve for each.

Betweenz = 0 and z = 1.95
Betweenz = 0 and z = 0.37
Betweenz = 1.32 andz = 1.82
Betweenz = —1.05 and z = 2.05
Betweenz = —0.03 andz = 0.53
Betweenz = +1.10andz = —1.80
To the right of z = 1.99

To the right of z = —1.36

To the left of z = —2.09

To the left of z = 1.68

2. Using the standard normal distribution, find each
probability.

PO < z < 2.07)
P(—1.83 <z < 0)
P(—1.59 < z < +2.01)
P(133 <z < 1.88)
P(—2.56 <z<0.37)
P(z > 1.66)

P(z < —2.03)

P> —1.19)

P(z < 1.93)

P> —1.77)

TS E0 TR AN &R
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sampling error 331 symmetric
standard error of the distribution 301
mean 333 z value 304

standard normal
distribution 304

Formula for the standard error of the mean:

o.=—+

= Vn

Formula for the z value for the central limit theorem:

_X—-n
‘T oNn

Formulas for the mean and standard deviation for the
binomial distribution:

p=n-p o=\n-pyq

3. Per Capita Spending on Health Care The average per
capita spending on health care in the United States is
$5274. If the standard deviation is $600 and the
distribution of health care spending is approximately
normal, what is the probability that a randomly selected
person spends more than $6000? Find the limits of the
middle 50% of individual health care expenditures.

Source: World Almanac.

4. Salaries for Actuaries The average salary for
graduates entering the actuarial field is $40,000. If the
salaries are normally distributed with a standard
deviation of $5000, find the probability that

a. An individual graduate will have a salary over
$45,000.

b. A group of nine graduates will have a group average
over $45,000.

Source: www.BeAnActuary.org

5. Speed Limits The speed limit on Interstate 75 around
Findlay, Ohio, is 65 mph. On a clear day with no
construction, the mean speed of automobiles was
measured at 63 mph with a standard deviation of 8§ mph.
If the speeds are normally distributed, what percentage
of the automobiles are exceeding the speed limit? If the


www.BeAnActuary.org

10.

11.

Highway Patrol decides to ticket only motorists
exceeding 72 mph, what percentage of the motorists
might they arrest?

. Monthly Spending for Paging and Messaging

Services The average individual monthly spending in
the United States for paging and messaging services
is $10.15. If the standard deviation is $2.45 and the
amounts are normally distributed, what is the
probability that a randomly selected user of these
services pays more than $15.00 per month? Between
$12.00 and $14.00 per month?

Source: New York Times Almanac.

. Average Precipitation For the first 7 months of the

year, the average precipitation in Toledo, Ohio, is
19.32 inches. If the average precipitation is normally
distributed with a standard deviation of 2.44 inches,
find these probabilities.

a. Arandomly selected year will have precipitation
greater than 18 inches for the first 7 months.

b. Five randomly selected years will have an average
precipitation greater than 18 inches for the first
7 months.

Source: Toledo Blade.

. Suitcase Weights The average weight of an airline

passenger’s suitcase is 45 pounds. The standard deviation
is 2 pounds. If 15% of the suitcases are overweight, find
the maximum weight allowed by the airline. Assume the
variable is normally distributed.

. Confectionary Products Americans ate an average of

25.7 pounds of confectionary products each last year
and spent an average of $61.50 per person doing so. If
the standard deviation for consumption is 3.75 pounds
and the standard deviation for the amount spent is
$5.89, find the following:

a. The probability that the sample mean confectionary
consumption for a random sample of 40 American
consumers was greater than 27 pounds.

b. The probability that for a random sample of 50, the
sample mean for confectionary spending exceeded
$60.00.

Source: www.census.gov

Retirement Income Of the total population of
American households, including older Americans and
perhaps some not so old, 17.3% receive retirement
income. In a random sample of 120 households, what

is the probability that greater than 20 households but less
than 35 households receive a retirement income?

Source: www.bls.gov

Portable CD Player Lifetimes A recent study of the
life span of portable compact disc players found the
average to be 3.7 years with a standard deviation of
0.6 year. If a random sample of 32 people who own CD
players is selected, find the probability that the mean

12.

13.

14.

15.

18.
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Review Exercises

lifetime of the sample will be less than 3.4 years. If the
mean is less than 3.4 years, would you consider that
3.7 years might be incorrect?

Slot Machines The probability of winning on a slot
machine is 5%. If a person plays the machine 500 times,
find the probability of winning 30 times. Use the normal
approximation to the binomial distribution.

Multiple-Job Holders According to the government
5.3% of those employed are multiple-job holders. In a
random sample of 150 people who are employed, what
is the probability that fewer than 10 hold multiple jobs?
What is the probability that more than 50 are not
multiple-job holders?

Source: www.bls.gov

Enrollment in Personal Finance Course In a large
university, 30% of the incoming first-year students elect
to enroll in a personal finance course offered by the
university. Find the probability that of 800 randomly
selected incoming first-year students, at least 260 have
elected to enroll in the course.

U.S. Population Of the total population of the United
States, 20% live in the northeast. If 200 residents of the
United States are selected at random, find the probability
that at least 50 live in the northeast.

Source: Statistical Abstract of the United States.

16. Heights of Active Volcanoes The heights (in feet
above sea level) of a random sample of the world’s
active volcanoes are shown here. Check for
normality.

13,435 5,135 11,339 12,224 7,470
9,482 12,381 7,674 5,223 5,631
3,566 7,113 5,850 5,679 15,584
5,587 8,077 9,550 8,064 2,686
5,250 6,351 4,594 2,621 9,348
6,013 2,398 5,658 2,145 3,038

Source: New York Times Almanac.

17. Private Four-Year College Enrollment A

random sample of enrollments in Pennsylvania’s
private four-year colleges is listed here. Check for
normality.

1350 1886 1743 1290 1767

2067 1118 3980 1773 4605

1445 3883 1486 980 1217

3587

Source: New York Times Almanac.
Construct a set of at least 15 data values which appear to

be normally distributed. Verify the normality by using one
of the methods introduced in this text.
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Statistics
Today

What Is Normal?—Revisited

Many of the variables measured in medical tests—blood pressure, triglyceride level, etc.—are

approximately normally distributed for the majority of the population in the United States. Thus,
researchers can find the mean and standard deviation of these variables. Then, using these two
measures along with the z values, they can find normal intervals for healthy individuals. For
example, 95% of the systolic blood pressures of healthy individuals fall within 2 standard
deviations of the mean. If an individual’s pressure is outside the determined normal range (either
above or below), the physician will look for a possible cause and prescribe treatment if necessary.

Chapter Quiz

Determine whether each statement is true or false. If the
statement is false, explain why.

1.
2.

The total area under a normal distribution is infinite.

The standard normal distribution is a continuous
distribution.

. All variables that are approximately normally distributed

can be transformed to standard normal variables.

. The z value corresponding to a number below the mean

is always negative.

. The area under the standard normal distribution to the

left of z = 0 is negative.

. The central limit theorem applies to means of samples

selected from different populations.

Select the best answer.

7.

10.

11.

The mean of the standard normal distribution is

a 0 c. 100
b. 1 d. Variable

. Approximately what percentage of normally distributed

data values will fall within 1 standard deviation above
or below the mean?

a. 68%
c. 99.7%

b. 95%
d. Variable

. Which is not a property of the standard normal

distribution?

a. It’s symmetric about the mean.
b. It’s uniform.

c. It’s bell-shaped.

d. Tt’s unimodal.

When a distribution is positively skewed, the
relationship of the mean, median, and mode from left to
right will be

a. Mean, median, mode
c. Median, mode, mean

b. Mode, median, mean
d. Mean, mode, median

The standard deviation of all possible sample means
equals

a. The population standard deviation
b. The population standard deviation divided by the
population mean
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¢.  The population standard deviation divided by the
square root of the sample size
d. The square root of the population standard deviation

Complete the following statements with the best answer.

12.

13.

14.
15.

16.

17.

18.

19.

When one is using the standard normal distribution,
P(z<0)=

The difference between a sample mean and a population
mean is due to

The mean of the sample means equals

The standard deviation of all possible sample means is
called

The normal distribution can be used to approximate the
binomial distribution when # - p and n - ¢ are both
greater than or equal to

The correction factor for the central limit theorem
should be used when the sample size is greater than
the size of the population.

Find the area under the standard normal distribution
for each.

Between 0 and 1.50
Between 0 and —1.25
Between 1.56 and 1.96
Between —1.20 and —2.25
Between —0.06 and 0.73
Between 1.10 and —1.80
To the right of z = 1.75

To the right of z = —1.28
To the left of z = —2.12
To the left of z = 1.36

TSR TN AN =R

Using the standard normal distribution, find each
probability.

P(0 <z<2.16)

P(—1.87<z<0)

P(—1.63<z<2.17)

P(1.72 <z<1.98)

P(—=2.17<z<0.71)

P(z>1.77)

P(z < —2.37)

Pz > —1.73)

S0 TR R0 R



20.

21.

22,

23.

24.

25.

i. Pz <2.03)
j. P> —1.02)

Amount of Rain in a City The average amount of
rain per year in Greenville is 49 inches. The standard
deviation is 8 inches. Find the probability that next year
Greenville will receive the following amount of rainfall.
Assume the variable is normally distributed.

a. Atmost 55 inches of rain

b. Atleast 62 inches of rain

c. Between 46 and 54 inches of rain

d. How many inches of rain would you consider to be
an extremely wet year?

Heights of People The average height of a certain age
group of people is 53 inches. The standard deviation is

4 inches. If the variable is normally distributed, find the
probability that a selected individual’s height will be

a. Greater than 59 inches

b. Less than 45 inches

c. Between 50 and 55 inches
d. Between 58 and 62 inches

Lemonade Consumption The average number of
gallons of lemonade consumed by the football team
during a game is 20, with a standard deviation of

3 gallons. Assume the variable is normally distributed.
When a game is played, find the probability of using

a. Between 20 and 25 gallons
b. Less than 19 gallons

¢. More than 21 gallons

d. Between 26 and 28 gallons

Years to Complete a Graduate Program The average
number of years a person takes to complete a graduate
degree program is 3. The standard deviation is

4 months. Assume the variable is normally distributed.
If an individual enrolls in the program, find the
probability that it will take

a. More than 4 years to complete the program

b. Less than 3 years to complete the program

c. Between 3.8 and 4.5 years to complete the
program

d. Between 2.5 and 3.1 years to complete the
program

Passengers on a Bus On the daily run of an express
bus, the average number of passengers is 48. The
standard deviation is 3. Assume the variable is normally
distributed. Find the probability that the bus will have

a. Between 36 and 40 passengers
b. Fewer than 42 passengers

c. More than 48 passengers

d. Between 43 and 47 passengers

Thickness of Library Books The average thickness of
books on a library shelf'is 8.3 centimeters. The standard
deviation is 0.6 centimeter. If 20% of the books are
oversized, find the minimum thickness of the oversized
books on the library shelf. Assume the variable is
normally distributed.

26.

27.

28.

29.

30.

31.

32.

Chapter Quiz 351

Membership in an Organization Membership in an
elite organization requires a test score in the upper 30%
range. If w = 115 and o = 12, find the lowest
acceptable score that would enable a candidate to apply
for membership. Assume the variable is normally
distributed.

Repair Cost for Microwave Ovens The average repair
cost of a microwave oven is $55, with a standard
deviation of $8. The costs are normally distributed. If
12 ovens are repaired, find the probability that the mean
of the repair bills will be greater than $60.

Electric Bills The average electric bill in a residential
area is $72 for the month of April. The standard
deviation is $6. If the amounts of the electric bills are
normally distributed, find the probability that the mean
of the bill for 15 residents will be less than $75.

Sleep Survey According to a recent survey, 38% of
Americans get 6 hours or less of sleep each night. If 25
people are selected, find the probability that 14 or more
people will get 6 hours or less of sleep each night. Does
this number seem likely?

Source: Amazing Almanac.

Factory Union Membership If 10% of the people

in a certain factory are members of a union, find the
probability that, in a sample of 2000, fewer than 180
people are union members.

Household Online Connection The percentage of
U.S. households that have online connections is
44.9%. In a random sample of 420 households, what
is the probability that fewer than 200 have online
connections?

Source: New York Times Almanac.

Computer Ownership Fifty-three percent of U.S.
households have a personal computer. In a random
sample of 250 households, what is the probability that
fewer than 120 have a PC?

Source: New York Times Almanac.
33. Calories in Fast-Food Sandwiches The number of

calories contained in a selection of fast-food sandwiches
is shown here. Check for normality.

390 405 580 300 320
540 225 720 470 560
535 660 530 290 440
390 675 530 1010 450
320 460 290 340 610
430 530

Source: The Doctor s Pocket Calorie, Fat, and Carbohydrate Counter.

34. GMAT Scores The average GMAT scores for the
top-30 ranked graduate schools of business are listed
here. Check for normality.

718 703 703 703 700 690 695 705 690 688
676 681 689 686 691 669 674 652 680 670
651 651 637 662 641 645 645 642 660 636
Source: U.S. News & World Report Best Graduate Schools.
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Critical Thinking Challenges

Sometimes a researcher must decide whether a variable is
normally distributed. There are several ways to do this. One
simple but very subjective method uses special graph paper,
which is called normal probability paper. For the distribution
of systolic blood pressure readings given in Chapter 3 of the
textbook, the following method can be used:

1. Make a table, as shown.

Cumulative
Cumulative percent

Boundaries  Frequency frequency frequency
89.5-104.5 24
104.5-119.5 62
119.5-134.5 72
134.5-149.5 26
149.5-164.5 12
164.5-179.5 4
200

2. Find the cumulative frequencies for each class, and
place the results in the third column.

. Find the cumulative percents for each class by dividing

each cumulative frequency by 200 (the total frequencies)
and multiplying by 100%. (For the first class, it would be
24/200 X 100% = 12%.) Place these values in the last
column.

. Using the normal probability paper shown in Table 6-3,

label the x axis with the class boundaries as shown and
plot the percents.

. If the points fall approximately in a straight line, it can

be concluded that the distribution is normal. Do you feel
that this distribution is approximately normal? Explain
your answer.

. To find an approximation of the mean or median, draw a

horizontal line from the 50% point on the y axis over to
the curve and then a vertical line down to the x axis.
Compare this approximation of the mean with the
computed mean.

6-3  Normal Probability Paper

D
[=p]
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7. To find an approximation of the standard deviation,

locate the values on the x axis that correspond to the
16 and 84% values on the y axis. Subtract these two
values and divide the result by 2. Compare this

@ Data Projects

1.

Business and Finance Use the data collected in data
project 1 of Chapter 2 regarding earnings per share to
complete this problem. Use the mean and standard
deviation computed in data project 1 of Chapter 3 as
estimates for the population parameters. What value
separates the top 5% of stocks from the others?

. Sports and Leisure Find the mean and standard

deviation for the batting average for a player in the
most recently completed MBL season. What batting
average wou